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What’s New:  
This section provides information on updates and additions that have been made to 
DeltaGraph® since version 5.0. 

DeltaGraph v 7.0 
DeltaGraph 7 is a major new release of DeltaGraph for Macintosh and Windows, 
incorporating user interface changes as well as several new and enhanced features. We’ve 
listed below some of the interface changes as well as the major new features in the Mac OS X 
version. 

New Features: 
• Free rotation of (most) drawing objects 

• Show values under cursor 

• Highlight Data for Chart 

• Improved Undo 

• Pantone™ color swatch files are no longer included in the DeltaGraph install. 
However, DeltaGraph supports use of color swatch files in the .ai or .acb file format. 

• Improved software activation experience, with fewer restrictions on users 

• New optional cross platform library file format. Version 7 library files are cross-
platform, but the user may continue to use and create version 6 libraries. 

• Use Default Chart Font: When using the Chart Advisor or Chart Gallery, the user 
now has the option of using the default chart font (as specified in the user 
preferences) when creating new charts from a library. In past versions, all standard 
charts were created using the default chart font, while all library charts were created 
with the font specified when the chart was added to the library. Now the user can 
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specify that the default chart font be used when creating new charts from a library. 

• New, optional file format produces smaller files than version 6 for large data sets. 
Version 7 documents will be smaller (especially those with large data sheets) than 
version 6 documents. However, the user may continue to use and create version 6 
documents. 

• DeltaGraph 7 is supported only on Mac OS X 10.5 and later 

• DeltaGraph 7 is now a signed application. 

Free Rotation of Draw Objects 
Free rotation of is performed by selecting the object in the Draw 
view, and then choosing the Other… option under the Rotate item in 
the Draw menu: 

 

The dialog below will be displayed: 
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A number between 0 and 359 (inclusive) can be entered. 

Show Values under Cursor 
A floating window containing the value of the data point beneath the 
cursor in the selected chart can be shown. Select the chart, then 
choose the Show Values… item in the Chart Menu: 
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In the Show Values dialog, select the “On Cursor” item from the 
location popup menu. 
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Highlight Data for Chart 
The data represented by the selected chart element(s) can be 
highlighted in the Data sheet by selecting a chart element, and then 
selecting the “Highlight Data for Chart” item in the Chart menu. 
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Using Supported Color Swatch files with 
DeltaGraph 7 

Color swatch files in the .acb and .ai file formats can be used by 
DeltaGraph. In order to use color swatch files of these types, make a 
copy of the desired swatch files in the “Color Swatches” folder inside 
the DeltaGraph application folder. 
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All swatch files in the Color Swatches folder of the correct format will be shown in the Color 
Books window displayed by clicking the Swatches button in the Color Set window (available 
via the “Colors…” menu  item in the Edit menu. 
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DeltaGraph v 6.0 
DeltaGraph 6 is a major new release of DeltaGraph for Macintosh and Windows, 
incorporating user interface changes as well as several new and enhanced features. We’ve 
listed below some of the interface changes as well as the major new features in the Mac OS X 
version. 

Interface Changes: 
• New, Mac OS X style document window. 

 Command Bar, Status Bars now integrated into Document Window 

• The Scale Editor in the Command Bar is gone 

• Outliner is gone 

• Slide Show functionality is gone 

• Sorter View has become Organizer View 

• The Header / Footer Editor dialog, which used to be accessed via the Print Dialog, is 
now accessed directly from the item in the File Menu 

• The Document Setup… menu item in the File Menu is gone. Custom page sizes are 
now supported using the Mac OS X Page Setup Dialog. All pages use the Printer’s 
Page size as selected in the Page Setup Dialog. 

• In Chart View, new, fully Unicode Text Editor 

• Color Editor Window no longer directly references Pantone. 

 The old “Pantone Colors” button now says “Swatches” 

 The Pantone color books are no longer embedding in the DeltaGraph 
application file. 

Instead, all color book files in the .ai or .acb file format that are included in 
the “Color Swatches” folder in the DeltaGraph installation folder will be 
included in the color books listed in the dialog presented if you click the 
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“Swatches” button 

• Miscellaneous user interface changes 

 Rearranged Edit, View, Page menus 

 Font submenu is gone, in favor of Mac OS X Font Window 

Functionality Changes: 
• New, fully cross-platform file format 

• Full cross application support for Unicode international text. 

• Added “Draw In CMYK” to preferences 

• New implementation of EPS export uses Mac OS X services 

• PDF export supports Spot Colors 

• Both PDF and EPS support either CMYK or RGB color models 

• New Unicode Text Editor 

• The font menu is gone, in favor of Mac OS X Font Window 

• Not all fonts will now support condensed, extended, or bold styles  

• DeltaGraph 6 is supported only on Mac OS X 10.4 and later	
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DeltaGraph v 5.0.2 
The following features were added to DeltaGraph version 5.0.2: 

• Updated import/export support for Microsoft® Excel files 
(including Excel v.X) 

• Added data linking (for Excel or text files) 

Linking a Data File to a DeltaGraph Data Page 
You can create and save a data file in another application (Microsoft 
Excel or any application that saves data in a tab-, comma-, space-, 
multi-space-, or custom-delimited text format) and then add the data 
from the file to a DeltaGraph Data page by “linking” the file to 
DeltaGraph from the application in which you created it. When you 
update or modify linked data in the original application, the data are 
also updated in DeltaGraph when you open the DeltaGraph document 
containing the linked data. 

NOTE  ☞ You can link only one file to a Data page, and the linked data 
overwrite any existing data on the page. 

NOTE  ☞ If you add data to a page with a linked file, and then you add data to 
the linked file, the data in the linked file may overwrite the other data 
on the page.	
  

Linking a Text or Excel File 
To link a text data file or Excel file to a DeltaGraph document by 
importing it, do the following. 

1. Save the data file in a format that can be imported into 
DeltaGraph (tab-, comma-, space-, multi-space-, or custom-
delimited text format, or Excel). 

2. Open DeltaGraph. 

3. Open the destination Data page in a new or existing DeltaGraph 
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document 

4. Choose Import from the File menu. 

5. From the Show pop-up menu, select the format of the data file to 
be imported. 

6. Navigate to the data file name, and click Open. The message 
“Keep data linked to its file?” is displayed. 

7. Click Yes. The data file is linked to the DeltaGraph Data page. 

The selected data are written into the Data page starting in the upper 
left-hand corner and overwriting any existing data. A link is 
established to the original document in its original application, and the 
DeltaGraph Data page is automatically renamed with the title of the 
linked document. You can create only one link per Data page. 

Updating Linked Data 
To update linked data, modify the data in the application that contains 
the linked data (e.g., Microsoft Excel). When you update or modify 
linked data in the original application, the data are also updated in 
DeltaGraph when you open the Delta- Graph document containing 
the linked data. 

You can edit linked data in the Data page, but if you subsequently 
modify the linked document, the changes you made in the Data page 
are replaced by the updated linked data. To preserve changes you 
make to linked data in a Data page, you must unlink the document 
(see “Unlinking a Data File” below). 

If you delete a linked data file, a dialog box is displayed for you to 
find the file when you open the DeltaGraph document. You need to 
unlink the document (see “Unlinking a Data File” below). 

Unlinking a Data File 
After you link a file to a Data page, the “Link” command on the Data 
menu changes to “Unlink.” To break the link between a file in 
another application and a DeltaGraph Data page, select Unlink from 
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the Data menu, or press cmd-L. 

The data remain in the Data page, but the page is longer 
automatically updated when you change the data in the original file. 
You can modify the data in the Data page and save it. 

DeltaGraph v 5.5 
The following features were added to DeltaGraph version 5.5. 

• Drag and drop data import: 

You can import data files (including delimited text files and 
Excel files) by dragging them into the Data view. 

• Drag and drop image import: 

You can import image files of supported formats by dragging 
them into the Chart view. 

• Drag and drop export to other applications: 

You can export charts and other objects or groups of objects by 
dragging them into other applications. This places a PICT and a 
PDF version of the image on the clipboard. The receiving 
application decides which to use. 

• Pasting delimited data (tab, space, comma): 

A “Paste Delimited” option has been added to the Edit menu. 
After you cut or copy data from a space-, tab-, or comma-
delimited file, select Paste Delimited to paste the data into a Data 
page. You will be asked to specify the delimiter and the data will 
be added to the data page. 

• Added export formats: 

Additional export formats are now available (see Chapter 1, 
“Introduction” or Chapter 14, “Importing and Exporting 
Graphics”). 

• PDF import: 



 
  DeltaGraph for Macintosh Version 7 User Guide 4 

You can import Adobe PDF images to chart pages. 

• PDF export: 

You can now export individual charts or objects as PDF images 
(rather than printing to PDF, which prints the whole chart 
page). 

• Improved export quality for non-embedding export formats: 

The export process now takes full advantage of the OS X Quartz 
engine when exporting non-embedded image types (JPG, BMP, 
Photoshop, QuickTime, TIFF, etc.) . When exporting images, a 
full range of image quality options is now available by clicking 
the Options button. 

• Improved text rendering: 

Text is now fully rendered using the Quartz engine. 

• Transparency support: 

A Transparency tool has been added to the Toolbox in the Chart 
view (see below). 

• Quartz shadow support: 

A “Quartz” option has been added to the shadow types in the 
“Drop Shadow” dialog box in the Chart view (see “Adding Quartz 
Shadows to Objects” below). 

Adding Transparency to Objects 
You can add transparency to an object or objects in the Chart view 
using the Transparency tool in the Toolbox. Transparency effects are 
maintained if you export the image in any format except EPS or PICT. 
Transparency layers are maintained when you export the image as a 
PDF. 

Do the following to apply transparency to an object(s). 

1.  Select the object(s) you want to make transparent. 
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2.  Select the Transparency tool from the toolbox. A percentage scale 
appears. 

 

3.  Click and drag the slider on the scale to select the percentage of 
transparency you want the object to have from 0% (no 
transparency) to 100% (complete transparency, object not 
visible) 

 

The transparency is applied as soon as you release the mouse 
button. 
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Adding Quartz Shadows to Objects 
In addition to drop and inset shadows, you can add a Quartz shadow to 
an object or objects in the Chart view. A Quartz shadow is a drop 
shadow that can be made soft and blurry.  

You can place a Quartz shadow behind any Draw, Chart, or Text 
object in the Chart view. When you place a Quartz shadow behind a 
Text object, the shadow is placed behind object (the rectangle around 
the text) and not behind the text itself. (You can place a drop shadow 
behind the text itself.) You must apply a fill pattern to the Text object 
for the Quartz shadow to be drawn. 

To place a Quartz shadow behind an object, do the following: 

1.  Select the object(s) you want to change. 

2.  Choose Shadows from the Draw menu. The “Drop 
Shadow” dialog box appears. 

3.  At the Shadow Type pop-up menu, select Quartz. The 
following options become available. 
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4.  To set the offset or size of the shadow, either drag the white box 
on the left until the shadow is displayed as you want it, or at the 
“Horizontal” and “Vertical” options, type in or click the direction 
arrows to set the shadow width from -15 to 15 points. 

5.  To set the softness and blur of the Quartz shadow, click and drag 
the slider on the “Blur” scale. The image on the left illustrates the 
blur you have selected. 

6.  Click OK to apply the Quartz shadow and return to the Chart page 

 

You can apply the shadow settings in the “Drop Shadow” dialog box 
to any object by selecting the Shadow tool from the Toolbox and 
clicking the object. The same shadow settings are applied until you 
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change them. 

1 Introduction 
Red Rock Software is proud to bring you DeltaGraph® 7, the most 
comprehensive charting application for Mac OS® X. DeltaGraph's 
more than 20 year presence in the marketplace is testimony to its 
power and flexibility. Analyze, visualize, and customize your numbers 
efficiently and with the highest quality output with DeltaGraph 7. 

	
  

NOTE ☞  Remember that DeltaGraph is copyrighted and your copy has a unique 
serial number. It is illegal to make copies of DeltaGraph except for 
backup purposes. 

DeltaGraph 7 is a powerful charting program that can be used as a 
stand-alone application or to complement your spreadsheet and other 
software programs. DeltaGraph provides the tools you need to 
communicate information effectively in compelling charts that will be 
read and remembered. 

Whether you need charts to present your sales performance or explain 
highly technical data, DeltaGraph can help you do it faster and more 
efficiently with the highest quality results. 

DeltaGraph’s Chart Gallery features 83 distinct charts and graphs, 
including two – dimensional (2-D), three-dimensional (3-D), text, 
double axis, and combination overlay charts. A built-in Chart 
Advisor® even helps you make a selection if you are unsure about the 
best chart for your data. Hundreds of chart styles also are possible 
using the extensive design options provided, such as curve fitting, 
error bars, depth, 3-D rotation, multiple column shapes, and much 
more. You have control over every chart element. DeltaGraph 
includes a complete set of drawing tools, powerful data-handling 
functions, full color support, and high-resolution color support. 

DeltaGraph 7 is available in versions for Apple® Macintosh® 
computers and Microsoft® Windows® computers. While there are 
minor differences between the Macintosh and Windows versions of 
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DeltaGraph, they look and operate in a similar way. DeltaGraph files 
can even be shared across platforms, a convenient feature for users in 
mixed platform workgroups. 

Import Data Support 

You can import the following data formats:	
  

• Microsoft Excel 

• Tab-, comma-, space-, multi-, and custom-delimited text formats 

Import Graphic Support 

You can import the following graphic file formats: 

• Encapsulated PostScript® File (.EPSF) 

• PDF (.PDF) 

• Macintosh PICT (.PICT) 

• Windows Bitmap (.BMP) 

• Adobe® PhotoShop® (.PSD) 

• Portable Network Graphics (.PNG) 

• Graphic Interchange Format (.GIF) 

• Tagged Image File Format (.TIF, .TIFF) 

• QuickTime® Image (.QTI) 

• Joint Photographic Experts Group (.JPG, .JPEG) 

• JPEG 2000 (.JPG, .JPEG)	
  

• Movie 
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Export Graphic Support 

You can export the following graphic file formats: 

• Encapsulated PostScript (.EPS) 

• PDF  (.PDF) 

• Windows Bitmap (.BMP) 

• Joint Photographic Experts Group (.JPG, .JPEG) 

• JPEG 2000 Image (.JPG, .JPEG) 

• Adobe PhotoShop (.PSD) 

• Portable Network Graphics (.PNG) 

• QuickTime Image (.QTI) 

• Tagged Image File Format (.TIF, .TIFF) 

• Macintosh PICT (.PICT) 

Printer Support 

You can print your final chart documents on any printer supported by 
Mac OS X . 

Technical Support 
For 24-hour support, search our online solutions 
database at: 

http://support.redrocksw.com/dgknowledge/  

For email support send your question to: 

dgsupport@redrocksw.com 
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Opening Documents from Previous 
DeltaGraph Versions 

DeltaGraph 7 can open files from previous versions of DeltaGraph 
back to version 3.0. Simply open the earlier file as you would a 
DeltaGraph 7 file, using the Open option. The file is opened and 
automatically converted to the latest format. 
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2 Getting Started 
This chapter provides an overview of DeltaGraph for new users and 
serves as a quick reference for advanced users. It provides 
information on the following subjects: 

• DeltaGraph window elements 

• DeltaGraph’s three views 

• Plotting a chart 

• Understanding the basic elements of a chart 

• Quick tips 

• Using Smart Layouts and backgrounds 

• Understanding Custom Libraries 

• Using the DeltaGraph Help system 

DeltaGraph Window Elements 
When you open DeltaGraph, the following window elements are 
displayed: 

• Command bar (see page 2-3) 

• Navigational bar (see page 2-5) 

• Status bar (see page 2-6) 

• DeltaGraph “View” (default is the Data view) (see page 2-7) 
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The commands in the Menus and toolbar vary depending on the view 
selected. You can customize the various toolbars by control–clicking 
in it, like any Mac OS X toolbar. 

An example of the Chart view in DeltaGraph is shown below. The 
toolbar, the Toolbox, and other available functions are shown. 
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Toolbar 
The toolbar is located at the top of the window. Some of the icons on 
the toolbar are standard throughout DeltaGraph, but others vary 
depending on the view selected. 

All images of toolbars in this manual show the default version. You 
can customize the various toolbars by control–clicking in it, like any 
Mac OS X toolbar. 

NOTE ☞  If the “Tool Tips” option is enabled in “Preferences,” you can move 
the mouse pointer over an icon on the toolbar or Navigational bar to 
display a description of the icon’s function (see Chapter 7, “Setting 
Preferences”).To hide or show the toolbar, click the oval button in the 
upper-right corner of the window. The following sections provide 
illustrations of the Command bar in each view with a description of 
each icon. 
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Data View Toolbar 

The Data view Command bar is shown below with all available icons 

 

Chart View Toolbar 

The Chart view Command bar is shown below with all available icons. 

 

Organizer View Toolbar 

The Organizer view Command bar is shown below with all available 
icons. 

 

Navigational Bar 
The Navigational bar, shown below, is located at the bottom of the 
view window. 

 

The Navigational bar contains icons to do the following: 
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• Add a new page (Data and Chart views). 

• Move a page up or down (Data, Chart, and Organizer views). 

• Select a page (open the “Go To” dialog box to select a page). 

• Select a different view. 

• Pan the viewable area if the view is larger than the window 
(arrows and scroll bar). 

• View the Data and Chart views side-by-side (Split View). 

• Resize the window (click, hold, and drag the Size window icon). 

Status Bar 
The Status bar is below the toolbar bar in Chart View. The Status bar 
provides descriptions of the current command and 
measurement/coordinate information. In the examples below, the top 
image shows how the Status bar appears in the Chart view. 

 

Status Bar Elements 

Element Description 

Object 
description/ 
Help 

Displays a description of a highlighted menu object; if 
a command or icon is selected, displays Help 
information; may also indicate what type of operation 
is being performed. 

Unit of measure Indicates the unit of measure as specified in the “Rulers 
& Grids” dialog box. 

Object size Displays the size of the selected object. This can also 
be used to measure distance or size by clicking and 
dragging in the Chart page. 
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Pointer location Indicates the position of the pointer on the invisible grid 
in the active page. 

	
  

DeltaGraph Views 
A document is a DeltaGraph file that contains pages of data and 
charts that you create. Each document has three different views, as 
shown below. You can switch views using the View icons on the 
Command bar and Navigational bar. 

You can have multiple documents open at one time. 

 

 

 

 

 

 

Data view  You use the Data view to enter numerical data, which shows a 
comparison of two or more variables, such as changes over time or 
differences between two objects. It  is used to create two-dimensional 
(2-D) and three-dimensional (3-D) charts. 

Though you can add any number of Data pages to each document 
(limited only by available memory), you can have only one page 
open at a time. 
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Chart view  You use the Chart view to view, modify, and enhance a chart once the 
data are plotted. Though you can add any number of Chart pages to 
each document (limited only by available memory), you can have 
only one page open at a time. Each page can hold numerous charts. 

Organizer view  You use the Organizer view to organize your complete document or 
presentation. You can reorder pages and slides and apply screen show 
transitions to Chart pages in this view. In addition, you can use the 
Layout mode to create a Master Background and Smart Layouts that 
can be applied to Chart page objects so size, position, and color of 
objects remain consistent from page to page. 

 

 

 

 

 

 

	
  

Data View 

You use the Data view to enter numerical data and text data for 
table charts in a spreadsheet format. 

You can have numerous Data pages in the Data view, enabling you to 
store different sets of data in a single document. Only one Data page 
can be displayed at a time. 

To display the Data view, click the Data View icon on the Command 
bar or the Navigational bar, or choose Data View from the View 
menu. 

Data Page 

      To create a new Data page, do one of the 

To learn more about... Refer to... 

The Data view Chapter 4, “Organizing Data in the Data 
View” 

The Chart view Chapter 9, “Customizing Charts” and 
Chapter 11, “Working with Objects in 
Chart View” 

The Layout mode Chapter 5, “Creating Smart Layouts and 
Backgrounds” 
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following: 

• Click and hold the Data View icon on the Command bar and 
select New Data from the menu that is displayed. 

• Click Data View on the View menu, and select New Data 
from the submenu. 

• Click on the Navigational bar. 

To display the previous or next page in a document, do one of the 
following: 

• Click the up (previous) or down (next) arrow on the 
Navigational bar. 

• Click and hold the Page Selector icon on the 
Navigational bar and select the page that you want to 
view. 

• Click Data View on the View menu, and select the page 
name from the submenu. 
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A Data page (see figure below) is used to set up data for the majority 
of DeltaGraph charts. Each Data page accommodates up to 32,000 
rows and 256 columns. With multiple Data pages, you can store 
different sets of data in one document. 
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Data Page Elements 

Element Description 

Data cell Contains only one element of the data. 
You can select any cell by clicking in it. 
The box is highlighted, and the selected 
entry appears on the Editing line. 

Editing line Displays the contents of the selected cell so 
you can make changes to it. If the cell is 
empty, the Editing line has a blinking cursor 
so you can enter data for the highlighted 
cell. 

Columns Columns are headed A, B, C, D, and so on 
to help you identify them. 

Column labels You enter labels in the row directly below 
the column letters to identify the data 
series. The use of column labels depends 
on the type of chart you are plotting. 

Rows Rows are headed 1, 2, 3, 4, and so on to 
help you identify them. 

Row labels You enter labels in the column next to the 
row numbers to identify each category of 
data. The use of row labels depends on 
the type of chart you are plotting. 

Select All icon Click to select all data in the Data page 
(make sure no empty data cells are 
selected). 

Title cell The intersection of the row labels and the 
column labels. Enter a title for your Table 
chart in this cell. 
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Use commands in the File, Edit, Text, View, and Data menus to 
manipulate and format the data in a Data page. 

	
  

To learn more about... Refer to... 

Data pages Chapter 4, “Organizing Data in the Data 
View” 

Maneuvering in a Data 
page 

“Moving Around in a Data Page”  

Assigning Axis titles “Creating Chart Axis Titles” 

	
  

Chart View 
To display the Chart view, click the Chart View icon on the Command 
bar or the Navigational bar, or choose Chart View from the View 
menu. 

Chart Page 

To create a new Chart page, do one of the following: 

• Click and hold the Chart View icon on the Command bar 
and select New Page from the menu that is displayed. 

• Click Chart View on the View menu, and select New 
Page from the submenu. 

• Click on the Navigational bar. 

To display the previous or next page in a document, do one of the 
following: 

• Click the up (previous) or down (next) arrow on the 
Navigational bar. 
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• Click and hold the Page Selector icon on the Navigational bar 
and select the page that you want to view. 

• Click Chart View on the View menu, and select the page name 
from the submenu. 

NOTE ☞  You can plot charts from the Chart view, or the Data view. Each time 
you plot a chart, you have the option of adding it to an existing Chart 
page or creating a new Chart page for it. 

If you choose to use a Smart Layout (refer to “Using Smart Layouts” 
in chapter 2), you can apply it to the Chart page before or after you plot 
the chart. When you plot data without using a Smart Layout, the chart 
you create is displayed in the upper left corner of the new or selected 
Chart page. 

If you use layouts, text from the charts plotted in the Chart page are 
matched with layout placeholders. Attributes of the placeholders 
(size, position, color, etc.) are applied to text and charts in the Chart 
page. 

You can change program settings that affect all Chart pages using 
the “Preferences” option (see Chapter 6, “Setting Preferences”). 

In many of the dialog boxes accessed from the Chart menu, you can 
click a Show button to preview the results of your selections without 
exiting the dialog box. This allows you to experiment with different 
features without permanently changing your chart. If you want to 
move the dialog box so that you can see more of the preview chart, 
click and hold on the Title bar, and drag the dialog box out of the 
way. 

In addition to scroll bars (when needed), a Title bar, and window-
sizing icons, a Chart page contains palettes and windows (shown 
below) that are commonly used in the Chart view. 
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Chart Page Elements 

Element Description 

Custom 
Library 

Stores graphics and chart templates that you can drag into 
the current document or transfer between documents. 

Layout Set 
window 

Contains layouts created in the Layout mode or loaded from a 
Layout Set file. You can drag and drop layouts from the 
Layout Set window into a Chart page to determine the 
position, size, and color of charts and text in the Chart page. 

Toolbox Contains tools and palettes used to create, manipulate, and 
modify Chart page objects. 
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   To learn more 
about... 

Refer to... 

Creating a chart “Setting Up a Chart” in chapter 8 

Managing Chart pages “Creating or Adding a Chart Page” in chapter 8 

Chart view settings Chapter 6, “Setting Preferences” 

Creating placeholders “Creating and Using Smart Layouts” in chapter 5 
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Chart Page Objects 

You can have four types of objects on a Chart page, as 
illustrated below and described in the following table. 

 

Object Description 

Chart object A Chart object contains many chart elements, 
including labels and titles. You generally use the 
tools in the Toolbox and commands on the Text and 
Chart menus to manipulate or modify the elements 
in a Chart object as well as the Chart object itself. 
Specify default text attribute settings in 
“Preferences” (see Chapter 6, “Setting 
Preferences”). 

Draw object A Draw object is any object you add to a Chart page 
using the Draw tools in the Toolbox. You generally 
use the Toolbox and commands on the Draw menu 
to manipulate or modify Draw objects. 

Text object A Text object is any text you add to a chart using 
the Text tool in the Toolbox. You generally use the 
Draw tools and commands on the Draw menu to 
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manipulate or modify a Text object. You can use 
commands on the Edit menu to edit the text in a 
Text object and commands on the Text menu to 
change the text’s style attributes. Specify text 
attribute settings in “Preferences” (see Chapter 6, 
“Setting Preferences”). 

Imported Graphic 
object 

An Imported Graphic object is any object imported 
into a Chart page from another application. 

	
  

You can change the text attributes (font, size, style, and color) of 
chart labels and other text that is part of a Chart object from a Chart 
page, but you must change the content (the text itself) on the 
corresponding Data page. 

To learn more about... Refer to... 

Changing the format of the 
data 

“Formatting Text” in chapter 4 

Changing the axis order “Reformatting a Chart’s Axes” in chapter 9 

Selecting chart elements “Selecting a Chart and Chart Elements” in 
chapter 9 

Adding Draw objects “Creating and Editing Draw Objects” in 
chapter 11 

Adding Text objects “Working with Text Objects” in chapter 11 

Changing the color, fills, etc. “Using the Draw Menu” in chapter 11 
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The Toolbox 
The Toolbox (see figure below) contains the tools you use to modify 
Chart objects and create or modify Text and Draw objects in the 
Chart view. You can choose Undo on the Edit menu to cancel the last 
action performed with a Draw tool. 

 

The Toolbox appears automatically when you switch to the Chart 
view. You select a tool from the Toolbox by clicking it before 
drawing in the Chart view. You can double-click a tool to select the 
tool and lock it “on” until another tool is selected. 

To move the Toolbox around the screen, click and drag the Title bar. 
To hide the Toolbox, click the Close button in the upper left-hand 
corner, or select Hide Toolbox from the Draw menu. To display the 
Toolbox again, choose Show Toolbox from the Draw menu. 

To learn more about... Refer to... 
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The Toolbox “The Toolbox” in chapter 11 
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Organizer View 
To display the Organizer view, click the Organizer View icon on the 
Command bar or the Navigational bar, or choose Organizer View from 
the View menu. 

 

The Organizer view allows you to make global changes to all Chart 
pages, such as applying Smart Layouts. It also allows you to view and 
organize all of your Chart pages at the same time. 

Plotting a Chart 
You can plot (create) charts and chart elements contained in the 
Chart page from the Data, or Chart view. The plotted chart appears 
in the Chart view. A Smart Layout can be applied to a Chart page 
before or after you plot the chart. 
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Data view To plot data selected in a Data page, press cmd-G, or choose Chart 
Gallery from the Data menu. This displays the “Chart Setup” dialog 
box, which you use to access the Chart Advisor, choose the 
destination Chart page, select a chart, and select other plotting 
options. 

Chart view  To plot data in a Chart page, press cmd-G, or choose Chart Gallery 
from the Chart menu. This displays the “Chart Setup” dialog box, 
which you use to select the plotting options. 

Which options you select to plot charts in the Chart view depends on 
whether the Chart page already contains plotted data from the Data 
view, whether the Chart page is empty, and whether you intend to 
use Smart Layouts. 

If layouts are used, you can click or double-click most of the 
placeholders to fill them. Each placeholder contains instructions for 
filling.  

To learn more about... Refer to... 

Selecting data “Selecting Data” in chapter 4 

Creating a chart Chapter 8, “Plotting Data and the Chart 
View” 

Making changes to a chart Chapter 9, “Customizing Charts” and 
Chapter 10, “Changing Chart Options” 

	
  

The Chart Advisor 
If you are unsure of the type of chart that would best suit your data, 
the Chart Advisor can help you decide. Based on the data you enter 
in the Data page, and other selections you make in the Chart Advisor 
dialog box, one or more appropriate choices are provided for a chart 
type. Any open Custom Libraries, including the “Standard Library,” 
and any libraries in the “AutoLibrary Folder” will also be displayed 
as choices. 

If you decide to use one of the suggested chart types, you can 
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plot the chart directly from the “Chart Advisor” dialog box. 

To access the Chart Advisor, select the Data view, select the data that 
you want to chart, and then do one of the following: 

• Open the “Chart Setup” dialog box, and select the Chart 
Advisor tab. (The Chart Advisor tab is not available if the 
Chart Gallery is opened from the Chart view.) 

• If you want the Chart Advisor to open automatically when 
you plot a chart, select Open Advisor when Plotting in 
“Preferences” (see Chapter 7, “Setting Preferences”). 

To learn more about... Refer to... 

The Chart Advisor “The Chart Advisor” in chapter 8 

Setting preferences “Setting Chart View Defaults” in chapter 6 

	
  

Revising and Updating Charts 
If you revise data in the Data view, you need to update the charts 
plotted from the data. You can update the chart or charts in the Data 
view, or you can revise the chart(s) in the Chart view. 

Data view  To update all the charts associated with the changed Data pages, click 
the Update icon on the Data view toolbar, press cmd-=, or choose 
Update from the Data menu. Also use this option if you are changing 
existing data but not adding any data points or sets to the existing Data 
page. 

Chart view  To update only one chart, select it and click the Revise icon in the 
Chart view toolbar, or choose Revise Data from the Chart menu. This 
option is used when you want to add, remove, edit, or rearrange the 
data without affecting every chart generated from the data. 

	
  

	
  



 
  DeltaGraph for Macintosh Version 7 User Guide 33 

To learn more about... Refer to... 

Updating all related charts “Updating a Chart” in chapter 8 

Revising one chart only “Revising Chart Data” in chapter 8 
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Basic Chart Elements 
This section provides information on the basic chart elements of the 
various charts in DeltaGraph. The following figures and the 
descriptions in the table are examples of numerical charts. 
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NOTE ☞  The location of the elements in different types of charts may vary, and 
different types of charts may have different elements. For example, a 
Ternary chart does not have a Series or Category axis, it has three 
Value axes. 

 

Basic Chart Elements 

Element Description 

Axis label Label created in the Data page to name each individual axis. 
You can change the orientation of the label with the “Labels” 
command on the Chart menu. 

Axis title Name assigned to each axis. You add Axis titles in the Chart 
view using the “Labels” command on the Chart menu. 3-D 
charts can have titles on all three axes. 2-D charts can have titles 
on two axes. 

Chart 
element 

Any part of a DeltaGraph chart such as a grid, tick, label, axis, 
or data graphic. 

Data 
graphic 

A line, bar, or other chart graphic created by a data series—the 
“heart” of the chart. 

Data 
series 

Set of values plotted to create a group of bars, lines, or data 
graphics. Use the “Series” command on the Data menu to 
change the data series from columns to rows or from rows to 
columns in the Data view. 

Grid lines Lines extending from one axis to another to mark the units of 
measurement and make the graph easier to read. You can 
change the appearance of the grid lines for each axis using the 
“Ticks and Grids” command on the Chart menu. 

Legend A text and graphic combination showing the association of the 
Series axis labels to the data graphic on the chart. Depending on 
the type of chart, the legend labels are created using the row or 
column labels in the Data page. You can show/hide the legend 
or reverse the legend order using the “Legend” command on the 
Chart menu. 
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Origin The point at which two or more axes intersect. 

Tick 
marks 

Short marks, usually perpendicular to the axes, that show the 
units of measurement. You can change the appearance of tick 
marks by clicking the Ticks and Grids icon on the Command 
bar or the “Ticks and Grids” command on the Chart menu. 

X axis In a 3-D chart, the position and purpose of the X axis depends 
on the type of chart. In a 2-D chart, it is the horizontal axis and 
is used as a Value, Category, or Series axis depending on the 
type of chart. 

Y axis In a 3-D chart, the position and purpose of the Y axis depends on 
the type of chart. In a 2-D chart, it is the vertical axis and is used 
as a Value or Category axis depending on the type of chart. 

Z axis In a 3-D chart, the Z axis is always the vertical axis and can be 
labeled on both sides of the grid plane. For all 3-D charts, it is a 
Value axis. In 2-D charts, the Z axis is typically the legend. 

	
  

To learn more about... Refer to... 

Names of each chart axis Chapter 7, “Chart Types” 

	
  

Chart Object Handles 
When you select an object in the Chart view, object handles appear 
around the object to show it is selected. 

The figure below illustrates the three types of object handles you will 
see in a numerical chart. In this 3-D chart, the whole Chart object, the 
Value axis grids, and one data series are selected. 
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Handle Description 

Object handles Small squares surrounding a selected Chart, Text, or 
Draw object. You can drag the object handles to 
change the size and shape of any object. 

Chart element 
handles 

Small circles surrounding a selected chart element. 
When a chart element is selected, you can change its 
color, pattern, and line style. If the element is text, 
you can change the text attributes. You can move axis 
labels and titles in numerical charts, but you cannot 
move other chart elements individually. All labels and 
titles from one axis can be moved as a group or 
individually. 

Axis resizing 
handles 

Large squares at the endpoint of each axis on a 
numerical chart. You can drag an axis resizing handle 
to lengthen or shorten the axis. This resizes the chart 
in one direction along the axis but does not affect the 
perspective. 

	
  

To learn more about... Refer to... 

Selecting chart elements “Selecting a Chart and Chart Elements” 
in chapter 9 
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Quick Tips 
Following are a few time-saving tips to open the dialog boxes used to 
change and apply attributes to elements of a chart or other objects in 
a Chart page. 

Double-Click 

Double-click various parts of a chart to display dialog boxes for 
modifying the appearance of labels, ticks and grids, and so on. 

Control-Click 

Click any Draw, Text, or Chart object in the Chart view while 
holding the control key to open a dialog box for changing various 
attributes. You can change fill and line color, pattern and weight, 
text color, font, style, size, alignment, and blends and shadows. 

Click and hold on any Draw, Text, or Chart object in the Chart view to 
change attributes specific to the type of object selected. Click a Draw 
or Text object to display a condensed Draw menu. Click a Chart 
object to display a condensed Chart menu. 

To learn more about... Refer to... 

Control-click “Changing Attributes” in chapter 11 
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Saving a Document 
To save a document for the first time, click the Save icon on the 
Command bar, select Save from the File menu, or press cmd-S, enter 
a document name in the dialog box, and click Save. Once the 
document has been named and saved, click the Save icon on the 
toolbar to save it with the specified name. 

Using Smart Layouts 
A Smart Layout, which consists mainly of placeholders for charts, 
titles, text, graphics, and bullets, serves as a template for assembling 
and arranging elements (charts, titles, text, graphics, etc.) in a Chart 
page. Several Smart Layouts are provided with DeltaGraph, but you 
can also create your own Smart Layouts. 

Smart Layout placeholders contain color, font, font size, and other 
attributes for Chart page objects. There are six types of placeholders: 
four types are for the tags assigned (Title, Text, Bullet, and Org), one 
is a Chart placeholder for a plotted chart, and one is a Graphic object 
placeholder for an Imported Graphic object. 

When applied to a Chart page, layouts determine position and size, 
and assign other attributes to the objects corresponding to the layout 
placeholders. Smart Layouts provide consistency between Chart 
pages, and documents. 

Each document has its own Layout Set. You can add to a document’s 
Layout Set, or save it for use in other documents. Each Layout Set can 
include layouts, Master and Exception Backgrounds, and a color 
scheme. 
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To learn more 
about... 

Refer to... 

Layouts “Creating and Using Smart Layouts” in chapter 5 

Backgrounds “Creating and Using Backgrounds” in chapter 5 

	
  

Using Custom Libraries 
You can use Custom Libraries to store any Chart, Draw, Text, or 
Imported Graphic object in a readily accessible location. You can use 
objects stored in a Custom Library again and again without the need 
to reconstruct intricate chart formatting or use “Cut” and “Paste” 
commands. When saving a chart in a library, you also have the option 
of saving the data along with it. This is helpful if you want to transfer 
the data between documents. 

You can open and create libraries in the Chart or Organizer view or in 
Layout mode. Click and hold the Library icon on the Command bar, 
or choose Libraries from the File menu to display a menu with 
options to open or create a Custom Library. 
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To add one or more objects to a new or existing library, select the 
object(s) and drag the selection into an open library window. If the 
object is a chart, a prompt appears asking whether you want to save 
it as a template or with data. 

To use a custom chart template or other object from a library, select 
the object icon in the library and drag it into an open Chart page. (You 
can also click the submenu in the library window and choose a library 
object from the list.) If the object is a chart that does not contain data, 
you are prompted to select the data to be plotted. After data are 
selected, click Plot. The data are plotted in the selected template with 
all the formatting of the original chart. If the selected object contains 
a Chart with data, or a Text, Draw, or Imported Graphic object, a 
copy of the original object appears in the Chart page when you 
release the mouse button. 

	
  

	
   To learn more about... Refer to... 

The Custom Library Chapter 14, “Creating a Custom 
Library” 
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Getting Help 
The DeltaGraph installation includes a PDF version of this User 
Guide, available from the Help menu. 

If the “Tool Tips” option is enabled in “Preferences”, you can move 
the mouse pointer over an icon on the Command bar or Navigational 
bar to display a description of the icon’s function (see Chapter 6, 
“Setting Preferences”). 

You can also visit the Red Rock Software Web site at 
www.redrocksw.com for additional information and technical 
support for DeltaGraph. 
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3 Tutorial 
This chapter is a tutorial to help you learn the basic functions in 
DeltaGraph. The four-part tutorial takes you through the typical steps 
involved in creating a 2-D XY Line chart, a 3-D Area chart, a Bullet 
chart, and running a slide show. 

It is recommended that you read Chapter 2, “Getting Started” before 
you begin the tutorial. 

Feel free to experiment with the various functions and options in 
DeltaGraph while you are completing the tutorial. Don’t worry if 
your charts look different from the examples in the manual. 
Remember that you can be creative with Delta- Graph and design 
charts and presentations to suit your particular needs. 

This tutorial assumes that you are familiar with the Macintosh 
computer and the OS 10.x operating system. If you need help with 
basic computer functions, refer to your computer’s documentation or 
the Macintosh Help system. 

Opening DeltaGraph 
Double-click the DeltaGraph icon, or click the icon and choose Open 
from the Finder File menu, to open DeltaGraph. An empty Data page 
in the Data view appears on your screen as shown below. 
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Creating a 2-D XY Line Chart 
This lesson shows you how to do the following: 

• Name and save a document 

• Name a Data page 

• Enter labels and data 

• Plot a chart using the Chart Advisor 

• Change the view size 

• Change the text attributes of axis labels 

• Move and resize a legend 

• Change the chart options 
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•  Change the axis value scaling 

•   Add grids 

• Change a chart’s data symbols 

•   Load a Smart Layout set and apply a Smart Layout 

•  Add a Text object to the background 

In this lesson, you will be entering four data series in four columns on 
a Data page, plotting a chart from the data using the Chart Gallery, 
making some changes on the plotted chart, and applying a Smart 
Layout background to the chart. 

Naming the Document 
      1.  Click the Save icon on the Command bar, or choose Save As from 

the File menu. The following dialog box appears. 

 

 

2.  In the “Save As” text box, type 
DeltaGraph Demo. 
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4.  Click Save. The Data page is displayed with the document name 
in the Title bar next to the active view name (e.g., DeltaGraph 
Demo:Data View). 

Naming the Data Page 
1.  Choose Name Page from the View menu.  

2.  Type XY Line Data over “Data #1.” 

3.  Click OK. The Page Selector icon on the Navigational bar displays 
the new Data page name. 

Entering Column Labels 
You are going to enter four series of data in four columns on a data 
page, one series in each column. Take the following steps to enter 
column labels for the data. 

1.  Click in the first data cell just below column A. The cell is 
highlighted, and a blinking cursor appears on the Editing line at 
the top of the window. 

The column labels will appear in the “Label” row beneath the 
column letters. For this chart, you will not enter row labels, which 
appear in the first column (headed “Label”) next to the numbered 
rows. However, row labels are entered in the same manner as 
column labels. 

2.  Type Elapsed Time on the Editing line, and press return. The 
label is entered at the top of the column and the next cell in the 
column is highlighted. 

3.  Click in the data cell just below column B, type A1\-3\=Nc, and 
press return. 

To enter the information from the Editing line in the selected cell, 
and to move from cell to cell, you can press return, tab, or one of 
the arrow keys, or you can click in any data cell. Press return to 
select the next cell in the column; press tab to select the next cell 
in the row; press an arrow key to move one cell at a time in the 



 
  DeltaGraph for Macintosh Version 7 User Guide 48 

direction of the arrow. 

4.  In the same manner, enter labels for columns C and D as shown 
below. 

 

If you make a mistake, use the delete key to erase incorrect 
characters, then retype them; or, click on the Editing line and 
type over or insert characters. 

NOTE ☞  The special text characters “\”, “+”, “-”, and “=” that you entered in 
the column labels will create superscript and subscript characters in 
the labels when you plot the chart. To learn more about entering 
special text characters in the Data page, see “Entering Special Text 
Characters” in chapter 4. 
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Entering the Data 
Using the same method you used to enter column labels, enter the 
rest of the data as shown below. 

	
  

 

 

 

 

 

 

 

 

 

 

	
  

Saving the Document 
To save the document, click the Save icon on the Command bar, 
select Save from the File menu, or press cmd-S. You should save 
your document periodically so that you don’t lose work if there is a 
power failure or other problem. 
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Plotting the Chart 
Take the following steps to plot the chart after you have entered all 
the data and saved the document. 

1. Click the Select All icon or press cmd-A to select all of the data 
on the current page in the Data view. All four data series and 
their associated column labels are selected, as shown below. 

 

2. Click the Plot icon on the Command bar, choose Chart Gallery 
from the Data menu, or press cmd-G. The “Chart Setup” dialog 
box appears. 
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Examples of all of the chart types are displayed. 

3.  Move the mouse pointer over a chart example to display its chart 
type below the scroll bar. Click the options on the right side of 
the dialog box to display various types and categories of charts. 

You can select and plot a chart directly from this dialog box or you 
can use the Chart Advisor to help you determine the best chart to 
use for the selected data. For this tutorial, you will use the Chart 
Advisor. 

3. Click the Advisor tab. 
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You can also display the Chart Advisor directly from the Data 
view by clicking the Plot icon while pressing the option key. 

5.  Based on the options you select, the Chart Advisor displays a list 
of charts that best represent the selected data. Experiment with 
some of the options to see how the Chart Advisor changes the 
“Suggested Charts.” 

6.  Now, select the options as shown in the illustration, and select the 
X-Y Line chart (second option) from the list. The selected chart 
appears in the Example box. 

7. Click OK. The XY Line chart is plotted and displayed in the Chart 
view. 
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A default name (Page #) appears in the Page Selector at the 
bottom of the page. You will name the chart page later. Note the 
superscript and subscript characters in the chart legend that were 
generated from the special characters you entered in the column 
labels. 

8.  To move the chart, click and hold on it and drag it to a different 
location in the window. Be careful not to click a handle (the small 
black boxes on the corners) or you will resize the chart. 

NOTE ☞  If you cannot see the whole chart, click and drag the window sizing 
icon in the bottom-right corner of the window to enlarge the viewing 
area. 
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Changing the View Size 
Take the following steps to change the size of the chart in the viewing 
area. 

1.  Choose Scale from the View menu. A pop-up menu appears with 
the several choices for sizing the chart. The “Actual” option sizes 
the chart at 100%. The “Fit To View” option sizes the chart to fit 
completely in the viewing area. The command key combination 
used to select each option is displayed next to the option. 

2.  Drag down the menu until 75% is highlighted, and release the 
mouse button. The active Chart page resizes so you can see the 
whole chart. The white area is the actual Chart page; the gray area 
is outside the page. 

3.  Click the Scale icon. The Chart page view is resized back to 100%. 

Changing the Orientation 
To change the orientation (portrait, landscape) of the document, do the 
following. 

1.  Select Page Setup from the File menu.  

2.  Select Landscape. 

Portrait 

The shortest side of the page is at the top (e.g., 8 x 11). 

Landscape 

The longest side of the page is at the top (e.g., 11 x 8). 

	
  

3.  Click OK. The Chart page is displayed with the new orientation. 
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Changing the Text Attributes of Axis Labels 
The X axis is the horizontal axis of the chart, and the Y axis is the 
vertical axis of the chart. Both axes on a 2-D XY Line chart are value 
axes, which means the numbers in the axis labels are generated 
automatically when the chart is plotted (rather than from text entered 
in the Data page). 

To change the text attributes of the axis labels in the chart, do the 
following. 

1.  Click anywhere in the chart to select it. Object handles (small 
squares) and axis resizing handles (larger squares) appear to show 
that the chart is selected. These handles are described in detail in 
“Chart Object Handles” in chapter 2. 

2.  Click one of the numbers that appear at the bottom of the chart. 
These are X axis labels. Chart element handles (small circles) 
appear showing that the X axis labels are selected. 

3.  Hold down the command key and click a number on the left side 
(Y axis) of the chart. Chart element handles now appear on both 
the X and Y axis labels. 
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4.  Pull down the Text menu, and select “Show fonts”. Then select a 
font style, size, and color. The labels reflect your changes. 

You can customize the menu bar to include a shortcut to the font 
dialog box. 

5.  Experiment with various fonts, styles, sizes, and colors to see 
how they affect the look of the chart. 

6.  While the labels are selected, click and drag them away from the 
axes if they are too close to the tick marks. 

7.  Click in an empty area of the chart to see the chart without handles. 

NOTE ☞   If you make a change to the chart that you do not like or didn’t 
intend, select Undo from the Edit menu, or press cmd-Z, to undo the 
most recent change. 

Moving and Resizing the Legend 
Do the following to move and resize the legend in the XY Line 
chart. 

1. With the chart selected, click the frame around the legend. Chart 
element handles appear showing that the legend is selected. 

 

2.  Click and hold in any of the empty white space inside the legend 
and drag the legend above the chart. You can hold down the 
option key while you drag to override the snap-to-grid feature. 

3.  Release the mouse button. The legend is placed in the new location. 

4. Click and hold on the lower-right legend handle and drag it up 
and to the right, making the legend short and wide. 
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5. Release the mouse button. The legend is resized, and the legend 
elements are rearranged. 

 

6. Click and hold on the legend frame and drag it to fine tune the 
positioning until the legend is in the location shown below, then 
release the mouse button. 

 

	
  

You can also change the text attributes in a legend (in the same 
manner that you changed the axis labels text attributes) or even hide 
the legend on the chart (select Legend from the Chart menu). 
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Changing the Chart Options 
Do the following to change the appearance of the chart using the 
“Options” command. 

1.  Select the chart. 

2.  Click the Options icon on the Command bar, or select Options 
from the Chart menu. 

The following dialog box appears. 

 

	
  

3.  Click Show Symbols to select it, and click Connect Points to 
deselect it. 

4.  Click Show to preview the change. (If necessary, move the dialog 
box out of the way by clicking on the Title bar and dragging it.) 

5.  To apply the change and close the dialog box, click OK. 

The options are applied to the chart as shown below. 
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6.  Experiment with different options to see how the appearance of 
the chart is affected. 

The options available in the “Options” dialog box depend on the 
type of chart selected. You can use the options to make several 
changes in the appearance of a chart and, in some cases, create an 
entirely different type of chart. 

Changing the Axis Values 
To maximize the area for data, do the following to adjust the axis 
scaling. 

1.  Press and hold control while you click and hold the mouse button 
on the chart. 

A pop-up menu appears with a list of shortcut commands. Most of 
the commands on this menu are also displayed on the Chart menu. 
You can also display the shortcut menu from Draw and Text 
objects. 
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2. Select Axis from the menu, and select X Axis from the submenu.  

3.  In the “Axis Scaling” section of the dialog box, select 
Logarithmic and verify that “Auto” is enabled for each axis 
value. This scales the X axis based on powers of 10, which 
makes rapidly increasing data on a large scale easier to 
interpret. 

4.  Click OK. Notice that the starting values for the Y (vertical) axis 
remain the same, but the X (horizontal) axis now begins at “1,” 
and the grid frequency has changed to reflect the logarithmic 
scaling. 

 

Adding Grid Lines 
1.  With the chart selected, select Ticks and Grids from the Chart 

menu, and select X Axis from the submenu.  

2.  Select Minor beneath “Show Grid Lines.” 
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3.  Click OK. Minor grid lines are added to the X axis. 

Changing the Chart Symbols 
Some of the charts in DeltaGraph display the data points as symbols 
(such as circles, squares, triangles, checkmarks, and so on). A special 
font called “DeltaSymbol” is the default symbol font for all charts. 
The symbol, size, and color can be changed for each data series 
(column in the Data page). 

Do the following to change the symbols on the chart. 

1.  Select the chart. 

2.  Double-click one of the square, circle, or triangle symbols in the 
chart or leg- end. 

3.  Select one of the data series from the list box on the left side of the 
dialog box. The color, size, and symbol selections in the dialog box 
change to reflect the selected data series symbol. 

4.  Click the “Color” pop-up menu and select a different color; then 
click the “Size” pop-up menu and select a size. 
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You can also select a different “Source” for the symbols if 
available on your system. For example, if you had any Custom 
Libraries loaded, you could choose an image from the “Custom 
Symbol” pop-up menu. Or if you have a symbol font collection 
on your computer, you can select a different font from the “Font” 
pop-up menu. 

5.  Click the “Key” pop-up menu and select a different symbol. The 
symbols available will vary depending on the font selected. You 
can see what the symbol will look like in the “Example” box. 

6.  Click Show to preview the change. (If necessary, move the dialog 
box out of the way by clicking on the Title bar and dragging it.) 

7. To apply the change and close the dialog box, click OK. 

 

	
  

Loading a Smart Layout Set 
A Smart Layout is used to position, size, and apply a background to a 
DeltaGraph document to make all of the charts in the document 
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consistent. A Smart Layout contains a color scheme, background 
graphics, and placeholders for the charts, titles, text, graphics, and 
bullets on a page. Do the following to load a Smart Lay- out set in the 
tutorial document. 

1. Choose Layout Editor from the Edit View menu. 

2. Select Load Set from the submenu. 

The following dialog box appears. 

 

3.  Click the “From” pop-up menu, select the “DeltaGraph” folder, 
and select the “Layouts” folder from the “DeltaGraph” folder. A 
list of the Layout Sets in the folder is displayed. 

4.  Click a layout set to see a preview of the colors and Master 
Background in its layouts. 

5.  From this dialog box, you have the option of loading just the 
layouts, the Master Background, the color scheme, or any 
combination of the three. For the tutorial, make sure all three are 
selected. 
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6.  Select Colosseum from the list and click Open. 

The Chart page is displayed with the layout set Master Background 
loaded. 

 

7.  Go to Page, submenu “Apply Layout” 

A floating Layouts window appears for you to select a layout from 
the set. 
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8.  Click and hold on the pop-up menu in the Layouts window. A list 
of the lay- outs in the set appears. Each layout set contains 12 
layouts. The layouts in each set have the same names. 

9.  Select 4 - 1 Chart & Title. The selected layout appears in the 
Layouts window. You can resize the window as required to view 
the selected layout. 

10. Click and hold on the layout in the Layouts window and drag it 
into the active Chart page. The title entered in the Outliner view is 
displayed and the chart is sized and positioned to match the 
selected layout. 

11. Change the text and symbol size and color to match the new layout 
as follows: 

•  To change the heading size, click the heading, then click , and 
select the desired point size from the list. 

•  To change the labels, hold down the command key and click a 
number on the Y axis (left side) of the chart, then click a 
number on the X axis (bottom). 

Chart element handles appear on the all the axis labels. Click  
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and select a point size. To change the color, select Color from 
the Text menu, and select a new color from the menu. 

•  To change the symbols for the data points, double-click one of 
the symbols in the chart or legend, and select a new color, size, 
and/or symbol for each data series. 

Your chart should look similar to the one below. 

 

12. Close the Layouts window. 

13. Remember to save the document periodically. Click the Save icon, 
choose Save from the File menu, or press cmd-S. 

Editing the Master Background 
You can add various Draw or Text objects to the Master Background, 
and you can change the colors of the background. Text placed in the 
Master Background will appear on all pages in the document. Do the 
following to add a Text object to the Master Background. 
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1. Go into the View menu, then the submenu Layout editor and then 
click Master Background. 

You are switched to the Layout mode, and the Master 
Background appears. The Window Indicator on the Command 
bar indicates the mode. 

 

2.  Click in the center of the background. The Text Tool box is 
displayed. 
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4.  Type Survey 2002 on the text line. Click outside the text block to 
close the Text Tool box, and the text is displayed on the 
background. You can also use the tools in the Text Tool box to 
add tabs, text position, and line spacing to your text. 

5.  Click the text to select it, and format the text using the text menu 
to affect; size, color, font and style. 

6.  Click and hold on the Text object and drag it to place it where 
you want it in the page. 
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7.  Click the Chart view icon to return to the Chart page. The Chart 
page appears with the new background elements. 

Creating a 3-D Area Chart 
This lesson shows you how to do the following: 

• Plot a Chart from the Chart view 

• Import data 

• Add chart titles 

• Resize a chart axis 
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• Change the text attributes of axis labels 

• Change the chart options 

• Rotate labels on a chart 

• Change the view of 3-D charts 

• Change fill patterns and color on data graphics 

• Name a Chart page 
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Plotting a Chart from the Chart View 
1. On the Chart page, click and hold on the Plot icon on the 

Command bar and select Chart Gallery, choose Chart Gallery 
from the Chart menu, or press cmd-G. The “Chart Setup” 
dialog box appears, and the standard chart types are displayed. 
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2.  In the “Kind” section, click 3-D. 

3.  Click the “Plot In” pop-up menu, and select New Page to plot the 
data on a new Chart page. 

4.  Move the mouse pointer over a chart example to display its chart 
type below the scroll bar. Click the options in the “Category” 
section to display various types and categories of charts. 

5.  Click and hold the mouse on one of the chart examples. A Help 
box appears explaining the type of data needed for the selected 
chart. 

6.  Select the options as shown in the illustration on the previous 
page, and select the 3-D Area chart type. The chart example is 
highlighted indicating that it is selected. 

7.  Click OK. The Data page you created in the first lesson appears 
with a floating window over it. 

 

8.  Do not click anything in or close the floating window. Proceed to 
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the next section to import data into a new data page. 

Importing Data 
1.  Click the Add Page icon on the Navigational bar. A new Data 

page is created with the name “Data #2.” 

2.  Choose Name Page from the View menu, enter 3-D Area Data 
for the new data page name, and click OK. The name appears in 
the Page Selector. 

 

      3.  Click the Import icon, and select Tab Delimited from the pop-up 
menu. The following dialog box appears. 
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4.  Open the DeltaGraph “Sample Files” folder, and double-click 
Buying Trends. Data from the Sample File appear in the active 
Data page. 
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5.  Choose Show Labels from the Data menu. This option allows 
you to scroll through the data and still view the column and row 
labels. It replaces the column letters with the column labels and 
the row numbers with the row labels. 

 

6.  Scroll down to the bottom of the data set. 
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Adding Chart Titles 
Do the following to add titles to the chart. 

1.  Click the Select All icon in the top-left corner to select all the data 
in the Data page. 

2.  Click Titles in the floating window. The floating window is 
expanded. You can move the floating window by clicking the 
Title bar and dragging it to another part of the page. 

NOTE ☞   If the floating window was closed, or you need to enter titles later, 
click the Plot icon and select the Attributes tab. Type in the 
headings, and use the “Select Cells” function to specify their 
locations. 

3.  Click in the cell on the Data page at the intersection of row “23” 
and column “Vehicles.” 
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4.  Type Year and press tab to move to the next cell. Type Consumer 
Goods and press tab, then type Dollars and press tab. 

5.  Click Year in the Data page to select the cell, and then click X 
Title in the floating window. The cell number appears next to the 
axis button. 

6.  Press tab to select the “Consumer Goods” cell, and click Y Title 
in the floating window. 

7.  Press tab to select the “Dollars” cell, and click Z Title in the 
floating window. 

 

8.   Click the Select All icon, then click Plot in the floating window. 
The 3-D Area chart is plotted and displayed in the Chart view with 
a default Chart page name (Page#). 
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You	
  can	
  adjust	
  the	
  scale	
  using	
  the	
  view	
  menu	
  or	
  zoom	
  tool	
  in	
  the	
  tool	
  
bar. 

Remember to save your document periodically. Click the Save icon, 
choose Save from the File menu, or press cmd-S. 

Resizing the Axis 
	
  

Note that the data on the bottom-left side of the chart are cramped. 
You need to stretch the chart to make room for it. Do the following 
to resize the chart axis to make it easier to read:. 

1.  Click the chart to select it. 
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Object handles (small white squares) and axis resizing handles 
(larger black squares) are displayed to show that the chart is 
selected. 

2.  Click and hold the bottom-right axis resizing handle and drag it to 
the right. 

As you drag, the axis expands, allowing more room for the 
labels on the bottom-left side. 
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3.  Release the mouse button at the point where the chart seems 
balanced. You can use the other axis handles if needed to adjust 
the chart. If you want to stretch the entire chart horizontally or 
vertically, click and drag a Chart object handle. 

4.  To move the chart, click to select it, then click and hold on the 
chart and drag it to a new position. 

Changing the Text Attributes of Axis Labels 
To change the text attributes of the axis labels in the chart, do the 
following. 

1.  Click in the chart to select it. 

2.  Click one of the axis labels on one axis of the chart. Chart element 
handles (small circles) appear showing that the axis labels are 
selected. 
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3.  Hold down the command key and click a label on each of the 
other axes of the chart. Chart element handles now appear on all 
axis labels 

4.  Use the text menu to change text formatting in the axis labels.	
  You 
can also select “Set All” from the Text menu to open a “Text 
Format” dialog box and make all of the changes to the selected 
text at the same time.	
  

5.  Experiment with various fonts, styles, sizes, and colors to see 
how they affect the look of the chart. 

 

Changing the Chart Options 
Do the following to change the appearance of the chart using the 
“Options” command. 

1.  Select the chart. 
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2.  Click the Options icon on the Command bar, or select Options 
from the Chart menu.  

3.  Click to deselect Projected Ticks and Labels, change the 
“Width” (under “Line Width”) to 65%, and enter a “Wall 
Thickness” of 15. You can either type a value in the entry box 
or click the selection arrows to scroll through the options. 
Leave all other options “as is.” 

4.  Click Show to preview your change. To apply the change, click 
OK. 

 

Rotating Labels 
You can rotate any of the axis labels or titles on any of the charts you 
create. You may want to experiment with different settings to find the 
best angle for them to be displayed. Several things may affect 
orientation of the labels. When you stretched the chart in the previous 
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step, the orientation of the axis labels may have changed because the 
available space was increased. The text size also affects the available 
space. Do the following to rotate some of the text and axis labels in 
the chart. 

1.  Select the chart. 

2.  Choose Labels from the Chart menu, and select Series (X) from 
the submenu. (You can also double-click the axis labels to open 
the dialog box.) The following dialog box is displayed. 

The X axis title “Year” is displayed in the “Axis Title” box. 

 

3.  Click the “Apply Setting To” pop-up menu, and select the tickline 
that identifies the location of the axis labels you want to change. 
The figure above shows the correct selection for the “Year” labels. 
You can set each tickline separately. 

4.  Change the “Rotation” under “Labels” to 90. 

5.  Click OK. The axis labels are rotated 90°. Experiment with other 
rotations. 
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You can click and drag axis titles and labels to reposition them if 
necessary. 

Changing the View of 3-D Charts 
Do the following to change the rotation, angle, and perspective of the 
3-D chart. 

1.  Select the chart. 

2.  Choose 3-D View from the Chart menu. The following dialog box 
appears. 
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3.  Change the “Orientation Elevation” to 18, “Rotation” to 37, and 
the “Perspective Ratio” to 60. 

4.  Click Show to see the results of your selections. You can also 
change the elevation and rotation by clicking the slides next to and 
below the sample cube. Experiment with different settings, and 
click Show to see how you want the chart to look. 

5.  Click OK to apply the changes. 
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You can click and drag axis titles or labels to reposition them if 
necessary. 

Changing Fill Patterns and Other Attributes 
Do the following to change the fill pattern on a selectable chart 
element (such as the bars, the grid back plane, or anything else in the 
chart that can be filled with a pattern or color). 

1.  Click the chart to select it. 

2.  Click the side of the orange bar (bar closest to the front) in the 
chart. Chart element handles (a row of small colored circles) along 
the top indicate that the entire side of the bar is selected. 

You can also select any individual element in the chart. For 
example, click one of the facets or rectangles along the top of a 
bar. On the first click, the entire top of the bar is selected, as 
indicated by the chart element handles on the corners. Click again 
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to select a single facet. 

3.  Hold down the command key, and click the top of the orange bar 
to select the entire bar. Note the chart element handles on all the 
corners as well as along the top, as shown below. 

 

NOTE ☞  To select more than one element at the same time, hold down the 
command key as you click each element. 

4.  Hold down the control key, and click in the selected bar, click 
attributes in the resulting menu. The Object Attributes dialog box 
is now displayed. 

 

You can change fill colors, line patterns, line widths, and colors 
on the chart. You can also use the “Blends,” “Dashes,” and 
“Shadows” options to add special effects. 
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5.  Click the “Fore Color” pop-up menu. From the color chart, 
select a different color. You can click Show to preview your 
change. 

6.  To apply the change, click OK. The figure below shows the bar 
changed to red. 

 

You can also use the palettes in the Toolbox to change fill colors, 
line patterns, line widths, and colors on your chart, and you can 
use the “Blends,” “Dashes,” and “Shadows” commands on the 
Draw menu to apply special effects. 

7.  For example, select an element, and click and hold on the 
foreground fill palette in the Toolbox. Then select a color from 
the color palette. 

Naming the Chart Page 
Do the following to name the chart using the “Name Page” option 
on the View menu. (You can also name a Data page using this 
option.) 
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1.  Choose Name Page from the View menu. 

2.  Enter “Consumer Spending” in the dialog box. 

3.  Click OK. The new name appears in the Page Selector on the 
Navigational bar. 

Applying a Smart Layout 
Most data entered in the Outliner automatically appear in the Chart 
page. A Title line is the exception. It needs a Smart Layout 
placeholder in order to be visible in the Chart page. Do the following 
to apply a Smart Layout to the chart. 

1. Go into the Layout editor via the View menu. 

2.  Click the window’s pop-up menu and select Title. The Bulleted 
List lay- out appears in the window. 

 

3.  Click and hold the layout and drag it into the active 
Chart page. 

Attributes such as colors, fonts, positions, and size are applied 
from the Smart Layout. The Title entry from the Outliner is also 
displayed with the layout’s attributes. 
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4.  Click the heading “Spending Habits” to select it, and then adjust 
the size using the Text menu. Click and hold to drag the heading 
into the desired position on the page. 

5.  Select the chart and drag it to position it on the page in the desired 
location. 

Changing the Text 
Do the following to change the text in the chart. 

1.  Double-click anywhere in the text in the chart. Text editor 
becomes open. 
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2.  Experiment with changing or adding to the text as follows: 

•  Click the text and add or delete letters or words. 

•  Press return at the end of the last line to add a new line. 

•  Change the hierarchical level of a line by clicking at the 
beginning of the line and pressing tab. This moves the bullet 
one level to the right. Press shift+tab to move it one level to 
the left. 

If a line wraps to another line, select the chart, and click and 
drag a Chart object handle to stretch the chart so the words 
will all fit on one line. 
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4 Organizing Data in the 
Data View 

This chapter explains how to work in the Data view to enter or 
import, edit, and organize data in preparation for plotting charts. 

Before you begin working in the Data view, you should be 
acquainted with basic functions and terminology in DeltaGraph. 
Refer to Chapter 2, “Getting Started” for information. 

This chapter covers the following: 

• Overview of the Data view 

• Working with Data pages 

• Moving around in a Data page 

• Entering and selecting data 

• Editing data and formatting text 

• Inserting/deleting rows and columns 

• Changing column widths 

• Transposing rows and columns 

• Revising data and updating related charts 

• Importing and exporting data 

• Formatting data 

• Sorting data 

• Applying numerical formats to data with Formula Builder 

• Applying mathematical functions to selected columns of data 
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• Printing Data pages 

	
  

	
  

Overview of the Data View 
You can access the Data view using any of the following methods: 

• Click the Data View icon on the Command bar 

• Click the Data View icon on the Navigational bar 

• Choose Data View from the View menu 

While in the Data view, click and hold the Data View icon to display 
a list of avail- able Data pages in the current document and an option 
for creating a new page. 

You enter or import data to create DeltaGraph charts in the Data 
view. A Data page accommodates up to 32,000 rows and 256 
columns. 
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To learn more about... Refer to... 

Setting the start-up preferences “Setting General Defaults” in chapter 6 

	
  

The Data Page 
The Editing line at the top of the page (see figure on the previous 
page) displays the contents of the selected cell. This is where you 
enter and edit data. When you click in the Editing line, the mouse 
pointer changes to an I-beam cursor, indicating that you can enter 
data or make text changes. 

There are two types of labels in a Data page: row labels, which are 
below the column marked “Label,” and column labels, which are to 
the right of the row marked “Label.” (See the figure on the previous 
page.) 

You do not have to add labels in the Data page to create a chart, but 
they help you keep track of the data as you enter them, and they 
categorize and serialize data for chart axes and legends. 

Which labels you need, and where you should position them on the 
Data page, depends on the type of chart you plan to create. For 
example, a Bar chart uses both row and column labels, a Paired 
Scatter chart uses no row labels and every other column label, a Table 
chart is all labels, and a Contour Fill chart does not use any labels at 
all. 

You can place Axis titles for a chart anywhere on the Data page. 
When you click the Plot icon, the “Chart Setup” dialog box appears. 
You can choose a chart, then click the “Attributes” tab in the “Chart 
Setup” dialog box to select the cells you want to use as chart titles. 

If you are uncertain of the best way to organize your data for the type 
of chart you want to plot, refer to Chapter 7, “Chart Types” for 
recommendations. 

Once the data are entered, you use commands on the Edit, Text, and 
Data menus to format and manipulate them. You can also cut or copy 
and paste data between Data pages to combine information from 
different sources for experiments and projections. If you copy 
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selected data from several sources and paste them in a new page, for 
example, you can plot a chart to test a particular hypothesis. 

To learn more about... Refer to... 

Naming and deleting pages “Adding a Data Page” in chapter 4-5 

Organizing data for certain 
charts 

Chapter 8, “Chart Types” 

Adding numerical formats to 
labels 

“Formatting Text” in chapter 4-13 

Selecting cells as chart titles “Creating Chart Axis Titles” in chapter 9-8 

	
  

The Command and Navigational Bars 
The Command bar, located directly below the Menu bar, and the 
Navigational bar, located at the bottom of every DeltaGraph view, 
contain icons that provide short- cuts to menu commands. 

 

 

All images of the Command bar in this manual show the extended 
version, which includes all available icons for the view. To change 
which icons are displayed  right click on the bar, then drag what you 
want onto the command bar from the resulting dialog. 

If the “Tool Tips” option is enabled in Preferences, you can move the 
mouse pointer over an icon on the Command bar or Navigational bar 
to display a description of the icon’s function (see Chapter 6, “Setting 
Preferences”). 

In the Data view, the Navigational bar (located at the bottom of the 
view) has icons to perform the following functions: 

• Add a new page 
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• Move a page up or down 

• Select a page (opens the Go To dialog box) 

• Select a different view 

• View the Data and Chart views side-by-side (Split View) 

Adding a Data Page 
Although you can have an unlimited number of Data pages in the 
Data view, you can have only one Data page visible at a time. You 
can create a new Data page using any of the following methods: 

1.  Click the Add Page icon on the Navigational bar. 

2.  Click and hold the Data View icon on the Command bar, and select 
New Page from the pop-up menu. 

3.  Choose Data View from the View menu, and select New Page 
from the submenu. An empty data page appears, with a default name 
(Data #1, Data #2, etc.) displayed in the Page Selector. 

Displaying a Data Page 
You can view a list of available Data pages and switch between Data 
pages using either of the following methods. 

1.  Click the Page Selector icon on the Navigational bar. A list of 
available Data pages appears on the menu. Click a page on the 
menu to go to that page. 

2.  Click and hold the Data View icon on the Command bar. A list of 
available Data pages appears on the menu. Click a page on the 
menu to go to that page. 

Naming a Data Page 
To help you keep track of the Data pages in a document, a default 
name is assigned to each page as you create it (“Page #1,” “Page #2,” 
and so on). You can change the default name to help identify the 
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page’s contents. To display the names of all the Data pages in a 
document, click and hold the Data view icon on the Command bar, or 
click and hold the Page Selector on the Navigational bar. 

To change a Data page name, do the following: 

1.  Choose Name Page from the View menu. The “Page Title” 
dialog box appears with the current name selected. 

2.  Type a new name. The new name overwrites the current name. 

3.  Click OK to rename the Data page. The new name replaces the 
old name. You can see the new name in the Page Selector. 

To exit the dialog box without making any changes, click Cancel. 

Deleting a Data Page 
To delete the active (open) Data page, do the following: 

1.  Select Delete Page from the View menu. A prompt appears 
asking to confirm your selection. 

2.  Click OK to delete the Data page. If you do not want to delete the 
page, click Cancel. 

The page and all data on the page are deleted. You cannot delete a 
Data page associated with a currently plotted chart. 

Moving Around in a Data Page 
The horizontal and vertical scroll bars make it easy to navigate 
through large sets of data. The vertical scroll bar is calibrated to 
1,000 rows so you can fine tune your scrolling position when 
working with average-size data sets. This means that when you drag 
to the bottom of the scroll bar, row 1,000 is displayed at the top of the 
page. If the page has more than 1,000 rows of data, the next number 
divisible by 100 is displayed at the top of the page. 

The different ways of moving around in a Data page and selecting 
individual cells are outlined in the table below. When key 
combinations are indicated, press both keys simultaneously. 
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Key(s) Movement 

Left arrow Moves the selection to the left one cell, or registers 
the entry on the Editing line then selects the cell to 
the left of the current selection. 

Right arrow Moves the selection to the right one cell, or registers 
the entry on the Editing line then selects the cell to 
the right of the current selection. 

Up arrow Moves the selection up one cell, or registers the entry 
on the Editing line then selects the cell above the 
current se- lection. 

Down arrow Moves the selection down one cell, or registers the 
entry on the Editing line then selects the cell below 
the current selection. 

return Same as Down arrow. 

tab Same as Right arrow. 

shift+tab Same as Left arrow. 

shift+return Same as Up arrow. 

Mouse button click Selects the cell under the mouse pointer, or registers 
the entry on the Editing line then selects the cell 
under the mouse pointer. 

	
  

Entering Data 
Before you begin entering data, be sure you know how to move 
around in a Data page (see “Moving Around in a Data Page” in 
chapter 4). And if you are uncertain of the best way to organize your 
data for the type of chart you want to plot, refer to Chapter 7, “Chart 
Types” for recommendations. 

As you enter data you will notice that numbers are right-justified 
and letters are left-justified. If you create a label consisting of 
numbers that you want treated as letters, such as a date, enter a 
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quotation mark (") before the number, or choose Alignment from 
the Text menu and Left from the submenu. 

To enter data in a Data page, do the following: 

1.  Use the mouse or arrow keys to select the cell in which you want to 
enter data. If the cell is empty, the cursor blinks at the insertion 
point on the Editing line. 

 

If something has been entered in the cell, the contents appear and 
are selected (highlighted) on the Editing line. If you type anything 
at this point, the current entry is overwritten. If you want to edit 
the current entry and not type over it, click on the Editing line to 
deselect the data before typing. 

2.  Type the data you want to enter on the Editing line. 

 

If you make a mistake, press Delete to backspace delete 
characters, or click and drag to select the incorrect characters, 
then type the corrections. 

3.  Click in a cell, press return, or press an arrow key to select another 
data cell. 

 

Everything you enter on the Editing line is placed in the data cell. 
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If the data you entered contains more characters than will fit in 
the current cell width, you can resize the columns to see more of 
the entry (see “Changing the Column Width” in chapter 4). You 
can also make columns narrower so that you can see more 
columns on the page. 

4.  Continue to select cells and enter information until all your data are 
entered. 

	
  

To learn more about... Refer to... 

Resizing columns “Changing the Column Width” in chapter 
4 

Setting date and time formats “Formatting Text” in chapter 4 

Organizing data for certain 
charts 

Chapter 7, “Chart Types” 

Reversing data in the Data page “Transposing Data” in chapter 4 

	
  

Selecting Data 
Whether you plot a chart from the Data view or from the Chart view, 
you need to select the data that you want included in the chart. You 
can select all or only a portion of the data on a page. This allows you 
to plot more than one chart from a single Data page. 

You can select data in a variety of ways. If you want data plotted in 
the same order that you entered it in the Data page, however, you 
must select them from the top down and from left to right. 

The different methods of selecting data are described below. 
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Select a single cell 

Click in the cell or use the arrow keys, tab, or return to select the 
desired cell. The contents of the selected cell appear, highlighted, on 
the Editing line. 

Select a row of data 

Click the number label at the left of the desired row. The entire row is 
selected and the row label, if any, appears on the Editing line. 

Select a column of data 

Click the letter label above the desired column. The entire column is 
selected and the column label, if any, appears on the Editing line. 

Select more than one adjacent row or column 

Click the first or last row or column in the group you want included, 
then drag to the last or first row or column you want included in the 
group of rows or columns. 

Select a block of data 

Click the first or last cell in the block you want to select, then hold 
down the shift key and click the cell in the opposite corner of the 
block. The contents of the first cell selected appear on the Editing line.  

or... 

Click in the first or last cell you want to select, and drag the mouse 
pointer diagonally down or up across the data you want to select. If 
all of the data you want to select are not visible in the page, continue 
dragging and the data are scrolled automatically. The contents of the 
first cell selected appear on the Editing line. 

Select non contiguous cells or blocks of data 

To select cells that are not next to each other, hold down the 
command key and click each cell, row, column, or data block that you 
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want to select. You can select groups or blocks of data to include in the 
noncontiguous group using any of the methods described above. 

Select all data in the Data page 

Click the Select All icon, choose Select All from the Edit menu, or 
press cmd-A. All 

data in the Data page are selected, including the lowest right-hand 
cell that contains data. This method may also select empty cells, 
which is not desirable when plotting. 

Select columns in a different order for plotting 

To plot data in a different order than you entered it in the Data page, 
hold down the command key while selecting columns in the order 
that you want the data plotted. If you want to select rows to be plotted 
in a different order, select Series on the Data menu, and select In 
Rows from the submenu. 

Editing Data 
You can cut, copy, delete, replace, or otherwise modify the words or 
numbers you have entered or imported in data cells, and you can cut, 
copy, clear, or paste rows, columns, or blocks of data in the Data 
page. You can also add empty rows or columns to the Data page. 

To edit the data in a cell, use the mouse or arrow keys to select the 
cell in which you want to edit the data. The contents of the cell 
appear and are selected (high- lighted) on the Editing line. To cut, 
copy, paste, or clear all of the data in a cell, leave all of the data on 
the Editing line selected, or select only the data you want to cut, 
copy, paste, or clear. 

To cut, copy, paste, or clear the data in any number of selected cells, 
rows, or columns, select the cells, rows, columns, or block of data as 
described in “Selecting Data” above. 

Then do any of the following to edit the data: 
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Overwrite the current data on the Editing line 

Do not click on the Editing line; type the new data over the highlighted 
entry. Press return or an arrow key to accept the new data. 

Edit the current entry and not overwrite it 

Click on the Editing line to deselect the data before typing. Press 
Delete to back- space delete characters, or click and drag to select the 
incorrect characters, then type the correction. Press return or an arrow 
key to accept the change. 

Cut the data in the selected cell(s), row(s), column(s), or block 

“Cut” data if you want to remove them and paste them elsewhere. 
Open the Edit menu and select Cut, or press cmd-X. Use “Paste” to 
paste it in another location on the Data page or in another Data page. 

Clear the data from the selected cell(s), row(s), or column(s) 

“Clear” data if you want to delete them permanently. Open the Edit 
menu and select Clear. (You will not be able to paste the data back in a 
Data page an you cannot “Undo” the action.) 

Copy the data in the selected cell(s), row(s), column(s), or block 

Open the Edit menu and select Copy, or press cmd-C. 

Paste the data that you cut or copied 

To paste the data that you cut or copied into another cell(s), row(s), 
column(s), or block on the same or another Data page, do one of the 
following. Any existing data is overwritten. 

• Select (highlight) the cell(s), row(s), column(s), or block into 
which you want to paste the data, open the Edit menu and select 
Paste, or press cmd-V. 

• Click the cell in the top, left corner of the area in which you want 
to paste it, open the Edit menu and select Paste, or press cmd-V. 
A block of data is pasted starting with the selected cell and 
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moving to the right and down. 

You can add or delete rows and columns in the data page, as follows: 

Insert an empty row 

Select the row above which you want to add a row, then choose Insert 
Rows from the Data menu. To insert more than one row, select the 
number of rows that you want to insert. The new row(s) are inserted 
just above the selected row(s). 

Insert an empty column 

Select the column next to which you want to add a column, then 
choose Insert Columns from the Data menu. To insert more than one 
column, select the number of columns that you want to insert. The new 
column(s) are inserted to the left of the selected column(s). 

Delete rows 

Select the row or rows you want to delete, then choose Delete Rows 
from the Data menu. If an existing chart uses the data in the row(s), a 
prompt asks you to confirm the deletion. Click OK to delete the row(s). 

Delete columns 

Select the column or columns you want to delete, then choose Delete 
Columns from the Data menu. If an existing chart uses the data in the 
column(s), a prompt asks you to confirm the deletion. Click OK to 
delete the column(s). 

	
  

To learn more about... Refer to... 

Selecting cells, rows, and columns “Selecting Data” in chapter 4 
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Formatting Text 
Select Font, , Style, or Color on the Text menu. Or select text on the 
page, and select Alignment on the Text menu to change the 
alignment of the selected text (only “Left,” “Center,” and “Right” 
apply to text on the Data page). 

You can also select Set All on the Text menu, to open a “Text For
 mat” dialog box and make all attribute changes to the text at the 
same time. 

Changes to text on the Data page affect the look of the text in the Data 
view only; the plotted chart is not affected. 

Entering Special Text Characters 
You can add superscript and subscript text or enter line breaks in a 
plotted chart by entering “Special Text” characters in the text in the 
Data page. The modifications appear only in the Chart view. 

NOTE ☞  The “Superscript” and “Subscript” commands on the Text menu, 
Style submenu, and the Style icon menu can be applied only in the 
Chart view. 

To add a Special Text character, do the following: 

1.  Click the data cell that contains the text you want to change . 

2.  In the Editing line, click to place the cursor in front of the text 
you want to make superscript, subscript, or where you want to 
place a line break. 

3.  Choose Special Text from the Text menu, and select Insert 
Superscript, Insert Sub- script, or Insert Linebreak from the 
submenu, or type in the special character sequence displayed on 
the menu and shown below. 

Superscript  \+  
Subscript  \-  
Line Break \r 

All text that follows the superscript or subscript marker will be 
changed. All text that follows the line break marker will appear 
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on a second line. 

4.  If you want normal text to follow the superscript or subscript text, 
place the cursor after the special text, and select Insert Normal 
from the Text menu, Special Text submenu to make all text 
following the cursor normal. 

Normal \= 

Example:  These are \+ special text 
\= characters. Appears as:  These are 
special text characters. 

Changing the Column Width 
If you are working with especially long or short data entries, you can 
adjust the column width to a more appropriate size. To change the 
width of a column, do the following: 

1.  Move the mouse pointer into the gray row at the top of the table 
and center it on the line that divides two columns (to the right of 
the column you want to resize). The pointer changes to . 

2.  Click and drag the column line to a new position. Only the column 
to the left of the line you moved is resized. 

Transposing Data 
Click the Transpose icon on the Command bar, or choose Transpose 
from the Data menu to switch the physical position of rows and 
columns in a Data page and the axes in any charts plotted from the 
data. “Transpose” affects all data on the page regardless of what is 
selected. If you try to transpose data that has already been plotted, a 
prompt warns you that data may be lost or changed and gives you a 
chance to cancel the command. 

If you already have charts plotted from the data, click the Series icon 
on the Command bar, or select Series on the Data menu, to switch 
the axes in any new charts you plot without changing plotted charts or 
the data from which they are plotted. 

Select In Rows to switch the axes and plot the series in rows. Select 
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In Column to plot the series in columns. You will not see the switch 
in the Data view, only when you plot the chart. 

NOTE ☞  If you switch the series, all charts you plot from Data pages in all 
documents will be switched until you switch it back or exit 
DeltaGraph. 

Revising Data and Updating Charts 
	
  

If you revise, delete, or add data in a Data page, you can update one 
or more of the charts plotted from the data without replotting the 
charts. 

To update all the charts in the current DeltaGraph document, make 
the changes in       the Data pages, then click the Update icon on the 
Command bar, select Update from the Data menu, or press cmd-=. 
All charts for which data have been changed are updated. 

To update one particular chart, select the chart in the Chart view, 
then click the Revise Data icon on the Command bar, choose 
Revise Data from the Chart menu, or press cmd-, (comma). The 
originating Data page is opened for you to make changes. 

Use “Update” if you are changing, but not adding to, the existing 
data. Since only the selected block of data is used to plot the chart, 
you must use “Revise Data” to remove or add data to the chart. 

NOTE ☞  If you selected the “Always Plot All Data” option in the Chart 
Gallery when you plotted your chart, all data, no matter what was 
added, removed, or selected, are updated. 

To learn more about... Refer to... 

Updating all related charts “Updating a Chart” in chapter 8 

Revising one chart only “Revising Chart Data” in chapter 8 
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Importing Data 
You can import data into a new Data page. Several possible formats 
are available. To bring data from another application into a Data 
page, click the Import icon on the Command bar, or choose Import 
from the File menu. You can import any of the following data 
formats: 

Tab delimited 

ASCII or UTF8 file, each field separated by a tab 

Comma delimited 

ASCII or UTF8 file, each field separated by a comma 

Space delimited 

ASCII or UTF8 file, each field separated by a space 

Custom delimited 

ASCII or UTF8 file, displays a dialog box so you can enter a 
custom string of separators for the imported data. You can enter an 
ASCII code containing up to three characters. 

Multi-space delimited 

ASCII or UTF8 file, spaces are interpreted as separate fields Most 
applications create tab-delimited text files. To determine which 
format a file contains, use a word processing program to open the 
data file and look at how each field is separated. 

To import data from another application, do the following: 

1.  Open a new or existing Data page. 

2.  Click in the cell where you want your imported data to begin. This 
applies only if you have specified the option in “Preferences” (see 
“Setting Export / Import / Clipboard Defaults” in chapter 6) to 
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import to a selected cell 

3.  Click the Import icon on the Command bar, or choose Import 
from the File menu. An “Open” dialog box is displayed. 

 

4.  Click the “Show” pop-up menu, and select the format of the file 
you want to import. Files not compatible with the selected 
format are dimmed or not dis- played. 

5.  Click the “From” pop-up menu, and select the folder in which the 
file you want to import is located. 

6.  Double-click the name of the file you want to import, or select 
the file and click Open. 

By default, if the first row or column of the imported data contains 
text, the data are placed so the text begins in the “Label” row and 
column. If the first column of the imported data is numerical, the data 
are placed beginning in column A, row 1. 

If you want to change the default so that imported data are placed 
beginning in a selected cell in the Data page, change the settings in 
Preferences (see “Setting Export/Import/Clipboard Defaults” in 
chapter 6). You might want to do this if, for example, you want to use 
dates as category and series labels. 

After importing data, you might need to use the “Cut” and “Paste” 
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commands on the Edit menu to rearrange column and row labels 
(see “Editing Data” in chapter 4). 

To learn more about... Refer to... 

Importing Data “Importing Data” in chapter 4 

Setting “Import Location” 
options 

“Setting Export/Import/Clipboard 
Defaults” in chapter 6 

	
  

Exporting Data 
Use the Export command to compile the data from a Data page into 
a tab-delimited file that can be imported into another application. 
The entire contents of the active Data page (regardless of what is 
selected) is included in the export file. To export data from 
DeltaGraph, do the following: 

1.  Open the Data page that contains the data you 
want to export. 

2.  Choose Export from the File menu, and the “Save” dialog box 
is displayed. 
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“Tab-delimited text” is the only export type currently available. 

3.  A default name consisting of the current page name and a “.txt” 
extension is entered in the Save As text box. If you want to 
rename the file, type over the default name. 

4.  Select the drive and folder in which you want to save the import file 
from the “Where” pop-up. 

5.  Click Save. The data are saved to the specified folder and can be 
imported into any application that reads tab-delimited text files. 

Formatting Data 
Use the Format command to reformat numerical data as times, dates, 
currency, percentages, or scientific values. When you format row 
and/or column labels in a Data page, the Category and/or Series axis 
labels of related charts are formatted automatically. Formatting of 
other data in a Data page appears only in the Data page. 

In the Data view, you can select and format row labels, column 
labels, and data. (In the Chart view you can format Value axis labels 
only with the “Format” command on the Chart menu.) When a chart 
is first plotted, the format of the data in the first data cell in each 
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column determines the format of the chart labels for the axis 
corresponding to that column. If you need to change the format of 
the chart after it is plotted, you must change it in the Chart view. 
Once the chart is plotted, changing the format in the Data page will 
have no effect on the chart. 

To reformat numerical data as currency, percentages, or scientific 
values, do the following: 

1.  Select the data you want to reformat. Refer to “Selecting Data” in 
chapter 4 for information on selecting data. 

2.  Choose Format from the Data menu, or press cmd-F. The 
“Set Format” dialog box appears. 

 

3.  Click the pop-up at the top of the dialog box and select Numbers. 

4.  Select from the following options. An example of each format you 
select is dis- played in the “Example” box at the bottom of the 
dialog box. 

Format 

Click to open a pop-up menu, and choose one of the following 
formats to apply to the selected data. 
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General 

Shows numbers as you entered or imported them into the Data 
page. This is the default format. 

Fixed 

Adds a fixed number of decimal places as specified in the 
“Decimals” option. For example, if you enter 1 in the 
“Decimals” text box, 15 becomes 15.0. 

Currency 

Places a dollar sign ($) before the number. For example, 15 
becomes $15. 

Percent 

Adds two zeros and a percent sign (%) after the number. For 
example, 15 becomes 1500% and 0.15 becomes 15%. 

Scientific (E) 

Shows numbers in scientific notation. For example, 15 (with 1 
in the “Decimals” text box) becomes 1.5E+1. 

Scientific (10) 

Shows numbers in scientific notation with the exponents 
displayed as superscripts. For example, 15 (with 1 in the 
“Decimals” text box) becomes 1.5x10\+1 ( 1.5 ⋅ 101  in the 
Chart view). 

Engineering (E) 

Shows numbers in scientific notation with powers of 10 
automatically changed to multiples of 3. For example, 15 
(with 1 in the “Decimals” text box) changes to 15.0E+0. 
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Engineering (10) 

Shows numbers in scientific notation with powers of 10 
automatically changed to multiples of 3 and the exponents 
displayed as superscripts. For example, 15 (with 1 in the 
“Decimals” text box) becomes 1.5x10\+1 ( 1.5 ⋅ 101  in the 
Chart view). 

Decimals 

Sets the number of decimal places from 0 to 15. Not available 
when “General” is the selected format. 

Use Commas 

Inserts a comma every three places to the left of the decimal point. 

	
  

Show Negative Using 

Select whether to show negative values with a minus sign or 
parentheses. 

5.  Click OK to implement the changes. To exit the dialog box 
without making any changes, click Cancel. 

To reformat numerical data as times and/or dates, do 
the following: 

1.  Select the data you want to reformat. Refer to “Selecting Data” in 
chapter 4 for information on selecting data. 

2.  Click the Format icon on the Command bar, choose Format 
from the Data menu, or press cmd-F. The “Set Format” 
dialog box appears. 

3.  Click the pop-up at the top of the dialog box and select Date/Time. 
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4.  Select from the following options. An example of the resulting 
format is shown in the “Example” box at the bottom of the dialog 
box. 

Time 

Click to display a pop-up menu, and choose one of the following 
time formats for the selected data. 

Format Example 

No Time Displays date 
only 

MM:SS 59:30 

HH:MM 12:59 PM 

HH:MM:SS 12:59:30 PM 

24HH:MM 24:59 

24HH:MM:SS 24:59:30 
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Date 

Click to display a pop-up menu, and choose one of the following 
date formats for the selected data. 

Format Example 

No Date Displays time only 

Short Date 4/23/2003 

Abbr. Date Apr 23, 2003 

Abbr. Date With Day Fri Apr 23, 2003 

Long Date April 23, 2003 

Long Date With Day Friday April 23, 2003 

Day-Month-Year 23-Apr-2003 

Day-Month 23-Apr 

Month-Year Apr-2003 

Year 2003 

Month April 

Abbr. Month Apr 

Weekday Friday 

Abbr. Weekday Fri 

	
  

5.  Click OK to implement the changes. To exit the dialog box 
without making any changes, click Cancel. 
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Sorting Data 
	
  

You can change the order in which the data are displayed in selected 
columns. You cannot sort column labels in the first row (“Label”). 
You can sort numbers or text (alphabetically). 

To sort selected data, do 
the following: 

1.  Select the column or columns of data you 
want to sort. 

2.  Click the Sort icon on the Command bar, or choose Sort from the 
Data menu. 

The following dialog box appears. 

 

3.  Select from the following options: 

First 

Click to display a pop-up menu of the letter labels of the selected 
column(s) and choose the column you want sorted first. Then 
click the pop-up to the right and choose whether you want the 
data sorted in Ascending or Descending order. “Ascending” 
sorts from lowest to highest, top to bottom. “Descending” sorts 
from highest to lowest, top to bottom. 
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Second 

If you selected more than one column, choose the column you want 
sorted secondary to the first column. Then click the pop-up to the 
right and choose whether you want the data sorted in Ascending or 
Descending order. 

Third 

If you selected more than one column, choose the column you want 
sorted tertiary to the second column. Then click the pop-up to the 
right and choose whether you want the data sorted in Ascending or 
Descending order. 

If you choose to sort second and third column, the data in the 
column selected in “First” are sorted first, the column selected in 
“Second” is sorted relative to the data in “First,” and the column 
selected in “Third” is sorted relative to the data in “Second.” 

For example, if the data look like the following before it is sorted: 

 

If you select both columns, and choose to sort column A “first” 
in ascending order, the results are as follows: 
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The numbers in column A are sorted numerically, but the 
numbers in column B stay in the same rows relative to column A 
that they were in before sorting. Note that the numbers in column 
B next to the “11”s in column A are not sorted. 

If you choose to sort column B “second” in ascending order, the 
results are as follows: 

 

The numbers in column B are now sorted relative to the numbers 
in column A. Note that the numbers in column B next to the “11”s 
in column A are sorted in ascending order. 

4.  Click Sort to reorder the columns as specified. To exit the dialog 
box without making any changes, click Cancel. 

If you want to sort each column individually and not relative to each 
other, select them one at a time, then select the column label from 
the “First” pop-up, select Ascending or Descending, and click Sort 
for each column. 

Building Formulas 
Use the Formula Builder command to perform calculations on a 
selected column of data, and fill a single cell or an entire column 
with values, times, and/or dates. 

To create a formula, do the following: 

1.  Open the Data page you want to use as the destination page. 

2.  Select a destination column for the results of the calculation. 
Select an empty or unneeded column because calculations 
overwrite any existing data. Refer to “Selecting Data” in 
chapter 4 for information on selecting a column. 



 
  DeltaGraph for Macintosh Version 7 User Guide 120 

3.  Click the Formula Builder icon on the Command bar, double-click 
the destination column’s letter label, or choose Formula Builder 
from the Data menu. The “Formula Builder” dialog box appears. 

 

	
  

The label of the destination column appears under the Formula 
window at the bottom-left of the dialog box (“Apply to:”).You can 
choose a different destination column by clicking the right or left 
arrow buttons next to the column label. 

NOTE ☞  Refer to the table in chapter 4 for information on each of the elements 
in the dialog box. 
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4.  Scroll through the list of functions in the Functions window and 
double-click the function you want to include in the formula. The 
appropriate formula shell appears in the Formula window with the 
cursor between the parentheses. The function description appears 
directly above it. 

You can also type the function name in the Formula window. If 
you need to enter more than one function, separate consecutive 
functions with an appropriate operator. Click the operator button, 
or type the operator in the formula. 

In the example above, the Function Description indicates that a 
column reference is required to complete the formula for the 
selected function, RSum. 

You create a formula using a combination of source column 
references and operators. 

5.  In the Source Columns window, double-click the column on 
which you want the function to be performed, or type the 
column’s letter label (A, B, C, etc.) between the parentheses in 
the Formula window. 

To include a source column that is not on the same page as the 
destination column, select the new page from the “Page Selector” 
pop-up menu, then double- click the column in the Source 
Columns window. The page name and column label are entered. 
To enter an alternate page’s column manually in the Formula 
window, enter the page name and column label in the following 
format: 

Page “Name”:D 

If you want to perform the function on more than one source 
column, separate the consecutive columns with a comma. Click 
the comma operator button, or type the comma in the formula. 

In the example above, a running sum will be performed on 
column A, and the calculations will be placed in column D. 

6.  Enter any additional information or operators for the formula as 
stated in the function description. Refer to “Formula Builder 
Functions” in chapter 4 for information on the functions 
available with descriptions and guidelines for completing the 
formula for each function. 
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7.  Click Calculate after you have entered the formula. 

If you made a mistake filling in the formula, a warning message is 
displayed that explains the problem or what you need to do before 
the calculation can be completed. 

If the formula is correct, the results of the calculations appear in 
the destination column. (If you cannot see the column, move the 
dialog box out of the way by clicking on the Title bar and 
dragging it.) 

8.  Click OK to save the calculations and return to the Data page. To 
exit the dialog box without entering the calculations on the Data 
page, click Cancel. 

After the calculations are entered in the Data page, you can include 
the column of calculated data in a plotted chart, you can edit the data 
(see “Editing Data” in chapter 4), and you can perform another 
calculation on them. 

If you select a column containing data that were created by a 
calculation function, the function used to perform the calculation is 
selected when you open the “Formula Builder” dialog box. 

Update Calculations 

Function calculations are based on the initial value of the source data. 
If you change the source data, the calculated data do not change 
automatically. If you want to update the calculations, click the 
Recalculate icon on the Command bar, or select Recalculate from the 
Data menu. 

Update Plotted Charts 

To update associated charts after adding one or more columns of 
calculated data to a Data page, click the Revise Data icon on the 
Command bar, or choose Revise Data from the Chart menu. If you 
used the “Recalculate” command to update numbers, associated charts 
are updated automatically if “Update Charts Automatically” is enabled 
in “Preferences” (see “Setting Chart View Defaults” in chapter 6). 
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Formula Builder Dialog Box Elements 
	
  

Formula Builder Dialog Box Elements 

Element Description 

Destination column The label of the column selected to receive the results of the 
calculation. To change the destination column in the dialog box, 
click the destination column selectors. 

Destination column 
selectors 

Click the left or right arrow buttons to change the destination column 
for the calculation results. You can choose any column on the 
original destination page. 

Formula window Displays the function’s formula as you create it. You can also type in 
all or parts of the formula. 

Formula shell A template for pre-programmed formula calculations. 

Function description A description of the information required to complete a function’s 
formula that is displayed when you double- click a function in the 
Functions window. Also, error messages are displayed if errors occur 
during calculation. 
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Formula Builder Dialog Box Elements (continued) 

Element Description 

Functions 
window 

List of the functions you can apply automatically. Double- click a 
function to select it. The function name and a formula shell appear 
in the Formula window, and a brief description of what is required 
to complete the formula appears just above the window. 

Operators Used to enter constants. You can click an operator button or type 
in the Formula window to include operators in the formula. 
Following are descriptions of operators that may not be self-
explanatory. 

#True         To enter manually, type 1. 

#False        To enter manually, type 0. 

[  ] Takes the row number from the annotated col- umn; for 
example, B[4] takes the entry from the fourth row of 
column B. 

@' and '  (Fill function only) Enters a date or time. @' precedes 
the time/date, and ' follows it, as in 

@'July 4, 1992', @'7/4/93', or @'10:29:59'. 

! Logical inversion (changes true to false and vice 
versa). 

%               Divides by 100. 

# Hash constants. Used to identify a name as a constant 
(e.g., #True). 

^ Signifies exponentiation in the formulas as binary 
operators. 

Page selector Click to select a page(s) from which to select a source column for 
the calculations. You can use columns from different pages in the 
same formula and set up functions for more than one page at a 
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time. 

Source 
Columns 
window 

Lists all the column labels from the selected page. Double- click 
the source column for the calculations to enter the column label in 
the formula. 

Formula Builder Functions 
The following table lists all the functions you can apply 
automatically in the Formula Builder. Each description includes a 
brief explanation of what each function does, the description from the 
dialog box, and sample guidelines for completing the function 
formula. Items in brackets [ ] indicate an optional entry for the 
formula. 

Formula Builder Functions 

Function Description 

	
  

	
  

Abs 

Takes the absolute value of each number in the source column and writes it 
into the corresponding cell of the destination column. The absolute value is 
the number without its sign; for example, the absolute value of -9 is 9. 

Examples: Abs(a), Abs(-9) 

	
  

	
  

Avg 

Writes the average of each row of numbers for two or more source columns 
into the corresponding cell in the destination column. Separate each column 
in the formula with a comma. 

Avg(two or more columns or numbers) Examples:
 Avg(a,b), Avg(a,b,c), Avg(5,14) 

	
  

	
  

TAvg 

Writes the average of the total of all the cells in the source column(s) into the 
first cell of the destination column. Separate each column in the formula with 
a comma. 

TAvg(one or more columns or numbers) 

Examples:     TAvg(a,b), TAvg(a,b,c), TAvg(3,6,14) 

	
   Writes the difference between each source value and the one that follows it 
into the corresponding cell of the destination column. 
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Diff Diff(a column) 

Examples: Diff(a), Diff(b) 

	
  

	
  

Exp 

Writes the transcendental constant e (2.71828...) to the power of each value in 
the source column into the corresponding cell in the destination column. 

Exp(a number or column) Examples:
 Exp(9), Exp(a) 

	
  

	
  

Formula Builder Functions (continued) 

Function  Description  

	
  

	
  

	
  

Fill 

Generates and writes data starting with the value, time, or date specified, 
incrementing by the value specified, to fill the number of cells specified in the 
destination column. 

Fill(start, increment, count [, units]) 

Examples:    Fill(0,5,10), Fill(0,100,10,#Rand), Fill(@'Oct 19, 

93',1,10,#Wk), Fill(@'Oct 31, 93',2,10,#Mon) 

	
  

	
  

Filter 

Evaluates values in the source column. If the values fall within the parameters 
specified, the corresponding value is output based on the second parameter. 

Filter(logical exp, true values [, false values]) Examples:
 Filter(a<5,a), Filter(a≥10,b) 
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Freq 

Counts the number of times each value appears in the source column, then lists 
the frequency of each source value in the destination column. Bound specs are 
used to define the bin range and can be defined in a separate column on the 
Data page. 

Bins compare the source column to the defined bound spec and out- put the 
number of values that falls within each bin. Rounding flags are: 0=< the number 
found in the bin (false), and 1=≤ the number found in the bin (true). If bound 
specs are used, the rounding flag is “<” otherwise it is = Freq(a column [, bound 
spec [, rounding flag]]). 

Freq(a column [, bound spec [, rounding flag]]) Examples:
 Freq(a), Freq(a, b), Freq(a,b,1) 

	
  

	
  

FreqL 

Labels the bins used in a Freq function and places them in the destination 
column. If bound specs are not used, rounding flags are not displayed. The 
FreqL formula must be exactly the same as the Freq formula. Refer to Freq 
(above) for rounding flag information. 

FreqL(a column [, bound spec [, rounding flag]]) Examples:
 FreqL(a), FreqL(a, b), FreqL(a,b,1) 

	
  

Ln 

Writes the natural logarithm of each value in the source column into the 
corresponding cell in the destination column. 

Ln(a number or column) Examples:
 Ln(9), Ln(a) 

	
  

	
  

	
  

Formula Builder Functions (continued) 

Function Description 

	
  

	
  

Log 

Writes the base 10 logarithm of each value in the source column into the 
corresponding cell in the destination column. 

Log(a number or column) Examples:
 Log(9), Log(a) 
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Median 

Writes the median of each row of numbers for two or more source columns 
into the corresponding cell in the destination column. Separate each column in 
the formula with a comma. 

Median(two or more columns or numbers) 

Examples: Median(a,b), Median(a,b,c), Median(5,14) 

	
  

	
  

	
  

TMedian 

Writes the median of the total of all the cells in the source column(s) into the 
first cell of the destination column. Separate each column in the formula with 
a comma. 

TMedian(one or more columns or numbers) 

Examples: TMedian(b), TMedian(a,b), TMedian(a,b,c) 

	
  

	
  

Mn 

Writes the minimum value of a column in the destination column. Mn(a 
column of numbers) 

Examples: Mn(a) 

	
  

	
  

	
  

Mod 

Writes the remainder of the divide operation of the two parameters in the 
source column into the corresponding cell in the destination column. 

Mod(a column, number or column) Examples:
 Mod(a,9), Mod(a,b), etc. 

	
  

	
  

Mx 

Writes the maximum value of a column in the destination column. Mx(a 
column of numbers) 

Examples: Mx(a) 

	
  

	
  

	
  

RSum 

Creates a running sum of all the values in the source column, then writes the 
sum of each value and all values that precede it in the column into the 
corresponding cell of the destination column. 

RSum(a column) 

Examples: RSum(a), RSum(b) 
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Formula Builder Functions (continued) 

Function Description 

	
  

Smooth 

Adds the current cell to a user-specified number of cells that follow it and 
writes the average into the corresponding cell of the destination column. 

Smooth(a column, smooth width) 
Examples: Smooth(a, 7) 

	
  

Std 

Writes the standard deviation for each row in the source column(s) into the 
corresponding cell in the destination column. Separate each column in the 
formula with a comma. 

Std(two or more columns or numbers) 
Examples: Std(a,b), Std(a,b,c) 

	
  

TStd 

Writes the total standard deviation of all the cells in the source col- umn(s) 
into the first cell of the destination column. Separate each column in the 
formula with a comma. 

TStd(one or more columns or numbers) Examples:
 TStd(b), TStd(a,b), TStd(a,b,c) 

	
  

Sqrt 

Writes the square root of each value in the source column into the 
corresponding cell in the destination column. 

Sqrt(a number or column) Examples:
 Sqrt(9), Sqrt(a) 

	
  

Squash 

Compresses all entries in the column by removing all blank data cells. 
Enter the column you want to compress. 

	
  

Squash(a column) 

Examples: Squash(c), Squash(a) 

	
   Determines the mean of all values in the source column, calculates the 
deviation of each source value from the mean, and writes the difference as a 
number of standard deviation units into the corresponding cell in the 
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ZScore 

destination column. 

ZScore(a column) 

	
  

Examples: ZScore(a), ZScore(b) 

	
  

	
  

	
  

Formula Builder Functions (continued) 

Function Description 

	
  

	
  

	
  

	
  

	
  

Trans 

Transcendental functions. All transcendentals are calculated in radi- ans, not 
degrees. Enters the function of each value in the source col- umn in the 
corresponding cell in the destination column. 

Transcendentals: sin, asin, sinh, asinh, cos, acos, cosh, acosh, tan, atan, 
tanh, atanh, cot, acot, coth, acoth, csc, acsc, csch, acsch, sec, asec, sech, 
asech 

Trans name(a number or column) Examples:    
sin(9), cos(a), acos(b) 

	
  

	
  

	
  

	
  

Others 

You can also create other mathematical formulas for addition, sub- traction, 
multiplication, division, or a combination. 

Examples: a+b, a+b+c, a+b-c, a/c, a+b∗c 

To take the third, fourth, or nth root of a column or number, enter 

A^(1/n) in the Formula window (with “n” being the power). 

	
  

Examples: A^(1/3) for cube root, A^(1/8) for 8th root 
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Creating a Histogram 
You can create histograms in DeltaGraph using either of the 
following two methods: 

1.  Enter and select a column of histogram data in the Data view and 
plot a Histogram chart from the “Chart Setup” dialog box. Refer 
to “Histogram Chart” in chapter 7 for information. 

or... 

2.  Bin the data manually as follows: 

•  Perform a FreqL function on source column(s) (to set up labels 
for the chart) 

•  Perform a Freq function on the same source column(s) using a 
different destination column 

•  Plot a column chart using both destination columns. 

Refer to “Creating a Histogram” in chapter 9 for more information. 

Printing a Data Page 
To print a Data page, click the Print icon on the Command bar, or 
choose Print from the Data view. A dialog box is displayed to make 
the necessary selections. In addition to the usual “Print” dialog box 
options, you can specify whether you want Data page grid lines and/or 
row and column labels to print or not. All data on the current page are 
printed regardless of what is selected. 

	
  

To learn more about... Refer to... 

Printing from the Chart view Chapter 15, “Printing in Chart View” 
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5 Creating Smart Layouts 
and Backgrounds 

	
  

	
  

This chapter explains how to create and use Smart Layouts and 
backgrounds. A Smart Layout, which consists mainly of placeholders 
for charts, titles, text, graphics, and bullets, serves as a template for 
assembling and arranging elements (charts, titles, text, graphics, etc.) 
in a Chart page. A background, which can consist of any combination 
of graphics, text, colors, and patterns, is a backdrop behind all of the 
elements in a page or layout. Layouts and backgrounds make it easy 
to standardize the appearance of your Chart pages to enhance their 
visual appeal. 

This chapter covers the following: 

• An overview of Smart Layouts, backgrounds, and Layout Sets 

• Loading and saving Layout Sets 

• Creating a Master Background 

• Creating and applying Exception Backgrounds 

• Creating and applying Smart Layouts 

• Using a layout to start creating a presentation 

• Filling Smart Layout placeholders 

To learn more about... Refer to... 

Page orientation and size “Setting Up the Document” in chapter 16 
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Overview of Smart Layouts and 
Backgrounds 

A Smart Layout is applied to Chart pages on a page-by-page basis. A 
background is applied to Chart pages or layouts. You can save your 
backgrounds and layouts to use again and again. 

When applied to a Chart page, a Smart Layout causes all elements on 
the page, whether already there or added later, to align and size 
themselves according to the attributes of their corresponding 
placeholder. You can also assign color schemes, type attributes, and 
other properties to placeholders, which the page elements take on 
automatically when the layout is applied to a page. Smart Layouts 
can be stored with the active document or saved as named sets so 
they can be used with any DeltaGraph document. 

There are two types of backgrounds: the Master Background and 
Exception Backgrounds. DeltaGraph automatically applies the Master 
Background to every Chart page in a document, though you can 
replace the Master Background with one of the two possible types of 
Exception Backgrounds: a Layout Background, which you assign to a 
specific layout and DeltaGraph applies to every Chart page that uses 
that layout, or a Page Background, which you assign to a particular 
Chart page. You can have only one Master Background for each 
document but an unlimited number of Exception Backgrounds. 

You must be in the Layout mode to create and edit your layouts and 
backgrounds. You can access the Layout mode from any view by 
choosing the Layout Editor from the View menu. This displays a 
submenu so you can create a new layout, apply an existing layout to a 
Chart page, load or save a Layout Set, or display the Master 
Background to edit. 

The Layout Mode contains a set of tools and palettes and two 
windows—the Lay- out window and the Background window. 
Because layouts and backgrounds are often used in tandem, you will 
probably switch frequently between the two windows, adjusting 
layout placeholders and background elements until you achieve the 
look you want. You can create numerous pages in each window, but 
you can have only one page and one window open at a time. 

DeltaGraph includes a collection of pre-formatted Smart 
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Layouts to get you started. These are stored in the “Layouts” 
folder included with DeltaGraph. 

Applying a Smart Layout to a Chart page is as easy as dragging an 
icon for the preferred layout from the Layout Set window into an open 
Chart page. Empty place- holders contain instructions for filling. 

 

To learn more about... Refer to... 

Color schemes “Color Schemes” in chapter 9 
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Layout Sets 
Every Smart Layout you create while working in a document is saved 
as a “set” with that document and can be displayed in the document’s 
Layout Set window. The Layout Set can be used with the originating 
document only, unless it is saved as a named Layout Set, then it can 
be loaded into any DeltaGraph document. Any Master or Exception 
Backgrounds, or color schemes in the document, are also saved with 
the Layout Set. 

The Layout Set window has all the standard window characteristics 
for Macintosh applications. In addition, the window contains a menu 
listing all the layouts loaded in the set, and it displays a scaled-down 
version of the selected layout. There is also an option that allows you 
to apply the selected layout to all the Chart pages in the current 
document. The Layout Set window reflects the layout that is applied 
to the currently active Chart page. Whenever you resize the Layout 
Set window, the displayed layout fits the dimensions of the window. 

 

A document’s Layout Set can be displayed in the Layout Set window 
in the Layout mode by choosing Layouts from the View menu and 
selecting Apply Layouts from the submenu. 

 
A Layout Set can be displayed in the Chart view or the Thumbnail 
mode of the Organizer view by clicking the Layouts icon on the 
Command bar or by choosing Apply Layouts from the Page menu. 
You can also choose Layouts from the View menu and select Apply 
Layouts from the submenu. 
Each DeltaGraph document has its own Layout Set. Whether it is 
empty or contains multiple Layout Sets loaded from other files, this 
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Layout Set remains completely independent of saved sets and sets in 
other documents. When you load a set, you actually merge or 
overwrite sets. Unlike a Custom Library, if you close the document’s 
Layout Set you do not have to re-open the file, you just have to click 
the Layout icon to re-display the window. 

To learn more about... Refer to... 

Naming layouts “Naming or Renaming a Layout 
or Background” in chapter 5 

Naming/Saving Layout 
Sets 

“Saving a Layout Set” in chapter 5 

	
  

Moving Around in the Layout Mode 
While in the Layout mode, you will often find yourself moving back 
and forth between windows and pages. DeltaGraph gives you several 
options for navigating in Layout mode as well as to and from Chart 
pages. 

Because you can have multiple pages in the Layout mode, the Add 
Page, Page Up, Page Down, and Page Selector icons on the 
Navigational bar are fully operational, though they offer different 
options depending on whether you are in the Layout window or the 
Background window. 

In addition to command icons and a set of magnification controls, the 
Layout mode Command bar, shown below, has a special Window 
indicator that lets you see at a glance whether you are in the Layout 
window or the Background window of the Layout mode. 

 

The special Layouts menu, available only in this mode, allows you to 
copy the current layout into a new Layout window (“Duplicate 
Layout”), hide placeholders (“Hide Layout Items”), hide the current 
background (“Hide Background”), change the background for the 
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active layout (“Edit Background”), or hide the Layout tools (“Hide 
Layout Tools”). 

Creating or Adding Layout and Background 
Windows 
 

Layouts can be created in the Layout mode or as you move into 
Layout mode. Backgrounds can only be created while you are in 
Layout mode or if you have chosen “Edit Background” from the 
Layouts menu while in the Chart view or Thumbnail mode of the 
Organizer view. 
There are two ways to create an empty layout or background 
as follows: 
1. Click the Add Page icon on the Navigational bar. 

 
2.  (Layouts only) Choose Layouts from the View menu and select 

New Layout from the submenu. The empty page appears with a 
default name (Layout #1, Back- ground #2, etc.) displayed in the 
Page Selector. 

Displaying a Layout or Background 
You can view a list of available layouts and backgrounds, and switch 
between layouts/backgrounds a variety of ways, as follows. 

1.  Click the Page Selector icon at the bottom of the page. A list of 
available lay- outs/backgrounds appears in the pop-up menu. 

Naming or Renaming a Layout or 
Background 

You cannot rename the Master Background, but you can rename 
Exception Back- grounds. The best time to name a layout or 
background is when you are creating it. This will save you from 
having to go back to the Layout mode or to the Chart page or layout 
to change a name. It may be helpful if you name your layouts and 
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back- grounds in a way that indicates the kinds of placeholder(s) 
included in the layout (i.e., “Title&1Chart,” “Chartw/Text,” etc.), or 
the type of background (i.e., “DoubleBlndw/HLine,” etc.). 

To help you keep track of the Chart pages in a document, DeltaGraph 
automatically assigns default names like “Layout #1,” “Background 
#2,” and so forth. You can assign names to Chart pages to help 
identify their contents. All the Chart pages associated with a 
document can be displayed by clicking the “Plot In” pop-up menu at 
the bottom of the Chart Gallery, by clicking and holding the Chart 
view icon on the Command bar, or by clicking and holding the Page 
Selector icon at the bottom of the page. 

You cannot name the Layout Sets that are part of specific 
documents. But if you save a Layout Set to a file, you will be asked 
to name the file, creating a named Layout Set you can load in any 
DeltaGraph document. 

NOTE ☞  Each Layout Set included with DeltaGraph has twelve identically 
named layouts. These Layouts Sets have been created so that if you use 
a layout from one of the sets, when a new set is loaded, that layout is 
replaced with the identically named layout from the new set. The 
position, size, and colors of the two sets may be totally different. This 
allows you to change the look of your entire document just by loading 
a different Layout Set. It is important to keep the names of layouts in 
each Layout Set the same so they can be easily updated with new 
Layout Sets. Keep this in mind if you decide to create a Layout Set of 
your own. 

To name or rename a layout or background, do the following: 

1.  In the Layout mode, display the layout you want to name. 

To navigate, use the View icons, the Page Selector icon, or 
commands from the “Layouts” submenu on the File menu. 

2.  Choose Name Page from the View menu. The “Page Title” 
dialog box appears with the default name selected. 

3.  Enter a new name. The new name overwrites the default name. 

4.  Click OK to rename the layout or background. The new name 
replaces the old name. You can see the new name in the Page 
Selector at the bottom of the page. To exit the dialog box without 
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making any changes, click Cancel. 

	
  

To learn more about... Refer to... 

Saving a named Layout Set “Saving a Layout Set” in chapter 5 

	
  

Deleting Layouts and Backgrounds 
Use the “Delete Page” command on the View menu to delete a layout 
or back- ground. This deletes the layout or background and all objects 
on the page from the document as well as from the Layout Set. 

If the current document contains layouts or backgrounds you do not 
want included in a Layout Set file, you can use this command to 
remove unwanted backgrounds before saving. 

To delete the active layout or background, do the following: 

1.  Choose Delete Page from the View menu. A dialog box appears 
asking you to confirm your selection. 

2.  Click OK to delete the layout or background. To exit the dialog 
box without making any changes, click Cancel. 

Loading and Saving Layout Sets 
Any Layout Set open when you save the current DeltaGraph 
document is automatically saved with the document. Master and 
Exception Backgrounds and color schemes are also saved with the 
Layout Set. Layout Sets themselves can be saved as named sets so 
they can be loaded and used in any DeltaGraph document. 

Once a Layout Set has been loaded into a DeltaGraph document, it 
loses its link with the original Layout Set file. To save any changes 
you make to a Layout Set, you must save the set to a file. 

If you prefer, you can also export backgrounds as you would any 
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graphic element or place backgrounds in a Custom Library so you can 
share them with other Delta- Graph documents. A Color Scheme 
palette can also be saved as a separate file using the Colors command. 

	
  

To learn more about... Refer to... 

Creating Custom Libraries “Creating a Library” in chapter 14 

Saving Color Scheme palettes “Color Schemes” in chapter 9 

Exporting graphics “Exporting Graphics” in chapter 13 

	
  

Loading a Layout Set 
Saved Layout Sets can be loaded in any DeltaGraph document. You 
cannot use a Layout Set from another DeltaGraph document unless 
the set has been saved to a file. Even though a DeltaGraph document 
has only one Layout Set, you can merge other Layout Sets in the 
same document. 

When loading a Layout Set, you have the option of loading all or 
some layouts, backgrounds, or the color scheme. If you merge Layout 
Sets, the Master Back- ground and color scheme of the current 
document’s Layout Set will be replaced by those in the merging 
Layout Set unless you deselect “Background” and “Color Scheme” 
when loading. 

To load a Layout Set, do the following: 

      1. Choose Layouts from the View menu and select Load Set from the 
submenu.	
  

The “Open” dialog box appears. 
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2.  Locate the Layout Set you want to open. Click a Layout Set to 
preview the Master background and color scheme. 

	
  

3.  Select or deselect Layouts, Background, or Color Schemes. If 
selected, the layouts, backgrounds, and color schemes from the 
selected Layout Set are loaded in the current document’s Layout 
Set. 

NOTE ☞  If you load new backgrounds and/or a color scheme, the 
existing ones are replaced. 

4.  Double-click a Layout Set name or select the name and click 
Open. If the cur- rent Layout Set has layouts or backgrounds with 
the same names, a message appears asking if you want to add 
them to the current Layout set or replace the current layouts and 
backgrounds. 

Depending on the options selected in the dialog box, the 
background, color scheme, and layouts are loaded and 
displayed in the view. 
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Saving a Layout Set 
Layout Sets saved to a file consist of any layouts in the existing 
Layout Set, the Master Background, additional backgrounds 
created, and a color scheme. Even though the Layout Sets are 
automatically saved to the active DeltaGraph document, you can 
save a Layout Set to a file so it can be loaded in other DeltaGraph 
documents. 

You can also use the Layout Set to save only the backgrounds and a 
color scheme by deleting any layouts in the set before saving. 

To save a Layout Set, do the following: 
 1. Choose Layouts from              
 
 the Edit menu and select Save Set from the submenu. The “Save” 
dialog box appears. 

 
	
  

2.  In the Save As box, enter the name you want to give this Layout 
Set. 

3.  Click Save to save the Layout Set. 
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You can choose Load Set from the Layouts submenu to load a saved 
set in another DeltaGraph document. 

Creating and Using Backgrounds 
You can create backgrounds in the Background window of the 
Layout mode. DeltaGraph automatically applies the Master 
Background to all Layouts and Chart pages created in the current 
document. Any changes made to the Master Back- ground are 
automatically reflected in the Layouts and Chart pages using the 
Master Background. 

If you do not want all the layouts and Chart pages in the current 
document to have the same background, you can specify one of two 
possible Exception Back- grounds: a Layout Background or a Page 
Background. Which one you use depends on whether you want to 
apply the background to every page that uses a particular layout or to 
one or more individual pages only. When you change a Layout Back- 
ground, every Chart page using that layout reflects the change. 
Changing a Page Background affects only the page(s) using that 
background. 

Backgrounds can contain any combination of type, graphics, colors, 
and patterns. You might want to include nothing more than a 
background color and a copyright line, or you may want to add the 
corporate logo, a decorative border, and an eye- catching color blend. 

You can temporarily hide the background in the active Chart page by 
choosing Hide Background from the Page menu. Selecting this 
command does not affect printing. If you print a Chart page while 
“Hide Background” is selected, the back- ground prints even though it 
is not visible on-screen. 

The Master Background 
Because it is intended to serve as a backdrop for most (if not all) of 
the Chart pages and slides in a document, the Master Background is 
applied automatically to all layouts and Chart pages in the active 
document. Though you can have only one Master Background per 
document, you can have any number of Exception Back- grounds that 
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can be applied to individual Chart pages and Smart Layouts. 

To create a Master Background, do the following: 

1. Choose Layouts from the View menu and select Master 
Background from the submenu.	
  

DeltaGraph takes you to the Background window of the Layout 
mode and displays the Layout mode Command bar, the 
DeltaGraph Toolbox, and the Master Background page at 50% 
view size. Unless you have already worked on the Master 
Background, the only element on the page is a page-sized box 
(with an X in the middle) that you can select, resize, drag, or 
delete. 

2.  Unless you want to leave the background plain white, select the 
background box and apply a color or blend. 

See “Applying Colors” in chapter 11 if you need help creating or 
applying colors or “Adding Special Blends to Objects” in chapter 
11 if you need help creating blends. 

3.  Create, paste, or import any text or graphics you want to include 
in your Master Background. 

There is no limit to the number of objects you can include. Just 
remember that everything you place in your Master Background 
is going to appear behind every Chart page unless an Exception 
Background is applied. 

4.  Exit the Master Background page. 

Where you go from here depends on what you want to do next. 
You can use the View icons, the Page Selector icon, or commands 
from the View menu to navigate. 

NOTE ☞  It is important to remember that whenever you exit the Master 
Background window, the background on the active page becomes 
the new Master Background, replacing the current Master 
Background in all your layouts and Chart pages. DeltaGraph alerts 
you before letting you exit so you do not replace your Master 
Background inadvertently. 
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Layout Backgrounds 
A Layout Background is an exception to the Master Background that 
is applied to a particular layout. This Exception Background replaces 
the Master Background each time the layout is used in a Chart page. 

If you do not want to permanently change the background of a layout, 
you have two options: 1) you can change the background in 
individual Chart pages, or 2) you can create two layouts which are 
virtually the same except one uses the Master Background, and the 
other uses a new Layout Background. 

When a Layout Background is created for a specific layout, the link 
to the Master Background is broken. Any changes to the Master 
Background will not change the background for the layout or any 
Chart page using the layout. 

To create a Layout Background, do the following: 

1.  Open DeltaGraph to the layout page you want to change. The 
layout page appears with placeholders and the Master 
Background. 

2.  Click the Background icon in the Layout Tools palette, or choose 
Edit Background from the Layouts menu. An alert dialog box 
appears, warning you that this operation will break the link to the 
Master Background. 

3.  Click OK. The placeholders disappear, and a copy of the 
background used in the current layout appears. If the current 
layout set does not contain a Master Background, the background 
appears with a large X in the middle. 

The changes made to this background have no effect on the 
Master Back- ground. 

4.  Click the background element and change the background as 
necessary. If other Exception Backgrounds have been created, 
they appear in the “Page Selector” pop-up menu at the bottom of 
the page. You can also switch to any of these pages, including the 
Master Background, if you change your mind. 

The background that is displayed when you return to a 
DeltaGraph view will be your Layout Background. If you select 
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one of the Exception Backgrounds from the “Page Selector” pop-
up menu and return to the layout, that Exception Background 
becomes the Layout Background. 

Page Backgrounds 
A Page Background is an exception to the Master Background that is 
applied to an individual Chart page. 

The link to the Master Background is broken in this case, which 
means that any changes to the Master Background will not change 
the background for the Chart page. 

To create a Page Background, do 
the following: 

1.  Open DeltaGraph to the Chart page you 
want to change. 

2.  Choose Edit Background from the Page menu. An alert dialog 
box appears warning you that this operation will break the link to 
the Master Background. 

3.  Click OK. The placeholders or other objects in the page disappear, 
and a copy of the background used in the current Chart page 
appears. If the current layout set does not contain a Master 
Background, the background appears with a large X in the 
middle. 

The changes made to this background have no effect on the 
Master Back- ground. 

4.  Change the background as necessary. If other Exception 
Backgrounds have been created, they appear in the “Page 
Selector” pop-up menu at the bottom of the page. You can also 
switch to any of these pages, including the Master Background, if 
you change your mind. 

The background that is displayed when you return to a 
DeltaGraph view will be your Page Background. If you select one 
of the Exception Backgrounds from the “Page Selector” pop-up 
menu and return to the Layout, that Exception Background 
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becomes the Page Background. 

Editing Backgrounds 
When you change a Master Background, any Chart pages using that 
background are updated automatically to reflect the changes. If you 
have assigned Exception Backgrounds to any Chart pages or 
Layouts, those backgrounds will not be updated. 

To edit an Exception Background such as a Layout or Page 
Background, you must be on the originating layout or Chart page. 
The procedures for editing backgrounds are the same as for creating 
them. 

To learn more about... Refer to... 

Creating a Master Background “The Master Background” in chapter 5 

Creating a Layout Background “Layout Backgrounds” in chapter 5 

Creating a Page Background “Page Backgrounds” in chapter 5 

	
  

Relinking to the Master Background 
When you assign an Exception Background to a Chart page or layout, 
the link to the Master Background is broken. If you decide later that 
you need to use the Master Background on these pages, DeltaGraph 
allows you to re-link to the Master Background. 

To relink to the Master Background, do the following: 

1.  Open the layout or Chart page using the Exception Background. 

2.  If you are in the Chart view, choose Edit Background from the 
Page menu. If you are in the Layout mode, choose Edit 
Background from the Layouts menu. The placeholders or other 
objects in the page disappear, and the Exception Back- ground 
appears. 
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3.  Click the Page Selector bar on the Navigational bar, and select 
Master Background from the pop-up menu. The Master 
Background appears, replacing the Exception Background. 

4.  leave the background editor. An alert dialog box appears asking 
if you want to re-link to the displayed background.	
  

5.  Click OK. The Chart page or Layout you were working on is 
displayed with the Master Background. If you want to exit the 
dialog box without recreating the link, click Cancel. 

Creating and Using Smart Layouts 
You create layouts in the Layout window of the Layout mode and 
apply them to Chart pages. 

Each Smart Layout may contain one or more placeholders that define 
the size, location, and other attributes (font, color, etc.) of the various 
elements on the Chart page. You can have an unlimited number of 
placeholders in a layout and an unlimited number of layouts per 
document, but only one layout per Chart page. 

Creating Layouts 
Use the icons in the Layout Tools palette (below) to create the 
placeholders, and can use the Draw tools in the Toolbox to add other 
elements if desired. (You might, for example, want to have a rule 
under the title or a border around the bullet text.) 

 

Placeholders are easily added to a layout page. You simply click a 
Placeholder icon in the Layout Tools palette, then click and drag the 
cursor across the layout page as if using the Rectangle tool. The name 
of the placeholder appears in the box after it is drawn. 
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A placeholder has most of the properties of a Chart view object; 
when it is selected in the layout page, you can use tools from the 
Toolbox and commands from the Draw menu to move, resize, and 
manipulate it. In addition, you can use the Font icons and/or 
commands from the Text menu to change text attributes for Title, 
Text, and Bullet placeholders. There is no limit to the number of 
placeholders that can be placed in one Layout. 

You can apply any layout to any Chart page. If all your Chart pages 
consist of exactly the same elements (a title, a chart, and a supporting 
graphic, for instance), you might want to use the same layout on 
every page so that each element always appears in exactly the same 
place at exactly the same size. But if different pages have different 
elements, or some charts need to be larger than others, you might 
want to use several different layouts. 

Layouts are saved with the document or stored in sets. DeltaGraph 
includes numerous sets of professionally designed Layout Sets. Each 
Layout Set consists of 

12 pre-defined, identically named layouts, a Master Background, and 
a color scheme. The colors, placement, and size of the placeholders 
in each Layout Set can vary dramatically. If you use these Layout 
Sets, you can load any of the other Layout Sets (use the Replace 
option when loading Layout Sets) to give your document a 
completely different look. 

If you do not want to use the Master Background with a particular 
layout (the Master Background is applied automatically to all 
layouts), you can override it by creating and applying a Layout 
Background, as described in “Layout Backgrounds” in chapter 5. 

If you are trying to coordinate a layout with a background or a 
particular Chart page, you may find yourself needing to switch 
views frequently. Use the View icons and the Page Selector icon 
to get around quickly. 

You can return to a layout page and make changes at any time. The 
changes will be reflected immediately in all pages using the changed 
layout. 

You can temporarily hide layout placeholders by choosing Hide 
Layout Items from the Layouts menu if you are in the Layout mode 
or from the Page menu if you are in a Chart page. This command 
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affects the on-screen view only. Layout items do not print, regardless 
of which option is selected. 

To create a Layout, do the following: 

1. Choose Layout Editor from the View menu and select New 
Layout from the submenu. 
DeltaGraph takes you to the layout window of the Layout mode 
and displays the Layout mode Command bar, the DeltaGraph 
Toolbox, the Layout Tools palette, and the Master Background 
page at 50% view size. Unless you have already worked on the 
Master Background, the only element on the page is a page-
sized box (with a white fill) that you can select, resize, drag, or 
delete. 

If you open the Layout Set window (choose Apply Layouts from 
the Page menu), the layout you create appears in the Layout Set 
window in a scaled-down version. 
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2.  Click the Title Placeholder icon in the Layout Tools 
palette. The cursor changes to a crosshair. 

3.  Click and drag the cursor to create the placeholder box. The name 
of the place- holder appears in the box. You can resize or move 
the placeholder at any time in the Layout page. In the Chart page, 
however, you cannot manipulate the placeholders until they are 
filled. 

4.  Create and position Bullet, Chart, Text, Org, and Graphics 
placeholders, using the icons in the Layout Tools palette. There is 
no limit to the number of place- holders you can place in one 
Layout page. 

5.  Change the placeholder attributes as desired. A placeholder has 
most of the properties of a Chart view object. When it is 
selected, you can use tools from the Toolbox and commands 
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from the Draw menu to move, resize, and manipulate it. In 
addition, you can change the following attributes for Layout 
place- holders: 

Title/Text placeholders 

You can change all text attributes, including font, size, style, 
alignment, and Color. 

Bullet placeholders 

You can change the shape, position, and color of the bullets for 
each level, line 
and paragraph spacing for each level, and text attributes for the 
entire block or level by level. This is now done using the Unicode 
text editor in a normal text box. 

Chart/Graphic Object placeholders 

There are no attributes that you can pre-define except the size and 
position of the placeholder. 

6.  If you want this layout to have a special background, you can 
create and apply a Layout Background to override the Master 
Background. The Layout Back- ground will appear on every 
Chart page using the layout. (See “Layout Back- grounds” in 
chapter 5 for more information.) 

7.  Choose Name Page from the View menu to name the 
Layout. The standard DeltaGraph naming dialog box appears. 

8.  Enter the name of the layout 
and click OK. 

9.  Exit the 
Layout page. 

You can use the View icons, the Page Selector icon, or commands 
from the View menu to navigate to another view or page. 
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To learn more about... Refer to... 

Setting up an Organizational 
chart 

“Organizational Chart” in chapter 7 

Filling placeholders “Filling Layout Placeholders” in chapter 5 

Manipulating objects “Manipulating Objects with the Pointer 
Tool” in chapter 11 

Changing text attributes “Formatting and Editing Text in a Text 
Object” in chapter 11 

Creating a Layout Background “Layout Backgrounds” in chapter 5 

	
  

Editing Layouts 
Layouts can be edited to change the size and position of placeholders 
and the color and size of text in the placeholders. Text attributes of 
Bullet placeholders can only be changed in the Layout mode. 
To edit a layout, do the following: 
1.  Double-click the layout in the Layout Set window or choose one 

of the layouts from the view menu. 
2.  Edit the Layout as necessary. Use the text editor to affect text, tab, 

leading, and symbol attributes for Bullet placeholders. 
3.  Click one of the navigational icons on the Command bar or 

Navigational bar to return to the previous view. 

Applying Layouts 
Layouts can be applied to an empty Chart page or to a Chart page 
containing charts and/or text. If you apply a layout to an empty page, 
DeltaGraph displays instructions in each placeholder on how to insert 
information. If you apply a layout to an existing Chart page, any 
graphics or charts in the Chart page that match up to a placeholder are 
snapped to that position and size, taking on the attributes assigned to 
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the placeholder. You can apply layouts you have created in the same 
document or layouts loaded in the document from a saved Layout 
Set. 

To apply a Layout, do the following: 

1.  Open the DeltaGraph Chart page to which you want to apply a 
Layout. You can apply a layout to a new Chart page or to a Chart 
page that already contains any combination of charts, text, and 
graphics. 

2.  Choose Apply Layouts from the Page menu. The Layout Set 
window appears in the upper right corner of the view. It contains 
scaled-down versions of the layouts in the current document 
Layout Set. If you have loaded any other Layout Sets, these 
layouts are also included in the window. The name of the layout 
appears directly below the Layout Set window title bar. 

 

3.  If the layout you need is not displayed, click the pop-up menu 
arrow, and select a layout from the list. The layout you select 
appears in the window. You can adjust the size of the window to 
enlarge or shrink the layout sample that appears. 

4.  If you want to apply the layout to all Chart pages in the 
current document, select Apply To All at the bottom of the 
Layout Set window. 

5.  Click the layout displayed in the window and drag it into the Chart 
page. 
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If the Chart page is empty, the placeholder(s) appear in the page, 
with written instructions on what to do. For additional 
information, see “Filling Layout Placeholders” in chapter 5. 

If the Chart page contains Text, Chart, or Draw objects, the 
objects that match up with a placeholder are snapped into 
position. Any objects on the page that do not match up with a 
placeholder remain unchanged. 

To learn more about... Refer to... 

The Layout Set window “Layout Sets” in chapter 5 

Loading a Layout Set “Loading a Layout Set” in chapter 5 
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Filling Layout Placeholders 
Smart Layout placeholders contain brief instructions for filling when 
they appear in the Chart pages. Follow the prompts that appear inside 
the placeholder. If the corresponding objects are already on the Chart 
page when a layout is applied, they automatically take on the 
attributes of the placeholder. 

Depending on the type of placeholder, Smart Layouts can be filled 
from the Chart, or Data views. 

Filling a Title Placeholder 
A Title placeholder can be filled from the Chart view. In the Chart 
page, you will notice that the page’s default name appears in the 
placeholder. To change this, click the placeholder and start typing a 
new title. The new title automatically renames the Chart page (notice 
the new name in the Page Selector at the bottom of the page. 

Filling a Text Placeholder 
A Text placeholder can be filled from the Chart view. 
In the Char view, click the placeholder and start 
typing. 

Filling a Chart Placeholder 
A Chart can be filled from the Chart or Data views. In the Chart view, 
double-click the placeholder. The “Chart Setup” dialog box appears so 
you can select a chart type, then you are switched to the Data view so 
you can select your data. 

In the Data view, select the data you want to plot, then click the Plot 
icon on the Command bar, press cmd-G, or choose Chart Gallery 
from the Data menu to select a chart type. 

When the chart is plotted, the size and color of the chart matches the 



 
  DeltaGraph for Macintosh Version 7 User Guide 157 

attributes of the placeholder. 

To learn more about... Refer to... 

Filling a Chart placeholder from the 

Data view 

“Creating a Chart in the Data View” 
in chapter 8 

Filling a Chart placeholder from the 

Chart view 

“Creating a Chart in the Chart View” 
in chapter 8 

	
  

Filling a Graphic Placeholder 
A Graphic placeholder can be filled only from the Chart view. Once 
you select the placeholder, you can import or paste a graphic in the 
placeholder, or drag an image from an open Custom Library onto the 
placeholder. 
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6 Setting Preferences 
This chapter describes how to set preferences (defaults) for several of 
the tasks you perform in DeltaGraph and for working with charts. You 
can manually change many of the chart defaults in individual charts. 

This chapter covers the following: 

• Setting defaults for the general operation of DeltaGraph 

• Setting default preferences for viewing charts 

• Setting default preferences for drawing in the Chart view 

• Setting default preferences for export/import/clipboard 

• Setting default preferences for charts 

• Setting default preferences for Automatic Updates 

Choose Preferences from the DeltaGraph menu. The 
“Preferences” dialog box appears. 

There are five tabs that each contain options to set up preferences for 
different tasks. The General tab is displayed when you open the 
dialog box. Click a different tab to view a different group of 
preferences. The following sections provide information on the 
options in each of the tabs. 

Click OK when you are finished setting up your preferences to 
implement the changes. To exit the dialog box without making 
any changes, click Cancel. 

Setting General Defaults 
To set general defaults for DeltaGraph click the General tab. 
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Make selections and enter data as required. You have the following 
options: 

New Document Startup 

Determines how a new document is started, as follows: 

For Charting 

Start a new document with the Data view as the initial view. 

Prompt for Layout Set 

Automatically open the “Load Layout” dialog box when a new 
document is created. 

View Options 

Determine what is displayed in the DeltaGraph views, as follows: 

Tool Tips 

If enabled, when you move the mouse pointer over a Command bar 
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icon, a brief description of the icon is displayed. If disabled, no 
message is shown. 

New Chart Page 

Determines whether or not Smart Layouts are automatically applied 
to new Chart pages, as follows: 

Blank Layout 

A blank layout is applied to a new Chart page. 

Prompt for Layout 

The Layout Set window appears every time a new Chart page is 
created so you can apply a layout. 

Duplicate Layout 

The layout used in the previous Chart page is applied to the new 
Chart page. 

Color Defaults 

Determines the default colors used when creating charts and objects in 
the Chart View. 

Fixed 

The standard DeltaGraph default colors are used. 

Scheme 

Color Scheme palette colors are used. 
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Setting Chart View Defaults 
Click the Chart View tab to set preferences for the Chart view. 

 

Make your selections and enter data as needed. You have the following 
options: 

Open Advisor when Plotting 

Opens the “Chart Setup” dialog box with the Chart Advisor tab selected 
when you click the Plot button, select Chart Gallery from the Data 
menu, or press cmd-G. (Only applies when plotting from the Data 
view.) 

Update Charts Automatically 

Sets a global preference so that charts are updated automatically when 
you modify the associated data. This eliminates the need for you to 
select the data and click Update. 

NOTE ☞  “Update Charts Automatically” is a substitute for the “Update” 
command but does not replace “Revise Data.” If you modify a 
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selected range of data, you do not need to select Update, but if you 
add or remove data cells, you still need to select Revise Data. 

Double-click on Charts 

Allows you to double-click various parts of a chart to display a dialog 
box relating to that area; in other words, if you double-click the Value 
axis labels, the “Labels” dialog box for that axis appears. Change 
takes effect immediately. 

Set Ruler/Grid Defaults 

Click Rulers/Grids and a dialog box is displayed for setting ruler 
and grid preferences. Setting these options will affect all existing 
chart pages. They will not affect those rulers and grids you have set 
manually on charts. (See “Changing Rulers and Grids” in chapter 
11.) 

Units 

Click the pop-up menu and select whether you want to display 
the rulers in inches, centimeters, points, picas, or ciceros. 

Show rulers 

Select to show the rulers along the top and left-hand side of 
the Chart view. Deselect to hide the rulers. 

Grid Settings 

Set preferences for the horizontal and vertical grid in the Chart 
view, as follows: 

Grid Size 

Enter or select the size of the space between the grid lines (in 
the measurement unit you selected in “Units” above). 

Show Grid 

Select to show the grid; deselect to hide it. 
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Snap to Grid 

Aligns all objects with the underlying grid when you create, 
resize, or move them. 

Setting Draw Object Defaults 
Click the Drawing tab to set defaults for manipulating draw and text 
objects in the Chart view and for applying colors and blends to any 
Chart page object. 

 

Make your selections and enter data as needed. You have the following 
options: 

Reduce Super- and Sub-scripts 

Automatically reduces by 20% the font size of superscripts and 
subscripts created using the “Special Text” command in the Data view. 
Applies only to charts. 
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Use Patterns for Colors 

Available for charts and other objects, this option uses patterns instead 
of colors when the monitor setting in the Macintosh Control Panel is 
set to “Black and White.” It is used mostly for black-and-white or 
monochrome monitors. Change takes effect immediately. 

Render Using CMYK 

Renders drawings using colors in CMYK space as opposed to RGB. 

Set Text Defaults 

Click to open the “Set All Text Characteristics” dialog box, and set text 
attributes for all new Text objects as well as Bullet and Organizational 
charts appearing in the Chart view without a layout placeholder. Sets 
defaults in the Chart view both for text blocks created using the Text 
tool. 

 

Use the pop-up menus and check boxes to make your selections, 
then click OK to implement the changes and exit the dialog box. 
Changes take effect immediately but apply to new Text objects only. 
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Setting Export/Import/Clipboard Defaults 
Click the Export/Import tab to set export, import, and 
clipboard preferences. 

 

Make your selections and enter data as needed. You have the 
following options: 

Include background in exports 

Includes backgrounds when exporting objects from the Chart or 
Organizer view. If you create a Master Background or an 
exception background, you can export all objects in the page plus 
the background used on that page. Only the background from the 
first page of each Chart page is exported. with the individual 
pieces. 

Import Location 

Select how you want imported data to arrive in the Data view, as 
follows: 
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Default 

Imported data arrives in the upper left of the data sheet, with text 
placed in the label column and row and numbers in column A and 
row 1. 

Selected cell 

Allows you to select the cell where you want imported data to be 
inserted. The cell you highlight becomes the upper-left cell of the 
new data (the “offset” cell). This lets you avoid overwriting 
existing data in a Data page and makes it possible to import data 
from a number of different files into the same Data page. It also 
gives you the option of overriding DeltaGraph’s attempt to discern 
labels from numerical data. Dates can then be used as category and 
series labels. 

Once you have chosen this option, simply highlight the cell where 
you wish the data to be entered and it is inserted, using the 
selected cell as its top left-hand corner. The methods for pasting 
data are the same. Pasting always places the data in the selected 
cells. 

 

Cell A:1 

Places the upper-left corner cell of the imported data in column A, 
row 1 of the Data page. This ensures that no data will be placed in 
the Label row or column. 

	
  

Cell Label:Label 

Places the upper-left corner cell of the imported data in the Label 
row and column of the Data page. When plotting charts, DeltaGraph 
interprets the contents of cells in the Label row and column as text, 
whether they contain values or characters. Using this option, you 
can force DeltaGraph to plot numbers (such as dates) as chart series 
or category labels on charts. 
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PICT Scaling 

Determines the scaling of exported PICTs and raster images. Higher 
dpi (dots per inch) values produce higher output resolution for PICT 
files. Can be used for exporting to applications requiring a lower 
resolution PICT. 

Setting Chart Defaults 
Click the Chart tab to set defaults for label text, ticks and grids, and 
symbols. The Chart defaults affect each chart that uses them when 
you recalculate the charts. They do not affect labels, ticks, grids, and 
symbols you set manually in charts. 

 

Make your selections and enter data as needed. You have the following 
options: 

Set Chart Defaults 

Select the default label text, ticks and grids, and symbols for charts, as 
follows: 

Label Text 
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Click to open the “Set All Text Characteristics” dialog box and 
change the defaults for the font, size, color, alignment, and style of 
label text. (Note that these changes may affect the “Auto” 
orientation and rotation of a chart’s labels.) 

 

Ticks/Grids 

Displays a dialog box that allows you to set the tick mark 
placement for both major and minor ticks, set tick mark length, 
and turn on major or minor grids. The “Show Ticks/Grids” 
section is disabled in Preferences but is enabled in the Ticks 
Setup dialog box for some chart types. 



 
  DeltaGraph for Macintosh Version 7 User Guide 169 

 

Symbols 

Displays a dialog box to customize default chart symbols. Options 
include setting custom font and size. You can also select the type of 
default symbols you want from an extensive list of symbol keys. 
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As with ruler, tick, and grid defaults, after the chart is 
recalculated, setting these options affects all existing charts that 
use the defaults. They do not affect those symbols you have set 
manually in charts. 

NOTE ☞   Symbol “Color” is disabled because default colors depend on the 

“Fixed/Scheme” color default, which you set for an entire 

document (see page 7-3). 

Draw Series with 

Determines how patterns and colors are displayed on the screen and 
printed, as follows: 

Colors and Patterns 

Uses colors and patterns when displaying/printing Chart pages. 

Colors Only 

Uses colors only when displaying/printing Chart pages. 
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Use Perspective Labels 

Affects 3-D chart labels only. Labels are automatically displayed in the 
same perspective as their associated charts. This preference applies to 
new charts only. 

To turn off perspective labels for selected charts only, use the Options 
command on the Chart menu. 

Setting Automatic Update Defaults 
Click the Updates tab to change preferences for DeltaGraph’s update 
service.  

 

Selecting the “Check automatically for new versions of DeltaGraph” 
box will cause DeltaGraph to check for updates upon opening, 
alternatively you can click the check now button to check for updates 
immediately. The “Ignoring updates through version:” text refers to 
the dialog brought up when a new version is detected, if ignored the 
update will be listed under this text. 
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To learn more about... Refer to... 

Setting label text defaults “Creating and Positioning Axis Labels 
and Titles” in chapter 9 

Changing ticks and grids “Creating Axis Breaks” in chapter 9 

Customizing symbols “Changing Chart Symbols” in chapter 9 

Creating color schemes “Color Schemes” in chapter 9 

Symbol options “Changing Chart Symbols” in chapter 9 
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7 Chart Types 
This chapter describes and illustrates each DeltaGraph chart and the 
type of data needed to create it. This chapter covers the following: 

• An overview of DeltaGraph chart types and the data they require 

• 2-D Business charts 

• 2-D Technical charts 

• 2-D Statistical charts 

• 3-D Business charts 

• 3-D Technical charts 

Chart Type Overview 
DeltaGraph’s chart types fall into two main categories: 2-D and 3-D. 

2-D and 3-D charts, are considered “numerical” charts even though 
some may contain textual data, are plotted from data entered in a 
Data page.. 

Numerical charts in DeltaGraph can have as many as three different 
types of axes: a value axis, which is defined by the values of the data 
plotted, a category axis, which displays the different categories of 
data, and a series axis, which is associated with the data series. 

In DeltaGraph, most 2-D charts contain two axes and a legend. The 
vertical axis is the Y axis, and the horizontal axis is the X axis. One 
of the axes is always a value axis. The second axis can be a category 
axis, a series axis, or even another value axis, depending on the type 
of chart. 

3-D charts have three axes: X, Y, and Z. On all 3-D charts, the vertical 
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axis is the Z axis and is always a value axis. The function, name, and 
placement of the X and Y axes depend on the type of chart. 

As you will discover, some charts are exceptions to the rules just 
outlined. The rest of this chapter examines the charts in detail, 
explaining the purpose of each chart, how to set up your data, and 
how the data are converted into a chart. 

If all of this is a bit overwhelming, you may want to use the Chart 
Advisor to help you choose the right chart type. To use the Chart 
Advisor, you must first import or enter data in the Data view. 

	
  

To learn more about... Refer to... 

The parts of a chart “Basic Chart Elements” in chapter 2 

Entering data in a Data page Chapter 4, “Organizing Data in the 
Data View” 

Using Layouts “Creating and Using Smart Layouts” in 
chapter 5 

Modifying your charts Chapter 9, “Customizing Charts” and 
Chapter 10, “Changing Chart Options” 

The Chart Advisor “The Chart Advisor” in chapter 8 

	
  

2-D Business Charts 

Column Chart 
Use a Column chart to compare one item to another or to compare the 
same or different items over a period of time. Column charts 
effectively show dramatic changes from one category to another. 

Each row of data corresponds to one set of columns for a given 
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category. Each column of data corresponds to a data series. Each 
column in a given category represents a value in the Data page. The 
vertical or Y axis shows values. The horizontal or X axis shows 
categories. 

Row labels are used to name each category. Column labels are used 
to name each data series. These labels appear in the legend. 

 

Stacked Column Chart 
Use a Stacked Column chart to compare parts to the total or to show 
how components of an item change over time. 

 

Each row of data corresponds to a single segmented column in the 
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chart (category). Each column of data corresponds to the same shade 
or color in each of the columns in the chart. Each column segment 
represents a value in the Data page. 

The vertical or Y axis shows values. The horizontal or X axis shows 
categories. The series are stacked on top of each other rather than 
placed side by side as in a regular Column chart. 

Row labels are used to name each category. Column labels are used 
to name each data series. These labels appear in the legend. 

Bar Chart 
Use a Bar chart to compare sizes and amounts or to emphasize 
differences between items, usually at the same point in time. 

 

 Each row of data corresponds to one set of bars for a given category. 
Each column of data corresponds to a data series. Each bar in a given 
category represents a value in the Data page. The vertical or Y axis 
shows categories. The horizontal or X axis shows values. 

Row labels are used to name each category. Column labels are used 
to name each data series. These labels appear in the legend. 

Bar With Line Overlay Chart 
Use a Bar with Line Overlay chart to compare sizes and amounts or 
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to emphasize differences between items, usually at the same point in 
time. The line overlay shows the trend of one or more items over a 
period of time or number of events. 

 

Each row of data corresponds to one set of bars for a given category. 
Each column of data corresponds to a data series. Each bar in a given 
category represents a value in the Data page. The vertical or Y axis 
shows categories. The horizontal or X axis shows values. Each 
column of data corresponds to one line or bar (series) in the chart. 
You can have more than one series per Data page. The vertical or Y 
axis shows values. The horizontal or X axis shows categories. 

Row labels are used to name each category. Column labels are used 
to name each data series. These labels appear in the legend. 

	
  

To learn more 
about... 

Refer to... 

Other chart options “Bar with Line Overlay Chart Options” in 
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chapter 10 

	
  

Stacked Bar Chart 
Use a Stacked Bar chart to show how all categories in a series 
compare over time or to compare parts to the total. 

 

Each row of data corresponds to one segmented bar (category). Each 
column of data corresponds to one segment of the bar in the chart. 
Each bar segment represents a value in the Data page. The vertical or 
Y axis shows categories. The horizontal or X axis shows values. The 
series are stacked one after another in a single bar, rather than placed 
side by side as in a regular Bar chart. 
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Row labels are used to name each category. Column labels are used 
to name each data series. These labels appear in the legend. 

	
  

To learn more about... Refer to... 

Other chart options “Stacked Bar and Column Chart Options” 
in chapter 10 

	
  

Stacked Bar and Column with Line Overlay 
Charts 

Use a Stacked Bar with Line Overlay or Stacked Column with Line 
Overlay chart to compare parts to the total or to show how 
components of an item change over time. The line overlay shows the 
trend of one or more items over a period of time or number of events. 

 

Each row of data corresponds to a single segmented bar or column 
in the chart (category). Each column of data corresponds to the same 
shade or color in each row or column. Each bar or column segment 
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represents a value in the Data page. 

For Bar charts, the vertical or Y axis shows values. The horizontal or X 
axis shows categories. The series are stacked on top of each other. For 
Column charts, the vertical or Y axis shows categories. The horizontal 
or X axis shows values. The series are placed side by side 

Row labels are used to name each category. Column labels are used 
to name each data series. These labels appear in the legend. 

To learn more about... Refer to... 

Other chart options “Stacked Bar and Column with Line 
Overlay Chart Options” in chapter 10 

	
  

Build-Up Chart 
Use Build-up charts to plot several different categories that build up to 
a total.  
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Build-up charts are typically used to show the progression of factors 
that make up the total. Each category’s bar starts where the previous 
one leaves off. For instance, you might plot a starting sales figure 
and then build it up monthly, with each month’s sales appearing in a 
separate category. The final category’s ending value would be the 
cumulative sales figure. 

Categories are connected between series by colored lines. You can 
change this by selecting “Connect between series” in the “Build-Up 
Options” dialog box. 

These charts also allow for multiple series. Subsequent series follow 
the first series in each category. 

To learn more about... Refer to... 

Other chart options “Build-Up and Stacked Build-Up 
Chart Options” in chapter 10 

	
  

Stacked Build-Up Chart 
The Stacked Build-up chart is similar to the Build-up chart except 
that it totals the values of all the rows of data and stacks them on top 
of each other then records the overall growth in value of the 
combined data. 
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As with Build-up charts, Stacked Build-up charts allow you to plot 
several different categories that build up to a total. Each category’s bar 
starts where the previous one leaves off and typically shows the 
progression of factors that make up the total. For instance, you might 
plot a starting purchasing figure for supplies of wood, concrete, and 
steel, and then increase it monthly, with each month’s pur- chases 
appearing in a separate category. The final category’s ending value 
would be the cumulative purchasing figure. 

Categories are connected between series by colored lines. You can 
change this by selecting “Connect between series” in the “Build-Up 
Options” dialog box. Stacked Build-up charts also allow for multiple 
series. The stacked version can have more than one value for each 
category. 

Floating Bar and Column Charts 
Use a Floating Bar or Floating Column chart to specify ranges of 
data in bar or column format. Specify the lowest and highest value 
for each bar. This results in bars that “float” without being attached 
to the category axis. 
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Two columns of data are required for each data series. The first 
column is typically used for the starting value, the second column for 
the ending value. The order in which you enter values does not 
matter; DeltaGraph will plot a bar covering the range of the two 
values. However, if you are using the range to display positive or 
negative change, use the “Show Values” command, once the chart has 
been plotted, to display the order in which the values were entered. 

Row labels are used to name each category. Column labels are used 
to name each data series. For this type of chart, label alternate 
columns as only the first label for each range appears on the legend. 

To learn more about... Refer to... 

Other chart options “Floating Bar and Column Chart 
Options” in chapter 10 
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Floating Stacked Bar and Column Charts 
Use a Floating Stacked Bar or Floating Stacked Column chart to 
specify ranges of data in bar or column format and to compare parts to 
the total or to show how components of an item change over time. 

 

The first data column of the charts is the baseline and each subsequent 
data column is stacked in series. For Column charts, categories appear 
on the X axis, and values appear on the Y axis. For Bar charts, values 
appear on the X axis, and categories appear on the Y axis. However, if 
you use the range to display positive or negative change, use the 
“Show Values” command after you plot the chart to display the order 
in which the values were entered. 

Each row of data corresponds to a single segmented column in the 
chart (category). Each column of data corresponds to the same shade 



 
  DeltaGraph for Macintosh Version 7 User Guide 185 

or color in each of the columns in the chart. Each column segment 
represents a value in the Data page. 

The vertical or Y axis shows values. The horizontal or X axis shows 
categories. The series are stacked on top of each other rather than 
placed side by side as in a regular Column chart. Row labels are used 
to name each category. Column labels are used to name each data 
series. 

NOTE ☞  When creating combination charts, this chart type can be used as a base 
chart. 

	
  

	
  

To learn more about... Refer to... 

Other chart options “Floating Stacked Bar and Column 
Chart Options” in chapter 10 

	
  

Floating Stacked Bar and Column with Line 
Overlay Charts 

Use a Floating Stacked Bar with Line Overlay or a Floating Stacked 
Column with Line Overlay chart to compare parts to the total or to 
show how components of an item change over time. Specify the 
lowest and highest value for each bar. This results in bars that “float” 
(not attached to the category axis). The line overlay shows the trend 
of one or more items over a period of time or a number of events. 
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Each row of data corresponds to a single segmented bar or column in 
the chart (category). Each column of data corresponds to the same 
shade or color in each of the rows or columns in the chart. Each bar or 
column segment represents a value in the Data page. 

For Bar charts, the vertical or Y axis shows values, and the 
horizontal or X axis shows categories. The series are stacked on top 
of each other. 

For Column charts, the vertical or Y axis shows categories, and the 
horizontal or X axis shows values. The series are placed side by side. 

Row labels are used to name each category. Column labels are used 
to name each data series. The labels appear in the legend. 

	
  

	
  

To learn more about... Refer to... 

Other chart options “Floating Stacked Bar/Column with 
Line Overlay Chart Options” in 
chapter 10 
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High-Low Chart 
Use a High-Low chart to show the highs and lows of different items 
or different periods of time. 

 

Two columns of data are required for each data series. The first 
column is used for the high point and the second is used for the low 
point. You can have more than one series per Data page, but 
remember that the first column is for high values and the second 
column is for low. The vertical or Y axis shows values, and the 
horizontal or X axis shows categories. 

Row labels are used to name each category. Enter a label in the 
first column of each series to name the data series. These labels 
appear in the legend. 

To learn more about... Refer to... 

Changing symbol shape and color “Changing Chart Symbols” in 
chapter 9 
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Range Chart 
A Range chart shows the highs and lows of an item as well as 
the midpoints between the two. You can make these 
comparisons over time. 

 

Three columns of data are required for each data series. The first two 
columns pro- duce values for the high and low points. The third 
column produces values for the midpoints. You can have more than 
one series per Data page. The vertical or Y axis shows values. The 
horizontal or X axis shows categories. 

Row labels are used to name each category. Enter a label in the 
first column of each series to name the data series. These labels 
appear in the legend 

. 

To learn more about... Refer to... 

Changing symbol shape and 
color 

“Changing Chart Symbols” in 
chapter 9 

Other High-Low and Range 
chart options 

“High-Low and Range Chart 
Options” in chapter 10 
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Segmentation Charts 
Segmentation charts allow you to add a second value to a column or 
bar chart. This second value is represented by the comparative widths 
of each column or bar. Segmentation charts are often referred to as 
“variable-width column” charts. The width of the column showing the 
greatest second value is represented at 100%, with the other columns 
represented as proportions of that. 

	
  

If you wish to represent types of computers both by annual unit sales 
and annual dollar sales, Annual unit sales could be represented by the 
height of the columns or bars, while annual dollar sales could be 
represented by the width of the columns or bars. 

In addition to series legends, Segmentation charts display 
Segmentation legends by default. The Segmentation legend can be 
customized in a similar way to Value axes. Double-click the legend’s 
tick grid to bring up the “Value Axis Ticks & Grids” dialog box and 
make your selections as required. Double-click the numbers in the 
legend to bring up the “Value Axis Labels” dialog box. The 
Segmentation legend can also be scaled to allow for larger numbers. 
Segmentation charts have their own “Bar/Column Segmentation 
Options” dialog box. 

When entering data, you should place category names in the Label 
column. Each series of data requires two columns. In the first column, 
enter values representing the height (or length) that will be displayed 
against the value axis. The label that you enter at the top of the first 
column will appear in the legend. In the series’ second column, enter 
values representing the magnitude (width) of the column, which will 
be displayed against the Segmentation legend. You can create multiple 
series in Segmentation charts by entering two columns of data for 
each series. 

To learn more about... Refer to... 

Customizing the 
Segmentation legend 

“Changing Tick Marks and Chart Grids” 
in chapter 9 and “Creating and 
Positioning Axis Labels and Titles” in 
chapter 9 
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To learn more about... Refer to... 

Other Segmentation chart 
options 

“Bar and Column Segmentation Chart 
Options” in chapter 10 

	
  

Column Segmentation Chart 
Use a Column Segmentation chart when you require a Column chart 
that needs to show two values per series. As with Column charts, they 
are especially effective in showing dramatic changes between 
categories. But with the Column Segmentation chart, if series perform 
in markedly different ways between two sets of values, this can be 
shown very clearly. 

 

Stacked Column Segmentation Chart 
Use a Stacked Column Segmentation chart when you want to group 
series and compare them categorically as a whole. The second value 
for each series provides another measure that can be displayed as 
width. With this Segmentation chart, if categories perform in 
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markedly different ways between two sets of values, it can be shown 
very clearly. Differences in widths become much sharper in Stacked 
Segmentation charts 

 

Bar Segmentation Chart 
Use a Bar Segmentation chart when you require a bar chart that needs 
to show two values per series. As with Bar charts, they are effective 
in showing dramatic changes between categories. But with this 
Segmentation chart, if series perform in markedly different ways 
between two sets of values, it can be shown clearly. 
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Stacked Bar Segmentation Chart 
Use a Stacked Bar Segmentation chart when you want to group series 
and compare them categorically as a whole. The second value for 
each series provides another measure that can be displayed as width. 
With this segmentation chart, if categories perform in very different 
ways between two sets of values, this can be shown very clearly. 
Differences in widths become sharper in stacked segmentation charts. 

 

Line Chart 
Use a Line chart to show the trend of one or more items over a 
period of time or number of events. 
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Line charts are best for plotting long series of data points. Each 
column of data corresponds to one line or series in the chart. You 
can have more than one series per Data page. The vertical or Y axis 
shows values. The horizontal or X axis shows categories. 

Row labels are used to name each category. Column labels are used 
to name each data series. These labels appear in the legend. 

To learn more about... Refer to... 

Changing symbol shape and 
color 

“Changing Chart Symbols” in 
chapter 9 

	
  

Step Chart 
Use a Step chart to compare items that do not show a trend. Step charts 
display discrete points along the value axis, with vertical lines 
showing the difference between each point. 
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Each column of data corresponds to one series of steps (or a data 
series) on the chart. You can have more than one series per Data 
page. The vertical or Y axis shows values. The horizontal or X 
axis shows categories. 

Row labels are used to name each category. Column labels are used 
to name each data series. This label appears in the legend. 

To learn more about... Refer to... 

Changing symbol shape and 
color 

“Changing Chart Symbols” in 
chapter 9 

Other chart options “Line and Step Chart Options” in 
chapter 10 

	
  

Open High Low Close Chart 
Use an Open High Low Close chart to show values that fluctuate in 
a given time period, such as a day or hour. 



 
  DeltaGraph for Macintosh Version 7 User Guide 195 

 

You can plot the starting value (open), the high, the low, and the final 
value (close). This chart is similar to the Candlestick chart. It is 
commonly used for market analysis and is also seen in investment 
publications. It can be used to plot the opening, high, low, and closing 
prices of an investment for a particular time, such as a day of oat 
futures. 

Each series must have four columns of data representing the open, 
high, low, and close respectively. Each Data page can contain more 
than one series of data at one time. The default chart has a vertical line 
extending from the low to the high values and a horizontal line 
projecting out to the left at the opening value and one extending to the 
right for the closing value. The length and direction of the horizontal 
lines can be adjusted using the “Options” command. 

Row labels are used to name each category. Enter a label in the 
first column of each series to name the data series. These labels 
appear in the legend 

A special legend can be turned on using the “Show Open/Close 
Legend” option in the “Options” dialog box. It indicates which side of 
the vertical line represents the opening value and which represents the 
closing value. 
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To learn more about... Refer to... 

Other chart options “Open High Low Close Chart 
Options” in chapter 10 

	
  

Candlestick Chart 
Use a Candlestick chart to show whether the open or close activity 
has increased or decreased within the bounds of the highs and lows 
for different items or different periods of time. 

 

 

This chart is similar to the Open High Low Close chart. It is 
commonly used for market analysis and is also seen in investment 
publications. It can be used plot the opening, high, low, and closing 
prices of an investment for a particular time, like a day of oat futures. 

Each series must have four columns of data representing open, high, 
low, and close respectively. The default chart has a vertical line, or 
“wick,” extending from the low to the high values. A box extends 
from the open value to the close value. Each Data page can contain 
more than one series of data at one time. 
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Row labels are used to name each category. Enter a label in the 
first column of each series to name the data series. These labels 
appear in the legend A special legend can be turned on using the 
“Show Candle Legend” option in the “Options” dialog box. It 
indicates which color represents an increasing box and which 
color represents a decreasing box. 

If the close value is higher than the open value, the candle is 
increasing and the default box color is white. If the close value is 
lower than the open value, the candle is decreasing and the default 
box color is red. The width of the open/close box can be adjusted 
using the “Options” command. 

To learn more about... Refer to... 

Other chart options “Candlestick Chart Options” in 
chapter 10 
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Bubble Chart 
A Bubble chart shows a visual comparison using three values. 

 

In a Bubble chart, each data series requires three columns of data. The 
first column produces the values for the X coordinate points, the 
second column produces the Y coordinate points, and the third 
column determines the size of the bubbles. Each data point represents 
a measurement that is the intersection of two values in a row and the 
diameter of a bubble. 

All the coordinates entered in a Bubble chart measure values; 
therefore, the vertical or Y axis and the horizontal or X axis both 
show values. 

To label each data series, enter labels over each column of X 
coordinates in the Data page. These labels appear in the chart legend. 
A separate value legend pro- vides a scale for the bubble size. This 
legend can be modified using the “Options” command in the Chart 
menu. 

To ensure that you do not have bubbles covering each other, change 
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the fill of all the bubbles to “None.” To change the size of the bubbles 
with respect to the data in the Z-component, click and drag the end of 
the small axis in the bubble size leg- end. Stretching the legend axis 
makes the bubbles bigger. Shrinking the legend makes the bubbles 
smaller. 

To learn more about... Refer to... 

Changing the legend and other 
options 

“Bubble Chart Options” in 
chapter 10 

	
  

Area Chart 
Use an Area chart to emphasize the volume or size of a data series over 
time. 

 

Each column of data corresponds to a data series or a filled area on 
the chart. The vertical or Y axis shows values, and the horizontal or 
X axis shows categories. 

Row labels are used to name each category. Column labels are used 
to name each data series in the legend. 
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To learn more about... Refer to... 

Area chart options “Area Chart Options” in chapter 10 

	
  

Spider Chart 
Use a Spider chart to show multiple variables, such as performance 
levels, ratings in different areas, or progress. A Radar chart can be 
created using a Spider chart and specific options from the “Options” 
dialog box (Chart menu). 

 

This chart calls for three or more rows and one or more columns of 
data. Each row of data corresponds to a category or spoke in the chart. 
Each column of data corresponds to a data series. These labels appear 
in the legend. 

Row labels are used to name each category or spoke. Column 
labels are used to name each data series. These labels appear in the 
legend. 
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If one or more of the chart’s spokes falls into a group, you may want to 
enter group labels, which function somewhat like an axis title in that 
they identify consecutive runs of categories. Group labels appear 
beyond the category labels around the perimeter of the chart and lie 
midway between the first category of the group and the last. To enter 
group labels, enter the group name, a colon (:), and the category label 
in the label column of the first category in the group. All category 
labels between one group label and the next are automatically 
included in the preceding group. 

Spider chart labels can be re-positioned by choosing “Labels” 
from the Chart menu. 

To learn more about... Refer to... 

Radar charts “Spider Chart Options” in chapter 10 

	
  

Pie Chart 
Use a Pie chart to show the relationship of parts to the whole. 

 

This chart type uses only one column of data. Each wedge of the pie 
represents a row value. A Donut chart can be created using a Pie 
chart and specific options from the “Options” dialog box (Chart 
menu). The center section of a Donut chart represents the sum of the 
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values of all parts. 

You can separate the pie slices in the chart by clicking a wedge and 
dragging it away from the rest of the pie. DeltaGraph allows you to 
drag a slice in one direction only. You can apply colors to Pie slices 
individually or as a whole. If you apply depth to a Pie using the 
“Depth” option from the Chart menu, you can apply separate colors 
to the depth or the Pie surface. Only the Pie parts selected are 
changed. 

Row labels are used to name each pie slice. These labels also appear 
in the legend. Column labels are not used in the chart. 

To learn more about... Refer to... 

Donut charts and other chart 
options 

“Pie and Stacked Pie Chart 
Options” in chapter 10 

	
  

Stacked Pie Chart 
Use a Stacked Pie chart to show the relationship of the parts to the 
whole for two or more data series. 

 

The information required for a Stacked Pie chart is identical to that 
required for a Multiple Pie chart. The Stacked Pie, however, plots a 
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separate pie for each column of data selected and stacks them on top 
of each other. The wedges of each pie rep- resent the row values in 
that column. You can apply colors to Pie slices individually or as a 
whole. If you apply depth to a Pie using the “Depth” option from the 
Chart menu, you can apply different colors to the depth or the pie 
surface. Only the pie parts selected are changed. 

Row labels are used to name each pie slice. These labels also appear 
in the legend. Column labels are used to name each pie. 

To learn more about... Refer to... 

Other chart options “Pie and Stacked Pie Chart Options” 
in chapter 10 

	
  

Multiple Pie Chart 
Use a Multiple Pie chart to show the relationship of the parts to the 
whole for two or more data series. 
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The information required for a Multiple Pie chart is identical to that 
required for a Stacked Pie chart. The Multiple Pie chart, however, 
plots a separate pie for each column of data selected and arranges 
them without stacking them. The wedges of each pie represent the 
row values in that column. 

You can separate the pie slices in the chart by clicking a wedge and 
dragging it away from the rest of the pie. This moves all the wedges 
of the same category at one time. To move only one slice, click the 
wedge you want to move again. Delta- Graph allows you to drag the 
slices in one direction only. 

You can apply colors to pie slices individually or as a whole. If you 
apply depth to a pie using the “Depth” option from the Chart menu, 
you can apply separate colors to the depth or the pie surface. Only the 
pie parts selected are changed. 

Row labels are used to name each pie slice. Column labels are used 
to name each pie. These labels also appear in the legend. 

You can reshape the arrangement of the pies or make their sizes 
proportional to a single pie’s contribution to the sum of the data in 
all the pies. You can resize and reshape the pies and spread or shrink 
the space between the pies. 

To learn more about... Refer to... 

Other chart options “Multiple Pie Chart Options” in 
chapter 10 
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Time Line Chart 
Use a Time Line chart to display a project schedule, time line, or 
even a product comparison based on a predetermined scale. 

 

A Time Line uses two columns per data series. Enter the labels for 
your Time Line in the first column (Label) and the numbers or times 
in the second column (A). You can create additional series on the 
same Data page with (B) labels, (C) numbers, (D) labels, (E) 
numbers, and so on. 

Once the Time Line is plotted, you can select and reposition chart 
labels as a group or individually. When you drag a category label to a 
new location, the “arm” connecting it to the Time Line follows. 

To learn more 
about... 

Refer to... 

Selecting chart elements “Selecting a Chart and Chart Elements” 
in chapter 9 

Changing the category 
axis 

“Creating Axis Breaks” in chapter 9 

Other chart options “Time Line Chart Options” in chapter 
10 

	
  

Table Chart 
Use a Table chart to chart data as it appears in the Data page. 
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Enter the table data, including row and column labels, as you want 
them to appear in the Table chart. You can use the upper left-hand cell 
in the Data page to enter a title over the row labels in the table. You 
can also make a chart column wider by selecting a vertical line and 
dragging it. 

You can attach a Table chart to an existing category-based chart by 
choosing “Attach Table” from the Chart menu. (The command is 
dimmed if you select an inappropriate chart.) Created from the same 
data used to plot the selected chart, the new Table chart appears in the 
Chart page aligned with the existing chart’s row labels. Because the 
two charts share the same “width between grids,” you cannot resize 
the Table chart along the adjoining axis. The only way to change this 
dimension of the Table chart is to resize the original. The Table chart 
resizes automatically to maintain the alignment. 

As soon as you select a Table chart in the Chart view, you will notice a 
shaded border around the outside. The Selection icon in the upper left 
corner of the shaded border changes from a solid square to a grid 
when you click it to indicate which selection mode you are in. The 
solid square indicates the backplane is selected. The grid indicates that 
the chart elements can be selected individually so you can change text 
attributes and alignment. 

Refer to the figure below for additional information about the Table 
chart. 

To learn more about... Refer to... 

Other Table chart options “Table Chart Options” in chapter 
10 
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Volume Open High Low Close Chart 
Use these charts to show values that fluctuate in a given time period, 
such as a day or hour. These charts can plot the total volume, starting 
value (open), the high, the low, and the final (close) values. This chart 
is similar to the Candlestick chart. It is commonly used for market 
analysis and appears in investment publications. It can be used to plot 
the volume, opening, high, low, and closing prices of an investment 
for a particular time. 

 

Each series must have five columns of data that represent volume, 
open, high, low, and close respectively. Each Data page can contain 
more than one series of data at one time. The default chart has a 
vertical line extending from the low to the high values and a 
horizontal line projecting out to the left at the open value and one 
extending to the right for the close value. The length and direction of 
the horizontal lines can be adjusted using the “Options” command. 

Row labels are used to name each category. Enter a label in the 
first column of each series to name the data series. These labels 
appear in the legend. 

A special legend can be turned on using the “Show Open/Close 
Legend” option in the “Options” dialog box. It indicates which side of 
the vertical line represents the opening value and which represents the 
closing value. 
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To learn more about... Refer to... 

Other chart options “Volume Open High Low Close and Volume 
High Low Close Chart Options” in chapter 10 

Volume High Low Close Chart 
This chart is similar to the Volume Open High Low Close chart 
except that it does not use the second column of data. The open 
values are not represented, and the corresponding second column in 
every series should be left empty. 

 

These charts plot the total volume, the high, the low, and the final 
value (close). As with Volume Open High Low Close charts, Volume 
High Low Close charts show values that fluctuate in a given time 
period, such as a day or hour. 

Each series must have five columns of data, with the second column of 
data empty. These represent the volume, high, low, and close 
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respectively. Each Data page can contain more than one series of data 
at one time. The default chart has a vertical line extending from the 
low to the high values, one horizontal line projecting to the left for the 
opening value, and one extending to the right for the closing value. 
You can adjust the length and direction of the horizontal lines. 

Row labels are used to name each category. Enter a label in the 
first column to name the data series. These labels appear in the 
legend. A special legend can be turned on using the “Show 
Open/Close Legend” option in the “Options” dialog box. It 
indicates which side of the vertical line represents the opening 
value and which represents the closing value. 

To learn more about... Refer to... 

Other chart options “Volume Open High Low Close and 
Volume High Low Close Chart 
Options” in chapter 10 
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2-D Technical Charts 

Paired Scatter Chart 
Use a Paired Scatter chart to show data points from one or more 
data series with each point having unique X and Y coordinates. 

 

This chart is similar to the Paired XY Line chart in the way the data 
are organized, but they are plotted differently because the Paired 
Scatter does not sort the X values before plotting the data. 

“Paired” refers to how the chart interprets the data that makes up each 
series of X and Y coordinates. 

In the Paired Scatter chart, data are arranged in paired columns of 
coordinate points that make up each data series. Each data series has 
two columns of data. The first column produces the X coordinate of 
the point, and the second column produces the Y coordinate of the 
point. A data symbol is plotted at the points with the specified X and 
Y coordinates. This allows you to plot data points that have different 
X and Y coordinates for each data series. 
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The number of rows determines how many points are in a data series. 

To label each data series of a Paired Scatter chart, enter labels over 
each column of X coordinates in the Data page. These labels appear 
in the chart legend. Because the Paired Scatter chart uses values on 
both the vertical and the horizontal axes, there are no category axis 
labels. 

To learn more about... Refer to... 

Changing symbol shape and 
color 

“Changing Chart Symbols” in 
chapter 9 

Other chart options “Scatter and XY Line Chart 
Options” in chapter 10 

	
  

Paired Intensity Scatter Chart 
Use a Paired Intensity Scatter chart to show data points from one 
or more data series with each point having unique X and Y 
coordinates. 

“Paired” refers to how the chart interprets the data that makes up each 
series of X and Y coordinates. 

In the Paired Intensity Scatter chart, data are arranged in paired 
columns of coordinate points that make up each data series. Each data 
series has three columns of data. The first column produces the X 
coordinate of the point, the second column produces the Y coordinate 
of the point, and the third column produces the Z-axis color intensity 
value. A data symbol is plotted at the points with the specified X and 
Y coordinates. Color intensity values set in the “Color Ramp” dialog 
box are accessed from the “Chart Options” dialog box. This allows 
you to plot data points that have different X and Y coordinates for 
each data series. The number of rows determines how many points are 
in a data series. 
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To label each data series of a Paired Intensity Scatter chart, enter 
labels over each column of X coordinates in the Data page. These 
labels appear in the chart legend. Because the Paired Intensity Scatter 
chart uses values on both the vertical and the horizontal axes, there 
are no category axis labels. 

To learn more about... Refer to... 

Changing symbol shape and color “Changing Chart Symbols” in 
chapter 9 

Other chart options “Intensity Scatter and Paired 
Intensity Scatter Chart Options” 
in chapter 10 

	
  

Paired XY Line Chart 
Use a Paired XY Line chart to show sorted data points from one 
or more data series with each having a unique X and Y 
coordinate. 
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“Paired” refers to how the chart interprets the data that make up each 
series of X and Y coordinates. 

This chart type is similar to an XY Line chart but uses a different type 
of data. The Paired XY Line chart is similar to the Paired Scatter 
chart in the way the data are organized, but they are plotted 
differently because the Paired XY Line chart sorts the X values from 
left to right before plotting the data, while the Paired Scatter chart 
does not. 

In the Paired XY Line chart, data are arranged in paired columns of 
coordinate points that make up each data series. Each data series has 
two columns of data. The first column produces the X coordinate of 
the point. The second column produces the Y coordinate of the point. 
A line is drawn connecting the points in the series. This lets you plot 
multiple series of data with different X and Y coordinates for each 
data series. The number of rows determines how many points are in a 
data series. 

To label each data series of a Paired XY Line chart, enter labels over 
each column of X coordinates in the Data page. These labels appear 
in the chart legend. 

Because the Paired XY Line chart uses values on both the vertical and 
the horizontal axes, there are no category axis labels. 
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NOTE ☞  If the X coordinate data are not sorted, they are sorted internally so a 
line is drawn from the point with the lowest X coordinate to the 
highest. The actual data does not change in the Data page. If you want 
the data to remain unsorted, use a Paired   Scatter chart and turn on 
“Connect Data Points” in the “Options” dialog box. 

To learn more about... Refer to... 

Other chart options “Scatter and XY Line Chart 
Options” in chapter 10 

	
  

	
  



 
  DeltaGraph for Macintosh Version 7 User Guide 215 

Scatter Chart 
Use a Scatter chart to show data points from one or more data 
series with each point having the same X coordinate and unique Y 
coordinates. 

 

This chart is similar to the XY Line chart in the way the data are 
organized, but they are plotted differently because the Scatter chart 
does not sort the X values plotting the data. The number of rows 
determines how many points are in a data series. 

A Scatter chart produces a scatter plot in which both the vertical or Y 
axis and the horizontal or X axis measure values. Each data series 
consists of two coordinates. The first coordinate (X), which is the 
same for all series, represents the first column of data. The second 
coordinate (Y), which differs for each series, represents the 
remaining columns of selected data. For each series in the chart, 
symbols are drawn that correspond to two coordinate data points. 
The number of rows deter- mines how many points are in a data 
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series. 

To label each data series of a Scatter chart, enter labels over each 
column of Y coordinates in the Data page. These labels appear in the 
chart legend. Because the Scatter chart uses values on both the 
vertical and the horizontal axes, there are no category axis labels. 

If your X coordinate column is not located at the beginning of your 
data, you can select non-adjacent columns of data by selecting the 
column you want for your X coordinate first and then holding down 
the command key and choosing the data you want for your Y 
coordinates. 

To learn more about... Refer to... 

Other Scatter chart options “Scatter and XY Line Chart Options” in 
chapter 10 

	
  

Intensity Scatter Chart 
Use an Intensity Scatter chart to show data points from one or more 
data series with each point having the same X coordinate and unique 
Y coordinates plus a Z- axis intensity value. The number of rows 
determines how many points are in a data series. 

Intensity scatter produces a scatter plot in which both the vertical or Y axis and the 
horizontal or X axis measure values. Each data series consists of two coordinates 
plus a Z-axis color intensity value. The first coordinate (X), which is the same for 
all series, represents the first column of data. The second (Y) and third (Z) 
coordinates, which differ for each series, represent the remaining columns of 
selected data. For each series in the chart, symbols are drawn that correspond to 
two coordinate data points. Color intensity values set in the “Color Ramp” dialog 
box are accessed from the “Chart Options” dialog box. 
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To label each data series of a Scatter chart, enter labels over each 
column of Y coordinates in the Data page. These labels appear in the 
chart legend. Because the Scatter chart uses values on both the 
vertical and the horizontal axes, there are no category axis labels. 

If your X coordinate column is not located at the beginning of your 
data, you can select nonadjacent columns of data by selecting the 
column you want for your X coordinate first and then holding down 
the command key. 

NOTE ☞  When creating combination charts, this chart type can be used as a base 
chart. 
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To learn more about... Refer to... 

Changing symbol shape and 
color 

“Changing Chart Symbols” in 
chapter 9 

Other chart options “Intensity Scatter and Paired 
Intensity Scatter 

Chart Options” in chapter 10 
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XY Line Chart 
Use an XY Line chart to show a comparison of one or more data 
series with each having the same X coordinate and unique Y 
coordinates. 

 

This chart is similar to the Scatter chart in the way the data are 
organized, but they are plotted differently because the XY Line chart 
sorts the X values from left to right before plotting the data, while the 
Scatter chart does not. 

An XY Line chart produces a line chart in which both the vertical or Y 
axis and the horizontal or X axis measure values. This differs from a 
Line chart where the X axis is a category axis. The XY Line chart 
allows you to use unevenly spaced data increments in the X axis. 
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Each data series consists of two coordinates. The first coordinate (X), 
which is the same for all series, represents the first column of data. 
The second coordinate (Y), which differs for each series, represents 
the remaining columns of selected data. For each data series in the 
chart, a line is drawn that corresponds to two coordinate data points. 
The number of rows determines how many points are in a data series. 

To label each data series of an XY Line chart, enter labels over each 
column of Y coordinates in the Data page. These labels appear in the 
chart legend. Because the XY Line chart uses values on both the 
vertical and the horizontal axes, there are no category axis labels. 

If your X coordinate column is not located at the beginning of your 
data, you can select non-adjacent columns of data by selecting the 
column you want for your X coordinate first and then holding down 
the command key and choosing the data you want for your Y 
coordinates. 

NOTE ☞  If your X coordinate data are not in sorted order, they are sorted 
internally so that a line is drawn from the point with the lowest X 
coordinate to the highest. The actual data are not changed in the Data 
page. If you want the data to remain unsorted, use a Scatter chart and 
turn on “Connect Data Points” in the “Options” dialog box. 
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XY Column Chart 
The XY Column chart (also known as a Merimeko chart) is 
essentially a scatter plot with lines added to create columns of 
potentially differing widths. 

 

This allows you to represent changes in values and differences 
between values by plotting rectangular areas. Each column can be 
t
r
e
a
t
e
d
 as lines or filled with color. 

	
  

To learn more about... Refer to... 

Other XY Column chart 
options 

“XY Column Chart” in chapter 7 
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Polar Chart 
Use a Polar chart to show a relationship between an angle measured in 
degrees and some other quantity. For example, volume vs. direction 
of listener measured at some fixed distance from a loudspeaker, the 
strain at a particular point on a camshaft as it rotates through 360 
degrees, or the quantity of measured airborne contaminant near a 
pollution source vs. wind direction. This chart can also be used to 
show cyclical trends by scaling time into degrees. 

 

	
  

The Polar chart requires at least two columns of data for each data 
series. The first column of data corresponds to distance from the 
center of the chart or the Radius, and the second column corresponds 
to the number of degrees on the perimeter of the chart or the Angle. 
To label each series, enter labels over the first column of each data 
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series in a Data page. 

	
  

To learn more about... Refer to... 

Changing symbol shape and 
color 

“Changing Chart Symbols” in 
chapter 9 

Other chart options “Polar Chart Options” in chapter 
10 

	
  

Ternary Chart 
Use a Ternary chart to show the percentage of a whole based on 
three parts of information. 

 

	
  

The Ternary chart requires three columns of data for each data series. 
The first col- umn corresponds to values on the X axis, the second 
column corresponds to values on the Y axis, and the third column 
corresponds to values on the Z axis. The posi- tion of the axes for a 
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Ternary chart can be changed from the “Options” dialog box. To label 
each data series, enter labels over the first column (X) of each data 
series. These labels appear in the legend. 

To learn more about... Refer to... 

Changing symbol shape 
and color 

“Changing Chart Symbols” in chapter 
9 

Other chart options “Ternary and Percent Ternary 
Chart Options” in chapter 10 

	
  

Ternary Percent Chart 
Use a Ternary Percent chart to show the percentage of a whole based 
on three parts of information, two of which are given as data in 
percent form. 
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The Ternary Percent chart requires two columns of data for each data 
series. Data must be in percent form (between 0 and 1). The X axis is 
a percentage of the value in the first column. The Y axis is a 
percentage of the value in the second column. Based on the two 
percents, a third value (Z axis) is calculated automatically as a 
percent of the remainder. To label the data series, enter labels over the 
first column (X) of each data series (every second column). The 
labels appear in the legend. The position of the axes for a Ternary 
Percent chart can be changed from the “Options” dialog box. 

To learn more about... Refer to... 

Changing symbol shape and color “Changing Chart Symbols” in 
chapter 9 

Other chart options “Ternary and Percent 
Ternary Chart Options” in 
chapter 10 
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Contour Line Chart 
The Contour Line chart is a variation of the Contour Fill and 3-D 
Surface Line/Fill charts. The Contour Line chart does not have a value 
axis. The values are shown as a series of lines and numbers in the 
chart instead. 

 

	
  

You must have at least two columns and two rows of data in a 
Contour Line chart. The vertical or Y axis shows the category, the 
horizontal or X axis shows the series. Each row of data corresponds 
to a category. Each column of data corre- sponds to a series. Each 
value in the Data page is represented at the intersection of the 
category and series points. Row labels are used to name each category 
on the Y axis. Column labels are used to name each series on the X 
axis. 
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To learn more about... Refer to... 

Other chart options “Contour Line Chart Options” in 
chapter 10 

	
  

Contour Fill Chart 
Use a Contour Fill chart to show surface variation of two sets of 
evenly spaced values (such as latitude and longitude at 10° intervals), 
which can be entered as row and category labels, and a unique 
number (such as elevation at a given point). 
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The Contour Fill chart is a variation of the Contour Line and 3-D 
Surface Line/Fill charts. The Contour Fill chart does not have a value 
axis. The values are shown as a variation in pattern or color and are 
represented in the legend instead. 

You must have a least two columns and two rows of data in a Contour 
Fill chart. The vertical or Y axis shows the category. The horizontal 
or X axis shows the series. Each row of data corresponds to a 
category. Each column of data corre- sponds to a series. Each value in 
the Data page is represented at the intersection of the category and 
series points. Row labels are used to name each category on the Y 
axis. Column labels are used to name each series on the X axis. 

	
  

To learn more about... Refer to... 

Other chart options “Contour Fill Chart Options” in 
chapter 10 
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XYZ Contour Line Chart 
Use an XYZ Contour Line chart to show variations and 
relationships over three sets of values: latitude, longitude, and 
elevation, for example. 

 

Each data series requires three columns of data. The first column 
produces the val- ues for the X coordinate points, the second column 
produces the Y coordinate points, and the third column (Z) represents 
an elevation. You are limited to 32,767 data points when creating an 
XYZ Contour Line chart. Remember that the more data points the 
chart contains, the longer it takes to plot and redraw. 

	
  

The XYZ Contour Line chart is a variation of the XYZ Contour Fill 
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chart. The XYZ Contour Line chart is 2-D with the third dimension of 
values shown as an annotated elevation on the chart. An XYZ Contour 
Line chart does not require labels or a legend. 

To learn more about... Refer to... 

Other chart options “Contour Line Chart Options” in 
chapter 10 

	
  

XYZ Contour Fill Chart 
Use an XYZ Contour Fill chart to show variations and relationships over three 
sets of values: for example, latitude, longitude, and elevation. 
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Each data series requires three columns of data. The first column 
produces the val- ues for the X coordinate points, the second column 
produces the Y coordinate points, and the third column (Z) is 
represented by the legend and the patterns or colors corresponding to 
elevation in the chart. 

You are limited to 32,767 data points when creating an XYZ Contour 
Fill chart. Remember that the more data points the chart contains, the 
longer it takes to plot and redraw. 

The XYZ Contour Fill chart is a variation of the 3-D Surface chart. 
The XYZ Con- tour Fill chart is 2-D, with the third dimension of 
values shown as a variation in pattern or color. Labels are not used on 
an XYZ Contour Fill chart, but values may be shown. 

To learn more about... Refer to... 

Other chart options “Contour Fill Chart Options” in 
chapter 10 
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Gridded Vector Chart 
Use a Gridded Vector chart to display a direction (like air flow) using 
vectors (arrows) over a gridded area. 

 

This chart is similar to the Radius/Angle Gridded Vector chart except 
that the R/A Gridded Vector chart lets you specify the length of the 
vectors through data. In this chart, the vectors remain static as a 
percentage of the size of the chart plot frame. 

At least one data series is required (each data series requires a single 
value). Since the data gives the angle at which to draw the vector on 
the gridded chart, a value between 0 and 360 can be entered. Values 
outside the 0 to 360 range are supported (if greater than 360, 360 is 
subtracted from the value; if less than 0, 360 is added to the value). 
All vectors on this chart are drawn at the same length. 
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Row labels are used to name each category on the Y axis. Column 
labels are used to name each series on the X axis. Vectors in the chart 
can be edited by double- clicking the arrows or by choosing “Edit 
Arrows” from the Draw menu. 

To learn more about... Refer to... 

Other chart options “Gridded Vector Chart Options” in 
chapter 10 

Changing the vectors “Creating and Editing an Arrow” in 
chapter 11 

	
  

Radius/Angle Gridded Vector Chart 
Use a Radius/Angle Gridded Vector (R/A Gridded Vector) chart to 
show direction (like airflow) using vectors (arrows) over a gridded 
area. 

 

This chart is similar to the Gridded Vector chart except that the R/A 
Gridded Vector chart lets you specify the length of the vectors 
through data. In the Gridded Vector chart, the vectors remain static as 
a percentage of the size of the chart plot frame. 
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Each data series requires at least two columns of data. The first 
column represents the radius or length of each vector and the second 
column represents the angle of the vector. Since the angle value gives 
the angle at which to draw the vector on the gridded chart, a value 
between 0 and 360 can be entered in the second column. Values 
outside the 0 to 360 range are supported (if the value is greater than 
360, 360 is subtracted from the value; if the value is less than 0, 360 
is added). 

Row labels are used to name each category on the Y axis. Column 
labels are used to name each series on the X axis. 

Vectors in the chart can be edited by double-clicking the arrows or by 
choosing “Edit Arrows” from the Draw menu. 

To learn more about... Refer to... 

Changing the vectors “Creating and Editing an Arrow” in 
chapter 11 

Other chart options “R/A Gridded Vector and XY Vector 
Chart Options” in chapter 10 

	
  

XY Vector Chart 
Use an XY Vector chart to display a direction (like airflow) using 
vectors and a magnitude (dependent on the endpoint calculation 
method). 

This chart is similar to the Gridded Vector and R/A Gridded Vector 
charts except this chart is not based on a grid. The other two charts 
depend on the origin point always starting in a grid block, while the 
XY Vector chart specifies the origin point based on the X and Y axes 
scaling. 

Each data series requires four columns of data. The first two columns 
represent the origin or “tail” of the vector. To label each series, enter 
labels over the first column (X) of each data series. These labels 
appear in the chart legend. Because the XY Vector chart uses values 
on both the vertical and horizontal axes, there are no Category axis 
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labels. 

 

Using the “Delta” (change) method in the “Options” dialog box, 
columns three and four determine the endpoint or “head” of the vector 
( ∆x and ∆y ), giving the incremental offset from the tail to the head of 
the arrow. Using the “End Point” method, columns three and four 
determine the endpoint or “head” of the vector (the X coordinate and 
the Y coordinate) based on the X axis and Y axis scaling. Using the 
“Radius/Angle” method, columns three and four determine the 
endpoint or “head” of the vector (the radius length and the radius angle 
respectively) based on the vector legend scaling. 

You can also use the “Options” command to switch methods for 
determining the endpoint of the vector. Vectors in the chart can be 
edited by double-clicking the arrows or choosing “Edit Arrows” 
from the Draw menu. 
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To learn more about... Refer to... 

Switching the vector 
endpoints 

“R/A Gridded Vector and XY Vector 
Chart Options” in chapter 10 

Changing the vectors “Creating and Editing an Arrow” in 
chapter 11 
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2-D Statistical Charts 

Histogram Chart 
Use a Histogram chart to show the frequency or occurrence of 
selected data in a specified range. 

 

All the values in the data selection are lumped together then divided 
into groups called categories or “bins,” and the number of data values 
in each bin is counted. All data values are lumped together in one 
series (a single column). Any labels for the categories or series are 
ignored. There is only one series and no legend, so series labels are 
not needed. At lease one data cell needs to be selected. Histogram 
“bin” labels take the place of category labels, whose options are 
chosen in the “Options” dialog box, “Binning” option. This dialog 
box can also be used to control which values go in each bin. A 
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rectangular data graphic is drawn for each bin, displaying the count in 
each. Labels are created for each data graphic, describing what is 
counted in each bin. The content of the labels is also controlled in the 
“Options” dialog box. 

This chart can be “overlaid” with an Ogive chart by using the 
“Show Ogive” option in the “Options” dialog box. The direction 
in which the running sum increases may be chosen in the 
Histogram chart “Options” dialog box. 

To learn more about... Refer to... 

Binning data and other chart 
options 

“Histogram Chart Options” in 
chapter 10 

Creating a Histogram chart 
manually 

“Creating a Histogram” in chapter 8 
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Pareto Chart 
Use a Pareto chart to show data that need to be counted and sorted. 

 

The data graphic representing the count is a rectangle, like that used 
for the Histogram chart. The functionality of the Pareto chart is 
almost identical to the Histogram chart, except that the bins are sorted 
according to the frequency count for each bin. 

All data values are lumped together in one series (a single column). 
Any labels for the categories or series are ignored. There is only one 
series and no legend, so series labels are not needed. At lease one 
data cell needs to be selected. 

Pareto “bin” labels take the place of category labels, whose options 
are chosen in the “Options” dialog box, “Binning” option. The 
direction in which the sorted counts increase may be chosen in the 
Pareto chart “Options” dialog box. 

This chart can be “overlaid” with an Ogive chart by using the “Show 
Ogive” option in the “Options” dialog box. 
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To learn more about... Refer to... 

Binning data and other chart 
options 

“Pareto Chart Options” in chapter 10 

	
  

Ogive Chart 
Use an Ogive chart to show the running sum of frequency counts. 

 

Ogive bin labels take the place of category labels. Bin labels are 
controlled through the “Binning” option in the “Options” dialog box. 
The running sums of the frequency counts may increase from left to 
right or right to left as selected in the Ogive chart “Options” dialog 
box. Each column of data is treated as a separate data series. A line 
data graphic is drawn for each data series. 

This chart can be “overlaid” on a Histogram or Pareto chart by using 
the “Show Ogive” option in the “Options” dialog box for those charts. 
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To learn more about... Refer to... 

Binning data and other chart 
options 

“Ogive Chart Options” in chapter 10 

	
  

Box Plot Chart 
Use a Box Plot chart to show the “spread” of data between categories. 

 

Rather than charting all data for each series and category, statistics 
are computed to reduce the amount of information displayed while 
still showing the distribution of data in each category. 

A Box Plot data graphic consists of five or six different pieces of 
information calculated from the data selection. The top, bottom, and 
line through the middle of the box correspond to the 75th percentile 
(top quartile), 25th percentile (bottom quartile), and 50th percentile 
(median) respectively. The whiskers on the bottom extend from the 
10th percentile (bottom decile) and top 90th percentile (top decile). 
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Outlier caps are placed at the end of the top and bottom decile 
whiskers (outlier caps). Any value falling beyond these outlier caps 
would be considered an outlier. The size of the outlier caps can be 
customized by specifying a width in the Box Plot “Options” dialog 
box. A symbol may also be placed on the arithmetic mean but only if 
the “Show Means” option is selected in the “Options” dialog box. 

The amount of data entered and the ordering of values is 
immaterial. Each row corresponds to a box or new category. Since 
the data for each series is combined into a representation for a 
single category, the resulting chart has only one data graphic per 
category. Series are not distinguished from each other in the final 
chart. Series labels are ignored. Row labels are used to name each 
category or box. 

The amount of separation is controlled with the “Object Placement” 
options in the 

“Options” dialog box. 

To learn more about... Refer to... 

Changing the separation 
and other options 

“Box Plot Chart Options” in chapter 
10 

	
  

Survival Chart 
Survival charts, found under Statistical charts in the Chart Gallery, 
plot surviving elements, expressed either as absolute numbers, or as 
percentages. 

If you were, for example, a doctor wishing to chart the survival of 
patients during an epidemic, the chart would consist of a Y axis that 
designates the percentage of patients surviving and an X axis 
designating the time elapsing. (It could also be other criteria, such as 
the concentration of a chemical used on bacteria when the X axis 
might plot cubic centimeters of chemical used.) The plot typically 
starts at 100% (but can begin at whatever the starting absolute 
quantity is) on the Y axis with a stepped line tracing the gradual 
decline in survival rate. 
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Data for a Survival chart must be entered as follows: in column A, 
enter periods of time elapsed (or cubic centimeters used or whatever 
the survival is dependent upon), in column B, enter the number 
surviving. 

To learn more about... Refer to... 

Other Survival chart 
options 

“Survival Chart Options” in chapter 
10 

	
  

Quality Control Charts 
DeltaGraph offers a variety of quality control charts. Quality control 
charts, also known as Shewhart charts, are specialized graphs used 
for the study of control of continuous processes. These charts are 
based on the idea that if control limits are established, the natural 
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variability of a process can be quantified. Any variation exceeding 
the established limits indicates a separate cause of variation. 

Quality control charts can be classified broadly according to the type 
of data analyzed, as follows: 

Charts for variables 

Indiscrete values, or continuous data, are used when the quality 
characteristic to be analyzed is measured on a continuous scale. For 
example, the measurement of unit parts or yields of a chemical 
process would result in indiscrete values. 

	
  	
  

Charts for attributes 

Discrete values, or enumerated data, are used when the quality 
characteristic of a process is measured by counting the number of 
nonconformities (defects) in an item or by counting the number of 
nonconforming (defective) items in a sample. 

DeltaGraph's quality control charts consist of X and Y data points 
plotted as symbols connected by line segments. The plotted values are 
the result of computations performed by DeltaGraph based on the 
type of quality control chart selected. A central line is also plotted to 
represent the average of all plotted values. 

DeltaGraph offers six types of quality control charts, as described in 
the following sections. 

X-R (X Bar-R) Chart 
The X-R (X Bar-R) chart uses the measured values in each subgroup 
to compute both the average value and the range. 

X-R charts are shown in two different forms, either as a single plot 
with two Y axis scales on the same plot or as two separate plots. 

The values plotted along the X axis are the subgroup number, which 
is either the row number or a lot number. The Y axis values are the 
average of the measured data for each subgroup for the first axis and 
the range for the second. Generally this type of chart is limited to 



 
  DeltaGraph for Macintosh Version 7 User Guide 245 

fewer than ten (<10) measured values. At greater than ten (>10), the 
analyst becomes more interested in the standard deviation than the 
range of the data. 

If you select more than two columns, the first column will be 
interpreted as sub- group numbers or measured data. 

 

Two related charts will be plotted one above the other. The upper 
chart shows the mean (average), upper and lower control limits, and 
upper and lower warning limits. The lower chart shows the mean 
(average) range and control and warning limits. 

X-S (X Bar-S) Chart 
The X-S (X Bar-S) chart uses the measured values in each subgroup 
to compute both the average and standard deviation. 
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This chart type is very similar to the X-R chart except that the 
standard deviation, rather than the range of values in the data, is 
plotted. From a statistical standpoint this chart is more appropriate 
when the set of measured values is greater than ten (>10). You follow 
similar steps in preparing to make a X-R chart. 

Fraction Defective (p) Chart 
The Fraction Defective (p) chart uses the fraction of defective items 
in each sub- group. 
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This chart may have variable subgroup sizes. The X axis is 
shown as the sub- groups or lot numbers, and the Y axis is shown 
in percentages (%). 

The first column represents subgroup size. The second column is the 
number of nonconformities in the subgroup. If you select three 
columns, the first column will be interpreted as subgroup numbers or 
measured data. 

Number of Defectives (pn) Chart 
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The Number of Defectives (pn) chart uses the number of defective 
items in each subgroup. 

 

The input is similar to the Fraction Defective (p) chart except that all 
subgroups must have the same number of members. The X axis is 
shown as the subgroups or lot numbers, and the Y axis is shown as 
the number of defective items. 

The only difference between a p and a pn chart is that a p chart uses a 
variable sub- group size, while a pn chart uses a constant subgroup 
size. 

Defects Per Unit (u) Chart 
	
  

The Defects Per Unit (u) chart shows the number of independent 
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defects per unit. 

 

This chart is used for a complex assembly where many 
independent defects are possible and can be used when the 
subgroup size varies or is constant. 

Number of Defects (c) Chart 
The Number of Defects (c) chart shows the number of defects per 
subgroup. 

 

This chart is similar to the u chart except that the sample sizes are the 
same. The only difference between a u and a c chart is that a u chart 
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uses a variable subgroup size, while a c chart uses a constant 
subgroup size. 

To learn more about... Refer to... 

Other chart options “Quality Control Chart Options” in 
chapter 10 
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3-D Business Charts 

3-D Column Chart 
The 3-D Column chart is a variation of a 2-D Column chart. Use it to 
compare one item to another or to compare different items over a 
period of time. Column charts effectively show dramatic changes 
from one category to another. 

 

Each row of data corresponds to one set of bars for a given category. 
Each column of data corresponds to a data series. Each value in the 
Data page represents one column in a given category. The right or X 
axis shows categories, the left or Y axis shows the series, and the 
vertical or Z axis shows values. 

NOTE ☞  On a default 3-D chart, the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 
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Row labels are used to name each category. Column labels are used 
to name each series. 

To learn more about... Refer to... 

Other chart options “3-D Column Chart Options” in chapter 
10 

	
  

3-D Area Chart 
Use an Area chart to emphasize the volume or size of a data series, 
frequently over time. This chart is a variation of a 2-D Line or Area 
chart. 

 

Each column of data corresponds to a data series or a filled area on 
the chart. The right or X axis shows categories, the left or Y axis 
shows the series, and the vertical or Z axis shows values. Row labels 
are used to name each category. Column labels are used to name each 
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series. 

NOTE ☞  On a default 3-D chart, the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 

. 

To learn more about... Refer to... 

Other chart options “3-D Area Chart Options” in chapter 10 

	
  

3-D Ribbon Chart 
Use a 3-D Ribbon chart to show trends. 

 

The 3-D Ribbon chart is a variation of a 2-D Line chart. Each column 
of data corresponds to one ribbon or data series on the chart. You can 
have more than one series per Data page. The right or X axis shows 
categories, the left or Y axis shows the series, and the vertical or Z 
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axis shows values. Row labels are used to name each category. 
Column labels are used to name each series. 

NOTE ☞  On a default 3-D chart, the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 

	
  

	
  

	
  

	
  

3-D Technical Charts 

3-D Scatter Chart 
The 3-D Scatter chart plots data points created by the intersection of 
three different coordinate values. Those points are connected to one 
of the chart planes with a drop line. Each of the three values that make 
up a point corresponds to a particular axis in a 3-D grid. The left axis 
is X, the right axis is Y, and the vertical axis is Z. 

NOTE ☞  On a default 3-D chart, the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 

All of the axes on a 3-D Scatter chart measure values: the 
frequency, amplitude, and phase of an electrical signal, for 
example. 

Each data series requires three columns of data. The first column 
produces the values for the X coordinate points, the second column 
produces the Y coordinate points, the third column produces the Z 
coordinate points. Each data point represents a measurement that is 
the intersection of the three values in a row. You can have more than 
one data series per Data page. 

To learn more about... Refer to... 

Other chart options “3-D Ribbon Chart Options” in 
chapter 10 
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Each data series in a 3-D Scatter chart is represented by a different 
set of symbols with drop lines to one of the three chart planes. To 
label each data series, enter labels over the first column of each series 
in a Data page. 

To learn more about... Refer to... 

Changing symbol shape and 
color 

“Changing Chart Symbols” in chapter 
9 

Other chart options “3-D Scatter Chart Options” in chapter 
10 
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3-D Scatterline Chart 
The 3-D Scatterline chart is a variation of the 3-D Scatter chart, 
except that it connects the data points by a line, as in “connect-the-
dots.” 

 

This chart measures something that moves in space as a function of 
time: a satellite orbiting earth, for example. The chart shows a path 
of contact points along an implied time line represented by the 
position of the points along the line. 

All of the axes on a 3-D Scatterline chart measure values. The left 
axis is X, the right axis is Y, and the vertical axis is Z. 

NOTE ☞  On a default 3-D chart the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 

Each data series requires three columns of data. The first column 
produces the values for the X coordinate points, the second column 
produces the Y coordinate points, and the third column produces the Z 
coordinate points. Each data point rep- resents a measurement that is 
the intersection of the three values in a row. 
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Each data series in a 3-D Scatterline chart is represented by a 
continuous line. To label the data series, enter a label for the first 
column of each series in a Data page. 

To learn more about... Refer to... 

Changing symbol shape and 
color 

“Changing Chart Symbols” in chapter 
9 

Other chart options “3-D Scatter Chart Options” in 
chapter 10 
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3-D Wireframe Chart 
The 3-D Wireframe chart is a variation of a Contour chart. Use a 3-D 
Wireframe chart to show surface variation based on two sets of 
evenly spaced values (such as latitude and longitude at 10° intervals), 
which can be entered as row and category labels, and a unique 
number (such as elevation at a given point). A Wireframe chart is 
suitable for showing three-dimensional changes in an object or over 
time. 

 

There must be at least two series and two categories. The right (X) 
axis shows categories, the left (Y) axis shows the series, and the 
vertical (Z) axis shows values. Row labels are used to name each 
category. Column labels are used to name each series. 

NOTE ☞  On a default 3-D chart the axes are the three lines that intersect in the 
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back of the chart. They are not the lines where the axis labels appear. 

	
  

To learn more about... Refer to... 

Other chart options “3-D Wireframe Chart Options” in 
chapter 10 

	
  

3-D Surface Fill Chart 
Use a 3-D Surface Fill chart to show surface variation based on two 
evenly spaced values (such as latitude and longitude at 10° intervals), 
which can be entered as row and category labels, and a unique 
number (such as elevation at a given point). 
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There must be at least two series and two categories per chart. The 
right or X axis shows the categories, the left or Y axis shows series, 
and the vertical or Z axis shows values. Row labels are used to name 
each category. Column labels are used to name each series. 

NOTE ☞  On a default 3-D chart, the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 

	
  

To learn more about... Refer to... 

Other chart options “3-D Surface Fill and 3-D Surface Line 
Chart Options” in chapter 10 

	
  



 
  DeltaGraph for Macintosh Version 7 User Guide 261 

3-D Surface Line Chart 
Use a 3-D Surface Line chart to show surface variation based on 
two evenly spaced values (such as latitude and longitude at 10° 
intervals), which can be entered as row and category labels, and a 
unique number (such as elevation at a given point). 

 

There must be at least two series and two categories per chart. The 
right or X axis shows the categories, the left or Y axis shows series, 
and the vertical or Z axis shows values. 

NOTE ☞  On a default 3-D chart, the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 

Row labels are used to name each category. Column labels are used 
to name each series. 



 
  DeltaGraph for Macintosh Version 7 User Guide 262 

3-D XYZ Surface Fill Chart 
Use a 3-D XYZ Surface Fill chart to show three dimensional data in 
which one quantity (plotted on the Z axis) varies depending on X and 
Y values. XYZ data are not evenly incremented like Surface Line or 
Fill data. 

 

All of the axes on a 3-D XYZ Surface Fill chart measure values: 
the frequency, amplitude, and phase of an electrical signal, for 
example. The left axis is X, the right axis is Y, and the vertical axis 
is Z. 

NOTE ☞  On a default 3-D chart, the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 

Each data series requires three columns of data. The first column 
produces the values for the X coordinate points, the second column 
produces the Y coordinate points, and the third column produces the Z 
coordinate points. Each data point rep- resents a measurement that is 
the intersection of the three values in a row. You are limited to 32,767 
data points when creating an XYZ Surface Fill chart. Remember that 
the more data points the chart contains, the longer it takes to plot and 
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redraw. 

To label each data series, enter labels in the first column of each 
series in a Data page. 

To learn more about... Refer to... 

Other chart options “3-D Surface Fill and 3-D Surface Line 
Chart Options” in chapter 10 

	
  

3-D XYZ Surface Line Chart 
Use a 3-D XYZ Surface Line chart to show three dimensional data 
in which one quantity (plotted on the Z axis) varies depending on X 
and Y values. 

 

XYZ data are not evenly incremented like Surface Line or Fill data. 
Each series consists of three columns. You are limited to 32,76`7 data 
points when creating an XYZ Surface Line chart. Remember that the 
more data points the chart contains, the longer it takes to plot and 
redraw. 
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All of the axes on a 3-D Surface Line chart measure values: the 
frequency, amplitude, and phase of an electrical signal, for example. 
The left axis is X, the right axis is Y, and the vertical axis is Z. 

NOTE ☞  On a default 3-D chart, the axes are the three lines that intersect in the 
back of the chart. They are not the lines where the axis labels appear. 

To learn more about... Refer to... 

Other chart options “3-D Surface Fill and 3-D Surface Line 
Chart Options” in chapter 10 
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8 Plotting Data and the 
Chart View 

This chapter focuses on creating charts and pictographs and working 
in the Chart view. It describes working in the Chart view, how to 
update and revise data, and how to use the Internal Command 
Language to automate the creating of charts from another application 
or from a text string. 

This chapter covers the following: 

• Plotting a chart 

• Creating, deleting, and naming Chart pages 

• Creating overlay and double-axis charts 

• Plotting multiple charts in a Chart page 

• Changing the type of chart in a Chart page 

• Revising the data in a chart 

• Using the Internal Command Language (ICL) to plot data 

To learn more about... Refer to... 

Page orientation and size “Setting Up the Document” in chapter 16 
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Setting Up a Chart 
You can access the “Chart Setup” dialog box in the Data or the Chart 
view. If you are plotting data in the Data view, data must be selected. 
If you are in the Chart view and want to plot a chart, data does not 
need to be selected. 

To access the “Chart Setup” dialog box, select Chart Gallery from the 
Data or Chart menu, depending on the view you are in. 

There are two tabs in the “Chart Setup” dialog box, as follows: 

• The Chart Gallery is primarily used to select a chart type to plot. 

• The Chart Advisor assists you in selecting the right chart for your 
data. 

The Chart Gallery 
The main purpose of the Chart Gallery is to select chart types for 
plotting. It lets you specify the type of chart you want, where you 
want it plotted (in a new or existing Chart page), and whether or not 
you want it plotted automatically. Delta- Graph also offers the option 
of using its own built-in sample data to plot a chart. This allows you 
to plot a sample chart, complete with data, to see what the chart 
looks like. 

To use the Chart Gallery, do the following: 

1.  Select data if necessary. Data only needs to be selected if you are 
opening the 

Chart Gallery in the Data view. 

2.  Choose Chart Gallery from the data or chart menu. 

The “Chart Setup” dialog box appears with the Gallery tab selected. 

 



 
  DeltaGraph for Macintosh Version 7 User Guide 267 

 

3.  Select options regarding the types of charts from which you want 
to choose from the right side of the tab. The window on the left 
displays all charts matching the options you have chosen. 

4.  Click the chart type you want to create. 

You can scroll through the window to see other charts available 
in the categories you selected. When you place the mouse pointer 
over a chart icon, the chart type appears directly below the scroll 
bar. 

In “Icons” view you can click the check box next to a chart 
category to select or deselect that item. For example, if you are 
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only interested in column and pie charts, you would deselect all 
other categories so that you do not have to sift through charts you 
will not use. 

Once you have chosen the types you want to display, you can 
scroll through the chart types using the horizontal scroll bar below 
the chart icons. 

5.  To switch to “List” view, click List. All chart types now are 
displayed as a list with small icons. Category divisions are not 
available in “List” view. 

6.  Collapse or expand each group of chart types by clicking the 
small triangle next to the name. 

7.  To select a chart type, scroll through the list of charts using the 
vertical scroll bar. You can also select a chart type by typing the 
first few characters of its name. 

8.  To plot a chart, select the chart type and click OK, or double-click 
the chart type. The chart will plot using the options you have 
selected in the Chart Gallery. You can set plot options from 
“Icons” or “List” view. 

9.  To display two-dimensional or three-dimensional charts in “Icons” 
or “List”view, click 2-D or 3-D. 

The next time you launch DeltaGraph it will appear with the Chart 
Gallery set- tings you selected the last time so you do not have to 
duplicate efforts. 

Custom templates containing charts for any auto-loaded or open 
Custom Libraries appear mixed in with the various categories of 
charts. If you have a Standard Library, those charts also appear 
in the window. 

If you click and hold on a chart icon, a brief explanation of the 
selected chart type is displayed. 

10. Click the pop-up menu next to “Plot In” if you want the chart 
plotted in an existing Chart page. 

If you are plotting in the Chart view, the page you were in appears 
as the selection. All Chart pages associated with the current 
document are listed in a pop- up menu on the Status bar at the 
bottom of the window. You can plot your chart in any Chart page 



 
  DeltaGraph for Macintosh Version 7 User Guide 269 

listed, regardless of whether or not it already contains other 
objects or charts. 

11. Select from the following “Plot Options” as required. 

Auto plot 

Determines whether or not the chart is plotted automatically in the 
selected 

Chart page. This gives you the option of drawing the chart to 
specific dimensions, which can be very helpful if you need to fit 
a special layout. 

When selected, DeltaGraph automatically calculates the best 
dimensions for the chart and draws it in the specified Chart 
page as soon as you click OK. 

When deselected and you click OK, DeltaGraph activates the 
specified Chart page and displays a chart icon attached to a cross 
hair cursor. Click and drag to create a box the size and shape you 
want your chart. When you release the mouse button, the chart 
appears. 

NOTE ☞  You may want to choose Rulers & Grids from the Draw menu, and 
select Show Rulers in the dialog box that appears before you start 
drawing your chart box. 

“Auto Plot” always reverts to the default when you finish drawing 
your chart. 

Always plot all  data 

This option applies to Data pages only. Select it if you want 
DeltaGraph to automatically plot all data from the open Data page. 
This option is useful when linking to an imported Excel file and 
you want to update the document using all of the data. It can also 
be used as a shortcut to updating a chart after you have revised the 
data. If this option was selected when you first plotted the chart, all 
you have to do to update the chart after making changes on the 
Data page is to resize an axis. 

Use sample data 

Plots the selected chart with sample data provided by DeltaGraph, 
allowing you to plot a sample chart without entering data. A new 
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Data page is created using the sample data. You can then review 
the Data page to learn how to enter data for the chart type you want 
to use. 

12. Click OK to create the new chart. If you are plotting in the Data 
view, the chart appears in the specified Chart page. If you are 
plotting in the Chart view and did not specify sample data, you 
will be prompted to select data in the Data page. 

To return to the previous view without plotting a chart, click 
Cancel. 

To learn more about... Refer to... 

	
  

Plotting in the Chart view 

“Creating a Chart in the Chart View” 
in chapter 8 

	
  

Modifying your charts 

Chapter 9 “Customizing Charts” and 
Chapter 10 

 

The Chart Advisor 
The Chart Advisor helps you decide the type of chart that will best 
suit your data. Data must be selected in the Data view before the 
Chart Advisor is available. 

Based on the data you selected in the Data page and other selections 
you make in the Chart Advisor, DeltaGraph offers one or more 
appropriate choices for a chart type. If you decide to use one of the 
suggested chart types, you can plot the chart directly in the Chart 
Advisor. 

The Chart Advisor presents chart selections from the standard 
DeltaGraph charts as well as from any open Custom Libraries, the 
Standard Library, or any files in the DeltaGraph “AutoLibrary” 
folder. 

To use the Chart Advisor, do the following: 
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1.  Select data in the Data view. Data must be selected to use the Chart 
Advisor. 

2.  Click the Plot icon on the Data view Command bar or press cmd-G. 
The “Chart 

Setup” dialog box appears. 

3.  Click the Advisor tab. You can also press the option key while 
clicking the Plot icon to automatically display the Chart Advisor. 

 

Some of the defaults may be overridden by the Chart Advisor if 
the selected data has obvious characteristics that were not 
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reflected in the dialog box. For example, if 1000 data points 
were selected, the Chart Advisor would more likely choose 
“Scientific/Technical” than “Business/Finance.” 

4.  Select options important to the ideas you are trying to convey. 
Categories of topics are listed that are important to choosing the 
type of chart best suited to your data. Select one option from each 
category to best describe the ideas you want your chart to convey. 

5.  All of the suggested chart types appear in the “Suggested Charts” 
section. Select a chart to display an example in the “Example” box. 

6.  Click OK to save your changes as the new Chart Advisor default 
settings and to plot the chart. The chart is displayed in the Chart 
view. If you want to exit the dialog box without selecting a chart, 
click Cancel. 

Creating Chart Axis Titles 
After you click OK in the “Chart Setup” dialog box, you will be give 
the opportunity to select cells you want to use as axis titles. You can 
also wait until your chart is plotted, then double-click the axis you 
want to label. 

To determine the type and location of axes of a particular chart, refer 
to Chapter 8, “Chart Types.” 

To create an axis title, do the following: 

1.  Select data if necessary. Data only needs to be selected if you are 
opening the “Chart Setup” dialog box in the Data view. 

2.  Click the Plot icon on the Data or Chart view Command bar, 
choose Chart    Gallery from the Data or Chart menu, or press 
cmd-G. The “Chart Setup” dialog box appears 

3.  Select a chart in the Gallery tab. The name of the selected chart 
appears in the Status bar at the bottom of the window. 

4.  If you have accessed this dialog box in the Data view, you can 
assign cells in the Data page as titles by clicking Select Cells. A 
floating window appears in the Data page. 
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“Select Cells” is not available in the Chart view, because you 
have not yet set up your data. 

5.  Click a data cell, then click the appropriate X Title, Y Title, or Z 
Title button. The selected cell is identified to the right of the 
button. 

6.  When all of the necessary cells have been identified, click Plot. To 
exit the dialog box without making any changes, click Cancel. 

Depending on the view you were in when the “Chart Setup” 
dialog box was displayed, the procedures are different for 
plotting your chart. 

To learn more about... Refer to... 

Other ways to assign axis 
titles 

“Creating and Positioning Axis 
Labels and Titles” in chapter 9 

	
  

Creating a Chart 
DeltaGraph gives you several options for plotting charts. Which one 
you choose will depend on the type of chart you need (numerical or 
text), the type of presentation you’re preparing, the DeltaGraph view 
you are most comfortable working in, and your own personal work 
style. 

You may find it helpful to refer to Chapter 8, “Chart Types” which 
uses sample data sets to explain how to enter data for the specific 
chart types. 

There are two ways to create a chart in DeltaGraph, as follows: 
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1.  Plot a chart in the Data view. Plotting in the Data view is known as 
the “Charting mode.” It requires entering (or importing) and 
selecting data in the Data view before plotting the chart. Only 
numerical charts (2-D and 3-D), Table charts, and Time Lines are 
plotted in the Data view. 

2.  Plot a chart in the Chart view. If you plot a chart in the Chart 
view, you will be prompted to select a chart and data. 

The “Preferences” dialog box (choose Preferences from the 
DeltaGraph menu) allows you to change the DeltaGraph default 
charting mode. When “For Charting” is selected as the “New 
Document Startup” option in the General tab, DeltaGraph opens all 
documents in the Data view.. 

	
  

To learn more about... Refer to... 

Working with Layout Sets “Creating and Using Smart Layouts” in 
chapter 5 

Setting preferences “Setting General Defaults” in chapter 6 

Different types of charts Chapter 7, “Chart Types” 

	
  

	
  

Using Smart Layouts 
	
  

Smart Layouts are the easiest way to ensure that your charts and 
presentations have a consistent look. Smart Layouts consist mainly 
of placeholders, which can be applied to Chart pages before or after 
charts, text, and other objects have been added to the page. 
Placeholders appear after the layout has been applied to the page. 
They can be filled in the Data view, or the Chart view depending on 
the type of placeholder. 

If you are using a layout that does not contain a placeholder for a 
chart, or if you do not need to plot a chart, you do not need to follow 
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the instructions for plotting a chart. 

To learn more about... Refer to... 

Setting mode preferences “Setting General Defaults” in chapter 6 

Loading a Layout Set “Loading a Layout Set” in chapter 5 

Creating a Layout Set “Creating and Using Smart Layouts” in 
chapter 5 

Filling placeholders “Filling Layout Placeholders” in chapter 
5 

	
  

Creating a Chart in the Data View 
Creating charts in the Data view involves entering and selecting data 
in the Data view. You can select a Chart page in the Chart Gallery, or 
you can choose to plot the chart in a new page, a Chart page already 
containing charts or other objects, or a page using a Smart Layout. 
You can also use the Chart Advisor to assist you in selecting a chart 
for the type of data selected. 

To create a chart in the Data view, do the following: 

1.  If the Data view is not displayed, click the Data View icon on 
the Command bar. 

2.  Enter data in the Data view. Numerical data can be imported 
from tab-, comma-, space-, and custom-delimited text or WKS, 
SYLK, and Excel for- mats. If you prefer, you may type or 
paste data in the Data page. 

3.  Select the data that you want to plot. 

4.  Choose Chart Gallery from the Data  menu, or press cmd-G. The  
“Chart Setup” dialog box appears with the Gallery tab selected. 

5.  Select a chart type and destination window. See “Setting Up a 
Chart” in chapter 8 for more information. 

6.  Click OK. The chart appears in the upper left corner of the selected 
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Chart page. You can position the chart and add any Text or Draw 
objects as necessary. 

If a Smart Layout has been applied to the page and contains a 
Chart place- holder, the chart appears in the size, position, and 
colors of the placeholder. 

All changes to the new or existing Chart page can be seen in the 
Outliner view. 

To learn more about... Refer to... 

Entering data in the Data view “Entering Data” in chapter 4 

Selecting data “Selecting Data” in chapter 4 

Creating a Chart in the Chart View 
Charts can be plotted in the Chart view. The Chart Advisor, 
however, cannot be used when plotting charts from this view. 

If you are using Smart Layouts, you can double-click the Chart 
placeholder to display the “Chart Setup” dialog box. 

Bullet charts can be created in the Chart view only if a layout has 
been applied to the Chart page. You can edit Text and Bullet objects 
created in the Outliner view by clicking the object and making your 
corrections. When adding entries to a Bullet chart, you can press tab 
and shift+tab to adjust the hierarchy. “Edit Bullets” from the Text 
menu can also be used to change the bullet symbol, text and level 
spacing, tabs, and margins of the Bullet object. 

To create a chart in the Chart view, do the following: 

1.  Create a new Chart page by clicking the Chart View icon on the 
Command bar and clicking the plus page icon. An empty Chart 
page is displayed. You can also select any other existing pages in 
the list. 

2.  Click the Chart icon on the Command bar, choose Chart 
Gallery from the Data menu, or press cmd-G. The “Chart 
Setup” dialog box appears. 

3.  Select a chart type and destination window in the Gallery tab. The 
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default destination window is the current Chart page. See “Setting 
Up a Chart” in chapter 8 for information on the other options 
available in this dialog box. 

4.  Click OK. The Data 
view appears. 

5.  Enter data in the Data view. Numerical data can be imported 
from tab-, comma-, space-, and custom-delimited text or WKS, 
SYLK, and Excel for- mats. (See “Entering Data” in chapter  
4.) 

6.  Select the data that you want to plot and click Plot. The chart 
appears in the upper left corner of the original Chart page. You 
can position the chart and add any Text or Draw objects as 
necessary. (See Chapter 12, “Working with Objects in Chart 
View.”) 

All changes to the new or existing Chart page can be seen in the 
Outliner view. 

To learn more about... Refer to... 

Layouts “Creating and Using Smart Layouts” 
in chapter 5 

	
  

Deleting a Chart 
There may be times you want to delete one or more charts from a 
Chart page. There are several ways to do this. You can undo any 
deletions using “Undo” from the Edit menu or by pressing cmd-Z. 

To delete one or more charts, do the following: 

1.  Select the chart(s). 

2.  Choose Cut or Clear from the Edit menu, or press the delete key. 
The “Cut” command stores a copy of the deleted chart(s) on the 
clipboard so it can be pasted in a Chart page. “Clear” and the delete 
key do not. 
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NOTE ☞  Deleting a chart does not remove the Chart page. See “Deleting a 
Chart Page” in chapter 8 

3.  To empty a Chart page so you can reuse it, choose Select All 
(cmd-A) from the Edit menu and press the delete key, or choose 
Cut (cmd-X) or Clear from the Edit menu. “Cut” places a copy of 
the select object(s) on the Clipboard; the other options do not. 

Creating or Adding a Chart Page 
DeltaGraph creates a new Chart page every time you plot a chart 
unless you choose to plot in an existing Chart page in the Chart 
Gallery. There may be times, however, when you will want to create 
a Chart page without plotting a chart; for example, if you want to 
input data directly in the Chart page using a Smart Layout, or import 
a graphic to store in a Custom Library for convenient access from any 
Chart page. 

There are three ways to create an empty Chart 
page, as follows: 

1.  Click the Add Page icon at the bottom of the 
Chart page. 

2.  Click and hold the Chart View icon on the Command bar and select 
New Page from the pop-up menu. 

3.  Choose Chart View from the View menu and select New Page 
from the submenu. The empty page appears with a default name 
(Page #1, Page #2, etc.) displayed in the Page Selector. 

Displaying a Chart Page 
Do one of the following to view a list of available Chart pages 
and to switch between Chart pages: 

1.  Click the Page Selector icon on the Navigational bar. A list of 
available Chart pages appears in the pop-up menu. 

2.  Click and hold the Chart View icon on the Command bar. A list of 
available Chart pages appears in the pop-up menu. 
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3.  In the Chart Gallery, you can plot a chart in any page in the active 
document by selecting a page from the “Plot In” pop-up menu. 

Naming a Chart Page 
To help you keep track of the Chart pages in a document, DeltaGraph 
automatically assigns the default names “Page #1,” “Page #2,” and so 
forth. You can assign your own names to Chart pages to help identify 
their contents. All the Chart pages associated with a document can be 
displayed in the “Plot In” pop-up menu at the bottom of the Chart 
Gallery, by clicking and holding the Chart view icon on the 
Command bar, or by clicking and holding the Page Selector icon at 
the bottom of the page. 

To name a Chart page, do the following: 

1.  Choose Name Page from the View menu. The “Page Title” 
dialog box appears with the default name selected. 

2.  Enter a new name. The new name overwrites the default name. 

3.  Click OK to rename the Chart page. The new name replaces the 
old name. You can see the new name in the Page Selector at the 
bottom of the page. To exit the dialog box without making any 
changes, click Cancel. 

Deleting a Chart Page 
If you want to delete a Chart page, you can use the “Delete Page” 
command on the View menu. This deletes the Chart page and all 
objects on the Chart page. You can delete multiple Chart pages in the 
Organizer view. 

To delete the active Chart page, do the following: 

1.  Choose Delete Page from the View menu. A dialog box appears 
asking to con- firm your selection. 

2.  Click OK to delete the Chart page. To exit the dialog box 
without making any changes, click Cancel. 
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To learn more about... Refer to... 

Deleting multiple Chart pages “Deleting Pages” in chapter 15 

	
  

Creating a Combination Chart 
DeltaGraph gives you the option of combining two different types of 
numeric charts (plotted from the same Data page) so you can 
highlight relationships. For example, you can overlay a Line chart 
that represents corporate expenses on a Column chart that represents 
revenues to create a combination chart that clearly illustrates what 
percentage of your income is eaten up by expenses. 

There are two parts to a combination chart. The first part is the base 
chart, which is the main chart type selected in the Chart Gallery when 
you first create a chart. The second part is the overlay chart. This is 
the chart type that you apply to your base chart using the “Overlay” 
command on the Chart menu. The data graphics of the overlay chart 
always go on top of the base chart. 

Column, Stacked Column, Bar, Stacked Bar, Line, Step, Area, XY 
Line, Paired XY Line, Scatter, and Paired Scatter charts can all be used 
as a base. 

Not all chart types can be used for combination charts. 3-D charts and 
non-rectangular 2-D charts do not work. A chart with values on both 
axes can only be over- laid with a chart that also has values on the X 
and Y axes. Overlay options that are not available or compatible are 
dimmed in the “Overlay” dialog box. Column, Stacked Column, Bar, 
Stacked Bar, Line, Step, and Area charts can be used together. XY 
Line, Paired XY Line, Scatter, and Paired Scatter charts can be used 
together. 

The overlay chart uses data that is already part of the base chart. This 
means that when creating a base chart to which you later add an 
overlay, you must first select all of the data that you want to appear in 
the final chart. This includes the data for both the base chart and the 
overlay chart. Refer to the figure in chapter 8 for an example of an 
overlay chart. 

NOTE ☞  If your chart does not include all of the data you want, use the 
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Revise Data command to add more data to the chart. This works 
both before and after you add an overlay. 

To create a combination chart, do the following: 

1.  Open the Data page that contains the data you need for your 
combination chart. 

You can also create the chart in the Chart view or use Smart 
Layouts as previously described. 

Only Column, Stacked Column, Bar, Stacked Bar, Line, Step, 
Area, XY Line, Paired XY Line, Scatter, and Paired Scatter 
charts can be used in combination charts. 

2.  Select the data you want plot. To add an overlay to a chart you 
must have two or more series of data. 

3.  Click the Plot icon on the Command bar, choose Chart Gallery 
from the Chart menu, or press cmd-G. The “Chart Setup” dialog 
box appears. 

4.  Choose the chart type you want as your base, or underlying, chart 
and the Chart page where you want it to be plotted. 

5.  Click OK to plot the chart as directed. The chart is automatically 
sent to a new Chart page unless you selected an existing Chart 
page from the pop-up menu in the “Plot Options” section of the 
dialog box. Click Cancel  if you do not want to plot the chart, and 
you are returned to the Data view. 

6.  Select the base chart and choose Overlay from the Chart menu. 
A dialog box appears so you can select a chart type and other 
parameters for your overlay chart. 
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7.  Click the Category pop-up menu in the “Choose Overlay Chart 
Type” section and choose a chart type for the overlay. 

8.  In the “Series Selection” area of the dialog box, select the first 
series you want to use in the overlay chart by typing in a number 
or clicking the direction arrows to scroll to the series you want. 
Only data that was selected to plot the base chart is available. 

The series number you pick and all data series that follow are 
assigned to the overlay chart. For example, if you have five data 
series in your chart and you choose series 3 as the first series in 
your overlay chart, the third, fourth, and fifth series are displayed 
in the overlay chart, and the first and second series are displayed 
in the base chart. 

The “Auto” check box automatically selects a number of series 
based on the total number selected. 

9.  To place the axis labels on an additional axis on your chart, click 
the appropriate check box in the “Display Additional Axes” 
section. If you are working with chart types that have values on 
both the horizontal (X) and vertical (Y) axes, your choices are “X 
Axis” and “Y Axis.” 

10. Click Show to preview your changes without exiting the dialog 
box. This makes it easy to experiment with different effects. You 
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can move the dialog box out of the way by dragging the title bar. 

11. When you have the results you want, click OK to implement 
the changes. To exit the dialog box without changing the chart, 
click Cancel. 

After you have created a combination chart, the “Options” command 
in the Chart menu has a submenu so you can choose to change 
options for the base chart or the overlay chart. 

Creating a Double-Axis Chart 
	
  

In conjunction with the overlay feature, DeltaGraph also makes it 
possible to display additional axes on your charts. You can add a 
second horizontal (X) and/or vertical (Y) axis to your 2-D charts. 
These additional axes can be formatted independently of the original 
axes. 

You can add an additional axis to a chart that does not include an 
overlay. For example, in a large chart, you may want to show your Y 
or X axis labels twice to increase the chart’s readability. If you have 
widely disparate data sets, you may choose to display additional axes 
to make the data easier to read. You do not need to overlay a 
different chart type simply to display an additional axis. 

In most cases, however, you will probably add a second axis in 
conjunction with an overlay so that data sets are differentiated by 
both axis scales and chart types. 

To create a chart with two independent axes, do the following: 

1.  Select the chart. 

2.  Following the steps in “Creating a Combination Chart” in chapter 
8, create an overlay so that at least one series of data is part of an 
overlay. Typically, this data would be in a different range of 
values from the data in the base chart. 

3.  While in the “Overlay” dialog box, select which additional axis 
you want by clicking the appropriate check boxes in the “Display 
Additional Axes” section. 
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4.  Click Show to preview your changes without exiting the dialog 
box. This makes it easy to experiment with different effects. You 
can move the dialog box out of the way by dragging the title bar. 

5.  When you have the results you want, click OK to implement the 
changes. Additional axes are created. Value axes are automatically 
scaled to fit the data that is part of the overlay. To exit the dialog 
box without changing the chart, click Cancel. 

 

When a second X or Y axis is added to a chart it is also added to the 
submenus that appear when you select Axis, Ticks and Grids, or 
Labels from the Chart menu. This allows you to format the additional 
axis independent of the original axis. 

Creating a Histogram 
Histograms are used to show frequency or occurrence of data. Data 
for histograms can be created using the “Formula Builder” command 
on the Data menu. This method can be used for creating Histogram 
charts if plotting a standard Delta- Graph Histogram chart in the 
Chart Gallery does not provide the flexibility or type of histogram 
you desire. 

To create a histogram using the Formula Builder, do the following: 
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1.  Enter the raw data in the Data page as described in “Entering Data” 
in chapter 4. 

 

2.  Set up your bins in an empty column. In the example above, you 
would not want to plot a histogram reflecting each unique 
number, so you would set up bins, or ranges that the numbers will 
fall within, in column B. You do not have to set up bins if it is not 
necessary for your data. 

In the example, the lowest number in column A is 3, so you 
would start with 5 as the lowest bin and increase by 5. You can 
enter the bin numbers in column B as shown. Every number from 
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column A that is less than 5 will be counted in the first bin, 
numbers between 5–9 will fall in the second bin, etc. 

 

3.  Double-click an empty column (e.g., column C in the example), 
select an empty column and click the Formula Builder icon on the 
Command bar, or choose Formula Builder from the Data menu. 
This selects the empty column as your destination column. The 
“Formula Builder” dialog box is displayed. 
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4.  Scroll through the “Functions” window until “FreqL” is displayed. 

5.  Double-click FreqL. The formula shell appears in the “Formula” 
window, with the cursor blinking inside the parentheses. An 
explanation of the function appears directly above the “Formula” 
window. FreqL (Frequency Labels) pro- vides labels for the 
calculations that will be performed. 

6.  You can either type the column labels (e.g., “A,B”) in the 
parentheses or double-click the column labels in the “Source 
Columns” window. The columns must be separated by a comma. 

7.  Click Calculate Now. The calculations appear in the destination 
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column. These are used as labels when you plot the histogram. 

8.  Click Next Col. This selects the next empty column as the new 
destination column for the next calculation. The column name 
appears at the bottom of the dialog box. 

9.  Double-click Freq in the “Functions” window. 

10. Enter the column labels in the parentheses. 

11. Click OK. The frequency of the data in the first source column 
(A), sorted into the bins defined in the second source column (B), 
is displayed in the destination column. 

The first destination column (C) displays the labels for your chart. 
DeltaGraph uses “[” and “)” when generating the labels. [10,15) 
means “greater than or equal to 10 but less than 15.” 

 

12. Change, enter, or delete labels as necessary. You can also enter 
column labels at the tops of the columns if desired. 
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13. Select the labels and the calculated data in the two destination 
columns (C and D). 

14. Click the Plot icon on the Command bar, select a Column chart 
from the Chart Gallery, and click OK. The chart is displayed in the 
Chart view. It can be modified using the same options available to 
other DeltaGraph charts. 

 

	
  

To learn more about... Refer to... 

Histogram charts “Histogram Chart” in chapter 7 
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Plotting Multiple Charts in the Same Page 
There may be times you want to plot more than one chart in a Chart 
page. This can be an effective way to show side-by-side comparison, 
for example. You can also use this feature to replace a chart that has 
been deleted in the Chart view. 

Since a Chart page can contain any combination of charts and/or 
objects, all you need to do when plotting a new chart is select an 
existing Chart page from the pop- up menu to “Plot In” near the 
bottom of the Chart Gallery. See “The Chart Gallery” in chapter 8 if 
you need help with this. If you need more pages to display the charts, 
choose Number of Pages from the Page menu so you can click to 
select the number of pages you need in the dialog box that appears. 

To plot multiple charts, do the following: 

1.  Switch to the Data page that contains the data you want to plot. 

If you want to plot directly from the active Chart page, start at 
step 3. You can disregard step 5 because the chart will 
automatically be plotted in the active Chart page. 

2.  Select the data you want to include in your chart. 

3.  Click the Plot icon on the Command bar, choose Chart Gallery 
from the Chart menu, or press cmd-G. The “Chart Setup” 
dialog box appears. 

4.  Click a chart type in the Gallery tab. The selected chart is 
highlighted. 

5.  Click the “Plot In” pop-up menu and select an existing Chart page. 

6.  Click OK to add the new chart to the selected Chart page. To exit 
the dialog box without making any changes, click Cancel. 

If you need more pages to display the charts, choose Number of 
Pages from the Page menu. When the dialog box appears, click the 
grid to select additional pages. 

Changing the Chart Type 
After plotting a chart you may realize that a different type of chart 
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would be more appropriate for your data. There are two ways to 
change the type of chart: replot the data in the Data view, or use 
“Change Type” on the Chart menu. 

Certain chart types are incompatible and cannot be interchanged. As 
explained in Chapter 8, “Chart Types,” the data for some charts is set 
up differently than it is for others. Charts must have the same data 
configuration, and they must be of the same general type (2-D, 3-D or 
Text) to be interchangeable. Incompatible chart types are dimmed in 
the “Change Chart Type” dialog box so that you cannot select them. 

This option can also be used to abandon changes to a chart that does 
not come out the way you planned. “Change Type” allows you to 
reselect the same chart type with its original defaults, whereas 
selecting a different chart type retains all your formatting. 

To change the chart type, do the following: 

1.  Select the chart. 

2.  Choose Change Type from the Chart menu. The “Change 
Chart Type” dialog box appears with a picture of the selected 
chart in the “Example” box. 

3.  Choose a chart type from the “Category” pop-up menu. 

4.  Select the following option if applicable: 

Keep Size & Rotation 

Maintains any size or rotation changes made to the existing chart. 
This option is only available if you are selecting the same chart 
type or selecting a chart from a Custom Library. 

5.  Click Change to change the chart type. To exit the dialog box 
without changing the chart, click Cancel. 

Updating a Chart 
The Update icon on the Command bar or the “Update” command in 
the Data menu can be selected in the Data view when you want to 
update all charts associated with any changed pages in the Data view. 
“Update” is also used if you are changing existing data but not adding 
any data points or sets to the existing Data page. 
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To add or remove data from a chart or to update only one chart, see 
“Revising Chart Data” in chapter 8 

NOTE ☞  If you have turned on “Update Charts Automatically” in 
Preferences, you do not need to use the “Update” command. Any 
changes in the data will be reflected immediately in associated 
charts. Bear in mind, however, that you must use the 

“Revise Data” command if you want to add or remove rows or 
columns of data from a chart’s data range. 

To update all charts associated with a page, do the following: 

1.  Make changes to the data in the Data view. Changes can be 
entered manually in the Data page. Changes can also be imported 
or generated with calculations applied using the “Formula 
Builder” command. 

2.  Click the Update icon on the Command bar, choose Update from 
the Data menu, or press cmd-=. DeltaGraph automatically updates 
all associated charts without replotting the data. 

NOTE ☞  If you use “Check Spelling” from the Edit menu to correct 
misspellings in one or more Data pages, DeltaGraph automatically 
displays a dialog box asking if you want to update any associated 
charts. 

Revising Chart Data 
Use the Revise Data icon on the Chart view Command bar or the 
“Revise Data” command on the Chart menu when you want to update 
only the selected chart. 

Revising is for when you want to add, remove, edit, or rearrange the 
data without affecting every chart generated from the data. This 
makes it simple to select different data sets for a chart, add new series, 
categories, or data points to a chart, or do comparisons of different 
segments of your data. 

To update one chart only, do the following: 

1.  Select the chart you want to change. 
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2.  Click the Revise Data icon on the Chart view Command bar, choose 
Revise Data from the Chart menu, or press cmd-, (comma). If the 
chart is not selected, the computer beeps to remind you. 

DeltaGraph returns to the originating page in the Data view and 
displays a floating window in the lower-left corner to notify you 
that you are in the Revise Data mode. The existing data range for 
the chart you selected is high- lighted. 

 

You can drag the floating window’s Title bar to move it away 
from your viewing area. 

3.  Select the new data range. 

When you are in the Revise Data mode, many other Data view 
features are active and available to you. You can enter or import 
new data, create a link to an Excel file, change the hierarchy of 
entries, switch to another page, or use the “Formula Builder” 
command to create new data. While in the Revise Data mode, you 
cannot plot a new chart or delete the current chart. 

To add to the current data selection, hold down the command 
key, and select the additional data. To select a new range of data, 
deselect the current data by clicking in any cell, and then select a 
new range. You can select by column, row, or individual cells. 

4.  Click Titles in the floating window to assign axis titles. 

Refer to “Creating Chart Axis Titles” in chapter 8 for information 
on assigning axis titles to data cells. 

5.  When you have selected the new data, click Revise in the floating 
window. 

Your new data selection is applied to the selected chart only 
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and you are returned to the Chart view. 

If you decide not to make any changes to your data selection, 
click Cancel in the floating window to exit the Revise Data mode 
and return to the Chart view. 

Using the Internal Command Language 
(ICL) 

DeltaGraph’s use of the Internal Command Language lets you 
automate chart creation from another application or text string. Using 
programs such as Hyper- Card™, SuperCard™, Microsoft Excel, 
Microsoft Word, Lotus 1-2-3, or any other application that can 
generate a text string and send it to the clipboard, you can create 
Command Scripts that automatically bring in data, create charts, and 
copy them to the clipboard for transfer back to the original 
application. 

Creating Command Script Formats 
A Command Script is written in one of the programs described 
above. An example Command Script is shown below. There are three 
basic elements to each Command Script: header, command list, and 
data. 

 

The Header and the Command List are always on the same line of text 
with no carriage returns. The total length of all parameters in the 
Header and the Command List cannot be greater than 255 characters. 
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The Command List is ended by a carriage return. The next line and 
all following lines of text make up the data to be used in creating the 
chart. 

	
  

ICL 
Command 
Script 
Elements 

 

Command Description 

	
  

Header 

Tells DeltaGraph that a command script follows. 
“DGRH” is the four-character Header and must 
be used at the beginning of every script. The 
Header is followed by a semi-colon (;) to separate 
it from the Command List. 

	
  

Command List 

Lists the chart type and formatting options 
available for the creation and formatting of the 
chart. Each of the individual commands must be 
separated by a semi-colon. The Command List 
does not need to be in any particular order. Refer 
to the table above for examples of individual 
commands. 

	
  

Data 
The Data must be in tab-delimited form with a 
carriage return at the end of each line of text. The 
chart will use the data just as it would if it were 
in the Data view. Any Series axis labels should 
appear in the first line of data. Any Category axis 
labels should appear in the first column of data. 

	
  

Using Command List Options 
There are two types of commands in the Internal Command 
Language. Some require you to enter a parameter and others only 
require the command name. Commands requiring you to enter a 
parameter have an equal sign (=) immediately after them. All 
commands except the Chart command are optional. If an available 
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command is not used in the script, the default chart setting is used 
when creating the chart. Also, if a command or parameter is 
misspelled, it is ignored. Commands are not case-sensitive. 

	
  

ICL Command List 
Options 

 

Command Description 

	
  

chart=chartname 

Describes what type of chart you want the script to build. 
You can choose any DeltaGraph chart name or any chart 
from a Custom Library. 

Spelling must be exact. For 3-D charts, the name must 
include the dash between the “3” and the “D” and a 
space after the “D.” 

	
  

Example: chart=3-D Column 

	
  

w=integer	
  

Describes the width of the plot frame for 2-D charts and 
the width of the X and Y axes in 3-D charts. Width is 
measured in points (1 point is equal to 1/72 of an inch). 
The parameter entered can be any integer between 1 and 
32767. 

Example: w=350 
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h=integer	
  

Describes the height of the plot frame in 2-D charts and 
the height of the Z axis in 3-D charts. Height is 
measured in points (1 point is equal to 1/72 of an inch). 
The parameter entered can be any integer between 1 and 
32767. 

Example: h=225 

	
  

font=fontname	
  

Describes the font you want used in your chart. You can 
use any font available in the Font menu. This entry will 
be overridden if a Custom Library chart is used in 
“chart” above. 

Example: font=Times 

	
  

size=fontsize	
  

Describes the font size for the text in your chart. You 
can enter any integer between 3 and 127. This entry will 
be overridden if a Custom Library chart is used in 
“chart” above. 

Example: size=18 

	
  

library=libraryfilename	
  

Describes the Custom Library name you want to open. 
The library must be in the same folder or directory as 
DeltaGraph. The named library will not open if there are 
already four Custom Libraries open (any auto-loaded 
libraries are opened first). 

 

Example: WRI Sales Library 

color	
   Tells DeltaGraph to draw the chart using color defaults. 

quit	
   Tells DeltaGraph to quit after building the chart. 

	
  

To create an ICL script, do the following: 

1.  Attach the Header and Command List to your tab-delimited data as 
shown in “Creating Command Script Formats” in chapter 8 
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2.  Copy the Command Script. 

3.  If it is not already open, open DeltaGraph. 

If the “quit” command is used, the chart is placed on the clipboard and Delta- Graph is 
closed. If the “quit” command is not used, the new chart appears in the Chart view.
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9  Customizing Charts 
This chapter describes ways you can increase the impact and 
legibility of your DeltaGraph charts by using commands from the 
Chart menu to modify individual chart elements. You can also use 
the tools in the Toolbox and commands on the Text menu to change 
the colors, patterns, line widths, and text attributes for an entire chart 
or selected elements. 

This chapter covers the following information: 

• Selecting a chart and chart elements 

• Creating chart color schemes 

• Changing the appearance of a chart’s axes 

• Formatting chart text 

• Adding axis titles to a chart 

• Changing the placement of axis labels and titles 

• Adding value labels to data graphics 

• Changing the shape, color, and size of chart symbols 

• Showing and hiding chart grids 

• Changing the direction and length of tick marks 

• Changing the viewing angle of 3-D charts 

• Adding depth to 2-D charts 

To learn more about... Refer to... 

Modifying data in numeric 
charts 

Chapter 4, “Organizing Data in the 
Data View” 

Other ways to modify charts Chapter 10, “Changing Chart Options” 
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To learn more about... Refer to... 

Adding error bars and curve 
fits 

Chapter 12, “Adding Error Bars and 
Curve Fits” 

Modifying chart lines, colors, 
and fills 

“Changing the Attributes of a Draw, 
Text, or 

Chart Object” in chapter 11 

Importing graphics Chapter 13, “Importing and Exporting 
Graphics” 

 

Selecting a Chart and Chart Elements 
Before you can move, resize, or modify a chart, you must select it. 
To change the colors, patterns, line widths, or text attributes of 
individual chart elements, you must select the element. When 
initially plotted, charts are automatically selected so that you can 
have immediate access to the appropriate commands. 

Although the legend and all labels are part of the chart, any one of 
them can be moved independently of the chart and the other elements 
if selected separately as a chart element. The legend can also be 
resized separately. 

To select a chart, do the following: 

1.  Display the appropriate Chart page by clicking the Chart View icon 
on the Command bar and selecting a page from the pop-up menu. 

2.  Click the Pointer tool in the Toolbox if it is not already selected. 

3.  Click anywhere on the chart you want to select. Object handles 
(small squares) appear in the four corners of the chart to show it is 
selected. Axis resizing handles (large squares) also appear. 2-D 
charts have two axis resizing handles. 3-D charts have three axis 
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handles (see the figure below). 

Any changes you make at this point to line widths, text attributes, 
patterns, or color will affect the entire chart. If you want to 
modify individual elements only, you must select them 
separately. 

When the chart is selected, you can move it by placing the pointer 
in the chart and dragging it to a new location. 

 

To select a chart element, do the following: 

1.  Make sure the whole chart is selected. 

2.  Click the chart element you want to select. (To select the legend, 
click its border.) Small circles appear to show that the element is 
selected (see the figure above). If the chart element you select is 
part of a group, such as axis labels, tick marks, legend text, or 
legend/data graphics, the whole group is selected. 

3.  To select only one element in a group, click again on the element. 
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4.  To select multiple chart elements, hold down the command key 
when you click to select each element. 

You can select the following chart elements: 

• whole chart 

• labels on an entire axis or a single label 

• legend, all legend labels, or a single legend label 

• a single legend graphic, with or without corresponding data 
graphics (bar, line, and so on)* 

• a data graphic series (with corresponding legend graphic) or a 
single data graphic* 

• an axis, axis grids, or axis tick marks 

• chart back planes 

• bottom or top depth plane or side depth plane (2-D charts) 

• tops of data graphic series or a single data graphic* (3-D charts) 

• right sides of data graphic series or a single data graphic* (3-D 
charts and 2-D 

charts with depth added) 

• left sides of data graphic series or a single data graphic* (3-D 
charts) 

* When a data graphic is selected, the lines defining the graphic are 
also selected. To change the fill color or pattern, use the Fill palette. 
To change the line width, use the Line Width palette. To change the 
line color or pattern, use the Line palette. 

To learn more about... Refer to... 

Moving and resizing charts “Moving and Resizing Objects” in 
chapter 11 
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Opening Dialog Boxes 
Many of the dialog boxes described in this chapter can be 
displayed one of two ways: 

• Double-click chart elements to display various dialog boxes 
(“Double-click on Charts” must be selected in Preferences; see 
“Setting Chart View Defaults” in chapter 6). 

• Click and hold the mouse while holding the control key to display 
a pop-up menu of options available on the Chart menu. 

General chart attributes such as text and colors can be changed by 
clicking the chart while pressing the control key. You can select the 
entire chart or an individual element. The “Object Attributes” dialog 
box is displayed 

.  

The options available in this dialog box work similarly to the 
tools, palettes, and commands available in DeltaGraph. This 
dialog box allows you to change a variety of attributes at the same 
time. 
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To learn more about... Refer to... 

Using Control-click or right 
mouse button 

“Changing Attributes” in chapter 11 

	
  

Color Schemes 
A Color Scheme allows you to choose colors for ticks and grids, text 
shadows, chart labels, text, axis titles, page titles, backgrounds, 
bullets, data series, and so on, all at the same time. You can load an 
existing Color Scheme, edit a Color Scheme, or save a new Color 
Scheme. You can add DeltaGraph system colors or digital 
simulations of  colors to a Color Scheme. 

If “Scheme” is selected as the color default in the Preferences, 
General tab (see “Setting General Defaults” in chapter 6) and a 
Color Scheme is loaded, all charts in the active document use the 
colors in the scheme. If “Scheme” is not selected, you can manually 
apply scheme colors as you would any other color. 

A loaded Color Scheme appears at the bottom of the DeltaGraph color 
palette, and, if you created a custom color palette, it appears just 
above the Color Scheme palette. Color Schemes are also stored in 
Layout Sets. When you load a Layout Set in the current document, 
you have the option of using the Color Scheme included with the set. 
If you open a new Color Scheme or change the existing scheme, all 
objects in the current document reflect the changes. You can also 
override the Color Scheme palette selections by manually changing 
objects or elements to non- scheme colors. 

Multiple open documents can have separate Color Schemes. If the 
current document has a Color Scheme, a Layout Set saved for the 
document will be saved with the document’s Color Scheme. 

Loading a Color Scheme 
You can load a Color Scheme in the active document to apply the 
colors in the Color Scheme to all objects and elements in the charts in 
the document. When you load a new Color Scheme palette, it replaces 
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the existing palette, changing the colors in all objects in the active 
document. If multiple documents are open, the Color Scheme only 
applies to the active document. 

To load a Color Scheme, do the following: 

1.  Choose Colors from the Edit menu. The “Color Set” dialog box 
appears with the Scheme tab selected. 

 

2.  Click Load. A standard “Open” dialog box appears. Only Color 
Scheme palettes appear in the dialog box. 

3.  Select a Color Scheme palette from the dialog box and click 
Open. The palette appears in the Scheme tab. You can edit the 
colors as necessary (refer to the next section). 

4.  Click OK to load the Color Scheme in the active document. 
Colors in the selected palette are applied to all objects and 
charts in the document. 

Editing or Creating a Color Scheme 
You can edit the Color Scheme that is loaded in the active document, 
or you can create a new Color Scheme by editing an existing Color 
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Scheme and saving it with a new name. To edit or create a new Color 
Scheme, do the following. 

1. Choose Colors from the Edit menu. The “Color Set” dialog 
box appears with the Scheme tab selected. 

 

The Color Scheme for the active document is displayed. You can 
edit it, or you can load a different Color Scheme to edit (refer to 
“Loading a Color Scheme” in chapter 9). 

2.  Select from the following options to edit the Color Scheme: 

Choose Item to Edit 

Displays the available objects and Chart elements and the 
colors assigned to them in the Color Scheme palette. Click the 
item whose color you want to edit. The selected colors are 
applied to each item as described below. 

Highlight 

Not applied automatically, can be manually applied to a 
selected object. 

Grid/Tick/Axis 
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Determines the color of all axis ticks and grids on numerical 
charts. 

Text Shadow 

Not applied automatically, can be manually applied to a 
selected object. 

Chart Labels 

Determines the color of all axis labels on numerical charts. 

Bullet Text 

Determines the color of text in a Bullet chart. 

Axis Title 

Determines the color of all axis titles on numerical charts. 

Page Title 

Determines the color of text contained in  a Title placeholder 
in a Smart Layout. 

Background 

Determines the color of the Master Background rectangle 
element. 

Bullet 

Determines the color of bullets in a Bullet chart. 

Text 

Determines the color of text contained in a Text placeholder 
in a Smart Layout. 

Data Series 

Determines the color of up to six data series elements in 
numerical charts. 

Color Model 

Shows the color model of the selected color, 



 
  DeltaGraph for Macintosh Version 7 User Guide 308 

as follows: 

RGB 

Shows the percentages of red, green, and blue. 

CMY 

Shows the percentages of cyan, magenta, and yellow. 

CMYK 

Shows the percentages of the four process colors: cyan, 
magenta, yellow, and black. 

HSL 

Shows the percentages of hue, saturation, and light. 

3.  Click System Colors or Swatches to select a new color for the 
selected item, as follows: 

System Colors 

 

To select a DeltaGraph system color, click System Colors, and the 
“Colors” dialog box is displayed. 
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Display colors using one of the five options at the top of the box, as 
follows: 

•  Color Wheel (shown in the image) 

•  Color Sliders 

•  Color Palettes 

•  Image Palettes 

•  Crayons 

Move the pointer over an icon to display a message that describes 
its function. You can use any of the methods to select a color. For 
example, to use the Color Wheel method, click a location in the 
color wheel to select a color. Change it by clicking a different 
location. Click OK to apply the color. 

Colors from a swatch file 

To select a color from a swatch, click Swatches, and the “Color 
Books” dialog box is displayed. 
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Click a color to select it. 

4.  To save the changes to the loaded Color Scheme, click Save to 
open a “Save” dialog box, select the name of the Color Scheme, 
and click Save to save the Color Scheme and return to the 
“Color Set” dialog box. 

To save the edited Color Scheme with a new name (to create a 
new Color Scheme), click Save to open the “Save” dialog box. 
Enter a name for the new Color Scheme, and click Save to 
return to the “Color Set” dialog box. 

NOTE ☞  To apply the edited Color Scheme to the active document 
without saving the changes, do not click Save. 

	
  

5.  Click OK to apply the Color Scheme and return to the Chart view. 
The new colors are applied to all objects and charts in the active 
document. To exit the dialog box without applying the new Color 
Scheme, click Cancel. 
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If you saved the edited Color Scheme, you can load it in any 
document. To do so, select Colors from the Edit menu to open the 
“Color Set” dialog box, click Load, and select the Color Scheme. 

	
  

To learn more about... Refer to... 

Creating custom colors “Working with Custom Colors” in chapter 
11 

Setting preferences Chapter 6, “Setting Preferences” 

Loading a Layout Set “Loading a Layout Set” in chapter 5 
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Reformatting a Chart’s Axes 
A chart’s axes are the lines creating the frame of the chart. They are 
marked at each end by axis resizing handles (large squares), which 
appear when you select the chart. 3-D charts have three axes: an X, 
Y, and a Z axis (see the figure below). 2-D charts have only two axes: 
an X and a Y. The function and the name of each axis varies 
depending on the type of chart. 

 

Pie, Table, Time Line, Polar, Spider, Ternary, Organizational, and 
Bullet charts are unique in that some do not have axes 
(Organizational, Bullet, Pie, and Table charts), the axis names are 
unique to the chart type (Time Line, Spider, Ternary, and Polar 
charts), or the axes cannot be reformatted (Polar chart). 

For those charts containing axes, at least one of the axes is a Value 
axis. Most charts also have a Series and/or a Category axis, but some 
charts such as the Spider chart, may have two or more Value axes. 
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DeltaGraph creates the axes for each chart you plot according to the 
type of chart and basic parameters of the data. For example, it 
calculates a “correct” length for each axis, determines the best 
position for each axis and its components, and displays labels on 
each axis as appropriate. 

You can select the Axis icon on the extended Command bar or choose 
Axis from       the Chart menu to open a dialog box to change these 
and many other attributes of a chart’s axis. The “Set All” command 
on the Chart menu allows you to change more than one axis at a time. 

To learn more about... Refer to... 

Identifying the axes in a 
chart 

Chapter 7, “Chart Types” 

	
  

Changing the Value Axis 
DeltaGraph automatically computes appropriate values for the 
beginning and end of each Value axis and for the incremental 
placement of tick marks along the axis. These values are based on the 
range of data used to plot the chart. 

To change these values, and other attributes of the Value axis, click 
the Axis icon       on the extended Command bar, or choose Axis 
from the Chart menu, and select a 

Value axis from the submenu (axes listed by names such as “X 
Axis,” or “Z Axis” are always Value axes). This opens a dialog box 
with options and defaults specific to the chart selected. For charts 
with two or more Value axes, you must change each axis separately. 

The procedure is similar for changing the Value axes of both 2-D 
and 3-D charts. To change a Value axis, do the following: 

1.  Select the chart. 

2.  Click the Axis icon on the extended Command bar, choose Axis 
from the Chart             menu and select a Value axis from the 
submenu, or double-click the chart’s 

Value axis. The “Value Axis” dialog box is displayed. 
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NOTE ☞  If double-clicking does not bring up the dialog box, make sure 
“Double-click on Charts” is selected in the “Chart View” tab in 
Preferences. For information, refer to “Setting Chart View Defaults” 
in chapter 6. 

The options available depend on the chart type selected. The values 
displayed depend on the data used to plot the chart. 

3.  Make your selections and enter data as needed. Each “Value 
Axis” dialog box includes some of the following options: 

Axis Values 

Set the minimum/maximum values and the major/minor increments 
for marking them on the Value axis. Depending on the chart type 
selected, the mini- mum/maximum values appear at the 
“Bottom/Top,” “Inner/Outer,” or “Left/ Right” edges of the Value 
axis. You can type in new values to extend or shorten the axis. 

If you change any of the axis values, the corresponding “Auto” 
check box(es) and the “Automatic” check box on the right side 
become deselected. To automatically change an axis back to its 
default value, click the applicable “Auto” check box. To change 
all the axes back to their original values, select Automatic. 

Major Increment 

Sets the divisions for labels, major ticks, and major grids on the 
Value axis. Enter a value or click the direction arrows to scroll the 
options. 
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Minor Divisions 

Sets the divisions for minor ticks and grids on the Value axis. 
Enter a value or click the direction arrows to scroll the options. 

Reverse Order of Values 

Some charts allow you to flip them over on their Value (Y) axis so 
that the Category (X) axis appears at the top of the chart with the 
data flowing downwards. This option is also available on Value-
Value charts, such as Scatter charts. In these cases, the other axis 
placement is not affected. 

Axis Scaling 

Determines the axis-scaling algorithm. DeltaGraph automatically 
computes values for the three algorithms as described below, but 
you can enter new values in the “Axis Values” section of the dialog 
box. You have the following axis-scaling options: 

Linear 

Scales the chart based on graduated values computed from the 
data in the Data view. 

Automatic 

DeltaGraph automatically calculates appropriate incremental 
divisions for the axis, as well as minimum/maximum values. 
If you enter new values for any or all of the options under 
“Axis Values,” this option is deselected. To automatically 
reset all values to their default, re-select this option. 

Logarithmic 

Scales the chart based on powers of ten. This option does not 
apply to Stacked charts, Build-up charts, Ternary charts, High 
charts, Contour Line charts, Contour Fill charts, or Grid 
Vector charts. 

Range 

This option allows you to specify start and end values for axes 
that fall between the major increments while displaying the 
rest of the axis labels at normal increments. For example, the 
labels for a normal axis with a starting value of 2.4 and a 
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major increment of 5 would be 2.4, 7.4, 12.4, and so on. With 
this option, the axis labels would be 2.4, 5, 10, and so on. 

Date/Time 

Scales the chart based on units of time measurement, which is 
useful only if your data consists of dates or times. 

If you choose the “Date/Time” option, “Minor Divisions” 
(in the “Axis Values” section) changes to “Minor 
Increment.” You may also have to format your Value axis 
labels in the Chart view to reflect the times or dates you 
want to display. 

The “Major/Minor Units” pop-up menus offer the following 
options: 

 Seconds 

Minutes  

Hours  

Days  

Weeks  

Months  

Quarters  

Years 

Decades  

Centuries 

	
  

Automatic Axis Scaling 

Determines the start and end values of the axis based on the 
values of the data plotted. 

If “Standard” is selected, then the items in the “Axis Values” 
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section (Top/Left Value, Bottom/Right Value, Major Interval) 
will be changed so that zero is either on or between the top/left 
value and bottom/right value. “Floating” attempts to optimize 
any of the first values without requiring zero to lie between the 
extremes. “Automatic” needs to be selected in the “Axis 
Scaling” group box in order for “Standard” or “Floating” to 
operate. 

Axis Break 

Displays the “Axis Break” dialog box so you can break the 
value axis and customize its width, range of the break, and the 
symbols you want to use. See “Creating Axis Breaks” in 
chapter 9 

Axis Attributes 

Displays a dialog box so you can change the placement and 
length of the Value axis. 

The following dialog box appears when setting axis attributes 
for 2-D charts. 

 

	
   	
  

Axis Placement 

Determines the location of the selected Value axis. The 
available selections (Left/Right or Top/Bottom) depend on the 
type of chart selected and the orientation of the Value axis. In 
a chart consisting of two or more Value axes, this feature is 
particularly useful when plotting both positive and negative 
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numbers. 

Left 

Displays the selected Value axis on the left side 
of the chart. 

Right 

Displays the selected Value axis on the right side 
of the chart. 

Top 

Displays the selected Value axis at the top 
of the chart. 

Bottom 

Displays the selected Value axis at the bottom 
of the chart. 

On Category/On Value 

Controls the placement of the selected Value axis and 
its tick marks on the Category or Value axis grid. The 
placement of the Value axis labels does not change. 
You can enter the Category or Value axis grid number 
on which you want the selected Value axis to appear or 
click the direction arrows to scroll the options. 

	
  

Axis Length 

Determines the length of the Value axis and which measuring 
unit is used. 

Click the pop-up menu to choose from inches, centimeters, 
points, or picas. You can type in a new length or click the 
direction arrows to scroll the numbers in 36-point (half-inch) 
increments. 

Axis Offset 

You can use this group box to explode, or move an axis away 
from the chart. For more details on offsetting axes, see 
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“Changing Axis Offset” in chapter 9. 

The following dialog box appears when setting the axis attributes 
for 3-D charts. 

 

Axis Placement 

Controls where the Value axis intersects the Category axis. 
The placement of the Category labels does not change. You 
can enter the value on the Value axis at which you want the 
Category and Series axes to inter- sect it. On XYZ charts, you 
enter the value at which you want the perpendicular axis (or 
axes) to intersect the current Value axis. 

In a chart consisting of two or more Value axes, this feature 
is particularly useful when plotting both positive and 
negative numbers. 

Axis Length 

Determines the length of the Value axis and which measuring 
unit to use. 

Click the pop-up menu to choose from inches, centimeters, 
points, or picas. You can type in a new length or click the 
direction arrows to scroll the numbers in 36-point (half-inch) 
increments. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 
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5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

To learn more about... Refer to... 

Changing the angle axis of a 
Polar chart 

“Changing Axis Offset” in chapter 9 

	
  

Changing Category and Series Axes 
Many of the DeltaGraph defaults for Category and Series axes, 
including the number of labels showing, the order of the data series, 
and the length and location of the Category and Series axes in 2-D 
charts, are easily changed. Click the Axis icon on the extended 
Command bar, or choose Axis from the Chart menu and select the 
axis you want to change from the submenu. This opens a dialog box 
whose options and defaults are specific to the chart and axis selected. 
Remember, charts consisting of all Value axes do not have Category 
or Series axes. 

To change the Category and Series axes, do 
the following: 

1. Select a chart. 

2.  Click the Axis icon on the extended Command bar, choose Axis 
from the Chart             menu and select the axis you want to 
change from the submenu, or double click one of the chart’s axes. 
The “Category Axis” or “Series Axis” dialog box is displayed. 
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NOTE ☞  If double-clicking does not bring up the dialog box, make sure 
“Double-click on Charts” is selected in the “Chart View” tab in 
Preferences. For information, refer to “Setting Chart View Defaults” 
in chapter 6 

The options available depend on the chart type selected. The 
values displayed in each dialog box depend on the data used to 
plot the chart. The “3-D Series Axis” dialog boxes are set up in 
the same manner as the “3-D Category Axis” dialog boxes. 

 

3.  Make your selections and enter data as needed. Each dialog box 
includes some of the following options: 

Reverse Data Order 
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(Not for every chart) Reverses the order of the selected axis. Also 
shifts labels and ticks so that every data graphic, label, and tick 
falls on a major grid. 

Shift Ticks 

(Category charts only) Positions the Category axis ticks between 
the Category axis grid marks (rather than at the grid marks) 
centering them over the Category axis labels as shown below. 

 

Data Starts On Axis 

Puts the first data point on top of the Y-axis. 

Data Starts On Axis 

(Not for every chart) Extends the data graphics to the edges of the 
Category axis. 

Labels 

Controls at what interval the axis labels are displayed. For example, 
1 = show every axis label, 2 = show every other axis label, and so 
on. You can enter a label interval in the text box or click the 
direction arrows to scroll the options. 

Axis Placement 

(2-D charts only) Determines the location of the chart’s Category 
axis. The available selections (Left/Right or Top/Bottom) depend 
on the type of chart selected and the orientation of the Value axis. 

Left 
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The axis inserts at the left side of the chart. 

Right 

The axis inserts at the right side of the chart. 

Bottom 

The axis inserts at the bottom of the chart. 

Top 

The axis inserts at the top of the chart, creating “hanging data 
graphics.” 

On Value 

Controls the placement of the selected Category axis and tick 
marks on 

the Value axis grid. The placement of the Category axis 
labels does not change. You can enter the Value axis grid 
number on which you want the selected Category axis to 
appear or click the arrows to scroll the options. 

Axis Length 

Determines the length of the Category/Series axis and which 
measuring unit to use. Click the pop-up menu to choose from 
inches, centimeters, points, or picas. You can type in a new length 
or click the direction arrows to scroll the numbers in 36-point (half-
inch) increments. 

Axis Offset 

Allows you to move the Category axis a specified distance from the 
data and can be applied in inches, centimeters, picas, points, or 
ciceros. Setting a negative value places the axis inside the chart. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 
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Changing Axis Offset 
Changing axis offset applies to any two-dimensional charts that have 
value, category, overlay, or broken axes. This feature allows you to 
grab and drag an axis. Dragging is constrained to one direction. You 
can also specify axis offset in the axis options dialog box. This 
feature does not apply to Spider, Radar, Polar, Ternary, Pie, Multiple 
Pie, Stacked Pie, Time Line, Table, or 3-D charts. 

Axes on 2-D charts can be exploded, or moved some distance away 
from the chart, by dragging or by using axis options. 

To change axis offset by dragging, do the following: 

1.  Select a chart. 

2.  Click and hold an axis and drag it in the direction it is to be offset. 
Horizontal axes can only be dragged vertically. Vertical axes can 
only be dragged horizon- tally. An offset axis is shown in the 
figure below. 

 

NOTE ☞  When moving an axis, any items associated with the axis, such as 
ticks and axis labels, are moved as well. 

To specify axis offset using axis options, do the following: 
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1.  Select the chart, choose Axis from the Chart menu, and select an 
axis from the submenu. 

If you select a value axis, the “Value Axis” dialog box appears. If 
you select a category axis, the “Category Axis” dialog box 
appears. 

2.  For a Value axis, click the Axis Attributes button. In this dialog 
box there is an “Axis Offset” group, which allows you to offset 
the axis in inches, centimeters, points, picas, or ciceros. 

Both the Value dialog box and the Category dialog box allow 
you to specify the offset in 0.05 inch increments as the default. 

3.  Enter an offset setting as required. 

NOTE ☞   A positive offset is away from the axis, regardless of the orientation. 
When an axis is displayed on the opposite of its “natural” side, a 
positive offset is still away from the chart. 

Changing the Axes of a Polar Chart 
Polar charts have two axes: the Radius axis and the Angle axis. 
Changing the Radius axis is the same as changing the Value axis 
on a 2-D chart; refer in chapter 9 for information. 

The Angle axis of a Polar chart can also be modified. You can change 
the start and end points of the axis, whether the angle increases in a 
clockwise or counterclockwise direction, the number of tick marks on 
the axis, and several other axis-related attributes. 

To change the Angle axis of a Polar chart, do 
the following: 

1. Select a Polar chart. 

2.  Click the Axis icon on the extended Command bar, or choose 
Axis from the Chart menu and select Angle from the submenu. 

The “Angle Axis” dialog box appears. 
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3.  Make your selections and enter data as needed. You have 
the following options: 

Axis Scaling 

Controls the start/end points of the Angle axis and how many 
degrees apart the labels and tick marks are along the axis. 

Major 

Sets the major tick marks and degree labels by interval. You 
can enter a degree interval or use the direction arrows to scroll 
the options. If you enter “60,” for example, the chart angles 
are divided and marked every 60°. If “Auto” is selected, the 
degree interval reverts to the default. 

Minor 

Controls how many divisions there are between the major tick 
marks. You can enter any number between 1 and 200 or use 
the direction arrows to scroll the options in increments of 5. If 
“Auto” is selected, the degree interval reverts to the default, 
which is 3. This means that each of the chart’s major intervals 
(specified above) is subdivided into three minor intervals. 

Start 

Controls at what degree the chart starts. You can enter a 
number between 0° and 359° or click the direction arrows to 
scroll the numbers in 5° increments. The starting angle must 
be smaller than the ending angle. If “Label” is selected, the 
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starting degree is displayed. If “Auto” is selected, the chart 
reverts to the default and begins at 0°. 

End 

Controls at what degree the chart ends. You can enter a 
number between 

1° and 360° or click the direction arrows to scroll the 
numbers in 5° increments. The ending angle must be larger 
than the starting angle. If “Label” is selected, the ending 
degree is displayed. If “Auto” is selected, the chart reverts to 
the default and ends at 360°. 

Angle Information 

Sets the angle from which the chart is viewed. 

Reference Angle 

Rotates the chart by the number of degrees entered. You can 
enter a number between -360° and 360° or click the direction 
arrows to scroll the numbers in 5° increments. 

Increasing (Clockwise/Counterclockwise) 

Determines whether the chart angle increases clockwise or 
counterclockwise. This selection also affects the position of 
the data series, as shown in the following example. 
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4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

To learn more about... Refer to... 

Polar chart options “Polar Chart Options” in chapter 10 

	
  

Creating Axis Breaks 
Broken axis support provides several benefits. It offers the ability to 
skip a portion of an axis and indicate breaks in data markers. It also 
allows you to manage pro- portions of a graph so that series that vary 
dramatically from each other can be illustrated without affecting the 
readability of the graph. Accordingly, it allows certain charts to scale 
each side of an axis break separately. 
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Broken axis charts are built twice, once with each axis, then clipped to 
draw the two pieces around the break value. Axis breaks apply to all 
vector charts and all 2- D chart types except for Ternary, Spider, 
Polar, Pies, Contour Fill and Line, XYZ Contour Fill and Line, and 
Quality Control charts. Axis breaks are not supported for 3-D charts. 

In XY charts (such as Scatter and XY Line), support is given on both 
axes but only one break per axis is allowed. However, this break can 
be placed anywhere along the axis, it can omit as much of the axis as 
you wish, and you can insert a break of any size, using either a 
straight, slant, or squiggly break symbol. You can specify major 
divisions and minor tick increments independently for each side of 
the break. Only Value axes can be broken, not Category axes. 

An axis break can occur on any axis scaling type (linear, log, or 
date/time). The scaling method has to be the same on both sides of 
the break (in other words, if the first part of an axis is log, then the 
second must also be log). If the scaling method is changed on the 
axis, both sides of the break are affected. 

To create an axis break, do the following: 

1.  Select a chart. 

2.  Click the Axis icon on the extended Command bar, choose Axis 
from the Chart menu and select a Value axis from the submenu, or 
double-click the chart’s Value axis. This brings up the “Value 
Axis” dialog box (see “Changing the Value Axis” in chapter 9). 
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3.  Click the Axis Break button in the lower right-hand corner. The 
“Axis Breaks” dialog box is displayed. 

 

4.  Make your selections and enter data as needed. You have 
the following options: 

Use Axis Break 

Select this option to turn on the Axis Break function. The default is 
“on,” and most dialog box options are activated. 

Range 

This section contains options for the range of the break and the 
major increments and minor divisions to be used on the second 
section of the axis, if different from the first section. Default values 
are based on the data you have already set for the chart. The box 
includes the following options: 

Omit From 

Allows you to omit part of the axis. It specifies the start of the 
range to omit from the axis. 

To 

Sets the end of the range to omit from the axis. 
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Post Break Increment 

Specifies the major increments for the portion of the axis that 
occurs after the break if you want them to be different from 
the increments before the break. DeltaGraph calculates the 
default value. This, and the next option, are not highlighted. 
Turn off “Auto” to highlight them. 

Post Break Divisions 

This option specifies the minor divisions you want to use after 
the break if they are different from before the break. For 
example, you may want increments of 100 before the break, 
but 10 after the break. Again, to high- light this box, deselect 
“Auto.” 

Auto 

The two “Auto” check boxes are on by default. They allow 
DeltaGraph to automatically determine both the post break 
major increments and post break minor divisions. You only 
need to deselect “Auto” if you want to have different 
increments and divisions after the break than before it. 

Break 

This section contains options for the position and appearance 
of the break. 

Break At 

A percentage is written into this option to indicate the position 
at which the axis break appears on the chart. Specifying 50% 
places the break exactly in the middle of the axis. Specifying 
75% places the break three- quarters of the way to the higher-
value end of the axis, as shown below. 
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Width 

This option sets the width of the gap in the axis. The units are 
specified in the “Units” option directly below. 

Units 

A pop-up menu is provided to choose the units to be 
used for the gap width. Choices include inches, 
centimeters, points, picas, and ciceros. 

Symbol 

This pop-up menu contains symbols to be used for the 
break, including “None.” If the currently-selected axis is 
vertical, then vertical break symbols appear. If it is 
horizontal, horizontal break symbols appear. The symbols 
include Straight, Slant, and Squiggle. 

Length 

This option specifies the length of the selected symbol. The 
units specified are entered in “Units” below. 

Units 

This is a pop-up menu for choosing the units of length of the 
selected gap symbol. Choices include inches, centimeters, 
points, picas, and ciceros. 

The chart is drawn in two overlapping positions in the Chart 
page, suitably clipped to either side of the break. 
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Selecting a Break Symbol 
Axis break symbols can be selected in the same manner as other 
DeltaGraph elements. The first click selects the chart. The second 
click (on the axis break symbol) selects all break symbols for the 
selected axis. Axis breaks are made up of lines. As such, their line 
colors, patterns, and weights can be edited from the Tool- box 
Color/Pattern/Thickness palettes. Double-clicking a break’s symbol 
brings up the “Axis Break” dialog box independently of the “Value 
Axis” dialog box. 

Show Values 

Values are shown in typical fashion. If the data symbol (i.e., column) 
ends inside the break range and “Show Value” is set for “Outside,” the 
value is clipped (not shown). Data values can remain or be hidden at 
your discretion. Showing values in the middle of bars or columns 
places values on both sides of the break.  

Curve Fits 

Curve fits are drawn with breaks in the same manner as normal data 
elements (such as lines) with breaks. 

Changing Tick Marks and Chart Grids 
Tick marks are short lines on a chart’s axis that show units of 
measurement. Major tick marks represent the principal increments of 
the scale. Minor tick marks represent the secondary divisions. 

Chart grids are the lines that span the axes. They extend the 
measurement markings and make the chart easier to read. Value axes, 
such as the Z axis in the figure below, have both major and minor 
grids. Category and Series axes have no minor grids. Major grids 
coincide with the major increments and tick marks on the axis, minor 
grids with the minor divisions and tick marks. 

You can turn tick marks and chart grids on and off for each axis. You 
can also specify where on the selected axis you want tick marks to 
appear and how long you want them to be. In 3-D charts, you have 
the additional option of being able to set tick marks at right angles to 
the selected axis. The “Set All” command on the Chart menu allows 
you to change more than one axis at a time. 
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The figure below displays the types of tick marks and grids available 
to each axis. The name of each axis varies depending on the type of 
chart plotted. 

 

To change ticks and grids on a 2-D chart, do the following: 

1.  Select a 2-D chart that uses ticks and grids. Pie and Table charts do 
not use ticks and grid. Ticks for a Time Line chart are discussed 
directly after this procedure. 

2.  Click the Ticks & Grids icon on the extended Command bar, 
choose Ticks and       Grids from the Chart menu and select an axis 
from the submenu, or double-click a chart axis tick or grid. 

NOTE ☞   If double-clicking does not bring up the dialog box, make sure 
“Double-click on Charts” is selected in the “Chart View” tab in 
Preferences. For information, refer to “Setting Chart View Defaults” 
in chapter 6 

A “Value” or “Category” “Axis Ticks & Grids” dialog box is 
displayed. 
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3.  Make your selections and enter data as needed. The mini-axis in 
the middle of the dialog box reflects all the changes you make to 
tick settings. You have the following options for showing ticks 
and grids: 

Tick Mark Placement 

Determines how you want the tick marks displayed on the axis. 

Major/Minor Tick Marks 

Displays a pop-up menu with the following options: 

 Inside the axis 

 Outside the axis 

 On both sides of the axis 

 No tick marks 

Grids 
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Turns major or minor chart grids on or off. 

Tick Mark Length 

Sets the length of major and minor tick marks in points. You can 
enter a value between 0 and 50 points or click the direction arrows 
to scroll the options. 

Show Every 

(Category axis only) Controls at what interval the major ticks and 
grids are displayed. For example, 1 = show every major tick/grid on 
the axis, 2 = show every other major tick/grid on the axis, and so 
on. Enter an interval number in the text box or click the direction 
arrows to scroll the options. 

Start At 

(Category axis only) You can also specify where on the axis you 
want to begin displaying the ticks and grids. If “Auto” is selected, 
the chart reverts to the default and displays all major ticks and grids 
on the axis. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

To change Category ticks on a Time Line chart, do the following: 

1.  Select a Time Line chart. 

2.  Click the Ticks & Grids icon on the extended Command bar, or 
choose Ticks              and Grids from the Chart menu and select 
Category from the submenu. The “Time Line Event Ticks” 
dialog box is displayed. 

3.  Make your selections and enter data as needed. You have the 
following options for showing ticks and grids: 

Tick Mark Length 

Changes the length of the Category ticks. To change the length of a 
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segment, enter a point size or click the direction arrows to scroll 
through the values. The mini-axis on the left side of the dialog box 
reflects changes you make to tick settings. 

Tick Mark Placement 

Displays a pop-up menu so you can display the series labels either 
above or below the Time Line. 

To change ticks and grids on a 3-D chart, do the following: 

1. Select a 3-D chart. 

2. Click the Ticks & Grids icon on the extended Command bar, 
choose Ticks and Grids from the Chart menu and select an axis 
from the submenu, or double click a chart axis tick or grid 

NOTE ☞   If double-clicking does not bring up the dialog box, make sure 
“Double-click on Charts” is selected in the “Chart View” tab in 
Preferences. For information, refer to “Setting Chart View Defaults” 
in chapter 6 

The “3-D Axis Ticks & Grids” dialog box is displayed. 

 

3.  Make your selections and enter data as needed. You have the 
following options for showing ticks and grids: 
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Apply Settings To 

Determines which ticklines associated with the axis chosen are 
affected by changes made to the tick direction in this section of the 
dialog box. You can choose to change all of the ticklines or choose 
a single tickline from the pop-up menu. This option has no effect 
on the “Tick Length,” or “Show Ticks/Grid” options in the lower 
half of the dialog box. 

On Wall 

Displays major and minor tick marks on the inside of the chart wall 
for tick- lines selected in “Apply Changes To.” Only the Value axis 
has minor tick marks and grids. 

On End 

Displays major and minor tick marks on the edge of the chart axis 
for ticklines selected in “Apply Changes To.” The backplane must 
have a depth greater than 0 for this option to be seen. Only the 
Value axis has minor tick marks and grids. 

Outside 

Displays major and minor tick marks on the outside of the chart 
wall for tick- lines selected in “Apply Changes To.” Only the Value 
axis has minor tick marks and grids. 

	
  

Tick Direction 

Displays pop-up menus so you can change the angle of the ticks 
relative to the axis for the left and right sides of a 3-D chart. 
Choose from Straight, Bent, or Auto. In some circumstances the 
“Bent” direction cannot be seen and the option reverts to 
“Straight.” 
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Tick Length 

Sets the length of major and minor tick marks in points. You can 
enter a value between 0 and 50 points or click the direction arrows 
to scroll the options. 

Show Ticks/Grids 

(Category and Series axis only) Controls at what interval the 
major ticks and grids are displayed. For example, 1 = show 
every major tick/grid on the axis, 2 = show every other major 
tick/grid on the axis, and so on. Enter an interval number in the 
text box or click the direction arrows to scroll the options. 

You can also specify where on the axis you want to begin 
displaying the ticks and grids. If “Auto” is selected, the chart 
reverts to the default and displays all major ticks and grids on the 
axis. 

Grids On Walls 

(Not all charts) Displays grids on the inside of 
the chart wall. 

Grids On Ends 

(Not all charts) Displays grids on the edge of the chart wall. 
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The backplane must have a depth greater than 0 for this option 
to be seen. 

Grids On Data 

(Not all charts) Displays grids on the chart’s 
data graphics. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

To learn more about... Refer to... 

The names of chart axes Chapter 7, “Chart Types” 

Changing the tick increments “Reformatting a Chart’s Axes” in 
chapter 9 

	
  

Creating and Positioning Axis Labels and 
Titles 

3-D charts can have labels and titles on three axes, whereas 2-D charts 
can only have labels and titles on two axes (the Z axis or Series 
sometimes appears as a leg- end). 

Axis labels are text or numbers that identify what is measured on 
each axis of a chart. Labels are entered in the originating Data page. 
Their location on the Data page depends on the type of chart you are 
plotting. You can move and reformat axis labels from the Chart 
view, but you can edit them in the Data view only. 

Axis titles, which are used to name a chart’s axis, are created and 
edited in the Chart view. 

When DeltaGraph draws a chart, it automatically calculates the space 
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required for the axis labels and positions them to provide the best fit 
and legibility. 

You can change the default (“Auto”) orientation and rotation of all 
the labels on the selected axis. (Each axis must be changed 
separately.) You can also create and position axis titles. The “Set All” 
command on the Chart menu allows you to change more than one 
axis at a time. 

If you want to change the default size, font, style, or alignment of 
chart text (which may change the “Auto” orientation and rotation of a 
chart’s labels and titles), choose Preferences from the DeltaGraph 
menu, and click the Chart tab (see “Setting Chart Defaults” in 
chapter 6). 

To change labels and titles for 2-D charts, do the following: 

1.  Select a 2-D chart. Some charts (such as Polar, Pie, or Table 
charts) may not have labels you can change. 

2.  Click the Labels icon on the extended Command bar, choose 
Labels from the Chart menu and select the appropriate axis from 
the submenu, or double-click an axis label or title. 

NOTE ☞   If double-clicking does not bring up the dialog box, make sure 
“Double-click on Charts” is selected in the “Chart View” tab in 
Preferences. For information, refer to “Setting Chart View Defaults” 
in chapter 6. 

The “Axis Labels” dialog box is displayed. The options available 
depend on the chart type selected. The default selections always say 
“Auto,” but the meaning of “Auto” depends on the type of chart 
selected and the length of the axis’ title or longest label. Rotation is 
typically 0° unless a title or more of the labels will not fit on one 
line. 
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3.  Make your selections as needed. You have the following options: 

Show Labels/Show Titles 

Displays or hides axis labels/titles. Do not show labels/titles if you 
are outputting to a PostScript device. 

Determine the position (left or right, top or bottom) of the labels 
or title for the axis selected using the following options: 

Left/Bottom 

Displays axis labels/titles on the left/bottom axis. 

Right/Top 

Displays axis labels/titles on the right/top axis. 

Auto 

Displays the labels/titles in the default orientation and rotation 
selections forthe type of chart selected. 

Rotation 

Displays a pop-up menu to define the position of labels/titles, as 
follows: 

0° 
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Displays normal right-side-up position. 

90° 

Rotates clockwise 90° from the 0° position. 

180° 

Rotates clockwise 180° from the 0° position (upside down). 

270° 

Rotates clockwise 270° from the 0° position. 

Auto 

Default position for the chart selected. (The space required for 
the axis labels/titles is automatically calculated and they are 
oriented to provide the best fit and legibility.) If you select 
another option and a label or title will not fit on one line, the 
text wraps as needed. Resizing the chart or changing the text 
attributes may change the “Auto” orientation. 

Other 

Allows you to enter a specific degree for labels/title rotation. 

Other 

If you selected “Other” from the “Rotation” pop-up menu, enter the 
degree of rotation of the labels/titles in 1° increments. 

Axis Title 

Enter a name for the axis in the text box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  Click OK to implement the changes and return to the Chart 
view. To exit the dialog box without changing the chart, click 
Cancel. 

To change labels and titles for 3-D charts, do the following: 

1.  Select a 3-D chart. 



 
  DeltaGraph for Macintosh Version 7 User Guide 344 

2.  Click the Labels icon on the extended Command bar, choose 
Labels from the Chart menu and select the appropriate axis from the 
submenu, or double-click an axis label or title. 

NOTE ☞   If double-clicking does not bring up the dialog box, make sure 
“Double-click on Charts” is selected in the “Chart View” tab in 
Preferences. For information, refer to “Setting Chart View Defaults” 
in chapter 6. 

The “3-D Axis Labels” dialog box is displayed. The options 
available depend on the chart type selected. The default selections 
depend on the type of chart selected and the length of the axis’ title 
or longest label. If “Use Perspective Labels” is not enabled in 
Preferences (Chart tab) the rotation default is 0°. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Apply Settings To 

Determines which ticklines associated with the axis chosen are 
affected by the changes made in this dialog box. You can choose to 
change all of the ticklines or choose an individual tickline from the 
pop-up menu. 

Labels/Titles 

Determines the position and rotation of the labels or title for the 
selected axis. 

On 
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Determines if the labels/title are visible on the selected axis 
and ticklines. 

Auto Rotation 

Default position for the chart selected (DeltaGraph 
automatically calculates the space required for the axis 
labels/titles and orients them to pro- vide the best fit and 
legibility). If you select another option and a label or title will 
not fit on one line, the text wraps to add more lines as needed. 
Resizing the chart or changing the text attributes may change 
the “Auto” orientation. 

Rotation 

Determines the degree of clockwise rotation of the labels/title 
in 1° increments. Press the up/down arrow to change the entry 
in 5° increments. 

Axial Twist 

Displays a pop-up menu so you can define the bottom to top 
rotation on the axis like a spit on a rotisserie. 

Auto Straight 

Displays the labels/title parallel to the axis. 

Auto Bent 

Displays the labels/title perpendicular to the axis. 

0° 

This position varies depending on the axis. 

90° 

Flips 90° bottom to top from the 0° position. 

180° 

Flips 180° bottom to top from the 0° position. 

270° 
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Flips 270° bottom to top from the 0° position. 

Axis Title 

Enter a name for the axis in the text box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

	
  

To learn more about... Refer to... 

The names of chart axes Chapter 7, “Chart Types” 

Changing chart defaults “Setting Chart Defaults” in 
chapter 6 

	
  

Formatting Chart Text 
While in Chart view, DeltaGraph uses a fully Unicode text editor. 
You can change the font, size, style, and color of any selected chart 
label(s) or axis title(s) with commands in the Text menu. (The default 
for chart text, unless you change it in Preferences, is 12-point 
Helvetica, plain, black.) 

You can also use Text menu commands to add a shadow (an offset 
duplicate image) to selected text, realign text in a Table chart, or 
temporarily hide selected chart labels or axis titles. 

To edit the wording or spelling of a label, you must change it in the 
originating Data page, then update the chart. To edit the wording of 
an axis title, double-click it, and make the change in the “Labels” 
dialog box that appears. 

To format chart text, do the following: 
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1.  Select a chart. If you want to make the same change(s) to all the 
chart text, skip to step 3. 

2.  Click the axis title or any label in a group of labels you want to 
change. If you want to change just one label in a group of labels, 
click again on the label to select it. 

3.  Select commands from the Text menu as needed and make your 
choices from the submenus that appear. 

The selected text changes according to your choice. You can also 
use the font icons on the Command bar to perform a variety of 
options. In addition to the standard “Font,” “Size,” and “Style,” 
commands that also are available on the Command bar, the 
following commands are available from the Text menu: 

Alignment 

Changes text placement in Table charts only. 

Shadow 

Displays a dialog box so you can apply an offset duplicate image of 
selected text. This option also appears as “Drop Shadow” in the 
“Set All” dialog box. 

 

To create a shadow, click the white square on the left side of the 
dialog box and drag it, enter a point size, or click the direction 
arrows to scroll through the values. To select a color for the 
shadow, click the pop-up menu next to “Color” to display a color 
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palette. When you select a color, the palette disappears. Click OK 
to add the shadow to the text and exit the dialog box. 

Hidden 

Hides selected text (a label or series of labels, for example) in a 
Chart object. 

This is useful when you do not want to delete the label but do not 
want it dis- played or printed. 

Set All 

Displays a dialog box so you can set several text attributes in one 
step for one or more selected elements. 

To learn more about... Refer to... 

Changing chart defaults “Setting Chart Defaults” in chapter 6 

Creating axis titles “Creating and Positioning Axis Labels 
and Titles” in chapter 9 

The Preferences dialog box Chapter 6, “Setting Preferences” 

Editing data in the Data view “Editing Data” in chapter 4 

	
  

Showing Values on a 2-D Chart 
Occasionally you will want to label the data graphics in a chart. For 
example, you might want to add numeric values and/or percentages 
to each piece of a Pie chart, to show what percentage of the whole 
each column in a Column chart represents, or to add category labels 
to a chart that has no Category axis. 

The “Show Values” command on the Chart menu displays a dialog 
box so you can automatically add labels that reflect information 
entered in the Data view to the data graphics in any of the following 
2-D charts: Column, Stacked Column, Bar, Stacked Bar, all Build-
Up, Floating Bar and Column, all Segmentation, Line, Step, all Pie, 
Scatter, Paired Scatter, XY Line, Paired XY Line, XYZ Contour 
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Line, Bubble, Polar, Ternary, Spider, Histogram, Pareto, and Ogive. 

To show values on a chart, do the following: 

1.  Select one of the charts listed above. 

2.  Choose Show Values from the Chart menu. 

The “Show Values” dialog box is displayed. The available 
options and default values displayed depend on the type of chart 
selected. 

 

3.  Make your selections and enter data as needed using the following 
options: 

Location 

Displays a pop-up menu so you can specify where the labels appear 
in relation to the data graphics. The options vary according to the 
type of chart selected. You should note that the size of the label can 
affect its location. If the location is set for inside a column (at the 
start, middle, or end) but the label won’t fit inside, it will be placed 
outside. 

For all Column (except XY Column) and Bar, all Build-Up, and 
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Floating Bar and Column charts, the options are: 

None 

No labels showing. 

At Start 

Places labels at the start of each data graphic. 

Middle 

Places labels in middle of each data graphic. 

At End 

Places labels at the end of each data graphic. 

Outside 

Places labels outside each data graphic at the far end. For Pie, 
Stacked Pie, and Multiple Pie charts, the options are: 

None 

No labels showing. 

Inside 

Places labels inside each data graphic. 

Outside 

Places labels outside each data graphic. 

For Line, Step, Scatter, Paired Scatter, XY Line, Paired XY 
Line, XY Column, Bubble, Ternary, Polar, and Survival 
charts, the options are: 

None 

No labels showing. 

Above 

Places labels above each data symbol. 
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Below 

Places labels below each data symbol. 

Left 

Places labels to the left of each data symbol. 

Right 

Places labels to the right of each data symbol. 

On 

Places labels directly on each data symbol. For best results 
when using this option on any chart but a Bubble chart, 
deselect Show Symbols in the “Options” dialog box (select 
Options from the Chart menu). 

On Cursor 

On mousing over a chart element, the value represented is 
shown in a small floating window next to the cursor. 

Rotation 

Displays a pop-up menu so you can specify the orientation of the 
data graphic labels. You have the following options: 

0° 

Labels are in default position, typically horizontal, as in 
normal text orientation. 

90° 

Rotates labels 90° from 0°, typically vertical and reading from 
top to bottom. 

180° 

Rotates labels 180° from 0°, typically upside-down. 

270° 

Rotates labels 270° from 0°, typically vertical and reading 
from bottom to top. 
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Text 

Displays a pop-up menu so you can format the text. You have the 
following options: 

Value 

(Default for all except Pie charts) The numeric value of each 
data graphic as entered in the Data view. 

Percent 

The numeric value of each data graphic translated into its 
percentage of the whole. 

Category 

(Default for all Pie charts) The row labels from the Data view. 

Value (Percent) 

The numeric value of each data graphic and its percentage of 
the whole. 

Category (Value) 

The row labels from the Data view and their numeric values. 

Category (Percent) 

The row labels from the Data view and their numeric values 
translated into a percentage of the whole. 

Stacked Column and Bar, Stacked Column and Bar Segmentation, 
and Stacked 

Build-Up charts also have the following three options: 

Summations 

Shows the cumulative values of the series as they climb the 
columns or proceed along the bars. 

Summations (Percent) 

Shows the cumulative values and the cumulative percentages (in 
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parentheses) of the columns and bars. 

Category (Summation) 

Shows the category names and (in parentheses) the cumulative 
values of the columns or bars. 

4.  Click Show to preview your changes without exiting the dialog 
box. This makes it easy to experiment with different effects. You 
can move the dialog box out of the way by dragging the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

The default fill color for value labels is white. You can apply a 
different fill color (or “None”) to a selected label from the Fill 
palette. 

Changing Chart Symbols 
In DeltaGraph, symbols are used to represent data or data series in 
Line, High- Low, Range, Step, Scatter, Paired Scatter, XY Line, 
Paired XY Line, Ternary, Ternary Percent, Polar, Bullet, Box Plot, 
Ogive, 3-D XYZ Scatter, 3-D Scatter, 3-D Scatterline, XY Column, 
Survival, and 3-D Surface Line charts. The “Symbols” command on 
the Chart menu displays a dialog box so you can choose different font 
symbols, the built-in DeltaSymbol font, or pictographics from an open 
Custom Library. You can also change the symbols’ size and color. 

Using DeltaSymbol 
DeltaSymbol is a special symbol font included with DeltaGraph that 
is automatically loaded during installation. 

DeltaSym is the corresponding printer font and is copied to your 
System/Fonts folder during installation. This font is required for 
DeltaSymbols to prints correctly. 

When the DeltaSymbol font is installed in your system, these symbol 
characters are automatically generated for each chart that uses 
symbols. If the DeltaSymbol font is not in your System/Fonts folder, 
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the default symbol font becomes a “Built- in DeltaSymbol.” “Built-in 
DeltaSymbol” is a set of built-in drawing objects that represent all of 
the symbols available in the DeltaSymbol font, allowing you to 
display DeltaSymbol objects even if the DeltaSymbol font is missing. 

A PostScript version of DeltaSymbol is automatically loaded 
during installation for printing to a PostScript printer. 

To change chart symbols, do the following: 

1.  Select a chart that uses symbols. 
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2.  Choose Symbols from the Chart menu, or double-click a chart 
symbol. 

NOTE ☞   If double-clicking does not bring up the dialog box, make sure 
“Double-click on Charts” is selected in the “Chart View” tab in 
Preferences. For information, refer to “Setting Chart View Defaults” 
in chapter 6 

The “Symbols” dialog box appears showing the default symbol 
(and its size and color) for each data series. 

 

3.  Select the symbol/data series you want to change from the list on 
the left side of the dialog box. To make all the symbols the same, 
click Select All. 

4.  Make your selections as needed. You have the following options: 

High/Low/Middle 

(High-Low and Range charts only) Allows you to change the 
symbols for the different ranges in each data series separately. 
Click High (the default), Low, or Middle (for Range charts only) to 
select which range of symbols you want to change. 

Custom Symbols 

Displays a graphic pop-up menu so you can apply a pictographic 
image from an open Custom Library to a selected data series. 

Built-In DeltaSymbol 
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Displays DeltaSymbol as a built-in drawing object that represents 
all of the symbols available in the DeltaSymbol font. This provides 
an advantage over using the font itself in that the chart will not 
need the DeltaSymbol font to dis- play the symbols. The built-in 
DeltaSymbols however, are much smaller and do not provide the 
visual clarity of the font. There is no difference between the two 
when printing. 

Font 

Displays a pop-up menu so you can select a font for the selected 
symbol. You can choose from all the fonts in your System/Fonts 
folder. The default font, if installed, is “DeltaSymbol.” 

Color 

Displays a color palette so you can select a color for the selected 
symbol. 

Size 

Displays a pop-up menu so you can select a size for the selected 
symbol or pictographic. The “Other” option displays a dialog box 
so you can enter a non- standard point size for the font or 
pictographic. 

Key 

Displays a pop-up menu so you can select a symbol. Every 
available symbol is displayed. The symbols on the right side of the 
menu are opaque symbols. The standard alphabet character 
representing the selected symbol appears in the text box next to the 
menu. 

No Symbol 

Select this check box if you do not want a symbol for the selected 
data series. 

Example box 

Displays the selected symbol for the selected data series. 

5.  Repeat steps 3 and 4 for each symbol you want to change. If 
you have more than eight data series, use the scroll bar to move 
through the selections. 
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6.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

7.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

To learn more about... Refer to... 

Editing Bullet chart bullets “Creating Layouts” in chapter 5 

	
  

Working with 3-D View 
If you want to change the orientation, perspective, and/or vanishing 
point of a 3-D chart, select 3-D View from the Chart menu. This 
opens a dialog box that includes an interactive graphic display so you 
can visualize your changes as you make them. Click the Show button 
to experiment with different settings. 

Once you have implemented a change, you can use the “Change 
Type” command on the Chart menu to change the chart back to its 
default settings. Just choose the same chart type from the dialog box 
that appears. 

To change the view of a 3-D chart, do the following: 

1.  Select any 3-D chart. 

2.  Choose 3-D View from the Chart menu. The “3-D Rotation / 
Viewing Angle” dialog box is displayed. 
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3.  Make your selections and enter data as needed. As you change 
these values, the graphic cube on the right side of the dialog 
box changes to reflect your choices. You have the following 
options: 

Orientation 

(Measured in degrees) Controls the chart’s vertical viewing angle 
(Elevation) and horizontal viewing angle (Rotation) relative to the 
eye. 

To change either setting, enter a number from -90° to 90° 
(Rotation) or 0° to 360° (Elevation), click the direction arrows to 
scroll through the values in 5° increments, drag the vertical and 
horizontal slide markers in the adjusting bar next to the graphic 
cube, or click the arrows at each end of the adjusting bar to change 
the elevation. 

Perspective 

(Measured in percents) Controls the perceived distance of the back 
of the chart relative to the front. At 100% (default), the size of the 
back is equal to the size of the front. At 50%, the size of the back is 
one-half the size of the front. 

To change the perspective, enter a number from 20% to 
100%, or click the direction arrows to scroll through the 
values in 5% increments. 
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Vanishing Point 

(Measured in percents) Controls the point on the chart that the eye 
is looking through. The default settings for the vertical, horizontal, 
and depth vanishing points are always 50, the middle of the chart, 
but the effect that these settings have on the chart is relative to the 
“Orientation” and “Perspective” settings. 

To change the vanishing point, enter a number from 0% to 
100% or click the direction arrows to scroll through the values 
in 5% increments. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

Adding Depth to a 2-D Chart 
You can add depth to planes on the data graphics of a Column, 
Stacked Column, Bar, Stacked Bar, Area, Pie, or Multiple Pie chart. 

 

To add depth to a 2-D chart, do the following: 

1.  Select one of the 2-D charts listed above. 

2.  Choose Depth from the Chart menu. The “Depth” dialog box is 
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displayed. 

 

The black box on the right is part of a cube that represents the 
chart’s data graphic. 

3.  Click Add Depth. 

4.  Enter any number from -250 to 250 points in the text boxes next 
to “Vertical” and “Horizontal,” click the direction arrows to 
scroll the options, or drag the graphic cube itself to the desired 
position. 

When you change the depth settings, the black box changes to 
show the rest of the cube. The outline represents the depth. 

 

To remove depth from a 2-D chart, deselect the Add Depth option. 
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5.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

6.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

Using Legends 
A legend is a combination of text and graphics used to associate 
additional data with the chart. Depending on the type of chart you 
plotted, charts may be plotted with or without a legend. Row and 
column labels in the Data page determine the legend labels. 

The “Legend” command allows you to add to or remove chart 
legends. You can also reverse the direction of the data in the 
legend. 

To add a legend to a chart, do the following: 

1.  Select the chart. 

2.  Choose Legend from the Chart menu. The “Legend Options” 
dialog box is displayed. 

 

3.  Click Show Legend to turn the chart legend on. 
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4.  Make selections as needed from the following options: 

Reverse Legend Order 

Reverses the order of elements in the legend. 

Symbol Width/Height 

Determines the size of the graphic elements in the legend. This 
option does not affect the font size of the legend labels. 

5.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

6.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 
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10  Changing Chart 
Options 

The “Options” command (press cmd-Y, or click the Options icon on 
the Command bar) on the Chart menu makes it easy to customize 
your  charts. Available only when you have a chart selected, this 
command displays a dialog box that offers numerous options for 
changing the appearance and/or organization of the selected chart. 
The options available in the dialog box depend on the selected chart. 
Each dialog box has a Show button, which allows you to experiment 
with different options without permanently changing the chart. 

This chapter covers the following: 

• Showing/hiding grids, frames, and symbols 

• Adjusting the width of and space between bars in Bar and Column 
charts 

• Rotating elements in charts 

• Switching axes 

• Repositioning labels 

• Removing axis planes from 3-D charts 

• Adjusting the wall thickness on 3-D charts 

• Sizing bubbles on Bubble charts 

• Creating and removing projected ticks and labels 

• Dropping lines from symbols to the base of the chart 

• Clipping off data outside of the chart grid 
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• Changing the direction of Ternary and Polar charts 

• Creating margins in Organizational charts 

These are just a few of the options available for the charts in 
DeltaGraph. 

2-D Business Chart Options 

Bar and Column Chart Options 
To set options for a Bar and Column chart, do the following: 

1.  Select a Bar or Column chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Percentage 

Changes the value axis and shows each data graphic as a 
percentage of the whole. The top value changes to 1. 

Clip Data 
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Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis. You can also set different font styles, and so on, for each set 
of axis labels. The additional axis can also be dragged and offset. 
Turning on this option is the same as choosing “Overlay” from the 
Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Connect Between Series 

Draws connecting lines between all the data points of the same 
series in the color of those data series. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
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plot frame. 

Bar Placement 

Opens the “Bar Placement” dialog box so you can set the width and 
position of the data graphics. The dialog box graphic reflects the 
number of data series in your chart. 

 

Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To 
change the Category Gap, drag the lower bar-sizing handles 
(squares) in the dialog box graphic, enter any value between 0 
and 1,000, or click the direction arrows to scroll through the 
percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag 
the upper bar-sizing handles (squares) in the dialog box 
graphic, enter any number between -100 and 1,000, or click 
the direction arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the 



 
  DeltaGraph for Macintosh Version 7 User Guide 367 

“Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Bar with Line Overlay Chart Options 
Do the following to set options for a Bar with Line Overlay chart: 

1.  Select the chart. 

2.  For a Base Chart or an Overlay Chart, choose Options from the 
Chart menu, and a submenu is displayed. For a Base Chart only, 
you can click the Options icon on the Command bar, or press 
cmd-Y. 

3.  From the sub-menu, select Base Chart to modify the bars or 
columns. Select Overlay Chart to modify the line overlay. 

4.  Refer to “Base Chart Options” below for information on changing 
bars and/or columns. Refer to “Overlay Chart Options” below for 
information on changing the line overlay. 

5.  Click Show to preview your changes without exiting a dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

6.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Base Chart Options 

The dialog box for the Base Chart contains the following options. 
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Percentage 

Changes the value axis and shows each data graphic as a percentage of 
the whole. The top value changes to 1. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern or 
color or use a shadow. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
category axis. 

Show Additional Value Axis 
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Displays an additional value axis opposite the original value axis.You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Connect Between Series 

Draws connecting lines between all the data points of the same series 
in the color of those data series. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is not 
obscured. This can help to maintain a perspective on your data values 
when you have data markers that cover large areas of the plot frame. 

Bar Placement 

Opens the “Bar Placement” dialog box so you can set the width and 
position of the data graphics. The dialog box graphic reflects the 
number of data series in your chart. 

 

 

 

 

 

 

 

 

Category Gap 
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Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To change the 
Category Gap, drag the lower bar-sizing handles (squares) in the 
dialog box graphic, enter any value between 0 and 1,000, or click 
the direction arrows to scroll through the percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag the 
upper bar-sizing handles (squares) in the dialog box graphic, enter 
any number between -100 and 1,000, or click the direction arrows 
to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return to 
the “Options” dialog box. 

Overlay Chart Options 

The dialog box for the Overlay Chart contains the following options. 

 

Show Symbols 

Allows you to use symbols to mark the chart’s data points. 

Span Gaps 

Draws connecting lines through any missing data points. Each line is 
drawn from the last data point before the missing data to the first data 
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point after the missing data. It is automatically deselected if “Connect 
Points” is turned off or if “Fill Below Lines” is selected. 

Connect Points 

Draws a line between all the data points of the same series. 

Clip Data 

Hides or “clips off” any data plotted outside the chart grids. 

Fill Below Lines 

A filled polygon is drawn for each data series. It fills the space 
between the line data graphic and the category axis, similar to a 3-D 
Area chart. This option can be used in conjunction with “Lines in 
Front.” 

Lines in Front 

Draws lines on top of bars or columns. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 
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Stacked Bar and Column Chart Options 
To set options for Stacked Bar and Column charts, do the following: 

1.  Select a Stacked Bar or Column chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Percentage 

Changes the value axis and shows each data graphic as a 
percentage of the whole. The top value changes to 1. This option is 
available only when “Stack Negative Values” is deselected. 

Clip Data Only 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
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or color or use a shadow. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis. You can also set different font styles, and so on, for each set 
of axis labels. The additional axis can also be dragged and offset. 
Turning on this option is the same as choosing “Overlay” from the 
Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Stack Negative Values 

Includes negative values on the value axis. If deselected, the 
“Percentage” option becomes available. 

Connect Between Series 

Draws connecting lines between all the data points of the same 
series in the color of those data series. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Bar Placement 

Opens the “Bar Placement” dialog box so you can set the width and 
position of the data graphics. The dialog box graphic reflects the 
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number of data series in your chart. 

  

Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To 
change the Category Gap, drag the lower bar-sizing handles 
(squares) in the dialog box graphic, enter any value between 0 
and 1,000, or click the direction arrows to scroll through the 
percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag 
the upper bar-sizing handles (squares) in the dialog box 
graphic, enter any number between -100 and 1,000, or click 
the direction arrows to scroll through the options. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

Stack From 
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The values displayed in a stacked chart are running sums of each 
category of input data. The initial value of the running sum can be 
zero if “Zero (0)” is selected or the value at the category 
intersection if “Axis” is selected. If “Zero (0)” is selected, the data 
graphics do not move with the axis when the axis placement is 
changed. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Stacked Bar and Column with Line Overlay Chart 
Options 

Do the following to set options for a Stacked Bar with Line Overlay or 
Stacked 

Column with Line Overlay chart: 

1.  Select the chart. 

2.  For a Base Chart or an Overlay Chart, choose Options from the 
Chart menu, and a submenu is displayed. For a Base Chart only, 
you can click the Options icon on the Command bar, or press 
cmd-Y. 

3.  From the sub-menu, select Base Chart to modify the bars or 
columns. Select Overlay Chart to modify the line overlay. 

4. Refer to “Base Chart Options” below for information on changing 
bars and/or columns. Refer to “Overlay Chart Options” below for 
information on changing the line overlay. 

5.  Click Show to preview your changes without exiting a dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

6.  When you have the results you want, click OK to implement the 
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changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Base Chart Options 

The dialog box for the Base Chart contains the 
following options. 

 

Percentage 

Changes the value axis and shows each data graphic as a percentage 
of the whole. The top value changes to 1. This option is available 
only when “Stack Negative Values” is deselected. 

Clip Data 

Hides or “clips off ” any data plotted outside 
the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern or 
color or use a shadow. 
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Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis 
and set different font styles for each set of axis labels. The additional 
axis can also be dragged and offset. Turning on this option is the 
same as choosing “Overlay” from the Chart menu and turning on an 
additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning on 
this option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Stack Negative Values 

Includes negative values on the value axis. If deselected, the 
“Percentage” option becomes available. 

Connect Between Series 

Draws connecting lines between all the data points of the same series 
in the color of those data series. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is not 
obscured. 

This can help to maintain a perspective on your data values when 
you have data markers that cover large areas of the plot frame. 

Bar Placement 

Opens a dialog box so you can set the width and position of the data 
graphics. The dialog box graphic reflects the number of data series in 
your chart. 
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Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To change the 
Category Gap, drag the lower bar-sizing handles (squares) in the 
dialog box graphic, enter any value between 0 and 1,000, or click 
the direction arrows to scroll through the percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag the 
upper bar-sizing handles (squares) in the dialog box graphic, enter 
any number between -100 and 1,000, or click the direction arrows 
to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return to 
the “Options” dialog box. 

Stack From 

The values displayed in a stacked chart are running sums of each 
category of input data. The initial value of the running sum can be zero 
if “Zero (0)” is selected or the value at the category intersection if 
“Axis” is selected. If “Zero (0)” is selected, the data graphics do not 
move with the axis when the axis placement is changed. 
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Overlay Chart Options 

The dialog box for the Overlay Chart contains the following options. 

 

Show Symbols 

Allows you to use symbols to mark the chart’s data points. 

Span Gaps 

Draws connecting lines through any missing data points. Each line is 
drawn from the last data point before the missing data to the first data 
point after the missing data. It is automatically deselected if “Connect 
Points” is turned off or if “Fill Below Lines” is selected. 

	
  

Connect Points 

Draws a line between all the data points of the same series. 

Clip Data 

Hides or “clips off” any data plotted outside the chart grids. 

Fill Below Lines 

A filled polygon is drawn for each data series. It fills the space 
between the line data graphic and the category axis, similar to a 3-D 
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Area chart. This option can be used in conjunction with “Lines in 
Front.” 

Lines in Front 

Draws lines on top of bars or columns. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis.You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
value axis. 

Build-Up and Stacked Build-Up Chart Options 
To set options for a Build-up or Stacked Build-up chart, do the 
following: 

1.  Select a Build-up chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections as needed. You have the following options: 

Percentage 

Changes the value axis and shows each data graphic as a 
percentage of the whole. The top value changes to 1. If a Stacked 
Build-up chart, this option is available only when “Stack Negative 
Values” is deselected. 

Clip Data 

Hides or “clips off” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Used to turn frame on and off. It provides a backplane to the chart 
but does not affect the grid. This option must be selected if you 
want to fill the chart with a pattern or color or use a shadow. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 



 
  DeltaGraph for Macintosh Version 7 User Guide 382 

menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Stack Negative Values 

(Stacked Build-up chart) Includes negative values on the value 
axis. If deselected, the “Percentage” option becomes available. 

Connect Between Series 

Draws connecting lines between all the data points of the same 
series in the color of those data series 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Stack From 

(Stacked Build-up chart) The values displayed in a stacked chart 
are running sums of each category of input data. The initial value 
of the running sum can be zero if “Zero (0)” is selected or the value 
at the category intersection if “Axis” is selected. If “Zero (0)” is 
selected, the data graphics do not move with the axis when the axis 
placement is changed. 

Bar Placement 

Opens the “Bar Placement” dialog box so you can set the width and 
position of the data graphics. The dialog box graphic reflects 
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whether the chart is a Build- up or Stacked Build-up chart, as well 
as the number of data series in the chart. 

 

Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To 
change the Category Gap, drag the lower bar-sizing handles 
(squares) in the dialog box graphic, enter any value between 0 
and 1,000, or click the direction arrows to scroll through the 
percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag 
the upper bar-sizing handles (squares) in the dialog box 
graphic, enter any number between -100 and 1,000, or click 
the direction arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 
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5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Bar and Column Segmentation Chart Options 
To set options for Bar, Column, Stacked Bar, and Stacked Column 
Segmentation charts, do the following: 

1.  Select a Segmentation chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Percentage 

Changes the value axis and shows each data graphic as a 
percentage of the whole. The top value changes to 1. This option is 
available only when “Stack Negative Values” is deselected. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
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including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Show Segmentation Legend 

Displays the segmentation legend. In segmentation charts, there are 
two columns per row. One plots the axis data, the other the 
segmentation data. The segmentation legend quantifies the 
relationship between them. 

Stack Negative Values 

(Stacked Bar and Column Segmentation charts only) Includes 
negative values on the value axis. If deselected, the “Percentage” 
option becomes available. 

Connect Between Series 
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Draws connecting lines between all the data points of the same 
series in the color of those data series. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Stack From 

The values displayed in a stacked chart are running sums of each 
category of input data. The initial value of the running sum can be 
zero if “Zero (0)” is selected or the value at the category 
intersection if “Axis” is selected. If “Zero (0)” is selected, the data 
graphics do not move with the axis when the axis placement is 
changed. 

Bar Placement 

Opens the “Bar Placement” dialog box so you can set the width 
and position of the data graphics. The dialog box graphic reflects 
whether the chart is a Bar/ Column or a Stacked Bar/Column 
Segmentation chart, as well as the number of data series in the 
chart. 

 

Category Gap 
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Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To 
change the Category Gap, drag the lower bar-sizing handles 
(squares) in the dialog box graphic, enter any value between 0 
and 1,000, or click the direction arrows to scroll through the 
percentage options. Note that changes to the Category gap 
affect the Segmentation axis. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag 
the upper bar-sizing handles in the dialog box graphic, enter 
any number between -100 and 1,000, or click the direction 
arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Floating Bar and Column Chart Options 
To set options for Floating Bar and Column charts, do the following: 

1.  Select a Floating Bar or Floating Column chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections as needed. You have the following options: 

Percentage 

Changes the value axis and shows each data graphic as a 
percentage of the whole. The top value changes to 1. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 
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Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Connect Between Series 

Draws connecting lines between all the data points of the same 
series in the color of those data series. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Bar Placement 

Opens the “Bar Placement” dialog box so you can set the width and 
position of the data graphics. The dialog box graphic reflects the 
number of data series in your chart. 
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Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To 
change the Category Gap, drag the lower bar-sizing handles 
(squares) in the dialog box graphic, enter any value between 0 
and 1,000, or click the direction arrows to scroll through the 
percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag 
the upper bar-sizing handles (squares) in the dialog box 
graphic, enter any number between -100 and 1,000, or click 
the direction arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the “Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
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dialog box without changing the chart, click Cancel. 

Floating Stacked Bar and Column Chart Options 
Do the following to set options for Floating Stacked Bar and Column 
charts: 

1.  Select a Floating Stacked Bar or Floating Stacked Column chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options. 

Percentage 

Changes the value axis and shows each data graphic as a 
percentage of the whole. The top value changes to 1. This option is 
available only when “Stack Negative Values” is deselected. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 
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Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis and set different font styles for each set of axis labels. 
The additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Stack Negative Values 

Includes negative values on the value axis. If deselected, the 
“Percentage” option becomes available. 

Connect Between Series 

Draws connecting lines between all the data points of the same 
series in the color of those data series. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 



 
  DeltaGraph for Macintosh Version 7 User Guide 393 

Stack From 

The values displayed in a stacked chart are running sums of each 
category of input data. The initial value of the running sum can be 
zero if “Zero (0)” is selected or the value at the category 
intersection if “Axis” is selected. If “Zero (0)” is selected, the data 
graphics do not move with the axis when the axis placement is 
changed. 

Bar Placement 

Opens the “Bar Placement” dialog box so you can set the width and 
position of the data graphics. The dialog box graphic reflects the 
number of data series in your chart. 

 

Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To 
change the Category Gap, drag the lower bar-sizing handles 
(squares) in the dialog box graphic, enter any value between 0 
and 1,000, or click the direction arrows to scroll through the 
percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
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percentage of the bar width. To change the Series Gap, drag 
the upper bar-sizing han- dles (squares) in the dialog box 
graphic, enter any number between -100 and 1,000, or click 
the direction arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

4.  Click “Show” to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging the 
Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Floating Stacked Bar/Column with Line Overlay 
Chart Options 

Do the following to set options for a Floating Stacked Bar with Line 
Overlay or a Floating Stacked Column with Line Overlay chart: 

1.  Select the chart. 

2.  For a Base Chart or an Overlay Chart, choose Options from the 
Chart menu, an a submenu is displayed. For a Base Chart only, 
you can click the Options icon on the Command bar, or press 
cmd-Y. 

3.  From the sub-menu, select Base Chart to modify the bars or 
columns. Select Overlay Chart to modify the line overlay. 

4.  Refer to “Base Chart Options” below for information on changing 
bars and/or columns. Refer to “Overlay Chart Options” below for 
information on changing the line overlay. 

5.  Click Show to preview your changes without exiting a dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 
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6.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit without changing the 

chart, click Cancel. 

Base Chart Options 

The dialog box for the Base Chart contains the following options. 

 

Percentage 

Changes the value axis and shows each data graphic as a percentage of 
the whole. The top value changes to 1. This option is available only 
when “Stack Negative Values” is deselected. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern or 
color or use a shadow. 
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Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Stack Negative Values 

Includes negative values on the value axis. If deselected, the 
“Percentage” option becomes available. 

Connect Between Series 

Draws connecting lines between all the data points of the same series 
in the color of those data series. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is not 
obscured. This can help to maintain a perspective on your data values 
when you have data markers that cover large areas of the plot frame. 

Bar Placement 

Opens a dialog box so you can set the width and position of the data 
graphics. The dialog box graphic reflects the number of data series in 
your chart. 
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Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To change the 
Category Gap, drag the lower bar-sizing handles (squares) in the 
dialog box graphic, enter any value between 0 and 1,000, or click 
the direction arrows to scroll through the percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag the 
upper bar-sizing handles (squares) in the dialog box graphic, enter 
any number between -100 and 1,000, or click the direction arrows 
to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return to 
the “Options” dialog box. 

Stack From 

The values displayed in a stacked chart are running sums of each 
category of input data. The initial value of the running sum can be zero 
if “Zero (0)” is selected or the value at the category intersection if 
“Axis” is selected. If “Zero (0)” is selected, the data graphics do not 
move with the axis when the axis placement is changed. 
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Overlay Chart Options 

The dialog box for the Overlay Chart contains the following options. 

 

Show Symbols 

Allows you to use symbols to mark the chart’s data points. 

Span Gaps 

Draws connecting lines through any missing data points. Each line is 
drawn from the last data point before the missing data to the first data 
point after the missing data. It is automatically deselected if “Connect 
Points” is turned off or if “Fill Below Lines” is selected. 

Connect Points 

Draws a line between all the data points of the same series. 

Clip Data 

Hides or “clips off” any data plotted outside the chart grids. 

Fill Below Lines 

A filled polygon is drawn for each data series. It fills the space 
between the line data graphic and the category axis, similar to a 3-D 
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Area chart. This option can be used in conjunction with “Lines in 
Front. 

Lines in Front 

Draws lines on top of bars or columns. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis.You 
can format the additional axis independently from the original axis and 
set different font styles for each set of axis labels. The additional axis 
can also be dragged and offset. Turning on this option is the same as 
choosing “Overlay” from the Chart menu and turning on an additional 
value axis. 

High-Low and Range Chart Options 
To set options for High-Low and Range charts, do the following: 

1.  Select a High-Low or Range chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections as needed. You have the 
following options: 

Switch Axes 

Reverses the position of the two axes. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Symbols 

Uses symbols to mark the chart’s data points. 

Connect Points 

Connects all data points of the same series from one end of the axis 
to the other. This option must be selected to activate “Span Gaps.” 
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Span Gaps 

Draws connecting lines through any missing data points. Each line 
is drawn from the last data point before the missing data to the first 
data point after the missing data. It is automatically deselected if 
“Connect Points” is turned off. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Connect Points 

(Range charts only) Connects all data points of the same series 
from one end of the axis to the other. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 
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5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Line and Step Chart Options 
To set options for Line and Step charts, do the following:= 

1.  Select a Line or Step chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the 
following options: 

Show Symbols 

Uses symbols to mark the chart’s data points. 

Span Gaps 

Draws connecting lines through any missing data points. Each line 
is drawn from the last data point before the missing data to the first 
data point after the missing data. It is automatically deselected if 
“Connect Points” is turned off or if “Fill Below Lines” is selected. 
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Connect Points 

Connects all data points of the same series from one end of the axis 
to the other. This option must be selected to activate “Span Gaps.” 

Switch Axes 

Switches the X and Y axes. Deselecting switches them back again. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Fill Below Lines 

A filled polygon is drawn for each data series. It fills the space 
between the line data graphic and the category axis, similar to a 3-
D Area chart. This option can be used in conjunction with “Lines in 
Front.” 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Lines in Front 

The line data graphics in the chart are drawn in front of the line 
fills. This pre- vents the fills from obscuring any portion of the 
lines. This option is available only when “Fill Below Lines” is 
selected. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
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not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Depth Placement 

This button is only available if the depth of the chart has been 
changed using “Depth” on the Chart menu. Opens the “Depth 
Placement” dialog box so you can set the width and position of the 
data graphics. 
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Category Gap 

Controls the width and position of the data graphics based on 
a percent- age of the bar width. To change the Category Gap, 
drag the lower bar-sizing handles (squares) in the dialog box 
graphic, enter any value between 0 and 1,000, or click the 
direction arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Open High Low Close Chart Options 
To set options for Open High Low Close charts, do the following: 

1.  Select an Open High Low Close chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections as needed. You have the 
following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Switch Axes 

Reverses the position of the two axes. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Open/Close Legend 

Displays a legend showing which side of the High Low line is open 
and which side is closed. 

Hide Open 
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Hides the Open tick. 

Switch Open/Close 

Reverses the Open and Close ticks on either side of the High Low 
line. 

Hide Close 

Hides the Close tick. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Object Placement 

Opens the “Depth Placement” dialog box so you can set the length 
of the Open Close ticks. 
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Category Gap 

Controls the length of the Open Close ticks based on a 
percentage of the tick width. To change the Category Gap, 
drag the lower bar-sizing handles (squares) in the dialog box 
graphic, enter any value between 0 and 

1,000, or click the direction arrows to scroll through 
the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the “Options” dialog box. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 
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Candlestick Chart Options 
To set options for Candlestick charts, do the following: 

1.  Select a Candlestick chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Switch Axes 

Reverses the position of the two axes. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
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option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Candle Legend 

Displays a legend showing the colors associated with increasing 
and decreasing candles on the chart. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Object Placement 

Opens the “Depth Placement” dialog box so you can set the width 
of and distance between the candlesticks. 
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Category Gap 

Controls the width of and distance between the candlesticks 
based on a percentage of the candlestick width. To change the 
Category Gap, drag the lower bar-sizing handles (squares) in 
the dialog box graphic, enter any value between 0 and 1,000, 
or click the direction arrows to scroll through the percentage 
options. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Bubble Chart Options 
To set options for a Bubble chart, do the following: 
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1.  Select a Bubble chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Clip Data 

Hides or “clips off ” any bubble whose center extends outside the 
chart grids. This option will not clip off part of the bubble. 

Switch Axes 

Reverses the position of the two axes. 

Bubble Size Legend 

Controls features of the Bubble chart’s legend. 

Type 
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Determines the type of legend created. You can choose 
between an axis with ticks or a legend containing sample 
bubbles. “Align Bubble Centers” is available only when 
“With Bubble Samples” is selected and aligns the centers of 
the sample bubbles in the legend. 

Direction 

Rotates the Bubble axis legend horizontally or vertically. 

Label Position 

Determines the position of the labels in the legend. 

Size 

Displays a pop-up menu so you can size the chart’s bubbles linearly 
(size is proportionate to the data value), by volume, or by area. 

Auto Frame 

Auto-sizes the frame around the Bubble size legend when you 
resize the bubble axis or sample bubbles. If the legend has been 
manually re-sized, this option is deselected. Reselecting this option 
resets the Bubble legend frame to the default size. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Area Chart Options 
To set options for Area charts, do the following: 

1.  Select an Area chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections as needed. You have the 
following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Switch Axes 

Reverses the position of the two axes. 

Percentage 

Changes the value axis and shows each data graphic as a 
percentage of the whole. The top value changes to 1. This option 
creates an Area Percent chart. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
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can format the additional axis independently from the original axis. 
You can also set different font styles, and so on, for each set of axis 
labels. The additional axis can also be dragged and offset. Turning 
on this option is the same as choosing “Overlay” from the Chart 
menu and turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Stack From 

The values displayed in an Area chart are running sums of each 
category of input data. The initial value of the running sum can be 
zero if “Zero (0)” is selected or the value at the category 
intersection if “Axis” is selected. If “Zero (0)” is selected, the data 
graphics do not move with the axis when the axis placement is 
changed. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 
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Spider Chart Options 
Some of the options available for Spider charts are designed to create 
Radar charts. An example of a Radar chart can be found below. 

To set options for a Spider chart, do the following: 

1.  Select a Spider chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Back 

Displays an oval-shaped “back” in the chart. 
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The back can be selected by clicking first on the chart and then on 
the oval sur- rounding the category axes. The line or the fill of the 
back can be modified using the palettes in the Toolbox. 

Show Value Axis Labels 

Displays the Value labels at the end of each axes. 

Show Fill 

Displays the fill in each data graphic for all series. 

Show Arrows 

Displays arrows on the circular arcs used to annotate the categories 
contained in a group. Categories are grouped in the Data page. 

Show Outline 

Displays the outline or boundary of each data graphic for all series. 

Show Symbols 

Uses symbols to mark the chart’s data points. 

Show Axes/Ticks 

Displays all of the data series axes. These axes can be thought of as 
the spokes of the chart. If this option is off, the spokes become 
invisible. 
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Match 1st Axis 

Scales all of the value axes equally. 

 

The largest axis value determines the ending value. When this 
option is selected, any changes made to the first axis are also 
made to the rest of the axes. The various axis dialog boxes for 
the other axes are ignored unless “Match 1st Axis” is 
deselected. 

Pinch Gaps 

Draws connecting lines through any missing data points. Each data 
point is drawn from the last data point before the missing data to 
the center of the chart and then to the first data point after the 
missing data. 

Reference Angle 

Rotates the chart by the number of degrees entered. To change the 
reference angle, you can enter a number between -360° and 360°, 
or click the direction arrows to scroll the numbers in 10° 
increments. 

Spacing 

Label Gap 

Controls the distance or gap between the Value, Category, 
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and Group labels proportionately to the point size entered. To 
change this distance, you can enter a number between 0 to 
32768 points, or click the direction arrows to scroll the 
numbers in one-point increments. 

Group Tick Length 

Controls the length of the tick between the Group arrows. 

Direction 

Reverses the direction of the chart. 

Grids 

Radius Minor 

Displays the minor radial grids for the minor grids of the first 
category axis. 

Radius Major 

Displays the major radial grids for the major grids of the first 
category axis. 

 

Category 

Creates an additional spoke between each category axis. 
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For a Radar chart, make the following selections in the “Options” 
dialog box: 

Show Fill Off 

Show 
Axes/Tick Off 

Radius 
Major  On 

 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

	
  

To learn more about... Refer to... 

Creating group labels on a Spider 
chart 

“Area Chart Options”  
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Pie and Stacked Pie Chart Options 
Some of the options available for Pie charts are designed to create 
Donut charts. To set options for a Pie or Stacked Pie chart, do the 
following: 

1.  Select a Pie or Stacked Pie chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 
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Show Sum 

(Pie chart only) Displays the sum of the chart’s data series. You can 
select, change the attributes of, and move this number as you would 
any label. The new “label” first appears in the center of the pie. Use 
the commands on the Text menu to change text attributes and the 
Fill Color or Fill Pattern palette to add a color or pattern to the 
number’s background. 

 

Donut 

(Pie charts only) Creates a “hole” in the middle of the Pie chart. 
You can change the size of the hole with the “% Hole Size” option. 
This option must be selected to activate “% Hole Size.” 

% Hole Size 

(Pie charts only) Determines the size of the donut hole. To change 
the hole size, enter a value between 0% and 100%, or click the 
direction arrows to scroll the numbers in 5% increments. This 
option is available only when “Donut” is selected. 
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Reference Angle 

Rotates the pie by the number of degrees entered. To change the 
reference angle, enter a value between -360° and 360°, or click the 
direction arrows to scroll the numbers in 10° increments. 

Series Labels 

(Stacked Pie charts only) Displays a pop-up menu so you can 
position the Series axis labels in reference to the pie. Options are 
Upper Right, Lower Right, Lower Left, Upper Left, and None. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Multiple Pie Chart Options 
To set options for a Multiple Pie chart, do the following: 
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1.  Select a Multiple Pie chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Auto SuperFrame 

DeltaGraph automatically sizes the grid structure containing all the 
pies (the SuperFrame) so that it is as close as possible to a square. 
If you resize the SuperFrame by dragging one of the sizing handles 
(large box at the upper-left and lower-right corner), this option (and 
“Auto TargetFrames”) is deselected. To revert the frame back to its 
original size, reselect this option and “Auto Tar- getFrames.” 

Reference Angle 

Rotates all pies by the number of degrees entered. To change the 
reference angle, you can enter a value between -360° and 360° or 
click the direction arrows to scroll the numbers in 10° increments. 

Auto TargetFrames 
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DeltaGraph automatically determines the size of the grid structure 
containing each pie (a TargetFrame) based on the size of the largest 
pie. To change the size of the pies, click the TargetFrame handle 
and drag. All of the pies are resized proportionally. To constrain the 
pie shape to a square, use shift-Drag. To revert the TargetFrame(s) 
back to original size, reselect this option. 

 

Series Labels 

Displays a pop-up menu so you can position the Series axis labels 
in reference to each pie. Options are Above, Below, or None. 

	
  

Size Pies 

Displays a pop-up menu so you can size the pies, as follows: 

Equally 

Every pie is the same size (illustration on the left). 

By Radius 

Pies are scaled proportionately based on the radius of the 
largest pie (illustration on the right). 
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By Area 

Pies are scaled proportionately based on the area of the largest 
pie. 

Pie Layout 

Controls how the pies are arranged in the chart. You can choose to 
display the pies in rows or columns, then enter the number of rows 
or columns you want. “Auto” arranges the pies in as many rows as 
needed to accommodate the number of pies in the chart while as 
close as possible to a square for the Super- Frame. Reselecting 
“Auto” and “Rows” after trying other arrangements reverts the pies 
to their original grouping. 

 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 
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Time Line Chart Options 
To set options for a Time Line chart, do the following: 

1.  Select a Time Line chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Auto-Move Text 

DeltaGraph automatically positions chart labels for optimum 
legibility. If you reposition any or all of the labels manually, this 
option is deselected. To revert all of the chart labels back to their 
original positions, reselect this option. 

Switch Direction 

Rotates the viewing angle of the chart. The chart is displayed in the 
horizontal position unless “Switch Direction” is selected. This 
rotates the chart to the vertical position. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
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dialog box without changing the chart, click Cancel. 

Table Chart Options 
To set options for Table charts, do the following: 

1.  Select a 
Table chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Group Row Labels 

Removes the horizontal lines between the row labels. Deselect this 
option if you want the chart’s row labels separated by lines. 
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Group Column Labels 

Removes the vertical lines between the column labels. Deselect this 
option if you want the chart’s column labels separated by lines. 

Row Label Area 

Displays the row labels and the column that contains them. You 
can deselect this option if your table does not have row labels or if 
you want to remove the labels from your chart. 

Column Label Area 

Displays the column labels and the row that contains them. You 
can deselect this option if your table does not have column labels or 
if you want to remove the labels from your chart. 

Horizontal Lines 

Displays horizontal lines in the body of the chart. 

Vertical Lines 

Displays vertical lines in the body of the chart. 

Auto-Orientation 

Determines the order of row and column data and formats 
according to the default chart settings. If you make any changes to 
cell or gutter spacing default values, or to the size of the chart 
itself, you can click this button to make all spacing options revert 
to their original positions. If the Table chart is attached to a chart 
already on the Chart page, this option makes the orientation of the 
two charts the same. This option overrides all options in the 
“Manual Orientation” section. 

Cell Spacing 

Controls the horizontal and vertical dimensions of the cells in the 
chart as measured in points (1 point = 1/72"). To change cell 
spacing, you can enter a value between 0 and 32767 or click the 
direction arrows to scroll through the avail- able options. 

Gutter Spacing 
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Controls the amount of space between the text and the table’s grid 
lines as measured in points (1 point = 1/72"). To change the gutter 
spacing, you can enter a value between 0 and 16383 (half the “Cell 
Spacing” maximum) or click the direction arrows to scroll through 
the available options. You must select the options in the “Gutter 
Spacing” section to activate “Keep Cell Height” or “Keep Cell 
Width.” 

Top and Bottom 

Increases/decreases the space above and below the text in 
each row. 

Left and Right 

Increases/decreases the space to the left and the right of the 
text in each column. 

Keep Cell Height/Width 

Prevents the cell size from being changed by other gutter 
spacing options. Changing the gutter spacing automatically 
changes the size of the cells unless “Keep Cell Height” and 
“Keep Cell Width” are selected. In that case, the cell size 
remains the same. These options are available only after 
selecting one of the corresponding “Gutter Spacing” options. 

When a Table chart is attached to another chart (“Attach 
Table” on the Chart menu), one or the other of these options 
is disabled. This is because the category widths on an 
attached Table chart match exactly the widths between the 
tick marks of the original chart’s categories. 

Manual Orientation 

Controls the position of row and columns of data in the Table chart. 
This option does not affect the Data page. When this option is 
selected, “Auto-Orientation” is deselected. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
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dialog box without changing the chart, click Cancel. 

To learn more about... Refer to... 

Attaching a Table chart “Table Chart Options 

	
  

Volume Open High Low Close and Volume High 
Low Close Chart Options 

Do the following to set options for a Volume Open High Low Close or 
Volume 

High Low Close chart: 

1.  Select the chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the 
following options. 

Show Data Only 
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Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Open/Close Legend 

Displays a legend showing which side of the High Low line is open 
and which side is closed. 

Hide Open 

Hides the Open tick. 

Switch Open/Close 

Reverses the Open and Close ticks on either side of the High Low 
line. 

Hide Close 

Hides the Close tick. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis 
and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional category axis. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
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plot frame. 

Object Placement 

Opens the “Depth Placement” dialog box so you can set the length 
of the Open Close ticks. 

 

Category Gap 

Controls the length of the Open Close ticks based on a 
percentage of the tick width. To change the Category Gap, 
drag the lower bar-sizing handles (squares) in the dialog box 
graphic, enter any value between 0 and 1,000, or click the 
direction arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 
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2-D Technical Chart Options 

Scatter and XY Line Chart Options 
To set options for a Scatter, Paired Scatter, XY Line, or Paired XY 
Line chart, do the following: 

1.  Select the chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options. 

Switch Axes 

Reverses the position of the two axes. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Connect Points 
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Connects all data points of the same series. This option must be 
selected to make “Span Gaps” available. In Scatter charts, the data 
points are connected in the order selected from the Data view. In 
XY Line charts, the data points are connected from one end of the 
axis to the other. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Symbols 

Uses symbols to mark the chart’s data points. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Span Gaps 

Draws connecting lines through any missing data points. Each line 
is drawn from the last data point before the missing data to the first 
data point after the missing data. This option is available only when 
“Connect Points” is selected. 

Show Additional X Value Axis 

Displays an additional X value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis. You can also set different font styles, and so on, for each set 
of axis labels. The additional axis can also be dragged and offset. 
Turning on this option is the same as choosing “Overlay” from the 
Chart menu and turning on an additional value axis. 

Show Additional Y Value Axis 

Displays an additional Y value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis. You can also set different font styles, and so on, for each set 
of axis labels. The additional axis can also be dragged and offset. 
Turning on this option is the same as choosing “Overlay” from the 
Chart menu and turning on an additional value axis. 
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Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Grids On Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Drop Lines 

Drops a line from each data symbol to the X and/or Y axis. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Intensity Scatter and Paired Intensity Scatter 
Chart Options 

Do the following to set options for a Paired Intensity or Intensity 
Scatter chart: 

1.  Select the chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections as needed. You have the 
following options. 

Switch Axes 

Reverses the position of the two axes. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Connect Points 

Connects all data points of the same series. This option must be 
selected to make “Span Gaps” available. In Scatter charts, the data 
points are connected in the order selected from the Data view. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Symbols 

Uses symbols to mark the chart’s data points. 

Show Frame 
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Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Span Gaps 

Draws connecting lines through any missing data points. Each line 
is drawn from the last data point before the missing data to the first 
data point after the missing data. This option is available only when 
“Connect Points” is selected. 

Show Additional X Value Axis 

Displays an additional X value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional value axis. 

Show Additional Y Value Axis 

Displays an additional Y value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Grids On Top of Data 

Draws the chart grid on top of the data markers so the grid is not 
obscured. This can help maintain a perspective of the data values 
when data markers cover large areas of the plot frame. 

Drop Lines 

Drops a line from each data symbol to the X and/or Y axis. 

Ramp 
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Displays a dialog box so you can create a smooth color/gray scale 
blend for representing Z-axis intensity values on the chart. 

 

Primary 
Ramp 

Each of the selections displays a color palette you can use to 
select a start and end color or gray scale for your data 
graphic and legend. Changes are made from the top of the 
data graphic to the bottom. Changes to the ramp appear in 
the example box to the left. 

Use Secondary 
Ramp 

Works the same as the Primary Ramp. “Use Secondary 
Ramp” must be selected to activate these options. To 
determine where the secondary ramp begins, enter a value 
in the “Start Value” box. 

Outside Axis Values 

Each of the selections displays a color palette you can use to 
select a color or gray scale tint for data graphics that extend 
above or below the value axis. 

Click OK to save the changes, close the dialog box, and return 
to the 
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“Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

XY Column Chart Options 
To set options for XY Column charts, do the following: 

1.  Select an XY Column chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Show Symbols 

Allows you to use symbols to marks the chart’s data points. 

Switch Axes 
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Switches the X and Y axes. Deselecting switches them back again. 

Clip Data 

Hides or “clips off” any data plotted outside the chart grids. 

Show Frame 

Is used to add or remove the chart frame. It provides a backplane to 
the chart but does not affect the grid. This option must be selected 
if you want to fill the chart with a pattern or color or use a shadow. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Start From Y Axis 

Draws a line from the Y axis to the first data point. 

Show Additional X Value Axis 

Displays an additional X value axis opposite the original value 
axis. You can format the additional axis independently from the 
original axis and set different font styles for each set of axis labels. 
The additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional value axis. 

Show Additional Y Value Axis 

Displays an additional Y value axis opposite the original value 
axis. You can format the additional axis independently from the 
original axis and set different font styles for each set of axis labels. 
The additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Grids on Top of Data 



 
  DeltaGraph for Macintosh Version 7 User Guide 442 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Polar Chart Options 
To set options for a Polar chart, do the following: 

1.  Select a Polar chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Radius Label Position 
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Places labels along the radius in each of the positions selected. You 
can select one or more options. 

The “Start” and “End” options are available only if you have 
scaled your chart to less than 360° with the “Angle Axis” dialog 
box. To access the “Angle Axis” dialog box, choose Axis from 
the Chart menu and select Angle from the submenu. See 
“Changing Axis Offset” in Chapter 9. 

 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Symbols 

Uses symbols to mark the chart’s data points. 

Connect Points 

Connects all data points of the same series. This option must be 
selected to activate “Span Gaps.” 

Span Gaps 

Draws connecting lines through any missing data points. Each line 
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is drawn from the last data point before the missing data to the first 
data point after the missing data. This option is available only when 
“Connect Points” is selected. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Ternary and Percent Ternary Chart Options 
To set options for Ternary or Percent Ternary charts, do the following: 

1.  Select a Ternary or Percent Ternary chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Show Data Only 
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Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Projected Axis Titles 

Draws axis titles in perspective to the axis. 

Show Drop Lines 

Drops a line from each data symbol to each of the three axis planes. 

Projected Labels 

Draws labels in perspective to the grid lines. 

Projected Ticks 

Draws ticks in perspective to the grid lines. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Axis Direction 

Rotates the chart axes clockwise or counterclockwise, as shown 
below. 
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Title Direction 

Places the axis titles on the side of each axis or at the points of the 
triangle. 

Data/Axis Assignment 

Displays a pop-up menu so you can choose the location of each of 
the three value axes. The values for the X-axis typically come from 
column A. If you plotted non-adjacent data, however, it is the first 
column you selected. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

To learn more about... Refer to... 

Creating axis titles “Creating and Positioning Axis Labels 
and Titles” in Chapter 9 

	
  

Contour Line Chart Options 
To set options for Contour Line and XYZ Contour Line charts, do the 
following: 

1.  Select the chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections and enter data as needed. You have 
the following options: 

Frame 

Select one of the following: 

Show Data Only 

Displays only the data graphics, hiding all other chart 
elements, including the frame and labels. 

Show Axes, No Frame 

Displays the X and Y axes but does not display the chart 
frame. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. 
This option must be selected if you want to fill the chart with 
a pattern or color or use a shadow. 

Line Labels 

Controls the placement of the elevation labels on the contour line. 
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Label Rotation 

Displays a pop-up so you can choose the rotation of elevation 
labels. Options are 0°, 90°, 180°, 270°, Tangent, and Off. 
“Tangent” rotates the labels at the same angle as the contour 
lines. “Off” hides the labels. 

Major Spacing 

Controls the spacing between labels on the contour lines. Unit 
of measure is determined in “Rulers & Grids” on the Draw 
menu. To change the spacing between labels, you can enter a 
value or click the direction arrows to scroll through the 
available options. 

Data Display 

Controls the following display options: 

Square Grids 

Changes the grid pattern into squares where the grid lines for 
the X and Y axes intersect. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Draw Triangle Network 

(XYZ Contour Line chart only) Connects data points together 
in a triangular pattern on the surface of the chart. 

Show Symbols 

(XYZ Contour Line chart only) Uses symbols to mark the 
chart’s data points. 

Depression Ticks 

Controls the attributes of depression ticks, which indicate a 
depression (such as a hole or volcano) in the elevation relief. 

Show Ticks 
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Displays depression tick marks. 

Tick Length 

Controls the length of the depression ticks in points. To 
change tick length, you can enter a value or click the 
direction arrows to scroll through the available options. 

Tick Spacing 

Controls the distance between depression ticks. Unit of 
measure is deter- mined in “Rulers & Grids” on the Draw 
menu. To change tick spacing, you can enter a value or click 
the direction arrows to scroll through the available options. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Contour Fill Chart Options 
To set options for Contour Fill and XYZ Contour Fill charts, do the 
following: 

1.  Select the chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections as needed. You have the following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Square Grids 

Changes the grid pattern into squares where the grid lines for the X 
and Y axes intersect. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Ramp 

Displays a dialog box so you can create a smooth color/gray scale 
blend in the chart’s data graphics and legend. 

 

Primary Ramp 

Each of the selections displays a color palette you can use to 
select a start and end color or gray scale for your data 
graphic and legend. Changes are made from the top of the 
data graphic to the bottom. Changes to the ramp appear in 



 
  DeltaGraph for Macintosh Version 7 User Guide 451 

the example box to the left. 

Use Secondary Ramp 

Works the same as the Primary Ramp. “Use Secondary 
Ramp” must be selected to activate these options. To 
determine where the secondary ramp begins, enter a value 
in the “Start Value” box. 

Outside Axis Values 

Each of the selections displays a color palette you can 
use to select a color or gray scale tint for data graphics 
that extend above or below the value axis. 

Click OK to save the changes, close the dialog box, and 
return to the “Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Gridded Vector Chart Options 
To set options for a Gridded Vector chart, do the following: 

1.  Select a Gridded Vector chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections and enter data as needed. You have 
the following options: 

Vector Length 

Adjusts the vector line length as a percentage of the space 
between the adjacent horizontal grid lines. If the “Pivot” point 
orientation (see below) is “Head” or “Tail,” the vector orientation 
is a percentage of one half the distance between the adjacent 
horizontal grid lines. 

Switch Axes 

Reverses the position of 
the two axes. 

Clip Data 

Hides or “clips off ” any data plotted outside 
the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 
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Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Square Grids 

Changes the grid pattern into squares where the grid lines for the 
X and Y axes intersect. 

Vector Orientation 

These options determine the position and orientation of the vector 
(arrow) data graphic. 

Pivot 

Determines the pivot point of the vector graphic, or the point 
of connection from which the vector swings: from the Head 
of the arrow, from the Center of the arrow, or from the Tail of 
the arrow. 

Reference Angle 

Rotates the vector by the number of degrees entered. To 
change the reference angle, you can enter a number between -
360° and 360° or click the direction arrows to scroll the 
numbers in 5° increments. 

Increasing 

Determines whether the vector angle increases in a clockwise 
or a counterclockwise direction. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

R/A Gridded Vector and XY Vector Chart Options 
To set options for an R/A Vector Gridded or XY Vector chart, do the 
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following: 

1.  Select an R/A Gridded Vector or XY Vector chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Data Type 

Displays a pop-up so you can select a data type method for 
determining the vector ending point. All three methods use column 
one (X coordinate) and column two (Y coordinate) of each data 
series to determine the starting point of the vector based on the X 
and Y axes scaling. The ending point of the vector is determined by 
one of the following three methods: 

Delta (Change) 
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(XY Vector chart only) The sum from column one and 
column three gives the X coordinate based on the X axis. The 
sum of column two and column four gives the Y coordinate 
based on the Y axis. 

End Point 

(XY Vector chart only) The third column gives the value of 
the X coordinate based on the X axis. The fourth column 
gives the value of the Y coordinate based on the Y axis. 

Radius/Angle 

The third column gives the value of the vector’s radius length. 
On an R/A Gridded Vector chart, the maximum length can be 
adjusted using the “Vector Length” option. On the XY Vector 
chart, the maximum length of the vector is determined by the 
Vector Legend, which can be dragged to adjust this length. 
The fourth column gives the value of the angle in degrees. In 
an XY Vector chart, this option must be selected to activate 
“Show Legend” and the “Vector Orientation” options. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Square Grids 

(R/A Gridded Vector chart only) Changes the grid pattern into 
squares where the grid lines for the X and Y axes intersect. 

Switch Axes 

Reverses the position of the two axes. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 
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Vector Length 

(R/A Gridded Vector chart only) Adjusts the vector line length as a 
percentage of the space between the adjacent horizontal grid lines. 
If the “Pivot” point orientation (see below) is “Head” or “Tail,” it is 
a percentage of one half the distance between the adjacent 
horizontal grid lines. 

Vector Radius Legend 

Controls the appearance of the vector legend. The legend represents 
the maximum vector length. In the XY Vector chart legend, you 
can drag the vector to alter the length on the Radius/Angle data 
type. 

Show Legend 

Displays the chart legend. In an XY Vector chart, this option 
is available only when “Radius/Angle” is selected on the 
“Data Type” pop-up menu. “Show Legend” must be selected 
to activate the rest of the options in the “Vector Radius 
Legend” section of the dialog box. 

Auto Frame 

Resizes the vector legend to fit the current size of the legend 
object. In an XY Vector chart, this option is available only 
when “Radius/Angle” on the “Data Type” pop-up menu and 
“Show Legend” are selected. 

Direction 

Determines if the vector legend is drawn horizontally or 
vertically. In an XY Vector chart, this option is available only 
when “Radius/Angle” on the “Data Type” pop-up menu and 
“Show Legend” are selected. 

Label Position 

Determines the position of the labels in the legend. In an XY 
Vector chart, this option is available only when 
“Radius/Angle” on the “Data Type” pop-up menu and “Show 
Legend” are selected. 

Vector Orientation 
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These options determine the position and orientation of the vector 
(arrow) data graphic. In an XY Vector chart, this option is available 
only when “Radius/ Angle” on the “Data Type” pop-up menu is 
selected. 

Pivot 

Determines the pivot point of the vector graphic, or the point 
of connection from which the vector swings: from the Head 
of the arrow, from the Center of the arrow, or from the Tail of 
the arrow. 

Reference Angle 

Rotates the vector by the number of degrees entered. To 
change the reference angle, you can enter a number between -
360° and 360° or click the direction arrows to scroll the 
numbers in 5° increments. 

Increasing 

Determines whether the vector angle increases in a clockwise 
or a counterclockwise direction. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

2-D Statistical Chart Options 

Histogram Chart Options 
To set options for Histogram charts, do the following: 

1.  Select a Histogram chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
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box appears. 

 

3.  Make your selections as needed. You have the following options: 

Percentage 

The heights of the data series represent the count in a bin as a 
percentage of the total count of all bins. With this method, the sum 
of all the heights of the bins add up to 1 (i.e., 100%). This scaling 
of data in a histogram is commonly known as “relative frequency.” 
This is the most convenient form for comparing the frequency 
counts of some data to a known probability density function. 

Clip Data 

Hides or clips off any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Ogive 

Displays the “cumulative frequency” with the frequency counts. It 
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is displayed as a line data graphic. At each category boundary, the 
running sum of all the “previous” categories is plotted. This option 
must be selected to activate “Running Sum Increases.” 

Switch Axes 

Reverses the position of the two axes. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis 
and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis. You can also set different font styles, and so on, for each set 
of axis labels. The additional axis can also be dragged and offset. 
Turning on this option is the same as choosing “Overlay” from the 
Chart menu and turning on an additional value axis. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Running Sum increases 

Controls the direction of the Ogive data graphic. If “Switch Axes” 
is selected, the choices shown below change to “To the top” and 
“To the bottom” respectively. This option is available only when 
“Show Ogive” is selected. 

To the right 

The running sum increases from left to right on the chart. 

To the left 
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The running sum increases from right to left on the chart. 

Binning 

Displays a dialog box so you can specify how data is grouped or 
“binned” for counting and how the counted data is labeled. 

 

Bin Method 

When plotting any of the charts that require the binning of the 
data, select either Count Data or Use Range. “Count Data” is 
used when each unique value in the data set needs to be given 
a bin of its own. This is only useful if the data are repetitive, 
that is, the same data values appear more than once. “Use 
Range” is used when the desired bins are equal length 
intervals of numbers. The controls for “Use Range” are very 
similar to those in a “Value Axis” dialog box. 

Count Data 

Sizes of the bins are chosen to be just big enough to 
correspond to exactly one data value and there is one bin for 
each data value. Consequently, no bin is ever empty. 

Use Range 
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Each bin corresponds to a range of numbers. Even if there is 
no repetition in the data, some bins may correspond to several 
data values and some bins correspond to no values. The fields 
correspond to fields in a value axis dialog box, as follows: 

Max = Top Value 

Min = Bottom Value 

Inc = Major Increments 

Auto check boxes = Auto check boxes 

Automatic scaling = Standard or Floating scaling 

To determine the bin boundaries, the same logic is used as 
that to deter- mine where the major ticks are placed along an 
axis. Given the same cor- responding inputs in the “Binning” 
dialog box and “Value Axis” dialog boxes, the values of the 
bin boundaries correspond exactly to the values of the major 
ticks along an axis. When counting frequency, a data value is 
counted towards a particular bin if the value is between the 
values of its bin boundaries. 

Include End Effects 

Determines if two extra bins are created for a “Use Range” 
bin method. One bin is used to count all the values beyond the 
“Min” value and the other bin is used to count all the values 
beyond the “Max” value. 

Data Between Bins 

Determines which bin a data value falls into if it is equal to a 
bin boundary. If “Move Higher” is selected, the value is 
added to the next highest bin. If “Move Lower” is selected, 
the value is added to the next lowest bin. 

Label Positions 

Determines the position of the bin boundary labels. “On Bin 
Edge,” the category axis labels correspond to bin boundary 
values. “In Bin Center,” the category axis labels can have 
three different forms, as follows: 
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[min, max) 

The low and high bin boundary values are placed in the 
label. Each boundary value is separated by a list separator 
and a space and sur- rounded with either “[...)” or “(...],” 
depending on whether “Move Higher” or “Move Lower” 
is selected, respectively. If “Include Ends” is selected, the 
low end label and the high end label look something like 
“(-×, max]” or “(min, ×].” 

mid-point 

The arithmetic mean of the two bin boundaries is placed 
in the label. 

If “Include Ends” is on, no labels are generated for the 
end bins. 

min ≤ x < max 

The low and high bin boundary values are placed in the 
label. Each boundary value is separated by “≤ x <” or “< 
x ≤” depending on whether “Move Higher” or “Move 
Lower” is selected, respectively. If “Include Ends” is on, 
the labels created for the end bins look something like 
“x≤0” or “100<x.” 

The use of “min” and “max” on the pop-up refers to the 
minimum and maximum bin boundary values for each 
bin, not the “Min” and “Max” number items in the “Use 
Range” section of the dialog box. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

Bar Placement 

Opens the “Bar Placement” dialog box so you can set the width and 
position of the data graphics. The dialog box graphic reflects the 
number of data series in your chart. 
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Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To 
change the Category Gap, drag the lower bar-sizing handles 
(squares) in the dialog box graphic, enter any value between 0 
and 1,000, or click the direction arrows to scroll through the 
percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag 
the upper bar-sizing handles (squares) in the dialog box 
graphic, enter any number between -100 and 1,000, or click 
the direction arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
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changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Survival Chart Options 
To set options for Survival charts, do the following: 

1.  Select a Survival chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Show Symbols 

Allows you to use symbols to mark the chart’s data points. 

Span Gaps 

Draws connecting lines through any missing data points. Each line 
is drawn from the last data point before the missing data to the first 
data point after the missing data. It is automatically deselected if 
“Connect Points” is turned off or if “Fill Below Lines” is selected. 

Connect Points 
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Connects all data points of the same series from one end of the axis 
to the other. This option must be selected to activate “Span Gaps.” 

Switch Axes 

Switches the X and Y axes. Deselecting switches them back again. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Additional X Value Axis 

Displays an additional X value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional value axis. 

Show Additional Y Value Axis 

Displays an additional Y value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Grids on Top of Data 
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Draws the chart grid on top of the data markers so that the grid is 
not obscured. 

This can help to maintain a perspective on your data values 
when you have data markers that cover large areas of the plot 
frame. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Pareto Chart Options 
To set options for a Pareto chart, do the following: 

1.  Select a Pareto chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 
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Percentage 

Determines if the height of the column represents the number of 
data items that are less than or equal to the current bin boundary as 
a percentage of the total count of all bins. With this method, the 
position of the column on the value axis starts at 0% on one end of 
the chart and ends at 1 or 100% on the other end. This scaling of 
data in a Pareto chart is called “relative.” This is the most 
convenient form for comparing the cumulative frequency counts of 
some data to a known probability distribution function. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Ogive 

Displays the “cumulative frequency” with the frequency counts. It 
is displayed as a line data graphic. At each category boundary, the 
running sum of all the “previous” categories is plotted. This option 
must be selected to activate “Running Sum Increases.” 

Switch Axes 

Reverses the position of the two axes. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis 
and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional category axis. 
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Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can format the additional axis independently from the original 
axis. You can also set different font styles, and so on, for each set 
of axis labels. The additional axis can also be dragged and offset. 
Turning on this option is the same as choosing “Overlay” from the 
Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Sort Increases 

Displays a pop-up menu so you can choose the direction in which 
to sort the bins. If “Switch Axes” is selected, the choices shown 
below change to “To the bottom” and “To the top” respectively. 

To the left 

The column sizes increases in size from right to left. 

To the right 

The column sizes increases in size from left to right. 

Running Sum Increases 

Controls the direction of the Ogive data graphic. If “Switch Axes” 
is selected, the choices shown below change to “To the top” and 
“To the bottom” respectively. This option is available only when 
“Show Ogive” is selected. 

To the right 

The running sum increases from left to right on the chart. 
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To the left 

The running sum increases from right to left on the chart. 

Binning 

Displays a dialog box so you can specify how data is grouped or 
“binned” for counting and how the counted data is labeled. In a 
Pareto chart, the bins are sorted according to the frequency count 
for each bin. 

 

Bin Method 

When plotting charts that require the binning of data, select 
either Count Data or Use Range. Select Count Data if each 
unique value in the data set requires a bin of its own. This is 
only useful if the data are repetitive (i.e., the same data values 
appear more than once). Select Use Range if the desired bins 
are equal length intervals of numbers. 

Count 
Data 

Bin sizes are chosen to correspond to one data value and 
there is one bin for each data value. Consequently, no bin 
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is ever empty. 

Use 
Range 

Each bin corresponds to a range of numbers. Even if no 
data are repetitive, some bins may correspond to several 
data values and some to no values. The fields correspond 
to fields in a value axis dialog box, as follows: 

Max = Top Value 

Min = Bottom Value 

Inc = Major Increments 

Auto check boxes = Auto check boxes 

Automatic scaling = Standard or Floating scaling 

To determine the bin boundaries, the same logic is used as 
that to deter- mine where the major ticks are placed along an 
axis. Given the same corresponding inputs in the “Binning” 
dialog box and “Value Axis” dialog boxes, the values of the 
bin boundaries correspond exactly to the values of the major 
ticks along an axis. When counting frequency, a data value is 
counted towards a particular bin if the value is between the 
values of its bin boundaries. 

Include End Effects 

Determines if two extra bins are created for a “Use Range” 
bin method. One bin is used to count all the values beyond the 
“Min” value and the other bin is used to count all the values 
beyond the “Max” value. 

Data Between Bins 

Determines which bin a data value falls into if it is equal to a 
bin boundary. If “Move Higher” is selected, the value is 
added to the next highest bin. If “Move Lower” is selected, 
the value is added to the next lowest bin. 

Label Positions 
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Determines the position of the bin boundary labels. “On Bin 
Edge,” the category axis labels correspond to bin boundary 
values. “In Bin Center,” the category axis labels can have 
three different forms, as follows: 

[min, max) 

The low and high bin boundary values are placed in the 
label. Each boundary value is separated by a list separator 
and a space and surrounded with either “[...)” or “(...],” 
depending on whether “Move Higher” or “Move Lower” 
is selected, respectively. If “Include Ends” is selected, the 
low end label and the high end label look something like 
“(-×, max]” or “(min, ×].” 

mid-point 

The arithmetic mean of the two bin boundaries is placed 
in the label. If “Include Ends” is on, no labels are 
generated for the end bins. 

min ≤ x < max 

The low and high bin boundary values are placed in the 
label. Each boundary value is separated by “≤ x <” or “< 
x ≤” depending on whether “Move Higher” or “Move 
Lower” is selected, respectively. If “Include Ends” is on, 
the labels created for the end bins look something like 
“x≤0” or “100<x.” 

The use of “min” and “max” on the pop-up refers to the 
minimum and maximum bin boundary values for each 
bin, not the “Min” and “Max” number items in the “Use 
Range” section of the dialog box. 

Click OK to save the changes, close the dialog box, and return 
to the 

“Options” dialog box. 

Bar Placement 

Opens the “Bar Placement” dialog box to set the width and 
position of the data graphics. The dialog box graphic reflects the 
number of data series in the chart. 



 
  DeltaGraph for Macintosh Version 7 User Guide 472 

 

Category Gap 

Controls the space between data graphics and grid lines on the 
category axis based on a percentage of the bar width. To 
change the Category Gap, drag the lower bar-sizing handles 
(squares) in the dialog box graphic, enter any value between 0 
and 1,000, or click the direction arrows to scroll through the 
percentage options. 

Series Gap 

Controls the space between each data graphic based on a 
percentage of the bar width. To change the Series Gap, drag 
the upper bar-sizing handles in the dialog box graphic, enter 
any number between -100 and 1,000, or click the direction 
arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the “Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
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dialog box without changing the chart, click Cancel. 

Ogive Chart Options 
To set options for an Ogive chart, do the following: 

1.  Select an Ogive chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Percentage 

Determines if the height of the line represents the number of data 
items that are less than or equal to the current bin boundary as a 
percentage of the total count of all bins. With this method, the 
position of the line on the value axis starts at 0% on one end of the 
chart and ends at 1 or 100% on the other end. This scaling of data 
in an Ogive chart is called “relative.” This is the most convenient 
form for comparing the cumulative frequency counts of some data 
to a known probability distribution function. 

Show Data Only 
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Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Connect Points 

Connects all data points in the same series from one end of the axis 
to the other. 

Switch Axes 

Reverses the position of the two axes. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis 
and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Show Legend 

Displays the chart legend. Deselect this option to hide the legend. 

Grids on Top of Data 
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Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Running Sum Increases 

Controls the direction of the Ogive data graphic. If you select 
“Switch Axes,” the options change to “To the right” and “To the 
left” respectively. 

To the right 

The running sum increases from left to right on the chart. 

To the left 

The running sum increases from right to left on the chart. 

Binning 

Displays a dialog box so you can specify how data is grouped or 
“binned” for counting and how the counted data is labeled. 

 

Bin Method 
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When plotting any of the charts that require the binning of the 
data, select either Count Data or Use Range. “Count Data” is 
used when each unique value in the data set needs to be given 
a bin of its own. This is only useful if the data are repetitive, 
that is, the same data values appear more than once. “Use 
Range” is used when the desired bins are equal length 
intervals of numbers. The controls for “Use Range” are very 
similar to those in a “Value Axis” dialog box. 

Count Data 

Sizes of the bins are chosen to be just big enough to 
correspond to exactly one data value and there is one bin for 
each data value. Consequently, no bin is ever empty. 

Use Range 

Each bin corresponds to a range of numbers. Even if there is 
no repetition in the data, some bins may correspond to several 
data values and some bins correspond to no values. The fields 
correspond to fields in a value axis dialog box, as follows: 

Max = Top Value 

Min = Bottom Value 

Inc = Major Increments 

Auto check boxes = Auto check boxes 

Automatic scaling = Standard or Floating scaling 

To determine the bin boundaries, the same logic is used as 
that to deter- mine where the major ticks are placed along an 
axis. Given the same cor- responding inputs in the “Binning” 
dialog box and “Value Axis” dialog boxes, the values of the 
bin boundaries correspond exactly to the values of the major 
ticks along an axis. When counting frequency, a data value is 
counted towards a particular bin if the value is between the 
values of its bin boundaries. 

Include End Effects 

Determines if two extra bins are created for a “Use Range” 
bin method. One bin is used to count all the values beyond the 
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“Min” value and the other bin is used to count all the values 
beyond the “Max” value. 

Data Between Bins 

Determines which bin a data value falls into if it is equal to a 
bin boundary. If “Move Higher” is selected, the value is 
added to the next highest bin. If “Move Lower” is selected, 
the value is added to the next lowest bin. 

Label Positions 

Determines the position of the bin boundary labels. “On Bin 
Edge,” the category axis labels correspond to bin boundary 
values. “In Bin Center,” the category axis labels can have 
three different forms, as follows: 

[min, max) 

The low and high bin boundary values are placed in the 
label. Each boundary value is separated by a list separator 
and a space and surrounded with either “[...)” or “(...],” 
depending on whether “Move Higher” or “Move Lower” 
is selected, respectively. If “Include Ends” is selected, the 
low end label and the high end label look something like 
“(-×, max]” or “(min, ×].” 

mid-point 

The arithmetic mean of the two bin boundaries is placed 
in the label. If “Include Ends” is on, no labels are 
generated for the end bins. 

min ≤ x < max 

The low and high bin boundary values are placed in the 
label. Each boundary value is separated by “≤ x <” or “< 
x ≤” depending on whether “Move Higher” or “Move 
Lower” is selected, respectively. If “Include Ends” is on, 
the labels created for the end bins look something like 
“x≤0” or “100<x.” 

The use of “min” and “max” on the pop-up refers to the 
minimum and maximum bin boundary values for each 
bin, not the “Min” and “Max” number items in the “Use 
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Range” section of the dialog box. 

Click OK to save the changes, close the dialog box, and 
return to the “Options” dialog box. 

Depth Placement 

This button is only available if the depth of the chart has been 
changed using “Depth” on the Chart menu. Opens the “Depth 
Placement” dialog box so you can set the width and position of the 
data graphics. 

 

Category Gap 

Controls the width and position of the data graphics based on 
a percentage of the bar width. To change the Category Gap, 
drag the lower bar-sizing handles (squares) in the dialog box 
graphic, enter any value between 0 and 1,000, or click the 
direction arrows to scroll through the percentage options. 

Click OK to save the changes, close the dialog box, and return 
to the “Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 
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5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Box Plot Chart Options 
To set options for a Box Plot chart, do the following: 

1.  Select a Box Plot chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the 
following options: 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Switch Axes 
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Reverses the position of the two axes. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Show Mean 

Draws a symbol for the mean of each category. The symbol is 
centered over the category in the category axis dimension. It is 
drawn at the arithmetic mean of all the data in the category in the 
value axis dimension. 

Show Additional Category Axis 

Displays an additional category axis opposite the original axis. You 
can format the additional axis independently from the original axis 
and set different font styles for each set of axis labels. The 
additional axis can also be dragged and offset. Turning on this 
option is the same as choosing “Overlay” from the Chart menu and 
turning on an additional category axis. 

Show Additional Value Axis 

Displays an additional value axis opposite the original value axis. 
You can for- mat the additional axis independently from the 
original axis. You can also set different font styles, and so on, for 
each set of axis labels. The additional axis can also be dragged and 
offset. Turning on this option is the same as choosing “Overlay” 
from the Chart menu and turning on an additional value axis. 

Object Placement 

Opens the “Depth Placement” dialog box so you can set the width 
and position of the data graphics. 
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Category Gap 

Controls the width and position of the box based on a 
percentage of the bar width. To change the Category Gap, 
drag the lower bar-sizing handles (squares) in the dialog 
box graphic, enter any value between 0 and 1,000, or click 
the direction arrows to scroll through the percentage 
options. 

Click OK to save the changes, close the dialog box, and 
return to the “Options” dialog box. 

Grids on Top of Data 

Draws the chart grid on top of the data markers so that the grid is 
not obscured. This can help to maintain a perspective on your data 
values when you have data markers that cover large areas of the 
plot frame. 

Show Outlier Caps 

Lets you either show or hide outlier caps and customize their width. 
The default is set to show the caps at 0.2 inches. Width can be 
specified in inches, centimeters, points, picas, or ciceros. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
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the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

Quality Control Chart Options 
To set options for a X-R (X Bar-R), X-S (X Bar-S), Fraction 
Defective (p), Number of Defectives (pn), Defectives Per Unit (u), or 
Number of Defects (c) chart, do the following: 

1.  Select a Quality Control chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Chart Options 

Select the type of QC chart. The choices that appear will vary 
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depending on the type of QC chart you selected from the chart 
gallery. For example, for an X- Bar you can change the lower chart 
from Range (X Bar-R) to Standard Deviation (X Bar-S). 

Show Symbols 

Allows you to use symbols to mark the chart’s data points. 

Show Data Only 

Displays only the data graphics, hiding all other chart elements, 
including the frame and labels. 

Show Frame 

Provides a backplane to the chart but does not affect the grid. This 
option must be selected if you want to fill the chart with a pattern 
or color or use a shadow. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Switch Axes 

Reverses the position of the two axes. 

Allow Negative Values 

Allows negative control limits. When you plot a QC chart, the 
upper and lower warning and control limits are automatically 
calculated based on your data. These can be negative, as they often 
are when used, for example, to measure defects in a flow process. 

Show Mean 

The mean is calculated from the sample data and plotted on the 
chart as the central line. 

Show Control Limits 

The options in this group box set the upper and lower control limits 
on a QC chart, indicating when sampled data is outside the control 
range and requires investigation. You have the choice of having 
DeltaGraph automatically calculate the control limits based on the 
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sigma value or manually applying an upper and lower control limit 
in the dialog box. 

Sigma Limits 

DeltaGraph sets the upper and lower control or warning sigma 
limits (standard deviations) above and below the central line. 
When selected, these limits are calculated automatically. When the 
subgroup size is constant, control limits result in a straight line. 
When they are variable, they are represented as a stepped line. By 
default, DeltaGraph applies a sigma value of 3 for control limits 
above and below the central line and 2 for warning limits above 
and below the central line. 

Annotation 

This group box allows you to set display attributes for each QC 
chart. You can show or hide control labels, the legend, and 
control values. 

Show Warning Limits 

This group box sets upper and lower warning limits on a QC 
chart, indicating when sampled data is outside the control range 
and requires investigation. You have the choice of having 
DeltaGraph automatically calculate the warning limits based on 
the sigma value or manually applying an upper and lower 
warning limit in the dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 
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3-D Business Chart Options 

3-D Column Chart Options 
To set options for a 3-D Column chart, do the following: 

1.  Select a 3-D Column chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Square Grids 

Changes the grid pattern into squares on the bottom plane of the 
chart. 

Projected Ticks and Labels 
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Draws ticks and labels in perspective to the grid lines. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Ticks and Labels Outside Walls 

Extends the ticks slightly beyond the chart walls and places the 
labels outside the walls at the same perspective as the ticks. 

Back Planes 

Turns any or all six backplanes on or off. (Backplanes are the 
“walls” of the chart.) West, North, and Bottom planes represent the 
left, right, and bottom planes on a default chart. When you click 
one of the check boxes, the respective axis on the sample box is 
highlighted. 

South, East, and Top planes in a default chart represent the 
invisible sides and top of the chart. The South, East, and Top 
plane options are only effective if the rotation of the chart has 
been changed using “3-D View” from the Chart menu. 

Bar Width 

Controls the width of the chart’s data graphics using the category 
and series axis grids as a boundary and based on a percentage of 
the base grid size. 

To change the width of the data graphics, you can drag the sizing 
handles vertically (resizes the graphics along the series axis) or 
horizontally (resizes the graphics along the category axis), enter a 
value between 1% and 100%, or click the direction arrows to 
scroll through the options. 

Shape 

Determines the shape of the data graphics. You can choose from 
bars, pyramids, monuments, and cylinders. 

Wall Thickness 

Controls the thickness of one or all backplanes on the chart as 
measured in points (1 point = 1/72"). To change the wall thickness, 
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enter a point size in the “Thickness” text box, or click the direction 
arrows to scroll through the values. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

3-D Ribbon Chart Options 
To set options for a 3-D Ribbon chart, do the following: 

1.  Select a 3-D Ribbon chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 
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Square Grids 

Changes the grid pattern into squares on the bottom plane of the 
chart. 

Projected Ticks and Labels 

Draws ticks and labels in perspective to the grid lines. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Ticks and Labels Outside Walls 

Extends the ticks slightly beyond the chart walls and places the 
labels outside the walls at the same perspective as the ticks. 

Back Planes 

Turns any or all six backplanes on or off. (Backplanes are the 
“walls” of the chart.) West, North, and Bottom planes represent the 
left, right, and bottom planes on a default chart. When you click 
one of the check boxes, the respective axis on the sample box is 
highlighted. 

South, East, and Top planes in a default chart represent the 
invisible sides and top of the chart. The South, East, and Top 
plane options are only effective if the rotation of the chart has 
been changed using “3-D View” from the Chart menu. 

Ribbon Size 

Controls the width and depth of the chart’s data graphics. The 
width of the ribbon is based on a percentage of the grid size, the 
depth is measured in points (1 point = 1/72"). 

To change the ribbon width, you can drag the sizing handles up or 
down, enter a value between 0% and 100%, or click the direction 
arrows to scroll through the options. 

To change the depth, you can enter a point size between 0 and 
250, or click the direction arrows to scroll through the point sizes. 

Wall Thickness 
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Controls the thickness of one or all backplanes on the chart as 
measured in points (1 point = 1/72"). To change the wall thickness, 
enter a point size in the 

“Thickness” text box, or click the direction arrows to scroll through 
the values. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

3-D Area Chart Options 
To set options for a 3-D Area chart, do the following: 

1.  Select a 3-D Area chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 
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3.  Make your selections and enter data as needed. You have 
the following options: 

Square Grids 

Changes the grid pattern into squares on the bottom plane of the 
chart. 

Projected Ticks and Labels 

Draws ticks and labels in perspective to the grid lines. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Ticks and Labels Outside Walls 

Extends the ticks slightly beyond the chart walls and places the 
labels outside the walls at the same perspective as the ticks. 

Back Planes 

Turns any or all six backplanes on or off. (Backplanes are the 
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“walls” of the chart.) West, North, and Bottom planes represent the 
left, right, and bottom planes on a default chart. When you click 
one of the check boxes, the respective axis on the sample box is 
highlighted. 

South, East, and Top planes in a default chart represent the 
invisible sides and top of the chart. The South, East, and Top 
plane options are only effective if the rotation of the chart has 
been changed using “3-D View” from the Chart menu. 

Line Width 

Controls the width of the chart’s data graphics based on a 
percentage of the grid size. To change the line width, you can drag 
the sizing handles up or down, enter a value between 0% and 
100%, or click the direction arrows to scroll through the options. 

Wall Thickness 

Controls the thickness of one or all backplanes on the chart as 
measured in points (1 point = 1/72"). To change the wall thickness, 
enter a point size in the “Thickness” text box, or click the direction 
arrows to scroll through the values. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 
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3-D Technical Chart Options 

3-D Scatter Chart Options 
To set options for a 3-D Scatter chart, do the following: 

1.  Select a 3-D Scatter chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Square Grids 

Changes the grid pattern into squares on the bottom plane of the 
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chart. 

Projected Ticks and Labels 

Draws ticks and labels in perspective to the grid lines. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Ticks and Labels Outside Walls 

Extends the ticks slightly beyond the chart walls and places the 
labels outside the walls at the same perspective as the ticks. 

Back Planes 

Turns any or all six backplanes on or off. (Backplanes are the 
“walls” of the chart.) West, North, and Bottom planes represent the 
left, right, and bottom planes on a default chart. When you click 
one of the check boxes, the respective axis on the sample box is 
highlighted. 

South, East, and Top planes in a default chart represent the 
invisible sides and top of the chart. The South, East, and Top 
plane options are only effective if the rotation of the chart has 
been changed using “3-D View” from the Chart menu. 

Drop 
Lines 

Drops a line from each data symbol to the selected plane. You can 
choose from XY Plane, XZ Plane, YZ Plane, or None. 

Symbol 
Orientation 

Draws the data symbols in the selected plane, which changes the 
symbols’ orientation. You can choose the XY, XZ, and YZ plane. 

Wall Thickness 

Controls the thickness of one or all backplanes on the chart as 
measured in points (1 point = 1/72"). To change the wall 
thickness, enter a point size in the “Thickness” text box, or 
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click the direction arrows to scroll through the values. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

3-D Wireframe Chart Options 
To set options for a 3-D Wireframe chart, do the following: 

1.  Select a 3-D Wireframe chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Square Grids 
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Changes the grid pattern into squares on the bottom plane of the 
chart. 

Projected Ticks and Labels 

Draws ticks and labels in perspective to the grid lines. 

Fill Wireframe 

Fills in the wireframe so the data graphic is opaque and you can 
add colors and fill patterns. 

Ticks and Labels Outside Walls 

Extends the ticks slightly beyond the chart walls and places the 
labels outside the walls at the same perspective as the ticks. 

Color by Value 

Assigns colors to each series based on the Z axis value. “Fill 
Wireframe” must be selected to use this option. 

Ramp 

Displays a dialog box so you can create a smooth color/gray scale 
blend in the chart’s data graphics and legend. 

 

Primary Ramp 

Each of the selections displays a color palette you can use to 
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select a start and end color or gray scale for your data 
graphic and legend. Changes are made from the top of the 
data graphic to the bottom. Changes to the ramp appear in 
the example box to the left. 

Use Secondary Ramp 

Works the same as the Primary Ramp. “Use Secondary 
Ramp” must be selected to activate these options. To 
determine where the secondary ramp begins, enter a value 
in the “Start Value” box. 

Outside Axis Values 

Each of the selections displays a color palette you can 
use to select a color or gray scale tint for data graphics 
that extend above or below the value axis. 

Click OK to save the changes, close the dialog box, and 
return to the “Options” dialog box. 

Back Planes 

Turns any or all six backplanes on or off. (Backplanes are the 
“walls” of the chart.) West, North, and Bottom planes represent the 
left, right, and bottom planes on a default chart. When you click 
one of the check boxes, the respective axis on the sample box is 
highlighted. 

Wall Thickness 

Controls the thickness of one or all backplanes on the chart as 
measured in points (1 point = 1/72"). To change the wall 
thickness, enter a point size in the “Thickness” text box, or 
click the direction arrows to scroll through the values. 

South, East, and Top planes in a default chart represent the 
invisible sides and top of the chart. The South, East, and Top 
plane options are only effective if the rotation of the chart has 
been changed using “3-D View” from the Chart menu. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 
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5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

3-D Scatterline Chart Options 
To set options for a 3-D Scatterline chart, do the following: 

1.  Select a 3-D Scatterline chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections and enter data as needed. You have 
the following options: 

Square Grids 

Changes the grid pattern into squares on the bottom plane of the 
chart. 

Projected Ticks and Labels 

Draws ticks and labels in perspective to the grid lines. 

Clip Data 
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Hides or “clips off ” any data plotted outside the chart grids. 

Ticks and Labels Outside Walls 

Extends the ticks slightly beyond the chart walls and places the 
labels outside the walls at the same perspective as the ticks. 

Back Planes 

Turns any or all six backplanes on or off. (Backplanes are the 
“walls” of the chart.) West, North, and Bottom planes represent the 
left, right, and bottom planes on a default chart. When you click 
one of the check boxes, the respective axis on the sample box is 
highlighted. 

South, East, and Top planes in a default chart represent the 
invisible sides and top of the chart. The South, East, and Top 
plane options are only effective if the rotation of the chart has 
been changed using “3-D View” from the Chart menu. 

Wall Thickness 

Controls the thickness of one or all backplanes on the chart as 
measured in points (1 point = 1/72"). To change the wall thickness, 
enter a point size in the “Thickness” text box, or click the direction 
arrows to scroll through the values. 

4.  Click Show to preview your changes without exiting the dialog 
box. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 

3-D Surface Fill and 3-D Surface Line Chart 
Options 

To set options for 3-D Surface Fill, 3-D Surface Line, 3-D XYZ 
Surface Fill, and 

3-D XYZ Surface Line charts, do the following: 
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1.  Select the chart. 

2.  Click the Options icon on the Command bar, choose Options 
from the Chart menu, or press cmd-Y. The “Options” dialog 
box appears. 

 

3.  Make your selections as needed. You have the following options: 

Square Grids 

Changes the grid pattern into squares on the bottom plane of the 
chart. 

Show Contour Lines on Surface 

(3-D Surface Fill and 3-D XYZ Surface Fill charts only) Displays 
the contour lines on the data graphic surface. 

Show Skirts 

Fills the area between the bottom of the plotted data and the base of 
the chart creating a skirt around the data graphic. This option must 
be deselected to activate the “Floor” options. 

Show Contour Lines on Ceiling 
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(3-D Surface Fill and 3-D XYZ Surface Fill charts only) Displays 
the contour lines on the chart ceiling. 

Clip Data 

Hides or “clips off ” any data plotted outside the chart grids. 

Projected Ticks and Labels 

Draws ticks and labels in perspective to the grid lines. 

Ticks and Labels Outside Walls 

Extends the ticks slightly beyond the chart walls and places the 
labels outside the walls at the same perspective as the ticks. 

Back Planes 

Turns any or all six backplanes on or off. (Backplanes are the 
“walls” of the chart.) West, North, and Bottom planes represent the 
left, right, and bottom planes on a default chart. When you click 
one of the check boxes, the respective axis on the sample box is 
highlighted. 

South, East, and Top planes in a default chart represent the 
invisible sides and top of the chart. The South, East, and Top 
plane options are only effective if the rotation of the chart has 
been changed using “3-D View” from the Chart menu. 

Wall Thickness 

Controls the thickness of one or all backplanes on the chart as 
measured in points (1 point = 1/72"). To change the wall thickness, 
enter a point size in the “Thickness” text box, or click the direction 
arrows to scroll through the values. 

Floor 

(Available for 3-D Surface Line and 3-D XYZ Surface Line charts 
only when “Fill” is selected.) You can select “Line” or “Fill” to 
project a 2-D representation of the chart (in the form of a line or fill 
shadow of the data graphic) onto the chart floor. This option is 
available only when “Show Skirts” is deselected. 

Ramp 
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(Available for 3-D Surface Line and 3-D XYZ Surface Line charts 
only when “Fill” is selected) Displays a dialog box so you can 
create a smooth color/gray scale blend in the chart’s data graphics 
and legend. 

 

Primary Ramp 

Each of the selections displays a color palette you can use to 
select a start and end color or gray scale for your data 
graphic and legend. Changes are made from the top of the 
data graphic to the bottom. Changes to the ramp appear in 
the example box to the left. 

Use 
Secondary 
Ramp 

Works the same as the Primary Ramp. “Use Secondary 
Ramp” must be selected to activate these options. To 
determine where the secondary ramp begins, enter a value 
in the “Start Value” box. 

Outside Axis 
Values 

Each of the selections displays a color palette you can 
use to select a color or gray scale tint for data graphics 
that extend above or below the value axis. 

Click OK to save the changes, close the dialog box, and 
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return to the “Options” dialog box. 

4.  Click Show to preview your changes without exiting the dialog 
box. You can move the dialog box out of the way by dragging 
the Title bar. 

5.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. If you want to exit the 
dialog box without changing the chart, click Cancel. 
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11 Working with Objects 
in Chart View 

This chapter explains how to use the tools in the Chart view’s 
Toolbox to generate text (Text objects) and graphics (Draw objects) 
that you can use to enhance your charts. You will learn how to edit 
these objects and the text in Text objects, how to use the commands 
in the Draw menu to manipulate the four types of objects you can 
have in a Chart page, and how to use the Line, Color, and Pattern 
palettes in the Toolbox to embellish Chart, Draw, and Text objects. 

This chapter covers the following: 

• Identifying objects in a Chart page 

• Using tools in the Chart view Toolbox 

• Selecting, moving, and resizing objects 

• Copying and deleting objects 

• Creating and editing Draw and Text objects 

• Editing and formatting the text in Text objects 

• Composing equations with the Equation Editor 

• Adding color, patterns, and special fills to objects 

• Changing chart and object color, lines, and text attributes 

• Manipulating objects with commands from the Draw menu 

• Creating pictographics 
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Identifying Objects 
There can be four types of objects in a Chart page, all of which must 
be selected with the Pointer tool before being deleted, copied, moved, 
modified, or manipulated with menu commands. A selected object—
whether a Chart, Draw, or Text object created in the Chart view, or a 
graphic imported from another application— displays four object 
handles that define its boundaries (see the figure below). 

 

Chart object 

Any numerical or text chart, A Chart object contains many chart 
elements, including labels and titles. 

Draw object 

Created with one or more of DeltaGraph’s drawing tools, it can be a 
simple line or a detailed drawing. 

Text object 

Created with the Text tool. In addition to having all the attributes of a 
Draw object, a Text object contains text that is manipulated with 
commands from the Edit and Text menus. 

Imported Graphic object 
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Any graphic imported from another application. 

To learn more about... Refer to... 

Creating charts Chapter 7, “Setting Preferences” 

Draw objects “Creating and Editing Draw Objects” below 

Text objects “Creating a Text Object” below 

Imported Graphic objects Chapter 13, “Importing and Exporting 
Graphics” 

	
  

The Toolbox 
The Toolbox appears automatically when you switch to the Chart 
view. You use the tools from the Toolbox in much the same way that 
you use traditional art tools, you have to pick them up before you 
start to draw. You “pick up,” or select, a tool from DeltaGraph’s 
Toolbox by clicking it before drawing in the document page. 

After using a tool, the cursor reverts back to the Pointer tool (Bezier 
Curve, Polygon tool, and Magnifying Glass are the only exceptions). 
If you double-click a tool when selecting it, the tool remains active 
until you select another tool. Press the spacebar to recall the last tool 
selected. 

You can move the Toolbox around the screen by clicking anywhere 
in the Title bar, holding down the mouse button, and dragging to a 
new location. You can hide the Toolbox by clicking the Close box or 
by selecting Hide Toolbox from the Draw menu. To open a closed 
Toolbox, select Show Toolbox from the Draw menu. When you quit 
DeltaGraph, the position of the Toolbox in the window is saved. 

Tools fall into the following four categories according to their 
functions: 

• Function tools — Pointer, Eyedropper, Blend, and Shadow tools, 
and Magnifying glass 

• Text tool 
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• Draw tools — Line, Rectangle, Rounded Rectangle, Bezier 
Curve, Arc, Oval, Freehand, Polygon, and Arrow 

• Palette tools — Fill palettes, Line palettes, and Line Width palette. 
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To learn more about... Refer to... 

Each tool “Creating and Editing Draw Objects” below 

	
  

Manipulating Objects with the Pointer Tool 
Because the Pointer tool is selected in the Toolbox when you first 
open Delta- Graph, it is considered the default tool. Also, you will 
notice that most other tool selections revert to the Pointer tool as 
soon as you release the mouse button. (The Bezier Curve and 
Polygon tools, both of which create multi-segmented objects, and the 
Magnifying Glass are the only exceptions, they remain active until 
you select another tool.) If you double-click a tool when selecting it, 
the tool remains active until you select another tool. 

The Pointer is used to select, move and resize objects in the Chart 
view. In addition, when an object is selected, you can copy, 
duplicate, and delete it, as well as apply commands from the Draw 
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menu. 

You can click once on any object in the Chart view with the Pointer 
while holding the control key to change various attributes. Click and 
hold the mouse button while holding the control key to display a 
dialog box so you can change general object attributes. A pop-up 
menu appears so you can display the previously described dialog box 
or change attributes specific to the type of object selected. 

To learn more about... Refer to... 

Selecting and manipulating 
elements in a chart object 

Chapter 9, “Customizing Charts” 

	
  

Selecting Objects 
There are two simple techniques for selecting one or more objects in 
a Chart page, as follows: 

1.  Use the Pointer tool to click the objects one at a time, holding down 
the shift key when selecting more than one object. 

2.  Use the Pointer tool to click and drag a selection rectangle around 
the object(s) you want selected 

Object handles appear around each object to indicate that it is 
selected. 

To select multiple elements of a Chart object, press the 
command key, and click the element(s). 
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Moving and Resizing Objects 
Once an object is selected, you can move or resize it. The table 
below contains several key combinations you may find useful when 
creating, moving, and resizing objects in the Chart view. If you 
move or resize an object in error, you can cancel the action by 
choosing Undo from the Edit menu or pressing cmd-Z. 

Key 
Combination 

Description 

cmd-Drag Temporarily disables the "Snap to Grid" option 
when drawing, resizing, or moving objects. 

shift+Drag Constrains the boundaries of an object to a 
square when drawing or resizing. 

option+Drag Copies the object being moved. 

	
  

To move an object, do the following: 

1.  Select the Pointer tool and position it over the object you want to 
move. If you are moving a Draw object with no fill, you must 
click a boundary line. 

2.  Click and hold the mouse button while you drag the object to its 
new location. As you drag, an outline the same size and shape as 
the object appears. A semi- transparent, reduced-size image is 
centered within the outline. 

 

To move more than one object at a time, do the following: 

1.  Holding down the shift key, select the objects you want to move. 

2.  Click any one of the selected objects and hold down the mouse 
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button while you drag the objects to a new location. The objects 
move as a group, maintaining the same spatial relationships. 

Use the control+shift key combination if you want to see the 
objects as you move them. 

 

NOTE ☞  See “Grouping and Ungrouping Objects” below for another way to 
move objects as a group. 

To change the size or shape of an object, do 
the following: 

1.  Select the object you want to resize. The object 
handles appear. 

2.  Click and drag a handle until the object is the size or shape you 
want. When you drag a handle, the pointer changes to a 
crosshair with arrows. 

 

NOTE ☞  This does not change the size of the text in a Text object, it changes 
the size of the object only. 

Copying Objects 
The “Copy” command makes a copy of any selected object(s), leaving 
the original(s) intact. It is most useful when you want to copy 
something to another Chart page in the same DeltaGraph document, 
another document, the Clipboard, or another application. The copy is 
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saved to the Clipboard where it replaces the previous contents. (See 
“Duplicating Objects” below to learn the most efficient way to copy 
objects for use in the same Chart page.) 

You can copy a Chart object to the Clipboard to be pasted in another 
application as a PICT object. If you paste the object back in a Chart 
page, a PICT or PDF version (depending on the application) appears. 

If you hold down the Option key while choosing Copy from the Edit 
menu, an EGO (Edit Graphic Object) image is placed on the 
Clipboard. Some Macintosh applications support this format. Refer to 
Chapter 18, “AppleScript Commands” for more information. 

To copy one or more objects, do 
the following: 

1.  Select the object(s) you 
want to copy. 

2. Choose Copy from the Edit menu 
or press cmd-C. 

3. De-select the object by 
clicking outside it. 

A copy of the object is now on the Clipboard, ready to paste 
anywhere you like. (See “Pasting Objects” below.) 

Duplicating Objects 
If you want an exact replica of one or more selected objects for 
placement in the same Chart page, choose Duplicate from the Edit 
menu or press cmd-D. The duplicate object appears slightly offset 
from the original with its object handles visible to show that it is 
selected and ready for placement on the page. 

If the duplicated object is a chart, the duplicate uses the same data as 
the original. The duplicated chart is fully functional and remains 
independent, that is, it can be modified in any way available to the 
original object without affecting the original. 



 
  DeltaGraph for Macintosh Version 7 User Guide 513 

 

If you want an exact replica of one or more objects to use in a 
different document, drag the object(s) into a Chart page of a second 
open DeltaGraph document. This leaves the original object(s) intact 
and still selected. If a chart is copied from another document, a Data 
page is added, containing data for the duplicate chart. 

Deleting Objects 
To delete one or more objects, do 
the following: 

1. Select the object(s) you want to delete. 

2. Choose Cut or Clear from the Edit menu, or press the delete key. 

“Cut,” which can also be invoked by pressing cmd-X, places a copy 
of the object on the Clipboard; “Clear” and the delete key do not. 

Pasting Objects 
You can use “Paste” from the Edit menu to place the most recently 
cut or copied Draw, Text, or Imported Graphic objects in the same 
or a different Chart page, DeltaGraph document, or another 
application. 

To paste one or more objects, do the following: 

1.  Use the Copy or Cut command on the object(s) you want to paste. 
This places a copy of the object(s) on the Clipboard. 

2.  If necessary, activate a different DeltaGraph Chart page, open 
another Delta- Graph document, or open another application. 

3.  Choose Paste from the Edit menu or press cmd-V. The pasted 
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object(s) appear centered in the active page. You can paste the 
copy anywhere you like as many times as you like. 

Changing the View Size 
You can change the view size of the active Chart page, Organizer 
view (Thumbnail view only), or Layout mode using any of the 
following methods: 

• Type the keyboard equivalents for magnifying. 

• Click the Magnifying Glass in the Toolbox (Chart view and Layout 
mode only). 

• Select Scale from the View menu. 

• Select the Fit To View option. 

DeltaGraph lets you view the Chart view anywhere between 1% and 
400% of actual size. This allows you to edit Chart pages either from 
an overall perspective or from a detailed perspective. It also allows 
you to more efficiently use the screen space in which you have to 
work. 

You can use the Magnification Controls to do any of the following: 

• Switch back and forth between selected magnification and 100%. 

• Click the Counter Item to select the required magnification. 

To change the view size with the Magnifying Glass, do the following: 

1.  Select the Magnifying Glass from the Toolbox. The pointer 
changes to a magnifying glass with a “+” (plus sign) in the 
middle. 

2.  To increase the viewing size of the active Chart page, click the 
Chart page. 

3.  To decrease the viewing size of the active Chart page, hold down 
the option key while clicking the Chart page. The “+” (plus sign) 
in the middle of the glass changes to a “-” (minus sign), which 
signifies that it will decrease the viewing size when it is applied. 
The viewing size of the Chart page decreases. 
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To use the “Fit To View” option, do the following: 

1.  Click and hold the Magnification control icon on the Command 
bar. The Magnification pop-up menu appears. 

2.  Choose Fit To View. The Chart page scales to fit to in the document 
window. 

Creating and Editing Draw Objects 
The more time you spend experimenting with the tools — especially 
the Polygon, Bezier Curve, and Freehand tools — and techniques, the 
better you will under- stand and be able to take advantage of their 
capabilities. 

Once you have created a Draw object, you can use commands on the 
Draw menu to manipulate it and to add some interesting special 
effects (dashed lines, special fills, and drop shadows). You can also 
use the palettes in the Toolbox to change the object’s line widths and 
to add color or patterns to the object’s line or fill. 

To learn more about... Refer to... 

Changing line width, color, or 
pattern 

“Changing the Attributes of a Draw, 
Text, or Chart Object” below. 

Changing the line width “Creating Dashed Lines” below 

	
  

Creating and Editing a Line 
To create a line, do the following: 

1. Select the Line tool from the Toolbox. The pointer changes to a 
crosshair. 

2.  Click and hold down the mouse button to begin your line. 

3. Drag the mouse in the direction you want your line to follow. 
When you release the mouse, the line appears with object handles 
on each end to show it is selected. 
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4. While a line is selected, you can increase or decrease its length or 
change its direction by dragging a handle. When you drag a 
handle or move the line, the pointer changes to a crosshair with 
arrows. 

Creating and Editing a Rectangle, Rounded 
Rectangle, Square, Circle, or Oval 

The Rectangle tool displays a pop-up containing the Rectangle tool 
as well as the Rounded Rectangle tool. Use the Rectangle tool to 
make a rectangle and the Rounded Rectangle tool to make a rounded 
rectangle. Use the Oval tool to make an oval or circle. 

To create a rectangle, rounded rectangle, square, circle, or oval, do the 
following: 

1.  Select the Rectangle, Rounded Rectangle, or Oval tool from the 
Toolbox. The pointer changes to a crosshair. 

2.  Click and hold down the mouse button to begin the object. 

3.  Drag the mouse diagonally in any direction until the object is 
the size and shape you want. Hold down the shift key while 
dragging to constrain the object to a perfect square, square 
with rounded corners, or circle, depending on which tool you 
are using. 

4.  Release the mouse button. The object appears with object handles 
around it to show it is selected. 

You can move, resize, and modify a rectangle, rounded rectangle, 
square, circle, or oval as explained in other sections. You can also use 
“Edit Round Corners” on the Draw menu to modify the curvature of 
the corners in a rounded rectangle. 

To change the corners of a rounded rectangle, do the following: 

1.  Select the rounded rectangle (its object handles should be visible). 

2.  Choose Edit Round Corners from the Draw menu. All but the 
bottom right selection handle disappears. 

3.  Click the bottom right selection handle, and drag down and away 
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from the rectangle to make the corners more round. 

4.  Drag up and into the rectangle to make the corners more square. 

 

5.  Release the mouse button when the object is the shape you want. 

6.  Click outside the rectangle to de-select it and end the edit. 

Creating and Editing a Bezier Curve 
You can use the Bezier Curve tool to create very complex Draw 
objects. Like the Polygon and Freehand tools, the Bezier Curve tool 
creates irregularly shaped, multi-sided objects; however, you can 
change the segments between each point into curved lines. Also like 
a polygon and freehand object, a Bezier curve can be closed (the first 
and last segments are joined) or open (first and last segments are not 
joined). 

A Bezier curve can be transparent and consist of the line only, or it 
can be filled with a color or pattern like other Draw objects. 

Holding down the command key while creating or resizing a 
Bezier curve con- strains each tangent to a straight line in the 
original direction of movement from the drawing point. 

Because the smoothness of a Bezier curve depends on the exact 
placement of its points, a Bezier curve does not “Snap to Grid.” 

To create a simple or compound curve, do the following: 

1.  Select the Bezier Curve tool from the Toolbox. The pointer 
changes to a crosshair. 

2.  Click the mouse once where you want your curve to begin. A 
small circle marks the starting point. 

3.  Move the mouse until the crosshair pointer is where you want the 
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first segment of your curve to end, then click again and hold down 
the mouse button. 

If you release the mouse, a straight line appears between the first 
and second points. 

If you hold down the mouse button and drag, a tangent line 
appears (as shown below) that allows you to drag the curve into 
the shape you want. Drag down to make an n-shaped curve. Drag 
up to make a u-shaped curve. 

 

4.  Release the mouse button. The tangent line disappears, and 
object handles appear around the curve to show it is selected. 

5.  Continue creating more points and setting the angle and shape of 
the curves with the tangent lines until your curve is complete. 
DeltaGraph automatically connects the curve segments. 

6.  Click the Pointer tool or any other tool in the Toolbox to de-select 
the Bezier Curve tool when your shape is complete. 

You can move, resize, or modify a Bezier curve as explained in other 
sections. You can also use “Edit Bezier Curve” from the Draw menu 
to change the position of each segment point and the shape of each 
curve segment. If a segment in a Bezier curve is straight, there is no 
tangent line and you can change only the position of the segment 
point. 

You can delete a segment point by holding down the option key 
while clicking the segment point. 

To edit a Bezier curve, do the following: 

1.  Select your Bezier curve (its object handles should be visible). 
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2.  Choose Edit Bezier Curve from the Draw menu or press cmd-
E. Square object handles appear at each segment point. 

 

3.  Select the handle of the segment point you want to change and 
drag it to a new position. 

4.  Release the mouse when you have repositioned the segment point 
where you want it. A tangent line with round handles at each end 
appears tangent to the curve. These object handles can be dragged 
to control the size and shape of the curves. 

 

5.  Select either end of the tangent line and drag to edit the shape of 
the curve. The curve is reshaped or stretched in the direction you 
move the tangent line handle. Select and drag the opposite handle 
of the tangent if you want the curve to be reshaped in the other 
direction. 
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6.  Repeat steps 3-5 as needed. 

7.  Click outside the curve’s boundaries to de-select it and end the edit. 

Creating and Editing an Arc 
The Arc tool creates an arched line from one point to another. The 
curvature and angle of the arc are controlled by the position, 
direction, and distance of the second point in relation to the first. An 
arc can be transparent and consist of the line only, or it can be filled 
with a color or pattern like other Draw objects. 

To create an arc, do the following: 

1.  Select the Arc tool from the Toolbox. The pointer changes to a 
crosshair. 

2.  Click and hold down the mouse button to begin your arc, then 
drag the mouse diagonally in any direction until the arc is the 
shape you want. 

When you release the mouse, the arc appears with object 
handles around its boundaries to show it is selected. 

You can move, resize, and modify an arc as explained in other 
sections. You can also use “Edit Arc” from the Draw menu to move 
the two endpoints. 

To edit the angle of an arc, do the following: 
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1.  Select your arc (its object handles should be visible). 

2.  Choose Edit Arc from the Draw menu. Object handles appear at 
each end of the arc. 

3.  Drag the handles to change the angle of the arc. A line appears to 
show you the angle the arc is creating. 

4.  When you have repositioned the endpoints as needed, click 
outside the arc’s boundaries to de-select it and end the edit. 

Creating and Editing a Freehand Object 
The Freehand tool creates a freeform line consisting of numerous 
Bezier curves. Like the polygon and Bezier curve, a freehand object 
can be closed (the first and last segments are joined) or open (first 
and last segments are not joined). A free- hand object can be 
transparent and consist of the line only, or it can be filled with a color 
or pattern like other Draw objects. 

To edit a Freehand object, refer to the instructions for editing a Bezier 
curve. Holding down the command key while resizing a Bezier curve 
in the free- hand object constrains each tangent to a straight line in the 
original direction of movement from the drawing point. 

To create a Freehand Object, do the following: 

1.  Select the Freehand tool from the Toolbox. The pointer changes to a 
crosshair. 

2.  Click the mouse and drag to create your object. 

3.  Release the mouse button. Object handles appear around the 
object to show it is selected. 

Creating and Editing a Polygon 
The Polygon tool creates irregularly shaped, multi-sided objects. A 
polygon is made up of multiple segments that are joined together by 
segment endpoints. Like a Bezier curve, and a freehand object, a 
polygon can be closed (the first and last segments are joined) or open 
(first and last segments are not joined). 
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To create a polygon, do the following: 

1.  Select the Polygon tool from the Toolbox. The pointer changes to 
an x. 

2.  Click the mouse where you want the polygon to begin. A small 
circle marks the starting point. 

3.  Move the mouse until the x is where you want the first segment of 
the polygon to end, then click again. A dotted or solid line appears. 
You can drag this point to get it just where you want it before 
releasing the mouse button. The first segment of the polygon 
appears when you release the mouse button. 

4.  Move the mouse and click again to create the second segment. 
At this point object handles appear to indicate the boundaries of 
the object. 

5.  Continue moving and clicking the mouse until you have created 
the number of segments you want in the polygon. 

You can close the polygon by clicking the first point, but you do 
not have to close the polygon to finish it. 

6.  Click the Pointer tool or any other tool in the Toolbox to de-select 
the Polygon tool when your shape is complete. 

You can move, resize, and modify a polygon as explained in other 
sections. You can also use “Edit Polygon” from the Draw menu to 
change the position of each of the segment points in your polygon. 

To edit the segment points of a polygon, do the following: 

1.  Click the Pointer tool, then select your polygon. 

2.  Choose Edit Polygon from the Draw menu or press cmd-E. 
The object handles disappear, and round handles appear at each 
segment point of the polygon. 

3.  Place the pointer over each segment point you want to move and 
drag until the point is positioned where you want it. 

When you drag, a dotted line appears to show you the new shape. 
DeltaGraph automatically reconnects the line segments that were 
connected in the original polygon. Segments that were not 
connected can be moved farther apart or closer together. 
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4.  When you have repositioned all the segment points you want 
moved, click out- side the polygon to de-select it and end the edit. 

Creating and Editing an Arrow 
Creating and editing an Arrow is similar to working with lines. In 
addition, a DeltaGraph arrow can have an arrowhead at either or both 
ends. “Edit Arrow” on the Draw menu controls the position and 
dimensions of the arrowhead(s). 

To create an arrow, do the following: 

1.  Select the Arrow tool from the Toolbox. The pointer changes to a 
crosshair. 

2.  Click and hold down the mouse button to begin your arrow, 
then drag the mouse in the direction you want your arrow to 
point. When you release the mouse, the arrow appears with 
object handles on each end. While the arrow is selected, you 
can increase or decrease its length or change its direction by 
dragging the handles. When you drag a handle or move the 
arrow, the pointer changes to a crosshair with arrows. 

You can move, resize, and modify an Arrow as explained in other 
sections. The shaft of an arrow has no area to fill, but the arrowhead 
has a fill area whose pattern and colors can be edited. You can also 
use “Edit Arrow” from the Draw menu to add arrowheads to either or 
both ends of the arrow and to change the length and height of the 
arrowhead. 

To edit an arrow, do the following: 

1.  Select your arrow (its object handles should be visible). 

2.  Choose Edit Arrow from the Draw menu. The following dialog box 
appears. 
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3.  Click the Start, End, or Both Ends option button, depending on 
where you want arrowhead(s). 

4.  Enter a height from 3 to 30 points and a length from 4 to 40 points 
in the text boxes. The arrows in the dialog box change with the 
numbers to show you the results of your settings. 

5.  When you have the results you want, click OK to implement the 
change and return to the Chart page. To exit the dialog box 
without changing the arrow, click Cancel. 

To learn more about... Refer to... 

Object lines or fills “Changing the Attributes of a Draw, 
Text, or Chart Object” below 

Dashed lines “Creating Dashed Lines” below 

	
  

Working with Text Objects 
Occasionally you may want to create extra text that is separate from 
the text displayed in the Data view— a title or some additional 
explanatory text for a chart perhaps. This is done in a Chart page. 

NOTE ☞  Unlike placeholder text, text objects are independent and not 
dynamically linked to other views. 

If you are using Smart layouts, it is recommended that you use 
placeholders to enter text in your Chart page. Text entered in 
placeholders is displayed in the Outliner view. Smart Layouts help 
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maintain consistency between multiple Chart pages. 

To learn more about... Refer to... 

Using Smart Layouts “Creating and Using Smart Layouts” in 
Chapter 5 

	
  

Creating a Text Object 
Before you can add extra text to a Chart page, you need to create a 
Text object to contain it. In a Text object, DeltaGraph feels as 
familiar as any word processor. The key to creating and working 
with Text objects is the Text tool from the Tool- box. 

A Text object can contain up to 32,000 characters. When selected 
with the Text tool, this text can be edited and formatted, like all 
DeltaGraph text, with commands from the Edit and Text menus 
utilizing full Unicode. 

Whenever a Text object’s insertion point is active, a Text ruler is 
visible across the top of the object. As in most word processors, this 
ruler controls tabs and margins, line and paragraph spacing, and text 
alignment. 

The Text object itself has the same attributes as a Draw object, object 
handles that are visible when the object is selected, object boundary 
lines, which remain invisible unless you specify a new line width, and 
an object fill area. 

When selected with the Pointer tool, a Text object can be moved, 
sized, cut, copied, and deleted like any other object in a Chart page. 
You can also use the palettes in the Toolbox and most of the 
commands on the Draw menu to enhance and manipulate your Text 
objects. 

To learn more about... Refer to... 

Manipulating Text objects “Manipulating Objects with the 
Pointer Tool” below 
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Changing object attributes “Changing the Attributes of a Draw, 
Text, or Chart Object” below 

	
  

To enter text in a Chart page, do the following: 

1.  Select the Text tool from the Toolbox. The pointer changes to an I-
beam. 

2.  Click and hold down the mouse button to begin your Text object. 

3.  Drag a rectangle area with the mouse to contain your text. To 
help you draw the Text object in the appropriate size, a box 
appears as you drag the mouse. 

4.  Release the mouse button. Object handles appear to show the 
boundaries of your Text object. A Text ruler is visible just over 
the Text object and a cursor is blinking at the insertion point in 
the upper left-hand corner of the text block. 

5.  Type your text. You can enter up to 32,000 characters per Text 
object. As you type, the insertion point moves to the right and 
automatically jumps down to the beginning of the next line when it 
reaches the right boundary of the Text object. When you reach the 
bottom boundary, the text block expands vertically to 
accommodate your text. 

6.  When you are done entering text, click outside the Text object to 
de-select it. The object handles and the Text ruler disappear, 
leaving only the text. 

7.  If you want to resize the Text object, use the Pointer tool to re-
select it and drag one of the object handles until you have the size 
and shape you want. Resizing the Text object has no effect on the 
size of the type, although the text rewraps to fit the new size and 
shape. 

Formatting and Editing Text in a Text Object 
Each character in a Text object can be a different font, size, style, 
and/or color. When you set alignment, however, it affects all the 
text in the object. 
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You can set text attributes one at a time for one or more selected Text 
objects with commands from the Text menu, or you can set any or all 
attributes for selected text only from the “Set All” dialog box that 
appears when you choose “Set All” from the Text menu. 

To edit text in a Text object, do the following: 

1.  Double-click the text block you want to change, or select the Text 
tool from the Toolbox and click the text to position the insertion 
point. The Text ruler appears above the text, and you can see the 
insertion point blinking. 

2.  Perform the following actions as needed: 

•  Select text. 

•  Use the delete key to erase mistakes. 

•  Type in new text. 

•  Use the commands on the Edit menu as you would in any word 
processor.  

To change text attributes in a Text object, do the following: 

1.  Select the text you want to format. You can select text by clicking 
and dragging, double-clicking a particular word, or choosing 
Select All (cmd-A) from the Edit menu. 

If you want to change all the text in one or more Text 
objects, select the object(s) themselves. 

2.  Use the Styles drop down menu in the Unicode.editor to change 
how the text appears along with all options from the Text menu. 

With the exception of the “Alignment” command, which affects 
all the text in a Text object regardless of what is selected, these 
commands apply to selected text only. 

“Font,” “Size,” and “Style,” work exactly as they would in any 
word processor. Color options are explained below. 

The “Set All” command on the Text menu displays a dialog box 
so you can set all the attributes for selected text in a Text object at 
the same time. 
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3.  When you are finished formatting your text, click outside the Text 
object to de- select it. 

Using the Text Ruler 
Whenever the insertion point is active in a Text object, DeltaGraph 
displays a ruler across the top of the text (see the figure below). This 
Text ruler has simple settings that let you reset tabs and margins, text 
alignment, and spacing between lines of text and paragraphs. These 
settings affect all text in the object. 

Setting Margins and Paragraph Indents 
DeltaGraph’s Text ruler has markers that make it easy to change 
margins and the setting for paragraph indents. Like the other 
functions of the Text ruler, these set- tings affect everything in the 
selected Text object.  

NOTE ☞  When you resize a Text object, the margins and any specified 
paragraph indent move by a corresponding amount. 

Left Margin and Indent marker 

This icon is a combination of two markers, which start out lined up 
together with the left edge of the Text object. These markers are moved 
separately. 

Left Margin marker 

All left-aligned text, with the exception of indented first lines, lines up 
with this marker. Drag the marker (the top half of the combination icon 
shown above) along the ruler to change the setting. 

Indent marker 

Controls only the first line of each paragraph. Drag the marker (the 
bottom half of the combination icon shown above) along the ruler to 
change the setting. Position it to the right of the Left Margin marker to 
create a standard paragraph indent. Position it to the left of the Left 
Margin marker to create a hanging indent. Line it up with the Left 
Margin marker if you want no indent at all. 
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Right margin marker 

Sets the limitations for the right edge of each line of text. Drag the 
marker along the ruler to change the setting. 

Setting Tabs 
Move the Tab icons to set the tab stops for all text in the object. 
To select a tab stop, click the Tab icon of your choice and drag it 
into the Tab bar. 

Left align 

Aligns the left margin of tabbed text to the tab. 

Center align 

Aligns the center of tabbed text to the tab. 

Right align 

Aligns the right margin of tabbed text to the tab. 

Decimal align 

Aligns the decimal point of tabbed text to the tab. 

Changing Text Alignment 
You can click the Alignment icons on the Text ruler instead of using 
the “Alignment” command on the Text menu to change alignment 
for all text in the selected object. 

Flush left 

Every line of text aligns with the left margin. 

Centered 

Every line of text centers in the object’s margins. 

Flush right 
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Every line of text aligns with the right margin. 

Justified 

Adjusts each line of text to fill the space between margins or paragraph 
indents. 

Changing Spacing Between Lines and 
Paragraphs 

DeltaGraph makes it possible for you to adjust the spacing, often 
referred to as leading, between lines and paragraphs in one-point 
increments. (A point is a type- setter or printer’s measurement equal 
to 1/72 of an inch.) 

Line Spacing Menu 

Distributes space proportionally above and below each line in a 
paragraph. The center of the button shows the current setting. To 
decrease the spacing, click to the left. To increase the spacing, click to 
the right. 

Paragraph Spacing button 

Clicking Other	
  in	
  the	
  line	
  spacing	
  menu allows you to change the 
paragraph spacing, which distributes space proportionally above and 
below each paragraph in a text object	
  

Inserting Math Equations with Equation 
Editor 

Equation Editor in DeltaGraph is a special version of Design Science 
MathType™. If you frequently create print or Web documents with 
equations, you may find MathType is better suited to your needs. 
MathType is as easy to use as Equation Editor and has many extra 
features to help you save time, create a wider range of equations, and 
publish equations on the Web. 

MathType is available in English, Japanese, German and French. For 
further information about purchasing MathType, contact your 
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software dealer or Design Science directly, as follows: 

Design Science, Inc. 
4028 Broadway 
Long Beach, CA 90803 
USA 
Toll free: 800-827-0685 
International: 562-433-0685 
Fax: 562-433-6969 
Email: sales@dessci.com 
Web:  http://www.dessci.com 

Equation Editor allows you to insert mathematical equations in your 
Chart pages. This lets you clearly illustrate, with textbook-quality 
equations, formulas used in your charts and graphs. 

To insert an equation in a Chart page, do the following: 

1.  Choose Open Equation Editor from the Edit menu. 
Equation Editor is launched. 

 

2.  Use Equation Editor’s controls to compose an equation. For 
information and instructions, refer to Equation Editor’s 
documentation or Help file. 

3.  Copy and paste your composed equation into the 
Text Editor. 
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Changing the Attributes of a Draw, Text, or Chart 
Object 

The Fill, Line, and Line Width palettes in DeltaGraph’s Toolbox 
make it easy to add special design flourishes to any Draw, Text, or 
Chart object. You can change the following attributes with the 
appropriate palettes: 

•  Foreground and background fill colors 

• Fill pattern of an object (the default is black for Draw and 
Chart objects, “N,” or none, for Text objects) 

•  Foreground and background line colors 

• Line pattern of an object (the default is plain, black for Draw 
and Chart objects, “N,” or none, for Text objects) 

•  Line width of an object’s boundary lines (the default is 1 
point) 

NOTE ☞   Although the attributes of Imported Graphic objects cannot be 
changed in Delta- Graph, you can sometimes get around this by 
drawing an outline of the object in DeltaGraph. This creates a Draw 
object that you can modify in any of the ways described in this 
section and then layer with the original graphic to create the desired 
effect. 

To learn more about... Refer to... 

Changing lines to dashed lines “Creating Dashed Lines” below 

	
  

Adding special blends to objects 

“Adding Special Blends to 
Objects” below 

Placing a drop shadow behind 
and object 

“Adding Drop Shadows to 
Objects” below 
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Changing Line Widths 
DeltaGraph line widths are set in points (one point is 1/72 of an 
inch). The line width, color, and pattern of each line can be 
changed individually or as a group. 

Use the Line Width palette in the Toolbox to change line widths of the 
following: 

• Chart axes 

• Chart grids 

• Chart tick marks 

• Chart data graphics 

• Lines 

• Arrows 

• Any Draw, Text, or Chart object’s boundary lines 

To edit the line width of one or more objects, do the following: 

1.  Select the object(s) you want to change. 

2.  Click the Line Width palette icon in the Toolbox to display the pop-
up menu. 

The Line Width palette is displayed. You see a choice of line 
widths including “None,” “Very Thin” (0.25 points), “Thin” (0.5 
points), 1 through 5 points rep- resented graphically, and 
“Custom.” 

To specify a custom width, select Custom from the palette. 
DeltaGraph displays the “Set Pen Weight” dialog box. Enter a 
whole number or decimal from 0 to 8, or use the direction arrows 
to scroll through the standard options. (The smallest pen weight is 
1/256 of a point or 0.003906.) 

To close the dialog box without changing the line size, click off or 
away from the palette. 

3.  Drag the Pointer tool across the options and release the mouse. 
The selected line(s) change accordingly. 
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Applying Patterns 
The icons at the bottom of both the Fill and Line palettes control 
the patterns of any Chart or Draw object. 

The pattern palettes always display the current pattern for the 
selected object. If multiple objects are selected, the default pattern 
(white) is displayed. If no objects are selected, black is displayed. 

NOTE ☞  Gray scales print faster than patterns when outputting to a PostScript 
printer. 

To change the fill or line pattern of one or more objects, do the 
following: 

1. Select the object(s) you want to change. 

2.  Click the Fill or Line Pattern palette in the Toolbox and hold 
down the mouse button. The palette pops up to display the 
available choices. 

Both pattern palettes contain 64 patterns that can be applied to 
any Draw or Text object. The top two rows contain patterns. The 
bottom two rows contain PostScript gray scale patterns. If you 
are using a PostScript printer, any of these selections yields a 
very smooth gray pattern in your printed document. 

To close the dialog box without applying a pattern or gray 
scale, click off or away from the palette. 

3.  Drag the Pointer tool across the patterns and release the mouse 
to make your selection. The palette closes and the selected 
object(s) reflect your change. 

Applying Colors 
The overlapping icons in both the Fill and Line palettes control the 
color of any Chart or Draw object. The Foreground square (upper 
left) is for setting foreground color. The Background square (upper 
right) is for setting background color. 

The foreground color can be thought of as the pattern itself, such 
as checks or lines. The background color is what the pattern rests 
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on. 

 

Initially, the default foreground color is black (any part of an object 
that is black is part of the foreground), and the default background 
color is white (any part of the object that is white is part of the 
background). 

When you select an element that is set to a different foreground or 
background color, that color appears in the appropriate palette of 
the Toolbox. 

To change the foreground color of an object or line, do the following: 

1.  Select the object(s) you want to change. 

2.  Click the Foreground square of one of the color palettes in the 
Toolbox. The palette pops up to display the available color 
choices. 

The color palette includes 90 different colors, including black 
and white, and up to 16 custom colors. The current Custom Color 
and Color Scheme palettes are located at the bottom of the Color 
palette. 

3.  Drag the Pointer tool across the colors and release the mouse 
to make your selection. The selected object(s) reflect your 
change. 

NOTE ☞   To make a solid color, be sure that “Black” in the Fill Pattern palette 
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is selected. If “White” is selected, choosing a color automatically 
changes the selected object to solid black. 

To change the background color of an object or line, do the following: 

1.  Select the object(s) you want to change. 

2.  Click the Background square from one of the color palettes in the 
Toolbox. The palette pops up to display the available color 
choices. 

3.  Drag the Pointer tool across the colors and release the mouse to 
make your selection. The color appears in the background portion 
of the pattern, creating an effect that is a combination of the 
foreground and background colors. By selecting a 50% gray 
pattern in the Fill Pattern palette, you can create “new” colors by 
combining a foreground and a background color. 

NOTE ☞  Background color shows on a selected element only when the 
element’s fill pattern is not solid. 

	
  

Working with Custom Colors 
You can create a set of “custom” colors, which can be used for any 
DeltaGraph object to which color may be applied. You can use either 
DeltaGraph system colors or digital simulations of colors to create a 
custom color palette. 

The “Colors” command on the Edit menu displays a dialog box so 
you can create up to 16 custom colors. Once created, these colors 
appear at the bottom of every color palette in DeltaGraph so you can 
select and apply them as you would any other color. 

DeltaGraph includes numerous color palettes which can be loaded, 
edited, and saved as necessary. Any Custom Color palettes created 
can be saved, named, and opened from other DeltaGraph documents. 
Only one Custom Color palette can be open at one time. 

To learn more about... Refer to... 

Setting color preferences “Setting General Defaults” in Chapter 6 
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Loading a Custom Color Palette 

Custom Color palettes can be saved from, and loaded in, any 
DeltaGraph document. To load a Custom Color palette, do the 
following: 

1.  Choose Colors from the Edit menu. The “Color Set” dialog box 
appears with the Scheme tab selected. 

2.  Click the Custom tab. 

 

3.  Click Load. A standard “Open” dialog box appears. Only 
Custom Color palettes appear in the dialog box. 

4.  Select a Custom Color palette from the dialog box and click 
Open. The palette appears in the Custom tab. You can edit the 
colors as necessary (refer to the next section). 

5.  Click OK to load the Custom Color palette in the active document. 
Colors in the palette can be applied to all objects and charts in the 
document. 
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Creating and Editing a Custom Color Palette 

To edit an existing color palette or to create a new color set, do the 
following: 

1.  Choose Colors from the Edit menu. The “Color Set” dialog box 
appears. 

2.  Click the Custom tab. 

 

The currently loaded custom color palette is displayed. You can 
edit it, or you can load a different custom color palette to edit 
(refer to “Loading a Custom Color Palette). 

3.  Select from the following options to create or edit a custom color 
set: 

Choose Item to Edit 

Displays the colors in the custom color palette that is loaded. Click 
a color to edit it, or click an empty box to add a color. 

Color Model 

Shows the color model of the selected color, as follows: 
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RGB 

Shows the percentages of red, green, and blue. 

CMY 

Shows the percentages of cyan, magenta, and yellow. 

CMYK 

Shows the percentages of the four process colors: cyan, 
magenta, yellow, and black. 

HSL 

Shows the percentages of hue, saturation, and light. 

4.  Click System Colors or Swatches to select a new color, as 
follows: 

System Colors 

To select a DeltaGraph system color, click System Colors, and the 
“Colors” dialog box is displayed. 
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You can display colors using one of the five options at the top of 
the box: 

•  Color Wheel (shown in the image) 

•  Color Sliders 

•  Color Palettes 

•  Image Palettes 

•  Crayons 

Move the pointer over an icon to display a message that describes 
its function. You can use any of the methods to select a color. For 
example, to use the Color Wheel method, click a location in the 
color wheel to select a color. Change it by clicking a different 
location. Click OK to apply the color. 

Swatches 



 
  DeltaGraph for Macintosh Version 7 User Guide 541 

To select a color from a swatch file, click Swatches, and the 
“Color Books” dialog box is displayed. The swatch files that 
have been included in Color Swatches folder inside the 
DeltaGraph folder will be listed in the Book popup menu: 

 

Click a color to select it.  

5.  To save the changes to the loaded custom color palette, click 
Save to open a “Save” dialog box, select the name of the color 
palette, and click Save to save the palette and return to the 
“Color Set” dialog box. 

To save the edited custom color set with a new name (to create a 
new custom color palette), click Save to open the “Save” dialog 
box. Enter a name for the new color set, and click Save to return 
to the “Color Set” dialog box. 

NOTE ☞  To load the edited custom color palette without saving the changes, 
do not click Save. 

6.  Click OK to load the new custom color palette and return to the 
Chart view. The new colors can be applied to all objects and charts 
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in the active document. To exit the dialog box without loading the 
new Custom Color palette, click Cancel. 

If you saved the edited Custom Color palette, you can load it at any 
time and use your custom colors in any chart. To load the new 
Custom Color palette, select Col- ors from the Edit menu to open the 
“Color Set” dialog box, click the Custom tab, click Load, and select 
the color palette. 

To learn more about... Refer to... 

Creating chart color schemes “Color Schemes” in Chapter 9 

	
  

Using the Eyedropper Tools 
The Eyedropper tool contains a pop-up with an Empty Eyedropper 
and a Full Eye- dropper tool. The eyedroppers work together to select, 
copy, and change fore- ground and background colors and patterns of 
Draw or Text objects, pictographics, shadows, line size, color, style, 
blend, or any elements in a chart. In Text objects, the eyedropper tools 
work on the object fill and the color and pattern of the text itself. 

Any attributes that can be changed using “Object Attributes” from the 
Draw menu can be copied and duplicated by the Eyedropper tools. 

Once you have selected an object and copied its characteristics using 
the Empty Eyedropper, you can use the Full Eyedropper to apply 
those same colors and pat- terns to one or more selected objects at 
the same time. 

To copy object attributes, do the following: 

1.  Click the Eyedropper tool. The Empty Eyedropper tool is 
selected and the pointer becomes an eyedropper. 

2. Select the object containing the pattern/color with the 
Eyedropper. 
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3.  Double-click on the selected object with the tip of the eyedropper 
to copy the object’s attribute(s). The attributes are copied, the Full 
Eyedropper tool is automatically selected, and the pointer changes 
to a full eyedropper. 

 

4.  With the full eyedropper, select any object(s) you want to contain 
the copied attribute(s). To select multiple objects, hold down the 
shift key while clicking the objects. 

 

5.  Double-click any one of the selected object(s) to apply the 
attribute(s). All selected objects are filled with the copied 
attributes. You can apply these same attributes at any time by 
using the Full Eyedropper tool. 

 

The pattern/color copied with the Empty Eyedropper tool can be 
used over and over again at any time by selecting the Full 
Eyedropper tool. The pattern/colors remain until new attributes are 
copied. 

To apply a copied pattern/color, do 
the following: 
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1.  Click the Eyedropper tool and select the Full Eyedropper tool from 
the pop-up. 

The pointer becomes a full eyedropper. 

2.  Select any object(s) you want to contain the copied attribute(s). To 
select multiple objects, hold down the shift key while clicking the 
objects. 

3.  Double-click any one of the selected object(s) to apply the 
attribute(s). All selected objects are filled with the copied 
attribute(s). 

	
  

	
  

Using the Draw Menu 
The Draw menu contains commands that help you manipulate objects 
in the Chart view and add some nifty graphic effects to your Draw, 
Text, and Chart objects. 

To learn more about... Refer to... 

Editing Draw objects “Creating and Editing Draw Objects” 
below 

	
  

Changing Attributes 
You can click any object in the Chart view with the Pointer tool 
while holding the control key to change various attributes. Click 
once to change general object attributes, click and hold the mouse to 
change attributes specific to the type of object selected. 

You can click any Draw object with the Pointer tool while holding 
the control key to change blends, shadows, the fill and line color, 

To learn more about... Refer to... 

“Object Attributes” command “Changing Attributes” below 



 
  DeltaGraph for Macintosh Version 7 User Guide 545 

pattern and weight, and text color, font, style size, and alignment. 

To change general object attributes, do the following: 

1.  Hold down the control key and click the object, or choose Object 
Attributes from the Draw menu. The following dialog box 
appears. 

 

2.  Change attributes as necessary. You can change the fill and line 
color, and pat- tern, line width and style, text size, color, font, 
style, alignment, object and text shadow, and blends. 

3.  Click Show to preview your changes without exiting the dialog 
box. This makes it easy to experiment with different effects. You 
can move the dialog box out of the way by dragging the Title bar. 

4.  When you have the results you want, click OK to implement the 
changes and return to the Chart view. To exit the dialog box 
without changing the chart, click Cancel. 

To change specific object attributes, do the following: 

1.  Press the control key, and click and hold the mouse button on the 
object. 

Depending on the object selected, one of the following pop-up 
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menus appears. 

 

2.  Choose any of the commands from the pop-up menu as needed. 
Depending on the type of object selected, some of the commands 
may not be available. These commands work the same as the 
commands on the Chart and Draw menus. “Attributes” displays 
the “Object Attributes” dialog box. 

Applying Pictographs 
Clip art images, pictures, and even DeltaGraph Draw objects may be 
applied to any chart element or Draw object created in DeltaGraph 
that can be filled. Select the columns for a series in a Column chart, 
for example, and pick a picture from an open Custom Library. Simply 
drag the picture from the library, drop it onto a selected object, and 
the “Pictograph” dialog box is displayed. 

The picture can be stretched, tiled, stacked, scaled proportionally, and 
stacked proportionally. The pictograph may also be “anchored” to the 
plotframe, which is useful for applying textures of different types to 
different series, for making graphic objects look like they are 
windows exposing a background scene, or simply for clipping one 
graphic to another. 

A background color can also be applied to an object or chart element 
containing a pictographic using the Background Color palette. 

Pictographics can be stored in a Custom Library, or if you import an 
image, you must first copy it, select the object or element, then use 
the Paste Pictographic command from the Edit menu. The same 
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dialog box appears. 

Following are the rules for applying pictographics: 

	
  

• Pictographics themselves may contain objects which contain 
pictographics or blends. 

• You cannot have a blend and a pictographic in an object at the same 
time. 

• Objects containing pictographics can contain a pattern or color. 

• Pictographics may consist of any collection of objects except for 
charts, Quick- Time movies, and placeholders. 

• Pictographics can be pasted into any rectangle, rounded rectangle, 
arc, bezier, polygon, oval, or any of these objects inside a chart. 

• Pictographics can be applied to any object or chart element that a 
blend can be applied to. 

• Any image that can be imported into DeltaGraph, or created in 
DeltaGraph, can be used as a pictographic. 

To apply a pictographic, do the following: 

1.  Open a Library containing images that can be used as pictographics. 

2.  Click the Library icon on the Command bar, or choose Libraries 
from the File menu to open a Library. 

or 

Import or create and copy an image that can be used as a 
pictographic. 

Any image that can be imported into DeltaGraph can be used as a 
pictographic. You can press cmd-C or choose Copy from the Edit 
menu to copy an object. 

3.  Select Draw object(s) or chart element(s) in the Chart view. 
Selection handles appear around the selected object(s) or 
element(s). 

4.  Click the image you want to use as a pictographic and drag it into 
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the selected object/element. 

or 

Choose Paste Pictographic from the Edit menu, press shift and 
choose Paste from the Edit menu, or press shift+cmd-V. 

A variation of the following dialog box appears. 

 

5.  Make your selections as needed. You have the following options: 

Type 

Determines the type of scaling used to display the image in the 
selected object/element. 

Original Size 

Draws the pictographic the same size as the source image 
when it is pasted or dropped in the object/element. 

Scaled 

Draws the Pictographic scaled to fit inside the destination 
object/element. 

Scaled Proportional 

Draws the pictographic scaled to fit inside the destination 
object/element but with all proportions kept the same as the 
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original image. 

Tiled 

Draws the pictographic in its original size but tiled to 
completely cover the destination object/element’s area. If the 
image is larger than the selected object, you will not see any 
tiling. 

Stretched 

The selected image must be comprised of two or three 
separate ungrouped sections to be used as a stretched 
pictographic. With a two-section image, the top image 
remains the same size while the bottom image is stretched to 
fill the selected object. With a three-section image, the middle 
image is stretched. If the image is taller than wide, then the 
resulting pictographic is drawn vertically inside the 
destination object, otherwise it will be stretched horizontally. 
The destination object does not determine which orientation is 
chosen. 

For additional information in creating and using stretched 
pictographics, refer to “Creating Graphics for a Stretch 
Pictographic” below. 

Stacked 

Stacks the image disproportionately with each image 
representing major tick increments on the value axis. This 
only works effectively on Column and Bar charts and is only 
available if the image is being pasted or dropped into a chart 
element. 

Stacked Proportional 

Stacks the image proportionately with each image 
representing major tick increments on the value axis. This 
only works effectively on Column and Bar charts and is only 
available if the image is being pasted or dropped into a chart. 
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Anchor 

Determines the starting point for tiling, or alignment of scaled 
images. You can align the pictographic image in the center, top left, 
top, top right, left, right, bottom left, bottom, or bottom right of the 
selected element or object. 
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Align to Plot Frame 

This option is only available if the image is being pasted or 
dropped into a chart element. Aligns the image to the plot frame of 
any 2-D chart or to the actual bounding box of 3-D charts. 

 

Overlap Edges 

Controls whether the image is overlapped in the object or chart 
element. If this option is on, the image is tiled or scaled including 
any pen width. If it is not on, the pen width is ignored, and the 
images overlap each other. 

Hide Fill & Line 

Controls whether the destination object/element lines and fills are 
displayed when the pictographic is applied. 

Copy 

Allows you to copy a pictographic image applied to an 
object/element. This is helpful if the original image is not available 
but the image is applied to an object in the Chart view. You can 
copy the image, exit the dialog box, select a new object/element, 
and press shift+cmd-V, to paste the pictographic. 

6.  Click OK. The image is placed in the selected object or 
chart element. 
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Creating Graphics for a Stretch Pictographic 

	
  

There are some images in the “Picto Graphics” library in the “Clip 
Art” folder that are designed for use as a stretched pictographic. 
These objects are identified in the library by an “(s)” after the object 
name. 

Images for stretched pictographics must be imported into 
DeltaGraph as two or three separate ungrouped sections. 

 

With a two-section image, the top image remains the same size while 
the bottom image is stretched to fill the selected object. With a three 
section image, the middle image is stretched. Make sure that when 
the image is created, the middle image is sent to the back before it is 
used as a stretched pictograph. 

If the image is taller than it is wide, then the resultant pictographic is 
drawn vertically inside the destination object, otherwise it is stretched 
horizontally. The destination object does not determine which 
orientation is chosen. 

In the figure above, the eraser is the top or first image, the point of 
the pencil is the bottom or third image, and the pencil body is the 
middle image. When this image is applied to a series of columns in a 
Column chart, the middle portion of the pencil is stretched, and the 
point and eraser remain the same size in each column. 

If you create or import images for use as a stretched pictographic, 
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create or import each section separately. You can only use images 
that contain two or three separate elements. 

NOTE ☞  For best results when applying a stretched pictographic, resize your 
pictographic so that it is no wider than the element or object to 
which it is being applied. 

To prepare a stretched pictographic, do the following: 

1.  Create or import two or three separate graphic elements to comprise 
the image. 

If the image is a single object, you may be able to separate it if it 
is a PICT image and “Import PICTs as multiple objects” is 
selected in the “Preferences” dialog box. 

2.  Align the separate graphic elements so they appear as one complete 
object. 

3.  Select all of the graphic elements. Do not group the elements 
together. 

4.  Drag the selected elements into a Custom Library. 

You can now drag the entire pictographic into any selected 
element/object in the Chart window. 

To learn more 
about... 

Refer to... 

Exporting pictographics “Exporting Graphics” in Chapter 13 

	
  

Changing Rulers and Grids 
DeltaGraph’s Chart view has an underlying grid for aligning objects. 
Select Rulers 

& Grids from the Draw menu to display a dialog box that lets you 
show or hide this grid, snap to it, or change its size. 

The dialog box also has an option for showing/hiding the rulers along 
the top and left side of the Chart view (see the figure below). You can 
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alter the units these rulers use choosing from inches, centimeters, 
points, picas, or ciceros. 

 

The “Snap to Grid” option, when selected, compels all objects to 
align to the Chart view’s underlying grid (whether visible or not) 
when you create, resize, or move them. You can override this 
command temporarily by holding down the option key while 
manipulating objects. 

You can specify defaults for rulers and grids by choosing Prefs from 
the Edit menu and modifying the Chart view preferences. 

To turn the grid and the “Snap to Grid” option on and off, do the 
following: 

1.  Choose Rulers & Grids from the Draw menu. The following dialog 
box appears. 
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2.  Make your selections as needed. You have the following options: 

Rulers 

Controls the features of the rulers, which can be displayed in the 
Chart view. 

Units 

Controls the measurement scale of the rulers displayed in the 
Chart view. 

Click the pop-up menu and select one of the following: 

Inches 

Centimeters 

0.39 inches or 
25/64 of an inch 

Points 

1/72 of an inch 

Picas 

12 points or 
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1/6 of an inch 

Ciceros 

European measurement system similar to pica. 12 points, 
or 11/64 of an inch. 

Show rulers 

Determines whether or not the rulers appear in the Chart view. 

Grid Settings 

Determines the size for the horizontal and/or vertical grid lines in 
the Chart view. The grid measurement scale is determined by the 
measurement scale specified for the ruler. 

Grid Size 

You can enter new settings, from a minimum of 0.1" to a 
maximum of 2", or click the direction arrows to scroll through 
the values. 

Show Grid 

Determines whether or not the horizontal and/or vertical grids 
are displayed in the Chart view. 

Snap to Grid 

Determines whether or not all objects in the Chart view align 
automatically to the horizontal and/or vertical grid lines when 
being created, moved, or resized. You can temporarily 
override “Snap to Grid” by holding down the option key 
while manipulating objects. 

3.  Click OK to implement the changes and return to the Chart 
page. To exit the dialog box without making any changes, click 
Cancel. 

	
  

To learn more about... Refer to... 

Default ruler and grid “Setting Chart View Defaults” in 
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settings Chapter 6 

	
  

Aligning Objects 
Use the “Align” option to line up selected objects along their edges, 
their centers, and/or the drawing grid. All objects are aligned by the 
object handles that define their boundaries. 

There are also shortcuts to align objects, chart, and placeholders on 
the page. If you select only one object before displaying the “Align” 
dialog box, the selected object is aligned in the page. 

To align objects to each other, do the following: 

1.  Select the objects you want to align. 

2.  Choose Align from the Draw menu or press cmd-M. The 
following dialog box appears. 

 

3.  Make your selections as needed. You have the following options: 

Align Edges 

Aligns the selected objects along their top, bottom, left, or right 
edges. 

Align Centers 
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Aligns the selected objects along a horizontal center point 
(Up/Down) or a vertical center point (Left/Right). 

Align to Grid 

Click this button to align the selected objects to the drawing grid. 

Examples of alignment options: 

 

4.  Click OK to implement the changes and return to the Chart 
page. To exit the dialog box without making any changes, click 
Cancel. 

Rotating Draw and Text Objects 
“Rotate” allows you to rotate a Draw or Text object 90° to the left or 
right, or flip a Draw object 180° vertically or horizontally. If you 
press the control key, click the object, and hold down the mouse 
button, a pop-up menu displays the “Rotate” commands. 

You can rotate or flip charts or imported graphics to the right, to the 
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left, vertically, or horizontally. 

Select Other to display the following dialog box. This lets you 
customize the rotation. Rotation is clockwise. This option is only 
available for Text objects. 

 

NOTE ☞  You can type only whole numbers for degrees in the “Rotate Text” 
dialog box. 

To edit a text object that has been rotated, double-click it. The text 
will be temporarily rotated to 0° while you edit it. When you de-
select the text object, it will return to its original rotation. 

Layering Objects 
Layering allows you to place one or more selected objects on top of 
or underneath another object. Use the “Send” command to reorganize 
your objects to produce different effects. 

To move any object up or down layers, do the following: 

1.  Select the object(s) you want to layer 

2.  Choose Send from the Draw menu, and select one of the options 
from the sub- menu that appears. If you press the control key, 
click the object, and hold down the mouse button, a pop-up menu 
displays the “Send” command. 

NOTE ☞   DeltaGraph remembers layers in the same order that you created or 
placed each object. If it appears that an object is not moving, apply 
the command again; you might have drawn an object in another part 
of your document that is inserting a layer between the objects you 
are trying to move. 
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Grouping and Ungrouping Objects 
Grouping allows you to treat several individual elements as one 
object. This is useful if you want to move several objects and 
maintain their relative spacing. 

NOTE ☞  Charts cannot be placed in a Library if they are grouped with other 
objects. 

To group objects, do the following: 

1.  Select the objects you want to group. Object handles appear 
around each selected object. 

2.  Choose Group from the Draw menu. The objects are now marked 
by one set of object handles, showing that they are being treated 
as one object. 

To ungroup objects, do the following: 

1.  Select the grouped object you want to ungroup. 

2.  Choose Ungroup from the Draw menu. Object handles 
appear around each object, showing that the objects are 
returned to their individual state. 

Locking and Unlocking Objects 
Use the “Lock” command to keep an object from being moved, 
deleted, resized, or edited. 

To lock one or more objects, select the object(s) you want to lock, 
then choose Lock from the Draw menu. To unlock selected object(s), 
choose Unlock from the Draw menu. 

Adding Special Blends to Objects 
You can use the “Blends” command on the Draw menu to create 
some remarkable effects with patterns and colors. You can choose 
from six different blending pat- terns to blend two colors in a 
specified number of steps. You can apply these blends to Draw, Text, 



 
  DeltaGraph for Macintosh Version 7 User Guide 561 

and Chart objects. In a Text object, the blends work only on the 
object fill, not on the text itself. 

You can use the Blend tool to apply the last blend created to an 
object. If you have a 16-color machine and are using blends, make 
sure the “Better Color Blends” option in the “Preferences” dialog box 
is off. This option is for 256 colors. 

To apply a special blend, do the following: 

1.  Select the object(s) you want to change. 

2.  Choose Blends from the Draw menu. The following dialog box 
appears. 

 

3.  Make your selections and enter data as needed. The square on the 
right side of the dialog box changes as you make your selections 
so you can see how they will affect your selected object. You can 
click the square to change the focal point of the blend. You have 
the following options: 

Style 

Changes the blending pattern. The default is “Stripe.” Select a 
blending pattern from the pop-up list. The following blending 
patterns are available: 
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Start Color/End Color 

Selects the starting and ending colors of the blend. To select a 
color, click the pop-up menu next to the option to display a 
Color palette. You can also choose from any existing custom 
colors. 

Number of Steps 

Changes the degree of the blend. The larger the number, the 
more gradual the blend. The more gradual the blend, the longer it 
will take your chart to redraw when the screen refreshes. You 
can enter a number or use the direction arrows to change this 
setting. 

None 

Turns the blending function on or off. 

4.  Click OK to apply the blend and return to the Chart page. To exit 
the dialog box without applying a blend, click Cancel. 

NOTE ☞  To remove a blend, select None from 
the dialog box. 

The blend created in the “Blends” dialog box can be used over and 
over again at any time by selecting the Blend tool. The blend will 
remain until a new blend has been created. 

To apply only the blend and not the color, press the control key while 
double-clicking an object to fill. 

To use the Blend tool, do the following: 

1.  Select the Blend tool from the Toolbox. The pointer becomes two 
paint buckets. 

2.  Select any object(s) you want to contain the blend. To select 
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multiple objects, hold down the shift key while clicking the 
objects. 

3.  Double-click any one of the selected object(s) to apply the blend. 
All selected object(s) now contain the last blend created using the 
“Blends” command. 

Creating Dashed Lines 
You can format any line in your charts or drawing objects or the 
boundary lines of any Draw, Text, or Chart object with special 
PostScript dash patterns. To modify the color, pattern, or width of 
these special dashed lines, use the appropriate palettes in the 
Toolbox. 

To change solid lines to dashed lines, do the following: 

1.  Select the object(s) you want to change. 

2.  Choose Dashes from the Draw menu. 

3.  Make your selections as needed. The line in the “Example” 
window changes to reflect your selections. You have the 
following options: 

Dash Pattern 

Select a dash pattern from the pop-up list. 

Scale 

Elongates or reduces the dash in the pattern to create different 
versions of the same pattern. You can set the scale of the dash 
pattern to Double, Normal, or Half- sized. 

Dash Caps 

Rounds one end of the selected line. 

4.  Click OK to apply the dash pattern and return to the Chart page. To 
exit the dia- log box without applying dashes, click Cancel. 
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Adding Drop Shadows to Objects 
The “Shadows” command places a drop shadow behind any Draw, 
Text, or Chart object in the Chart view. In a Text object, the shadow 
applies to the entire object not just the text. Inset shadows can be 
applied to any selected line. 

Colors and patterns for the shadows are selected from palettes in the 
“Shadows” dialog box. These palettes are identical to those in the 
Toolbox. 

You can use the Drop Shadow tool to select any object(s) and 
apply the last shadow created to those object(s). 

To place a drop shadow behind an object, do the following: 

1.  Select the object(s) you want to change. 

2.  Choose Shadows from the Draw menu. The following dialog box 
appears. 

3.  Make your selections and enter data as needed. The square on the 
left of the dialog box changes to reflect your selections. You have 
the following options: 

Shadow Type 

Displays a pop-up menu so you can select a shadow type. A drop 
shadow casts a shadow on any Draw object. An inset shadow 
creates a stripe one half the width of the selected line. This shadow 
can be applied to any Draw object. 

Foreground and Background 

Displays a Color palette so you can choose foreground and 
background colors for the shadow or pattern in the shadow. 

Pattern 

Displays a pattern palette so you can select a pattern or gray scale 
to use as the inset or drop shadow. 

Horizontal and Vertical 

Sets the offset of a drop shadow only. You can drag the white box 
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on the left, type in any number from -15 to 15 points, or click the 
direction arrows to change the shadow size. 

None 

Turns the shadow function on or off. 

	
  

4.  Click OK to apply the shadow and return to the Chart page. To 
exit the dialog box without applying a shadow, click Cancel. 

The shadow created in the “Shadow” dialog box can be used over 
and over again at any time by selecting the Shadow tool. The 
shadow will remain until a new shadow has been created. 

To use the Shadow tool, do the following: 

1.  Select the Shadow tool from the Toolbox. The pointer becomes a 
shaded triangle. 

2.  Select the object(s) to which you want to apply the shadow. To 
select multiple objects, hold down the shift key while clicking the 
objects. 

3.  Double-click any one of the selected object(s) to apply the 
shadow. All selected object(s) now contain the last shadow 
created using the “Shadow” command. 
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12 Adding Error Bars and 
Curve Fits 

This chapter gives you basic information on how to apply and 
define Error Bars and Curve Fits. It also explains how to define 
your own curve fit function. 

This chapter covers 
the following: 

• Adding error bars to a chart 

• Understanding the types of curves 

• Applying a curve fit 

• Assigning curve specifications to the curve fit 

• Applying a Spline curve 

• Creating user-defined curve fits 

Adding Error Bars to a Chart 
Error bars allow you to graphically illustrate actual errors, the 
statistical probability of errors, or a general approximation or 
“spread” in your data. Examples might include experimental errors in 
measurement or atypical data points in comparison to the rest of the 
data. 

You can add error bars to the following 2-D charts: Bar, Column, Bar 
and Column Segmentation, Floating Bar and Column, Line, Step, XY 
Column, Scatter, Paired Scatter, XY Line, and Paired XY Line. You 
can choose error bar options for all series or for an individual series 
with different parameters for the upper and lower error bars. 
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Error bars appear as two short dashes for the upper and lower values 
of the spread with a line connecting the two dashes at their centers. 
These three parts of the error bar are treated as one chart element in 
the chart, so you can, for example, make an all-red error bar, but you 
cannot make red dashes with a blue connecting line. 

NOTE ☞ If you need more graphic formatting control, and the underlying data 
are best rep-resented as a line chart, use the “Formula Builder” 
command on the Data menu, or do the calculations outside of 
DeltaGraph and make a Range chart with high and low components 
instead of a Line chart with error bars. 

To add error bars to a chart, do the following: 

1. Select the chart to which you want to add error bars. 

Error bars can be added to Bar, Column, Bar and Column 
Segmentation, Floating Bar and Column, Line, Step, XY 
Column, Scatter, Paired Scatter, XY Line, and Paired XY 
Line. 

2. Click the Error Bars icon on the extended Command bar, or 
choose Error Bars from the Chart menu. A variation of the 
“Error Bars” dialog box appears. 
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3. Make your selections and enter data as needed. The ends of 
each error bar are determined by making selections or typing 
values in the “Error Bar” dialog box. You have the following 
options: 

Series 

Sets error bars for all or one data series. “Default” affects all 
data series. To set error bars for an individual data series, 
select the series name from the pop-up menu below “One 
Series.” This automatically selects the “One Series” option. 

Once you have specified different parameters for a particular 
series, changes you make while you’re in the default mode 
will not affect it. Changes made in the “Options” and 
“Direction” sections affect only the series that are selected. 
Help for the “Series” section appears below the “Options” 
selections. 

Orientation 
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(Scatter, XY Column, and XY Line charts only) When using 
error bars with a Scatter chart, each X component and Y 
component can independently have error bars of any variety, 
including “None.” Switch back and forth between 
components by clicking the buttons under “Orientation.” 
When analyzing the data to determine where the error bars are 
placed, the above explanations are valid as long as “data 
value” is replaced with “X component of the data value” or 
“Y component of the data value,” as appropriate. 

Direction 

Sets the orientation of the error bars (Both, Plus, or Minus). 
You can have different error bar parameters for the Plus or 
Minus bar. For example you might use the standard error for 
the Plus but use a percentage for the Minus. You can also use 
the direction settings in combination with individual series 
settings. 

Options group box 

Lists the types of error bars you can add to your chart as 
follows: 

None 

No error bars are drawn. 

Standard Error 

The placement of each end of the error bar corresponds to 
the standard error of the data point. The standard error is 
computed as follows: 

 

where:  

sumSquare  =   sum of the squares of the data values  
minus the data series average  
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count =   number of valid data values plotted. 

% 

Each end of the error bar is placed at the specified 
percentage times the value of the data point. The 
percentage number is based on the scale of the axis. You 
can type in any value greater than or equal to zero or use 
the direction arrow to scroll the options. 

Fixed Value 

Each end of the error bar is placed a distance from the 
data value equal to the number entered. That number is 
based on the scale of the axis. You can type in any value 
greater than or equal to zero or use the direction arrow to 
scroll the options. 

Sample Standard Deviation(s) 

Each end of the error bar is placed at a distance N ⋅ SD in 
user scale units from the computed value. M . N  can be 
any number greater than or equal to zero. You can type in 
the appropriate value for N  or use the direction arrows to 
scroll the options. SD  is the sample standard deviation 
computed as follows: 

 

where:   

sumSquare and count are defined as above and 

M  =   sum of all valid data values for all series selected 
divided by count (i.e., the arithmetic mean) 

This computation places the mean of all the series at the 
center of each error bar, rather than placing the data 
values at the center of each error bar. So the position of 
the ends of each error bar measured along the Value axis 
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is the same for each category (such as a Line chart or 
Step chart) or each data value (such as a Scatter chart). 
That is, all the error bars “line up” instead of being 
“staggered” with the data. 

Variable 

Each end of the error bar is placed at a certain distance 
from the data value, the distance being different for each 
point of the series. The variable errors must be placed in 
a column of the Data page where the data to be plotted 
reside. Choose the name of the column from the 
“Variable” pop-up menu. For more information on 
creating variable error bars, see “Creating Variable 
Error Bars” below. 

Cap Length 

Sets the length of the end caps (whiskers) on the error 
bars. The default is set to 0.1 inches, but can also be set 
to picas, points, centimeters, or ciceros. This will affect 
all error bars in the selected series. 

Clear One Series/Clear All Series 

Changes the settings of the selected series back to the 
default setting. Select the series, then click the Clear 
button. 

4. Click Show to preview your changes without exiting the 
dialog box. This makes it easy to experiment with different 
effects. You can move the dialog box out of the way by 
dragging the Title bar. 

5. When you have the results you want, click OK to implement 
the changes and return to the Chart view. To exit the dialog 
box without changing the chart, click Cancel. 
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Creating Variable Error Bars 
Variable error bars are used when you want an individual error for 
each point on a series. If you have your own calculated errors, 
imported data, or data calculated by the Formula Builder, create 
variable error bars. 

To create variable error bars, do 
the following: 

1. Input both the data and variable error 
data in a Data page. 

 

2. Select and plot only the data for the chart, not the 
variable error data. 

3. Click the chart 
you plotted. 

4. Click the Error Bars icon on the Command bar, or choose 
Error Bars from the Chart menu. The “Error Bars” dialog 
box appears. 

5. Click the pop-up menu in the “Series” section of the dialog 
box, and select the first data series (Series 1 in the 
example). 

6. Click the “Variable” pop-up menu in the “Options” section 
of the dialog box, and select the column from the Data 
page that contains the corresponding error (Error 1 in the 
example). 

7. Repeat steps 5 and 6 until all of the series are matched up. 
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8. Click OK. The chart appears with error bars drawn in the 
chart. 

Curve Fitting 
Here we shall look at the general theory of curve fitting and at power, 
exponential, and logarithmic curves. For more details on these curve 
fits and for an explanation of the more complex theory behind 
polynomial curves, see the excellent treatment of numerical methods 
in Numerical Recipes in C by Cambridge Press, upon which some of 
the theory in this section is based. The brief tour given here is not 
intended to be an exhaustive explanation of curve fitting theory. 

There are four basic types of curve fits, as follows: 

• Power curves 

• Exponential curves 

• Logarithmic curves 

• Polynomial curves 

NOTE ☞ Spline fits are not true curve fits but are an illustrative tool. 

General Theory 
Before we delve into the mathematics of curve fitting, we should 
define what curve fitting is. It is a mathematical process by which a 
curve is determined that minimizes the squares of the distance from 
the curve to the data points. Thus, it is the attempt to find an equation 
that represents the data being fit. The better the fit, the smaller the 
distances are from the curve to the actual data points. However, 
unless the data are known to fit a particular equation exactly, the 
curve will not pass directly through all the data points. 

Consider the following case, where we wish to determine the best 
line through a set of data. The equation used to model the line is of 
the following form: 
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To measure how well the linear model agrees with the data, we use 
the chi-square merit function, which in this case is as follows: 

 

Substituting our linear equation, we get the following: 

 

The equation is minimized to determine a and b. At its minimum, 
derivatives of χ2 (a,b) with respect to a and b vanish. 

 

These conditions can be rewritten in a convenient form if we define 
the following sums: 

 

With these definitions we have the following: 

 



 
  DeltaGraph for Macintosh Version 7 User Guide 575 

The solution of these two equations in two unknowns is calculated as 
follows: 

 

These are the general forms of solutions for DeltaGraph’s curve 
fitting. The difference between the linear, power, exponential and 
logarithmic curve fits is confined mainly to linearizing the data prior 
to using the above equations to determine a and b. We will consider 
each of the remaining cases individually. 

Power Curve 
For a power curve fit, we use the following assumption about the 
model: 

 

Using the following algebra, we can linearize the equation: 

 

This linearized equation can use the above solution by assuming the 
error is of the following form: 
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As a result, we can use the ln(y) and the ln(x) to calculate A and B for 
the power equation. Using the natural logarithms in effect linearizes 
the data, so the same theory can be used to determine the line. The 
results are then used in the original equation to show the best fit. 

When using a power curve fit, you must know the range over which 
the model is valid. As seen in the next figure, when the power (b) is 
greater than 0 (zero) the curve is shaped like a “U” centered around 
x = 0. 

Changing the sign of a flips the “U” upside down. This means that, 
for data sets which appear like a portion of the b>0 family of curves, 
there is an a and b which is valid. 

Conversely, when b < 0 the curve appears like the lower left half of an 
“O”. As an example, consider b  = –1, which is y =  f( x )  =  a ⁄ x . As x 
tends toward 0, the value of y goes to ∞ and there is no curve on the x 
< 0  side of the graph. Hence, trying to fit data sets with a downward 
sloping trend for x < 0  will often result in no solution. 

 

Exponential Curve 
For an exponential curve fit, we use the following assumption about 
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the model: 

 

Using the following algebra, we can linearize the equation: 

	
  

As seen in the next figure, the trend for an exponential curve is 
toward 0 (zero) when x < 0 and toward ∞ when x > 0 . Changing the 
sign of a and b flips the curve around both the X and Y axes. That 
means an exponential curve fit is defined for any set of data. 
However, this does not say how well this form will fit the data. 
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Logarithmic Curve 
For a logarithmic curve fit, we use the following assumption about the 
model: 

y =  f( x )  = a + b ln ( x ) 

Using a similar argument as for the power curve fit, we get the 
following form of the error: 

 

The form of the logarithmic curve fit is shown below. As seen in the 
figure, the curve tends toward ± ∞ as x approaches 0 (zero) and is 
undefined for x < 0 . 

 

Let us consider another case of interest in which a curve fit is known 
to pass through 0 (zero). Some processes, by definition, must be 0 at 
the start. By slightly modifying the curve fit we can obtain a curve 
which passes through 0. Consider the following linear case: 

y  = f (x )  = a + bx 

We can force this curve to pass through 0 by specifying a = 0 
regardless of the data being fit. 
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y = f( x )  =  0 + bx 

Using the same derivative of the merit function as above, we have the 
following: 

 

Solving for b we get the following:  

 

In conclusion, similar solutions may be obtained for other types of 
curves. 

Using Curve Fits 
You can click the Curve Fits icon on the extended Command bar, or 
choose Curve Fitting from the Chart menu to draw a curve that is 
“fitted” to the plotted data points. 

There are two classes of curve fits: “equations” and “splines.” 
Equations assume the selected model or curve fit type describes the 
data being fit. By minimizing the differences between equation and 
data, the model represents the best approximation of a curve based on 
all data points. Because the type of model may not accurately 
represent the data, the curve may not pass through any of the data 
points. By comparison, a spline fit calculates a series of curve fits 
internally which must pass through each data point. 

Curves or curve fits can be applied to Line, Step, Scatter, Paired 
Scatter, XY Line, and Paired XY Line charts. You can draw curves 
for only one series, a selection of data series, or all the series. 

DeltaGraph displays curves within the boundaries of the axes only. If 
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you wish to see more of the curve you can extend the data ranges of 
your Value axes. 

 

By their nature, the formulas used to derive curves in DeltaGraph are 
complex. A fairly detailed explanation for the equations has been 
included to help more statistically oriented users understand the 
methods being used. If you find the math confusing, you can skip 
over the more technical passages. If you want to learn more about 
curve fitting, most college-level statistics textbooks can help. You 
can also refer to Numerical Recipes in C, William H. Press, Brian P. 
Flannery, Saul A. Teukolsky, William T. Vetterling, Cambridge 
University Press. 

The procedure outlined below takes you step-by-step through the 
curve fitting process. When appropriate, the steps refer you to other 
sections of the chapter for additional information. 

To fit a curve, do the following: 

1. Select the chart. Curve Fits can only be performed on Line, 
Step, Scatter, Paired Scatter, XY Line, and Paired XY Line 
charts. 

2. Click the Curve Fits icon on the extended Command bar, or 
choose Curve Fitting from the Chart menu. A variation of 
the “Curve Fitting” dialog box appears. 
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3. Click the “Series” pop-up menu in the “Specifications” 
section of the dialog box to select the series to which you 
wish to fit a curve. 

4. Choose the type of curve you want from the “Curve Fitting 
Type” section. This option determines the type of curve you 
want to apply to your data series. When you choose a linear, 
polynomial, power, exponential, or logarithmic curve type, 
the R2 or correlation coefficient value, along with the 
formula, is displayed in the “Formula” window. This value 
can be copied and pasted in a text block in your Chart page. 
The formula for a user-defined curve fit is displayed only 
after it is defined. Refer to the references below for 
additional information on the types of curve fits. 

5. Make changes to the “Specifications” and “Direction” 
sections as necessary. Refer to “Assigning Curve Fit 
Specifications and Direction” on page 13-18 for information 
on using these sections. To learn more about “Force Through 
Zero,” refer to “Force Through Zero Option” on page 13-20. 

6. Click Show to preview your changes without exiting the 
dialog box. This makes it easy to experiment with different 
effects. You can move the dialog box out of the way by 
dragging the Title bar. 
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7. If you want to fit curves to more data series, select a different 
series (step 3) and repeat steps 4-6. 

8. When you have the results you want, click OK to 
implement the changes and return to the Chart page. T o 
exit the dialog box without changing the chart, click 
Cancel. 

To learn more about... Refer to... 

Different types of curve fits “Understanding the Types of Curve Fits” 
below 

User-defined curve fitting “Creating a User-Defined Curve Fit” 
below 

Spline curves “Force Through Zero Option” below 

	
   	
  

Understanding the Types of Curve Fits 
Each of the “other” curve-fitting techniques (“Linear,” “Polynomial,” 
“Power,” “Exponential,” “Logarithmic,” and “User-defined”) uses 
the “linear least-squares method” to determine the “best fit” for the 
curve. xi and yi represent the data used to plot the chart. These curve 
fitting techniques are also displayed in the “Curve Fitting” dialog 
box. 

Choosing a Curve Fit 

Linear 

For the function fx  = ax + b , a and b are calculated so that the sum of 
the squares of the errors given by ( f( xi ) – yi )2  is minimized, as 
follows: 

fx  =  a ⋅ x + b 
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Polynomial 

For the function 

fx  =  a0 + a1 ⋅ x + a2 ⋅ x2+ … + an ⋅ xn,  

a multiple linear regression is performed using 1, xi , ( xi )2, …, ( xi )n as 
the values of the independent variables and yi as the values of the 
dependent variable. The results are used for 

a0, a1, …, an . 

You can enter a degree of the polynomial from 1 to 10. The default is 
3. The degree of the polynomial is dependent on the number of data 
points plotted as follows: 

2 points =  First-degree polynomial (2 points is a Line) 

3 points =  Second-degree polynomial 

4 points =  Third-degree 

polynomial and so on... 

It is not necessary to enter the exact polynomial degree for the 
plotted data. For example, if you have four points on your chart you 
can enter a degree of “5.” DeltaGraph automatically finds the 
appropriate degree to use. All of the “extra” terms in the 
polynomial higher than the “perfect fit” degree get coefficients of 
zero. 

Power 

For the function g( x )  = A ⋅ x + B, A and B are calculated so that the 
sum of the square of the errors given by:  

∑ [ g( ln( xi ) ) – ln( yi ) ]2 

is minimized. Then b is calculated as b  = eB , and the formula is 
displayed as  

f( x )  =  bxA. 
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Spline 

The formula is not displayed, because it is not convenient to display 
such a detailed formula in the “Curve Fitting” dialog box. 

Exponential 

For the function g( x )  = A + b ⋅ x , A and b are calculated so that the 
sum of the 

square of the errors given by ∑ [ g( xi ) – ln( yi ) ]2
  is minimized. Then 

a is calculated as a  = eA, and the formula is displayed as  

f( x ) =  e( a + b x )  = aebx . 

Logarithmic 

For the function f( x )  = a ⋅ ln( x ) + b , a and b are calculated so that the 
sum of the 

square of the errors given by ∑ [ f( xi ) – yi ]2 is minimized. 

User-Defined 

Allows you to create a curve-fit model function of your own. Click 
Define to define the parameters and establish your equation. For more 
information on creating a user-defined curve fit, refer to “Creating a 
User-Defined Curve Fit” below. 

Understanding How Curve Fitting Affects 
Different Charts 

In all the curve-fitting techniques, one or more model functions are 
chosen to rep- resent the best fit to the data. Every function must get 
its data from somewhere— the domain of the function. The curve 
representing these functions will go from one end of the domain to 
the other. 

Curve fitting on 2-D Scatter charts is different from curve fitting on a 
Line or Step chart. For Line and Step charts, the domain of the 
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function is always the category numbers and all numbers in between 
them. For Scatter charts, the domain can be either the X axis or the Y 
axis. Here X and Y refer to the data components. The X component 
of data for the first series always comes from the first column of 
values selected. The Y component comes from the second column. 

The X axis of a Scatter chart is horizontal unless “Switch Axes” is 
selected in the chart’s “Options” dialog box. To choose a component 
of the data to indicate the domain of the function, select Y is F(x) or X 
is F(y) from the “Direction” section of the “Curve Fitting” dialog box. 
“Y is F(x)” chooses the values on the x axis as the domain. “X is 
F(y)” chooses y values for the domain. 

When a Scatter chart with a Spline curve is selected, the 
“Direction” buttons are dimmed. Two functions are calculated, one 
that returns x values and one that returns y values. The domain for 
each function is the category numbers. 

In the options discussed below, the values xi and yi are determined by 
the chart type and the “Direction” selection. For a Line chart and a 
Step chart, the xi are the category numbers starting at 1 for the first 
category. The yi are the values in each of those categories. (The 
“Direction” selection does not matter.) 

For a Scatter chart, there are two cases as follows: 

• If “Y is F(x)” is selected,  xi  are the x components and yi are the y 
components. 

• If “X is F(y)” is selected,  xi  are the y components and yi are the x 
components. 

Assigning Curve Fit Specifications and 
Direction 

Defining the Number of Nodes 
DeltaGraph draws all curve fits as Bezier curves. A Bezier curve is 
defined by a list of nodes and control points. Nodes are points 
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through which the curve must pass. The position of the nodes, the 
slopes through the nodes, and the curvature through the nodes, are the 
same for the curve in DeltaGraph and the model chosen. Between 
nodes, the position slopes and curvature are not necessarily as 
precise. Control points are points that affect the path of the curve 
between nodes. 

“Number of Nodes,” in the “Specifications” section of the “Curve 
Fitting” dialog box, determines the number of Bezier nodes that the 
curve must pass through. For a Spline curve, this number must be the 
number of valid data points plotted, so the dialog box item is 
dimmed. For any other curve, you can enter any number greater than 
1 and less than 251. The default is 25. 

In general, more nodes means a more accurate representation of the 
curve. How- ever, more than two nodes on a straight line is 
unnecessary, while a large number of nodes can use excessive 
memory. 

Because DeltaGraph can curve fit data whose Value axis or axes are 
scaled by logarithm, the number of nodes for a linear fitted curve is 
not forced to two. If one Value axis is scaled by logarithm, a linear 
fitted curve is not a straight line. How- ever, if one Value axis is 
scaled by logarithm, an exponential fitted curve is a straight line. 

Defining the Number of Digits 
“Number of Digits” in the “Specifications” section of the “Curve 
Fitting” dialog box determines the number of digits that appear to the 
right of the decimal in the mantissa of each of the parameters that 
appear in the curve fit formula displayed in the “Formula” window. 
Enter a “0” to display all digits beyond the decimal. You can enter 
any number from 1 to 16. The default is 6. 

Selecting a Series 
You can use a different type of curve fit on each series of data in the 
chart. To choose the different series, click the pop-up menu next to 
“Series” in the “Specifications” section of the “Curve Fitting” dialog 
box. 
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Using the Squeeze Function 
When “Squeeze” is off (default) in the “Specifications” section of the 
“Curve Fit- ting” dialog box, the curve fit is drawn over the entire 
axis of the domain of the curve fit function. When “Squeeze” is 
selected, the curve is drawn over an interval bounded by the smallest 
and largest domain values. 

 

Choosing the Axis Direction 
The “Direction” section of the “Curve Fitting” dialog box gives 
you two options: “Y is F(x)” chooses Y as the dependent variable, 
and “X is F(y)” chooses X as the dependent variable. The 
examples below use a second-degree polynomial curve fit. 
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Force Through Zero Option 
Curve fits typically fit the exact trend of data, meaning they begin 
part way up the Y axis (at the Y intercept). Sometimes, however, the 
data actually begin from zero (0) on the Y axis, and using “Force 
Through Zero” in the “Curve Fitting” dialog box allows you to force 
the curve through the point of origin. 

This option is provided as a convenient means of starting a curve fit 
at the origin. It applies only to linear and polynomial curve fits. If you 
want to force a curve fit through some Y intercept, you can do so by 
creating a user-defined curve fit. A curve forced through the point of 
origin (zero) can be seen in the next example. 

Creating a Spline Curve 
The Spline curve is drawn through all points on the chart. The effects 
of a Spline curve on a chart are determined by the type of chart 
plotted. Below are two differ- ent types of charts plotted with the 
same data. On the Scatter chart, the Spline curve connects each data 
point in the order it was selected from the Data view. An XY Line 
chart, on the other hand, connects the points from one end of the 
domain to the other no matter how the data were selected in the Data 
view. 
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Applying Spline Curves to Line and Step Charts 
Over each interval between categories, the curve follows the function  
fx  =  a ⋅ x3 + b ⋅ x2 + c ⋅ x + d , which is a third-degree polynomial. 
Each interval can have a completely different set a, b, c, and d. 

The domain of f (the values that x can take) are the category 
numbers at the data points plotted and all real numbers in between. 
The range of f (the values com- puted by f) are in the user scale for 
the Value axis. 

The curve is smooth through the transitions from one third-degree 
polynomial to the next in the sense that the value of the function, its 
first and second derivatives at the right end of one interval, are equal 
to the corresponding values at the left end of the next interval to the 
right. 

Because category numbers are always increasing from 1 to the total 
number of cat- egories and also go from one end of the Category axis 
to the other, the curve does not cross over itself. 

Applying a Spline Curve to Scatter Charts 
Here the Spline curve is defined by two functions. The x function is 
defined on the category number of the data values and all real 
numbers in between and takes on values in the user scale of the X 
axis, while the y function is defined on the category numbers and 
takes on values of the Y axis. 

On each interval defined by adjacent category numbers, the curve 
follows the two functions as follows: 

 

As with the Line chart and Step chart, the ax, bx, cx, and dx, as well 
as the ay, by, cy, and dy, may be different for each interval. They are 
calculated so that the func- tion values, and their first and second 
derivatives, match up on interval boundaries. 



 
  DeltaGraph for Macintosh Version 7 User Guide 590 

Because the x and y components of the data values can be listed in 
any arbitrary order, the x components are not necessarily increasing 
with category and neither are the y components. Therefore, the curve 
may cross over itself many times. If the desired curve should not 
cross itself, then the data should be sorted either by the x component 
or y component (either outside of DeltaGraph or with the “Sort” 
command on the Data menu). 

Understanding User-Defined Curve Fits 
This feature allows you to define your own curve-fit function and 
provides more flexibility to model specifications. 

User-defined curve fitting is a general way of picking a function to 
represent or describe your data. Without user-defined curve fitting, 
you are restricted to a very narrow range of functions. For instance, 
the “linear” curve fit allows you to pick functions of the following 
form:  f( x )  = a ⋅ x + b . 

DeltaGraph picks the best values of a and b so that when plotted the 
function lies “as close as possible” to the data points supplied by the 
user according to the “linear least-squares” method. But with linear 
scaling on both axes of a Scatter chart, this curve is not “curvy”—it is 
a straight line no matter what values are selected by DeltaGraph for a 
and b. The other curve fit options may give a more “curvy” curve 
than “linear,” but each curve fit type has its own limited set of curve 
possibilities.	
  

User-defined curve fits allow quite a bit more freedom in that you can 
define what the possibilities are. A “Linear” curve fit uses only 
addition and multiplication and the two parameters a and b. User-
defined curve fits can use any of the operators, any of the functions 
(with a few restrictions on the arguments for some functions), and 
any number of parameters. Knowing what formula to type to get a 
particular family of shapes requires knowing analytical geometry. But 
you can use DeltaGraph as an experimental tool to see how different 
kinds of functions fit different kinds of data. 

It is more likely, though, that you have a specific model in mind 
based on some knowledge of science, mathematics, engineering, 
economics, or statistics. Such models have a great deal of variety, yet 
many of them are expressible in the function language of user-



 
  DeltaGraph for Macintosh Version 7 User Guide 591 

defined curve fits. In order to make the translation from a given 
model in, say, a science text to the function syntax of user-defined 
curve fits, several features have been implemented. 

User-Defined Curve Fitting Restrictions 
Variables can be named almost anything you choose. (Greek letters 
are not allowed.) Dependent variables don’t all have to be called “y” 
or “f,” independent variables don’t all have to be called “x” or “t,” 
and parameters don’t have to have names like “m1” or “m2.” 

Constants can be defined in order to simplify the formulas, and you 
can define as many as you like. The value of the constant can be a 
simple number or the result of evaluating an expression. 

Even user-defined curve fit models have limits though. You may have 
only one independent variable. This represents the x component of 
data in a two-component data series (such as in a Scatter chart) or the 
category number in a one-component data series (such as in a Line 
chart). You can also have only one dependent variable. This 
represents the y component of data in a two-component series (such as 
in a Scatter chart) or the only component of data in a one-component 
data series (such as in a Line chart). Your models will not be able to 
use some commonly used functions that we do not supply; for 
example, complex functions, many statistical functions, linear 
transformations, tensor transformations, integration, and 
differentiation. 

To display the “User-Defined Curve Fit” dialog box, do the following: 

1.  Select the chart to which you want to apply a user-defined curve fit. 

2.  Click the Curve Fits icon on the extended Command bar, or choose 
Curve Fitting from the Chart menu. The standard “Curve Fitting” 
dialog box is displayed. 

3.  Select User Defined in the “Curve Fitting Type” section of the 
dialog box. 

4.  Click Define at the bottom of the dialog box. The following dialog 
box appears. 
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Data 

This is the name given to the independent variable. You can call it 
“x,” “y,” 

“dollars,” or anything you like. However you spell it, this same 
spelling must be used whenever you refer to the independent 
variable in your model. This is just a name, not a formula or 
equation. 

Model 

This is the equation that defines the possibilities in your curve fit 
model. It is always of the following form: 

<dependent variable name> = 
<model formula> 

<dependent variable name> follows the usual naming rules. The 
name is just for “show”—you never have to type it in any other 
box. It will be displayed in the “Curve Fitting” dialog box’s 
“Formula” window and may also appear in the partial derivative 
expressions in the “User-Defined Curve Fit” dialog box’s 
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“Output” window when “Show Partials” is selected. 

<model formula> is the mathematical formula that details how 
the dependent variable of your model depends on the 
independent variable and the parame- ters. You can use any of 
the operators and functions that are valid in the “For- mula 
Builder” dialog box. You must use at least one parameter in your 
formula. You must use the independent variable in your formula. 
You can use any constant you have defined in the “Constants” 
window. 

Constants 

Each constant is a name and a formula. The constant name can be 
used in any other formula. It is shorthand for the result of 
evaluating the constant formula. Any number of constants can be 
defined (within limits of memory). 

Each constant definition consists of a constant name and an 
equal sign followed by a constant expression. If you have more 
than one definition, they must each be separated by a list 
separator (; in the U.S. version). These are called “constants” 
because a constant’s formula may not depend on the 
independent variable or any of the parameters. Other than that 
restriction, a constant can have any formula. 

The “Parameters” window can contain references to these 
constants in the formulas that set the initial values of the 
parameters. The model formula can also refer to any of these 
constants. These are entirely optional. 

Parameters 

These are the quantities that give your model its flexibility. In your 
model formula, you place a parameter in the formula wherever you 
have an unknown quantity and you want DeltaGraph to figure out 
what the best value of that quantity should be. 

Even though DeltaGraph will calculate a “best” value, you must 
supply an “initial” value. The technique used for determining best 
parameter values is an “iterative” algorithm (the Levenberg-
Marquardt method, see Numerical Recipes in C) and as such requires 
a reasonable guess as to what the right answer is before it can 
“improve” on it to get the best answer. 
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Any name you use for a parameter, along with an initial value for that 
parameter, must be included in the “Parameters” window and must 
follow a certain format. List separators (; in the U.S. version) must be 
used to separate each parameter definition. Parameter names follow 
the usual rules for names. Initial values can be numbers or formulas 
referring to constants. 

Please remember that any formulas used are for initial values only. 
DeltaGraph improves upon those values when you apply the curve fit. 
The final values of the parameters are displayed in the “Output” 
window of the “User-Defined Curve Fit” dialog box and in the 
“Formula” window of the “Curve Fitting” dialog box. If “Save All 
Iterations” is selected (default), then the best value so far of each 
parameter at each step of the iteration is displayed in the “Output” 
window when the curve fit is complete. 

Since the iteration starts with your initial values for each of the 
parameters and improves on them with each step, the final values of 
the parameters may be very different for a different set of initial 
values. 

User-Defined Curve Fitting Rules 
Every entry you make in the “Data,” “Model,” “Constants,” and 
“Parameters” fields in this dialog box starts out with a name followed 
by an equal sign (=). Each of these names is used to name the 
independent variable, the dependent variable or model, constants, or 
parameters that you are defining for your curve-fitting function. Refer 
to the “User-defined Curve Fit” dialog box illustration on page 13-24 
and the figure on page 13-33 for a user-defined curve fit example. 
The names that you assign to these fields have the following 
restrictions: 

• Names must be limited to 63 characters. 

• An equal sign (=) must follow the name. (The “Data” 
field does not require an equal sign.) 

• The name must be unique and cannot be used to name 
any other function in an- other field in the dialog box. 

• The name can consist of a combination of letters and 
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numbers or a single quote (’) but cannot start with a 
number. 

• The name cannot contain an underscore (_) or spaces. 

After the name and equal sign (=), the “Model,” “Constants,” and 
“Parameters” fields contain a definition for the name. 

• Constants can be defined with expressions containing 
references to previously defined constants. 

• Parameters can be initialized with expressions containing 
references to previously defined parameters or constants. 

• Letters of the alphabet can be used in the expression to 
represent columns of data in the Data view. If you want to 
use letters in the expression to refer to something other than 
columns of data, you must define them in the “Constants” or 
“Parameters” window. Letters that refer to columns, or what 
the computer may refer to as columns, are automatically 
capitalized. Columns in the Data view are lettered from A 
through Z, then AA through IT. 

• You can have multiple parameters or constants defined, 
however, be sure to separate definitions by a list separator 
(a semicolon is used in the U.S.). 

Using Formulas in a User-Defined Curve Fit 
You can use function arguments from the “Formula Builder” 
dialog box in the user-defined curve fit. Formulas are appropriate 
in three places as follows: 

• The constant expression in a constant definition. 

• The initial value in a parameter definition. 

• The model formula in the 
model definition.  

Other formula restrictions are as 

follows: 
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Model 

You can use the following functions without restriction in the “Model” 
window: 

sin, asin, sinh, asinh, cos, acos, cosh, acosh, tan, atan, tanh, atanh, 
cot, acot, coth, acoth, csc, acsc, csch, acsch, sec, asec, sech, asech, 
Sqrt, Exp, Log, Ln. You can also use the formula for the nth root as 
described in “Formula Builder Functions” on page 4-32. 

Any of the other functions can be used with the following 
restriction: neither the independent variable (“Data”) nor any 
parameter may appear in any of the function arguments. (This is to 
insure that the other function has zero-valued partial derivatives 
with respect to the independent variable and each parameter.) If you 
break the rule, an error message alerts you when you click 
Calculate Now. 

Constants and Parameters 

All of the functions can be used with no restrictions when defining 
values for constants and initial values for parameters. 

	
  

Loading and Saving a Curve Fit 
After entering your curve fit information in the User-defined Curve 
Fit dialog box, click Save. You can name and save these formulas as 
you would a regular file. 

You can also load all or just a portion of a saved user-defined curve 
fit. From the User-defined Curve Fit dialog box, click Load. You 
can select whether or not you want the Model, Data Name, 
Constants, or Parameters section of the saved user- defined curve fit 
to be loaded in the “User-defined Curve Fit” dialog box. User- 
defined curve fits can only be opened from this dialog box. 

To learn more about... Refer to... 

“Formula Builder” command “Building Formulas” in Chapter 4 
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Creating a User-Defined Curve Fit 
To create a user-defined curve fit, do the following: 

1. Display the “User-defined Curve Fit” dialog box as previously 
described.  

	
  

2. Enter the name you want to use to reference the independent 
variable in the text box next to “Data.” 

3. In the window under “Constants,” enter the name of a constant, 
an equal sign (=), then an expression to initialize the constant. 
This is an optional entry. The “Constants” window does not 
require any entry if you do not want to use named constants. 

You can have multiple constants, but you must separate them by 
a semicolon. The constants are used in the model expression (in 
the “Models” window) or in the parameter initializations (in the 
“Parameters” window). 

You cannot use the independent variable, the dependent 
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variable, the “Data” name, or a parameter name in the 
expression. Constants can be referenced and used in the 
“Parameters” window, or you can enter references to a cell in 
the Data view. 

To reference a cell, type the column letter followed by the cell 
number of the referenced data in square brackets. The example 
below references k1 as the constant name, D as the column 
letter, and 2 as the referenced cell in column D. 

 Example: k1=D[2] 

4. In the window under “Parameters,” enter the name of the 
parameter, an equal sign (=), then an expression to initialize the 
parameter. 

You must have at least one parameter. If you have multiple 
parameters, separate them by a semicolon. Because your model 
must include at least one parameter, you must have at least one 
parameter name and initial value included in the “Parameters” 
window (otherwise DeltaGraph has nothing to calculate). 

User-defined curve fitting uses an iterative algorithm. The initial 
value of each parameter is supplied here. Each iteration may 
improve the values of the parameters. 

In the curve-fitting algorithm, the constant expressions are 
evaluated and stored in the order you list them. Then the initial 
values of the parameters are evaluated and stored in the order 
you list them. Note the order in which you list the constants and 
parameters, and take care not to refer to an undefined constant or 
uninitialized parameter. 

You cannot use the independent variable or the dependent 
variable to define any of the initial values of the parameters. 

5. In the window under “Model,” enter the name you want to use 
as the dependent variable, an equal sign (=), then the model 
expression. 

You must have a model equation. The expression defines how 
the dependent variable in the model depends on the 
independent variable and the parameters. It should contain at 
least one reference to the independent variable (the name 
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entered in the “Data” section) and at least one reference to a 
parameter. 

6. Make changes to other options, as follows, in the dialog box as 
necessary. 

Reinitialize 

Changes the starting value for the next iteration based 
on the last value of the previous curve fit. If a curve fit 
has been calculated, clicking this button causes the best 
values of the parameters to be substituted for the initial 
values of the parameters. This change is reflected in the 
Parameters block. This is useful if the previous curve 
fit calculation has stopped because the maximum 
number of iterations was attained, but it is desirable to 
continue the curve fit algorithms for more iterations. 
Click Reinitialize followed by Calculate Now to 
continue the curve fitting algorithm. If a curve fit has 
not been calculated, then this button will be disabled. 

Max Iterations 

Determines the maximum number of calculations used 
in finding the best possible values for the parameters. 
Enter numbers from 1 to 32,767. The default is 5. 
Remember, the more iterations, the longer the 
computation takes. All iterations are displayed in the 
“Output” window and numbered 1:, 2:, etc. (see the 
figure on page 13-33). If you enter “0,” no iterations are 
calculated. The initial values of the parameters are used 
as the final values of the parameters 

Stop Below 

The algorithm stops if chi-squared is less than the 
entered value at the end of an iteration. 

Show Partials 

Shows partial derivatives of the model function with 
respect to the independent variable and parameters. This 
option does not affect the curve fit in any way; it is there 
for your own information. 



 
  DeltaGraph for Macintosh Version 7 User Guide 601 

with numbers 

Controls how the parameters inside a partial 
derivative are displayed in the “Output” window. 
Show partials must be selected. If deselected, then the 
names of the parameters are displayed in the partial 
derivative formulas. If selected, then the best values 
of the parameters are displayed in place of names in 
the partial derivative formulas. 

Show all Values 

Determines how many iterations will be displayed in 
the “Output” window, good or bad, including chi-
squared. When off, the “Output” box shows the best 
values of the parameters at any step shown. When on, 
the “Output” box shows the new parameters values 
used at each step shown, in addition to the best 
values. 

Use Weights 

Determines the value contributed to the total error of chi-
squared using values from a column of data from the Data 
view. Default is 1.0. To explicitly define the weights, 
enter the weights in one column of the Data page. Select 
that column from the “Use Weights” pop-up menu. The 
number on the first row of the column is the weight for 
the first selected row in the data selection. Subsequent 
rows of the weight column correspond to subsequent rows 
of the data selection. 

Specifying a weight much smaller than 1.0 for a 
particular data point magnifies the contribution of that 
data point to the total error and can make the total error 
much larger. 

Specifying a weight much larger than 1.0 for a particular 
data point diminishes the contribution of the data value 
to the total error. It does not reduce the total error much 
unless all the data values are assigned weights greater 
than 1.0. 
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Save All Iterations 

Puts the values of the parameters and the measure of fit 
after each step through the iteration in the “Output” 
window. Each iteration in the “Output” window is 
numbered 1:, 2:, etc.. 

Save Last Iteration 

Puts the values of the parameters and the measure of fit 
after the last iteration only in the “Output” window. 

7. Click Calculate Now. The iterations of the function appear in 
the “Output” window of the dialog box. 

The first line of the iteration contains the iteration number. This 
number has no significance other than to divide the iterations. 
Next comes the replacement values for the parameters for that 
iteration. These values change with every iteration and are used 
by the model function to obtain a best fit for the curve. A value 
for the square of the regression coefficient R2 , and chi-squared 
appear at the bottom of each iteration. Chi-squared is defined as 
follows: 

 

where: 

yi is the y component of the data 

xi is the x component of the data 

f ( xi )  is the value of the right-hand side of the model 
equation evaluated by substituting xi for the independent 
variable 

σi  is the weight associated with each data point 

the sum, Σ , is taken over all the categories in a data 
selection 

If “Show Partials” was selected, the partial derivatives of the 
model appear at the end of the output statement. These 
derivatives are the partial derivatives (a concept from calculus) of 
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the model function with respect to the independent variable and 
with respect to the parameters. You may find them useful, and 
the curve-fit algorithm needs to know them for the sake of 
precision. If you have n parameters, you will get n + 1 partial 
derivatives. Following is an example of user-defined curve fit 
output. 

 

The Greek symbol “ ∂ ” is used in the standard way to specify the 
derivative of one variable (always the dependent variable) with 
respect to another variable (the independent variable or a 
parameter). To the right of the symbol for a derivative is an equal 
sign (=) followed by the formula for the specified deriva- tive. 
That formula may have references to the independent variable 
and/or to the parameters, as dictated by the model formula you 
specify and the rules of calculus and algebraic simplification. 
Each partial derivative then looks like the following in the 
“Output” window: 

∂  <one variable> / ∂  <another variable> = <formula> 

8. Click OK to make the changes and return to the “Curve Fitting” 
dialog box. If you want to return to the “Curve Fitting” dialog box 
without specifying a user- defined curve fit, click Cancel. 

The final model formula for the user-defined curve fit now 
appears in the “Formula” window of the “Curve Fitting” dialog 
box. The parameters in the formula have been replaced by 



 
  DeltaGraph for Macintosh Version 7 User Guide 604 

numbers. These numbers are derived from the iteration with the 
best fit. 

9. Click Show to preview your changes without exiting the “Curve 
Fitting” dialog box. “Show” makes it easy to experiment with 
different effects. You can move the dialog box out of the way by 
dragging the Title bar. 

If the curve fit is not a good fit, it may require more iterations. 
Instead of using the same parameters and just requesting more 
iterations, replace the parameters in the “User-Defined Curve Fit” 
dialog box with the values in the “Formula” window. By 
replacing values, you can start from where you left off without 
recalculating any previous iterations. 

10. To fit curves to more data series, select a different series by 
clicking the “Series” pop-up menu and repeat steps 2-9. 

11. Click OK to implement the changes and return to the Chart 
view. To exit the dialog box without changing the chart, click 
Cancel. 

User-Defined Curve Fit Samples 
The following table lists some example User-defined Curve Fit 
formulas and Models. The sample files are included with DeltaGraph 
and are located in the “Curve Fits” folder in the “Sample Files” 
folder. These formulas can be loaded in the “User-defined Curve Fit” 
dialog box in the “Curve Fitting” dialog box. 

These samples can be used as starting points for creating your own 
formulas and models. The initial parameter values are listed and the 
formulas and models are displayed in mathematical terminology. 
For example: 
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User-Defined Curve Fit Sample Formulas 
Following are sample user-defined curve fit formulas included with 
DeltaGraph: 

	
  

Curve Fit Formula Parameters 

Double Exponential Decay 
 

a, b, c, d 

Exponential  a, b 

Exponential Decay 
 

a, b 

Exponential Rise to Max 
 

a, b, c 

	
  

Hyperbolic 

 

    

	
  

a, b 

Parabola 
 

a, b 

Power of Natural Log 
 

a, b 

	
  

Reciprocal 

 

 

	
  

a 

	
  

Reciprocal of Square Root      

	
  

a 

	
  

Sigmoid Logistic 

 

 

	
  

a, b, c, d 
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Sine Wave 

  

 

	
  

a, b, c, d 

Weighted 3rd Order Poly 
 

a, b, c, d 

	
  

User-Defined Curve Fit Sample Models 
Following are the sample user-defined curve fit models included with 
DeltaGraph: 

	
  

Curve Fit Formula Parameters 

Blood Glucose 
Concentration (mg/dl)  

k =  0.049  
b  = 1  
constants:  
a  = 139.2 

Holling’s Response Curve 
(prey eaten/minute)  

a  = 0.5 
b  = 0.25 

Ocean Depth Pressure 
(N/M2)  

a  = 1.01 ⋅ 105 

constants: 

b  = 1 ⋅ 103 

c =  9.8 

Oxygen Consumption in 
Fish 
(ml/hour) 

 
k =  0.76 
a  = 1 
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Achieving Better Curve Fits 
This section provides you with valuable hints and tips for creating 
more accurate curve fits. 

Reinitializing Parameters 
Reinitializing your initial parameters will sometimes increase their 
accuracy, making a much better fit. To reinitialize your parameters, do 
the following: 

1. Input your model and starting parameter(s). 

2. Increase the “Max Iterations” to a value appropriate to your 
model, computer speed, and computer math capabilities. 
This value can be as low as 1 for simple equations and as 
high as 10,000 for more complex ones. The models listed in 
the figure on page 13-33 were calculated using 20 to 50 
iterations. 

3. Click Calculate Now. 

4. Click Reinitialize. 

5. Repeat steps 3 and 4 until the parameters have minimal 
change or the “chi- squared” value is sufficiently small. 

6. Click OK. 

Curve Fit Hints 
Following are helpful hints and troubleshooting tips that may assist 
you in creating your curve fits: 

• The graph on the screen matches the function, specified in the 
model, very well at the nodes. The nodes are evenly spaced 
along the curve in the x-axis direction if y + f( x ) is selected 
for the curve fit. The placement of nodes can be controlled by 
the “Number of Nodes” option in the “Curve Fitting” dialog 
box. Sometimes a graph can look very different from the 
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model because the number of nodes is too small. 

• Avoid placing a node on an x value where the f( x ) value is 
not defined. Remember some of the functions supplied in 
DeltaGraph have ranges of values where the function is not 
defined. For example: 

 

• Avoid selecting initial values of parameters that cause the 
evaluation of the model function at any of the data value’s x 
coordinates to be undefined. This could cause a calculation 
error message to be displayed. 

• Avoid selecting initial values of the parameters that cause the 
evaluation of the model function at any of the node’s x 
coordinates to be undefined. This can cause the graph to be 
drawn “strangely” in the vicinity of such a node. 

• Be sure the number of parameters initialized in the 
“Parameters” block matches the spelling and number of 
parameters used in the model functions. 

• Compare the “chi-squared” error values displayed with the 
number in the “Stop below” value. Repeated “Calculate 
Now”/“Reinitialize” cycles are not necessary if the “Stop 
below” value adequately describes your requirement for 
terminating the iteration process. 

• User-defined curve fits may not always return what is 
expected. In the process of iterating, the general method does 
not always converge to what you would get with the “same” 
formula chosen from the standard curve fit types. It may not 
converge to what “looks” like the best answer. It does not 
necessarily converge to the smallest possible “chi-squared” 
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value. It does not necessarily converge at all. It may start out 
fine and then pick a value for a parameter that produces un- 
defined results and not be able to improve on the solution 
from that point on. 

• All user-defined curve fits depend on the data values 
supplied, the model, and the initial values of the parameters. 
Changing the data and initial values of parameters can make 
a very large difference in the final result. 



 
  DeltaGraph for Macintosh Version 7 User Guide 610 

13 Importing and Exporting 
Graphics 

It is easy to import and export graphics to and from the Chart view in 
DeltaGraph. For frequently used imported graphics, you may want to 
incorporate them in a template or save them in the Custom Library 
for easy access and convenience. 

This chapter covers the following: 

• Importing graphics 

• Exporting graphics 

• Exporting pictographics 

To learn more about... Refer to... 

Importing and exporting data “Importing Data”  and “ExportingData” in 
Chapter 4 

The Custom Library “Custom Libraries” in Chapter 14 

	
  

Importing Graphics 
You can use the “Import” command on the File menu to import 
graphics from other applications. Choose Import from any Chart 
page to display a submenu with the following formats: 

• Macintosh PICT (.PICT) 

• Windows Bitmap (.BMP) 
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• Adobe PhotoShop (.PSD) 

• Portable Network Graphics (.PNG) 

• Graphic Interchange Format (.GIF) 

• Tagged Image File Format (.TIF, .TIFF) 

• QuickTime Image (.QTI) 

• Joint Photographic Experts Group (.JPG, .JPEG) 

• JFIF Compliant (.JFIF) 

• JPEG 2000 (.JPG, .JPEG) 

• Encapsulated PostScript File (.EPSF) 

• Portable Document Format (.PDF) 

• Movie 

To import a graphic into DeltaGraph, do the following: 

1. Make sure the Chart page you want to import the graphic into 
is active. 

2. Choose Import from the File menu and select a format from 
the submenu. The standard “Open” dialog box is displayed. 
All of the files with the format you selected are displayed. 

3. Select the file you want to import, and click Open. The 
graphic arrives in the upper left-hand corner on top of 
anything already in that area. 

From now on, DeltaGraph treats the graphic as an Imported Graphic 
object. When selected, it can be moved, resized, and manipulated 
with many of the commands in the Edit and Draw menus. You can 
cut, copy, paste, clear, and duplicate it, align, layer, and lock/unlock 
it, and group it with other objects in the window. 

You can use the “Ungroup” command to separate an Imported 
Graphic object from other objects it has been grouped with. 
“Ungroup” cannot be used to separate individual elements in the 
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original imported file.	
  

To learn more about... Refer to... 

Objects in the Chart view Chapter 12, “Working with Objects in 
Chart View” 

Preferences Chapter 7, “Setting Preferences” 

	
  

Exporting Graphics 
To export DeltaGraph charts and objects to another application, use 
the “Export” command on the File menu to save the contents of a 
Chart page in one of the fol- lowing file formats: 

• Encapsulated PostScript (.EPS) 

• Adobe Portable Document Format (.PDF) 

Select As Other from the Export submenu to save the file in one of 
the following formats: 

• Windows Bitmap (.BMP) 

• Joint Photographic Experts Group (.JPG, .JPEG) 

• JPEG 2000 Image (.JPG, .JPEG) 

• MacPaint (.MAC) 

• Adobe PhotoShop (.PSD) 

• Portable Network Graphics (.PNG) 

• QuickTime Image (.QTI) 

• Silicon Graphics Image (.RGB, .BW, RGBA, .SGI) 

• Truevison Targa (.TGA) 

• Tagged Image File Format (.TIF, .TIFF) 
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You can export the entire contents of a Chart page or individual 
objects. Objects in a Chart page must be selected before exporting. 

Following is a list of things to keep in mind when deciding on a 
format for export- ing DeltaGraph graphics: 

• Objects exported as PICT files are now raster-based images, 
rather than vector based PICTs as in previous versions of 
DeltaGraph. 

• Objects exported as EPS files cannot currently include 
Quartz fills. Doing so results in the creation of EPS files 
which are not readable. 

• Exporting objects in EPS or PDF form provides the highest 
fidelity output, including support for spot colors. 

To export graphics, do the following: 

• Make sure the Chart page containing the objects you want to 
export is active and the objects are selected. If you are 
exporting from the Organizer view, make sure the page or 
thumbnail is selected. 

• Choose Export from the File menu and select a format from 
the submenu. A variation of the standard “Save As” dialog 
box appears so you can name and save the file you are 
exporting. DeltaGraph displays a default name for the 
document under “Export document as” in the dialog box. It 
consists of the active Chart page name, a period, and the 
extension of the format you choose (e.g., “.png,” “.eps,” or 
“.pict”). 

• Enter a name, choose your destination, then click Save to 
create a file you can use in another application or file. The 
graphic is written to the selected folder or directory under the 
format and name you specified. 
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14 Creating a Custom 
Library 

This chapter explains how to create and open a Custom Library 
and how to add and delete objects from a Custom Library. 

After you set the font, size, color, and style for the labels in a chart, 
choose colors and patterns for each data series, and set the grids, 
ticks, and axes the way you like them, the Custom Library allows you 
to store the chart as a template so you can reuse all of that hard work 
over and over again. This saves you from having to redo the same 
operations for your next chart. When you plot your next chart, you 
can choose a chart from the Custom Library, plot the new data, and a 
chart is created with your favorite formatting already in place. You 
can save your chart templates with or without data. This allows you 
to transfer data as well as charts to different DeltaGraph documents. 

To display a Custom Library, click the Library icon on the Tool bar, 
or choose Libraries from the File menu and select Open from the 
submenu. Custom Libraries can also be used to save clip art, 
pictographics, and logos commonly used in Chart pages and in slide 
show presentations you create. 

This chapter covers the following: 

• The types of objects that can go in a Custom Library 

• Creating, opening, and closing a Custom Library 

• Placing an object or chart template in the Custom Library 
and naming it 

• Retrieving an object or chart template from the Custom 
Library 

• Retrieving a slide from the Custom Library 

• Changing the name of an object in a Custom Library 
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• Deleting an object from the Custom Library 

Custom Libraries 
There is no limit to the number of Custom Libraries you can have 
because each library is saved independently of DeltaGraph 
documents. This allows you to create your own personal library and 
access it from any DeltaGraph document. You can display and access 
Custom Libraries from either the Chart or Organizer views or the 
Layout mode. Each Custom Library can contain an unlimited number 
of objects and/or chart templates. 

A Chart template consists of a formatted chart. This also includes any 
accompanying data and objects. If the object added to or used from a 
Custom Library does not contain a chart, it is simply referred to as an 
“object.” 

You can have an unlimited number of Custom Libraries open at a 
time (dependent on memory available). In addition, a special library 
called “Standard Library” is automatically opened when DeltaGraph 
is launched. The name “Standard Library” can be given to any of your 
DeltaGraph Custom Libraries to use this feature. Custom chart 
templates contained in this library are displayed in the various chart 
categories in the “Chart Gallery” dialog box (choose Chart Gallery 
from the Data or Chart menu, or click the Plot icon to display this 
dialog box). 

Auto-Loading Libraries 
Custom Libraries can also be opened automatically when DeltaGraph 
is launched by simply placing them in the “AutoLibrary Folder.” Up 
to four Custom Libraries can be included in the folder and loaded. 
Charts included in the Custom Libraries are displayed in the “Chart 
Gallery” dialog box along with the standard chart types. 

Creating a Library 
You can store Text, Chart, Draw, Imported Graphic objects, or any 
combination of objects in a Custom Library. An entire page from the 
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Organizer view, including any backgrounds applied to the Chart 
page, can also be added to a Custom Library as one object. The name 
of objects added to a Custom Library from the Organizer view are 
underlined. 

Elements from the library are fully editable. When dragged from 
the library, the objects can be edited, moved, and revised as they 
would if you had just created them. 

To close a library, click the Library window Close box on the 
left side of the library Title bar. 

To create a library, do the following: 

• Click the Library icon on the Tool bar, or choose Libraries 
from the File menu and select New from the submenu. The 
standard “Save As” dialog box appears. 

• Enter a name and choose your destination as desired. 

• Click Save to create a library file. The Custom Library is 
saved to the folder you selected. An empty Custom Library 
window with the name you assigned appears in the upper 
right corner of the Chart view. 

The Custom Library 
The Custom Library has all of the standard window characteristics, 
such as a scroll bar, Title bar, and a window resizing icon. The figure 
below shows examples of objects in a Custom Library. As you can 
see by the example, you can have a wide variety of objects in your 
library. 
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The title of your Custom Library appears on the Title bar, and the 
titles of the library objects appear below the object picture. Naming 
your library objects is explained below. 

Whenever you resize the Custom Library window, the objects 
rearrange them- selves to fit the dimensions of the window. 

Opening an Existing Library 
You can open any Custom Library from any DeltaGraph document. 
The maximum number of Custom Libraries that you can have open at 
one time is dependent on the amount of memory available. 

To open a library, do the following: 

1. Click and hold the Library icon on the tool bar, or choose 
Libraries from the File menu and select Open from the 
submenu. The standard dialog box for opening a file appears. 
Libraries can be named anything you like. 
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2. Locate the library you want to open, then double-click its 
name, or highlight the name and click Open. The Library 
window appears in the upper right side of the page. You can 
move and resize the Library window as you would a Chart 
page. Chart templates contained in the open Custom Library 
appear with the various chart categories in the “Chart Gallery” 
dialog box. 

Placing an Object in a Library 
Objects placed in a Custom Library can be used over and over again. 
Each element in the library object remains separate and can be altered 
just as it was before you placed it in the library. Procedures for 
storing any combination of Chart, Draw, Imported Graphic, or Text 
objects are all the same. 

Charts grouped with any other objects using the “Group” command 
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cannot be placed in a Custom Library. They can, however, be moved 
into the library together if they are selected and dragged together. 
Charts and objects in the Custom Library using color schemes and 
custom colors automatically use the color scheme and custom colors 
of the active document. If the active document does not have any 
color schemes or custom colors, the default fill for these objects is 
white. You can save color schemes and custom colors to be 
transferred between documents. 

Slides from the Organizer view can also be placed in the Custom 
Library.  Exception backgrounds, charts, text, and Data view data 
belonging to the selected slide are all placed in the library with the 
slide. The Master Back- ground is not copied into the Custom Library 
because it will use the destination document’s Master Background. 
The names of slides added to a Custom Library are underlined so you 
can distinguish them from other library objects. 

To add an object to a library, do the following: 

1. If you want to place a chart in a Custom Library, plot the 
chart and format it the way you like. 

2. Create a new or open an existing Custom Library. 

3. Select all objects you want included as a single library object. 

Selecting a chart includes the legend, all axis labels and titles, 
and chart elements. You must select Text, Draw, and 
Imported Graphic objects, in addition to Chart objects, if you 
want them included in the same library object. You can also 
use the “Group” command to group objects before you put 
them in the library. Objects can be ungrouped using the 
“Ungroup” command once they are placed in the Chart page. 

Charts cannot be placed in a library if they are grouped with 
other objects. However, you can simply select the chart along 
with other objects, and drag them together into the library. 
They will move together but remain ungrouped when dragged 
into a Chart page. 

4. Drag the selected item(s) until the crosshair cursor appears in 
the Library window. The cursor automatically highlights 
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objects in the library. The new object is positioned in the 
library directly before the highlighted object. 

 

5. Release the mouse button. The following dialog box appears. 

 

6. Enter the name you want to give the library object. If you are 
placing a chart in the Custom Library, you have the following 
options: 

Save charts as templates 

Saves only the chart formatting as a template. It 
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does not save the data. 

Save charts with data 

Saves all values associated with the chart. This 
option is helpful to use when you want to transfer 
the data to a new document. No matter what data 
are selected, all of the data on the page are saved. 

7. Click OK to name your new object and add it to the Custom 
Library. To return to the Chart view without adding the object 
to the library, click Cancel. 

To learn more about... Refer to... 

Custom colors “Working with Custom Colors” in 
Chapter 12 

Color schemes “Color Schemes” in Chapter 10 

	
  

Using an Object from an Open Library 
If you drag an object from the Custom Library into an existing Chart 
page, that Chart page must be displayed. You can also create a new 
Chart page by clicking       the Add Page icon at the bottom of the 
Chart page before you begin the following steps. 

If you want to drag a pictographic image into a chart element or object, 
the object or data graphic/series must be selected before you drag the 
library object from the library. Library objects cannot be placed in a 
layout or background window. You can, however, place them in a 
Chart page, copy the objects, and paste them in the layout or 
background page. When you place a slide from the library, a new Chart 
page is created, and all of the objects and the attributes stored with the 
objects are placed in the current document. 

When a Custom Library is open, you can access objects in that library 
in one of the following ways: 
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• Drag an object into the Chart page from the open Custom 
Library. 

• If the object contains a chart, select the chart template from 
the “Chart Gallery” dialog box. 

Charts contained in the Custom Library appear mixed in with the 
standard charts of the same category. Slides contained in the Custom 
Library are underlined. 

NOTE ☞  Custom colors for library objects created in a different DeltaGraph 
document cannot be transferred across documents and appear with 
colors as defined by the document. If color schemes or custom color 
palettes were used, the objects take on the colors of schemes and 
palettes of the active document.  

If your data contain more information than originally used when the 
chart template was created, you may need to apply fonts and other 
formatting options to the extra data plotted. 

To use a library object, do the following: 

1. Open the Custom Library of your choice. 

2. Select an object from the library and drag it into a Chart page. If 
the object does not contain a chart, or if the chart contains data, 
the objects are automatically displayed in the Chart page. You 
do not have to continue through the remainder of the steps. 

When a chart containing data is extracted, and the data used are 
not in the active document, a new page is created in the Data 
view to contain the new data. 

If a chart was saved as a chart template without data, DeltaGraph 
returns you to the last page used in the Data view. A “floating 
window” is displayed in the lower-left corner of the Data view 
telling you what you need to do and where the selected data will 
be plotted. 
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You can drag the Title bar to move the floating window away 
from your viewing area. 

NOTE ☞  Many of the Data view features are active and available to you. You 
can enter or import new data, link to a file, switch to another Data 
page, or use the data func- tions to create new data. 

3. Import, enter, or navigate to the data you want to use, then 
select the cells to be plotted. Hold down the command key to 
select non-consecutive cells. 

4. Click Titles to select axis titles. 

5. Click the Plot button in the floating window. The Chart page 
is redisplayed, the selected data are applied to the chart 
template, and a chart is created. If the library object contains 
more than one chart, any charts still requiring data are 
represented by a large box with an X in the middle. 

 

6. You can select the box and click the Revise Data icon on the 
tool bar, choose Revise Data from the Chart menu, or press 
cmd-, (comma) to add data to the chart. 

7. If you decide not to update the chart template, click Cancel  
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to return to the Chart view. 

Other objects contained in the library with the chart are displayed 
on the page regardless of whether the chart is plotted or not. You 
can plot the chart later as described in step 5. 

NOTE ☞  When a chart is still a box with an X in it, it can be moved or 
deleted but not resized. 

To rename a library object, do the following:  

1. Select the object you want to rename in the Custom Library. 
A dark border appears around the library object. 

2. Choose Change Name from the Library window pop-up 
menu. The standard “Name” dialog box appears. 

3. Type the new name in the text box below “Change Name to.” 

4. Click OK to rename the object. To exit the dialog box without 
saving the changes, click Cancel. 

To delete a library object, do the following: 

1. Select the object you want to remove from the Custom 
Library. A dark border appears around the object. 

2. Choose Remove Item from the Library window pop-up 
menu. A dialog box appears asking you to confirm your 
choice. 

3. Click OK to remove the object. To exit the dialog box without 
deleting the object, click Cancel. 

To learn more about... Refer to... 

Creating and applying 
pictographics 

“Applying Pictographs” in Chapter 12 
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15 The Organizer View 
	
  

The Title bar displays the name of the document followed by a colon 
and the name of the view. You can move the window around the 
screen by clicking and dragging the Title bar. 

Viewing Your Charts 
You can view the contents of the Organizer view in two different 
ways, as follows.  

“List” view (the default, unless you change it) lists the pages/slides 
by name and number. 
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“Thumbnail” view shows you a reduced graphic view of each slide.  
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There is no difference in functionality between the two views; the 
only difference is what you see. Personal preference and/or the task at 
hand will influence which view you use. If you need to conserve 
memory, work in List view as much as possible. (See “Adding Draw 
Delay to Slide Elements” on page 16-17 for more helpful 
suggestions.) 

To move back and forth between the two modes, click the 
List/Thumbnail icons at the top of the right scroll bar, click the 
Organizer View icon on the tool bar, or choose Organizer View from 
the View menu, and make your selection from the sub- menu. To 
change the default mode, save the document after switching modes. 
DeltaGraph considers this the default mode until you save the 
document again while it is in a different mode. 



 
  DeltaGraph for Macintosh Version 7 User Guide 628 

If you want to change the text attributes for the List view 
information, use commands on the Text menu or use the Font icons 
on the tool bar. 

	
  

	
  

Organizer View Elements 
Organizer View Elements 

Element Description 

	
  

Tool bar 

Provides quick access to menu commands. For 
additional information about the Organizer view 
Tool bar, refer to “Organizer View Command Bar” 
in Chapter 2. 

	
  

Marked/ Unmarked 
Charts 

Indicates whether or not the slide appears when you 
run your slide show. Click in the box next to the 
page number to toggle your selection. Marked 
slides are excluded from the show. 

	
  

Selected Chart 
Selected page(s) are highlighted with a dark border. 
Use the shift+click key combination to select more 
than one page. 

	
  

Page Names 

DeltaGraph automatically displays the name of the 
Chart page. You can change the name of any page 
by choosing “Name Page” from the View menu, 
then typing a new name in the dialog box that 
appears. In the Thumbnail view, you can click the 
name to display the same dialog box. 

	
  

Charts 
Thumbnail view:  Graphic representations of Chart 
pages. List view:  One line of information. 
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Selecting Chart Pages 
When chart pages are selected, you can reorder them, drag them into 
a new document or the Custom Library, or delete them. 

• To select a chart page in the List view, click the page name 
or anywhere to the right of the name. 

• To select a slide in the Thumbnail view, click anywhere in 
the main area of the page. 

• To select more than one chart page at a time, click and drag 
a selection rectangle around the pages (Thumbnail view) or 
down the numbers (List view), or use the shift+click method 
(hold down the shift key while clicking the pages you want 
to select). 

• In both views, a selection rectangle surrounds the selected 
page(s). 

NOTE ☞  Unless you specifically select one or more slides as described above, 
the first page in the view, or the page last acted upon, is selected by 
default. If you do not intend to act upon the selected page directly, it 
does not matter what is selected. 

	
  

To learn more about... Refer to... 

Marking pages “Marking/Unmarking Pages” below 

	
  

Naming or Renaming a Page 
DeltaGraph assigns each new slide a default name corresponding to 
the actual Chart page. Pages in the Sorter view can only be changed 
from the Thumbnail view. You can also change the name of the page 
in the Chart view. 

To name or rename a page, do the following: 
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1. Click the Thumbnail icon to display the Thumbnail view. 

2. Click the page you want to name/rename. The page is 
highlighted. 

3. Choose Name Page from the View menu. The “Page Title” 
dialog box appears. 

4. Enter the new name. You can enter up to 30 characters. The 
new name over- writes the default name. 

5. Click OK to rename the page. The new name replaces the 
old name in List and Thumbnail views. If you want to exit 
the dialog box without making any changes, click Cancel. 

Editing a Slide 
If you want to make changes to the contents of a page, you can either 
double-click the page in the Sorter view, select the page and choose 
Edit Page from the Sorter menu, or press cmd-E. Both of these 
methods return you to the originating Chart page so you can make 
your changes. The page is automatically updated when you return to 
the Sorter view. 

NOTE ☞  If you make changes in a Chart page without opening the page from 
the Sorter view, you must return to the Sorter view and select 
“Rebuild Page” from the Sorter menu if you want to update the 
affected slide. If more than one Chart page has changed, you can 
choose “Rebuild All Pages” from the Sorter menu. 

Marking/Unmarking Pages 
By default, all pages in the active document are included in printing 
(unmarked). To exclude pages from printing, you can click in the 
box next to the page number in the List or Thumbnail view. The 
international “No” symbol indicates that the slide will be excluded 
from printing. Click again to toggle your selection. 
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Marked Page Unmarked Page 

 

Deleting Pages 
To permanently remove one or more pages from your document, 
select the slide(s) in the Sorter view and press the delete key. You 
can also select the slide and choose Delete Page from the View 
menu. The page is also removed from the Chart view. 

To delete multiple pages, use the shift key to select multiple slides, 
then press the delete key. 

Reordering Pages 
DeltaGraph’s advanced multiple-selection capabilities give you great 
flexibility when reordering pages. All you have to do is select the 
pages(s) you want to move and drag them to a new location. You can 
even select pages in non-sequential order (using the standard 
shift+click method) and have them reorder just as you selected them. 

To reorder pages, do the following: 

1. Select the page(s) you want to move. When moving more 
than one page, be sure to select them in the order you want 
them. 

2. Click the first page you selected and hold down the mouse 
button. The cursor changes to the icon shown at the left. 

3. Drag the page(s) to the new location in the Organizer view, 
making sure that the first page is directly over its new 
location before releasing the mouse button. The pages 
rearrange themselves in the same order in which they were 
selected. 
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Printing from the Organizer View 
To print chart pages, handouts, or the page list in the Organizer 
view, do the following: 

1. Click the Print icon or choose Print from the File menu in 
the Organizer view. The standard “Print” dialog box 
appears. Select your Printer and appropriate Presets from 
the pop-up menus. 

2. Click the pop-up that shows a default of “Copies & Pages,” 
and select Delta- Graph. The Organizer view options are 
added to the dialog box. 

 

3. Select from the following options as needed: 

Print 

Select the items that you want to print: Slides, Handouts, 
and/or the Slide List (the List view). 

4. Click Preview if you want to see what the selected item(s) 
will look like printed. A preview window opens and the 
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document is displayed in an Adobe Acrobat® PDF format. 

5. Click Save As PDF if you want to save the printouts to 
Adobe Acrobat PDF files (as displayed in the preview). 

6. Click Print to print the document. If you want to exit the 
dialog box without printing, click Cancel. 

To learn more about... Refer to... 

Printing in DeltaGraph Chapter 17, “Printing in Chart View” 
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16  Printing in Chart View 
To print charts, on paper or to disk, you need to set up the 
document, the Chart pages, a header and footer if used, and specify 
your final printing requirements. This chapter covers the following: 

• Setting up the document 

• Setting up the Chart pages 

• Setting up headers and footers and previewing the printed 
document 

• Printing the document 

To learn more about... Refer to... 

Printing a Data page “Printing a Data Page” in chapter 4 

Printing files to disk “Printing the Charts” below 

	
  

Setting Up the Page 
Use “Page Setup” to set up document pages for printing.  

To set up Chart pages for printing, do the following: 

1. Click the Chart view icon on the Tool bar or Navigational 
bar to display the Chart view. You cannot set up options for 
Chart pages in any other view. 

2. Choose Page Setup from the File menu. The following 
dialog box appears:	
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3. Make your selections as needed. You have the following 
options:	
  

Settings 

Select from the pop-up menu the settings that you want to 
define, as follows: 

Page Attributes 

Set up the printer, paper size, orientation, and scale 
(as shown above). 

Custom Paper Size 

Changes the dialog box to set up a custom paper size. 
When finished, select “Page Attributes” to return to 
the “Page Setup” options. 

Summary 

Displays a summary of your selections in the dialog 
box. 
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Format for 

Select the printer on which you want to print the Chart pages. 
The printer name is displayed under the pop-up. Other options 
available in the dialog box are determined by the printer you 
select. 

Paper Size 

The paper sizes available depend on the printer you selected. 
Select the paper size you want to use from the pop-up menu. 

Orientation: 

Click the orientation in which you want the pages printed. 

Scale: 

You can scale the size of the chart on the page. Select 100% if 
you want the chart to fill the page. 

4. Click OK to save the information. If you want to return to the 
Chart view without saving, click Cancel. 
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Printing the Charts 
To print the Chart pages, do the following: 

1. Click the Print icon on the Tool bar, choose Print from the File 
menu, or press cmd-P. A standard “Print” dialog box appears. 

 

2. If necessary, select the printer and any appropriate presets for 
the printer. 

3. Select DeltaGraph from the pop-up menu that defaults to 
“Copies & Pages.” The following options are displayed for 
chart printing: 

Print Current Chart Page Only 

Select to print only the currently displayed Chart page. If this 
option is not checked, all pages in the document are printed. 

Header/Footer 
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Header/Footer are accessed through the file menu and brings 
up the following dialog box. 

 

Use Header/Footer 

Select to print a header or footer on each page. 

Format 

Determines what will appear in the header or footer, as 
follows: 

Date and Time 

Select a date and/or time format from the pop-up 
menu, or select “No Date” and/or “No Time.” 

Text Info 

Opens a dialog box so you can set font, color, and 
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styles for the header/footer text. 

Include Filename 

Select to include the document file name in the 
header/footer. 

Include on first Page 

Select to include the header/footer on the first 
page. If not selected, the header/footer is shown 
on all pages except the first page. 

Include Page # 

Select to include a page number, and then select 
whether you want the page number to appear at 
the beginning or end of the header/footer. 

Update Options 

Determines when the date and time information in the 
header/footer is updated. 

Automatic 

Updates the date and time to the current date/time 
automatically when printing. 

Fixed 

Stores the current date/time when selected and 
does not change it unless another option is 
selected. 

On Save 

Changes the date/time to the current date/time 
when the document is saved. 

Location 
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Click in the box to select whether you want the 
information in a header or footer and the position on the 
page. Click the left or right side or in the middle at the top 
of the box to select the location to print a header. Click the 
left or right side or in the middle at the bottom of the box 
to select the location to print a footer. A red line indicates 
the location when you click. 

Example 

Displays an example of what the header/footer will look 
like on the page and the information it will include. 

Click OK to save the information, or click Cancel  to exit 
without saving. You are returned to the Print dialog box. 

Preview 

Click to display the Chart pages in a preview window so you 
can see how they will look printed. 

Use the tools at the top of the window to change the view. 
Close the window to return to the Print dialog box. 

Save As PDF 

Click to save the Chart pages in an Adobe Acrobat PDF file. 

4. Click Print to print the document. 



 
  DeltaGraph for Macintosh Version 7 User Guide 641 

17  AppleScript Commands  
This chapter briefly describes how to use Apple events, Apple’s 
Scripting System (AppleScript™) with DeltaGraph. 

Apple Events are high-level messages that applications compatible 
with the Macintosh system use to communicate with each other. In 
DeltaGraph, repetitious chart-building tasks can be automated 
through the use of Apple events and Apple’s Scripting. This chapter 
outlines DeltaGraph’s supported Apple Events and their AppleScript 
commands. 

To view the list of commands that DeltaGraph supports, use the 
“Open Dictionary” command in Apple’s Script Editor. 

NOTE ☞  The information in this chapter assumes that the user is familiar with 
AppleScript and basic programming concepts. 

High Level Overview 
DeltaGraph has many options and settings. AppleScript commands 
would become overwhelming if all options and settings had to be 
specified in one command. DeltaGraph takes a different approach. 
Commands set global options that are accumulated through all 
commands. The Plot Chart command considers all the global options 
when plotting a chart. Global options are consistent when plotting 
multiple charts. To plot two charts with the same options, the options 
need only be set once. 

There are four basic steps to plotting a chart: 1) select the data for the 
chart, 2) specify chart options, 3) set export type, if any, and 4) plot the 
chart. 

Required Suite Commands 
DeltaGraph responds to the four required Apple Events: run, open, 
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print, and quit. 

Run 
The Run (Open Application) command is the equivalent of double-
clicking the DeltaGraph application icon from the Finder. 

Refer to the AppleScript documentation (AppleScript Language 
Guide) for information on the AppleScript command syntax and 
parameters. 

	
  

Example run application "DeltaGraph" 

Open 
The Open (documents) command is a request to open the specified 
DeltaGraph file or files. It is the equivalent of double-clicking a 
DeltaGraph file’s icon in the Finder. 

	
  

Command Syntax open directParameter 

Parameters directParameter 

The file or list of files to open. 

Class: String, alias, or a list of strings or aliases (type 'ALIS'). 

Result None 

Example tell application "Finder" 
open alias "My HD:DeltaGraph Folder:My Charts"  
end tell 
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Print 
The Print command is a request to print all chart pages of the specified 
DeltaGraph file or files. It is the equivalent of selecting DeltaGraph 
files from the Finder and choosing “Print” from the File menu. 

Command Syntax print directParameter 

Parameters directParameter 

The file or list of files to print. 

Class: String, alias, or a list of strings or aliases. 

Result None 

Example tell application "DeltaGraph"  
print alias "My HD:DeltaGraph Folder:My Charts"  
end tell 

Quit 
The Quit command is a request for DeltaGraph to quit. The equivalent 
is to choose “Quit” from DeltaGraph’s File menu. 

Command Syntax quit 

Parameters None  

Result None 

Example tell application "DeltaGraph" quit 
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DeltaGraph Suite Commands 
DeltaGraph has its own suite of Apple Events for setting input and plot 
options, plotting charts, and outputting charts. This section describes those 
Apple Events and their AppleScript commands. Following are the AppleScript 
commands for DeltaGraph’s Apple Events 

NOTE ☞  Parameters in square brackets are optional. 

Close File 
DeltaGraph has a Close File event in its Apple Event suite. The 
Close File call closes a specified open document in DeltaGraph 
and, optionally, allows you to save the file before closing. 

Command Syntax Close File documentName [save file YesOrNo] 

Parameters documentName 

The name of the open document to be closed. You may specify the 
file name with or without the full path name. 

YesOrNo 

The integer 1 indicates the file is to be saved, and 0 indicates the 
file is not to be saved. If you do not include this parameter, the file 
is not saved. 

Result Error message if unable to complete the command. Empty response if 
successful. 

Examples To save and close the file: 

Close File "Sales for September" save file 1 

To close the file 
without saving: 

Close File "Sales for August" save file 0 

or 
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Close File "Sales for August" 

Open Library 
The Open Library command asks DeltaGraph to open the specified 
DeltaGraph Library. 

	
  

Command Syntax Open Library libraryName 

Parameters libraryName 

The name of a library to be opened. The name may be a full path 
name or simply a file name. If only a file name is used, the file is 
assumed to be located in the DeltaGraph application directory.  

Result Error message if unable to complete the command. Empty response if 
successful. 

Examples To open a library from a specific path: 

Open Library "My HD:Work:Chart Libraries:Sales 
Chart Templates" 

To open a library from the DeltaGraph application directory: 

Open Library "My Fancy Library" 

Close Library 
The Close Library command closes the specified library by name. 

Command Syntax close library libraryName 

Parameters libraryName 

The name of the library to close. 

Result Error message if unable to complete the command. Empty response if 
successful. 
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Example close library "Sales Chart Templates" 

Load Color Scheme 
The Load Color Scheme command tells DeltaGraph to open the 
specified color scheme file. When used with the Plot Options 
command, Load Color Scheme allows you to set customized colors 
for chart objects that use default colors. 

Command Syntax load color scheme colorFile 

Parameters colorFile 

The name of a color scheme file to be opened. The name may be a full 
path name or simply a file name. If a only the file name is specified, 
the file is assumed to be located in the DeltaGraph application 
directory. 	
  

Result Error message if unable to complete the command. Empty response if 
successful. 

Examples To load a color scheme from a specific path: 

load color scheme "My HD:Work:Colors:Color 

Scheme 1"  

To load a color scheme from the DeltaGraph application 

directory:  

load color scheme "Color Scheme 5" 

Get Chart List 
The Get Chart List command returns a list of all charts by name 
from currently open libraries. 

Command Syntax Get Chart List 
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Parameters None 

Result The result is a list of charts currently available for plotting. 

Example Get Chart List 

Set Axis Lengths 
The Set Axis Lengths command sends specifications for the lengths 
of some or all possible chart axes, X, Y, and Z. 

Command Syntax Set Axis Lengths [for x xLength] [for y yLength] [for 
z zLength] 

Parameters xLength 

The length of the X axis in points. 

Class: Integer 

yLength 

The length of the Y axis in points. 

Class: Integer 

zLength 

The length of the Z axis in points. 

Class: Integer 

Result None 

Example Set Axis Lengths for x 200 for y 250 for z 150 

NOTE ☞  All three parameters for this command are optional. You may set axis 
lengths for some, all, or none of the axes, although setting lengths for 
none of the axes has no effect on the current settings. 
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Set Info3D 
The Set Info3D command specifies options settings for the next 3-
D chart to be plotted. These options include rotation, elevation, and 
perspective. 

Command Syntax Set Info3d [rotation rotationAngle] [elevation 
elevationAngle] [perspective perspectiveValue] 

Parameters rotationAngle 

The rotation angle, from 0–360 degrees, for 3-D charts. 

Class: Integer 

elevationAngle 

The elevation angle, from 0–360 degrees, for 3-D charts. 

Class: Integer 

perspectiveValue 

The perspective value, from 100 –20, for 3-D charts. 

Class: Integer 

Result None 

Example Set Info3D rotation 45 elevation 60 perspective 80 

Plot Options 
The Plot Options command sets various options for the next chart 
to be plotted, including text font, text size, text color, and color 
style. 

NOTE ☞  Plot options set with this command affect only default charts or those 
elements of chart templates that have not been modified by the user. 
For example, if you have set a library chart’s font to something other 
than the default font, the Plot Options font command parameter has 
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no effect on that chart’s font. 

Command Syntax Plot Options [text font fontName] [text size 
sizeValue] [text color rgbColors] [colorstyle 
styleType] 

Parameters fontName 

The name of the default font to use for the next chart’s labels. 

sizeValue 

The font size for the next chart’s labels. 

rgbColors 

The RGB color for labels on the next chart. 

Class: List of 3 integers, each between 0 and 65535 

styleType 

Specification of pattern or color options for the next chart, from 
the following types: 

default color 

Use standard colors only. 

patterns 

Use patterns only (no color). 

scheme color 

Use current scheme colors only. 

colored patterns 

Use the default color/pattern scheme. 

NOTE ☞  The “scheme color” option uses the color scheme that was set using the 

Load Color Scheme command. 
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Result Error message if unable to complete the command. Empty response if 
successful. 

Examples To set all parameters directly: 

Plot Options text font "Palatino" ← 

text size 24 ← 

text color {65535,1500,1500} ← 

colorstyle default color 

	
  

To set a list variable for the RGB text color and then use the variable in 
the Plot Options command: 

set colorList to 
{1234,65535,1234} Plot 
Options text color 
colorList 

Output 
The Output command sets the output type and location for the chart 
to be plotted next, as well as its file name for export from 
DeltaGraph. Charts can be exported in five different formats: PICT, 
Encapsulated PostScript (EPSF), JPEG, Microsoft Windows 
Bitmap, and Adobe Photoshop. 

Command Syntax Output outputType [to file fileName] 

Parameters outputType 

Specification of type for export from one of the following types: PICT, 
JPEG, EPSF, Microsoft Windows Bitmap format, Adobe Photoshop 
format. 

fileName 

Desired export file name, as type alias or text. 



 
  DeltaGraph for Macintosh Version 7 User Guide 651 

Result Error message if unable to complete the command. Empty response if 
successful. 

Examples To cause the Plot Chart command to return PICT 
as its result: 

Output PICT 

To export the next chart in JPEG: 

Output JPEG to file "My HD:Chart.jpg" 

Data 
The Data command specifies the data source for the next chart to be 
plotted. Use the Data command to set up data for the Plot Chart 
command. The data can be a string, or it can be imported from a tab-, 
comma-, or space-delimited text or Excel file. The Data command is 
optional. If it has not been specified in a script, the Plot Chart 
command attempts to use the selected data on the current sheet. The 
Open command can be used to open a specific DeltaGraph document 
and the Select Data command can be used to choose a particular data 
sheet and range of cells. 

	
  

Command Syntax Data [dataString] [as type dataType] [from 
file inputFile] 

Parameter dataString 

A string of data of the type specified in the dataType parameter. 
Default is tab delimited. 

dataType 

Specification of delimiter type of dataString or inputFile from one 
of the follow- ing types: Tab-delimited, Comma-delimited, Space-
delimited, or Excel. 

inputFile 
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Name of file to import. 

Result None 

Examples To use a string from the script as data: 

Data "F.Y. 1991 F.Y. 1992 

Portland20 32 

Denver16 28 

San Diego22 29" 

To set data to be imported from a tab-delimited text file: 

Data as type Tab Delimited from file ← 
"MyHD:Spreadsheets:Sales Data" 

	
  

Plot Chart 
The Plot Chart command names which chart is to be plotted and then 
plots it. The result is either exported to a file or returned directly as 
the commands result. 

NOTE ☞  Before using the Plot Chart command, data must be selected. This can 
be accomplished directly with DeltaGraph by opening a document 
and then selecting the appropriate data, by using commands such as, 
Open, Use, and Select Data, or with the Data command. The Output 
command must be used to set the export options. 

Command Syntax Plot Chart chartName 

Parameters chartName 

The name of the chart to be plotted. It must match exactly an available 
chart name. Available charts include built-in charts and any charts in 
open libraries. Use the Get Chart List command to retrieve a list of 
available charts. 

Result If no export option was specified, the result is a picture of the chart. 
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If an export option was specified, no return data is sent. An error 
message is displayed if unable to complete the command. 

Examples To plot a chart named “3-D Area.” 

Plot Chart "3-D Area" 

To place the result of the Plot Chart command into a variable for later 
use: 

set plotResult to Plot Chart "3-D Area" 

NOTE ☞  Older Macintosh Systems imposed a size limit of 32Kbytes for 
objects passed via Apple Events. If the chart you have plotted is 
greater than 32K in size, it is not properly sent via the Plot Chart 
event. Possible solutions are to plot a less complex chart or to export 
the chart and work with the exported file. 

No Default 
The No Default command clears all default settings set by the Use 
command. 

Command Syntax No Default [document ""] [sheet ""]  

Parameters document "" 

 Clears the active document name. 

sheet "" 

Clears the active data sheet name. 

Result Error message if unable to complete the command. Empty response if 
successful. 

Examples To clear the page name and the chart name: 

No Default page ""chart"" 
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Select Data 
The Select Data command uses the specified section of a data sheet 
for plotting data. The row of labels has an index value of zero as does 
the label column. Out of bounds values will be handled as follows: 

If a value is larger than the maximum number of rows, then the value 
is set to the appropriate maximum. If the start row is negative, it is set 
to zero. If the end row is negative, it is set to the maximum number of 
rows. The same rules apply to columns. 

Command Syntax Select Data [start row firstRow] [start column 
firstColumn] [end row lastRow] [end column lastColumn] 

Parameters firstRow 

 An integer indicating the first row of data in the selection. 

firstColumn 

An integer indicating the first column of data in the selection. 

lastRow 

An integer indicating the last row of data in the selection. 

lastColumn 

An integer indicating the last column of data in the selection. 

Result Error message if unable to complete the command. Empty response if 
successful. 

Examples To select data in cells starting in row 1, column 2 and ending in row 
10, column 3, inclusively. This is a contiguous block of 20 cells. 

Select Data start row 1 start column 2 end row 10 end 
column 3 

To select the labels and data in cells starting in row 1, column 1 and 
ending in row 20, column 5, inclusively. This is a contiguous block of 
110 cells including both the row labels and column labels. 
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Select Data end row 20 end column 5 

Use 
The Use command makes the named element (the document or data 
sheet) the default data object. 

Command Syntax Use [document docName] [sheet sheetName] 

Parameters docName 

The active document to use as the default. Can be a 
full file path. 

sheetName 

The active DeltaGraph document sheet to use as 
the default. 

Result Error message if unable to complete the command. Empty response if 
successful. 

Example tell application "DeltaGraph 5" 

Use document "HD:DeltaGraph:MyDocument.dg5" sheet 
"First"  
Select Data start row 1 start column 1 end row 4 
end column 9 
Output JPEG to file 
"OS_X:Users:klund:Desktop:Output.jpg" 
Plot chart "Line"  
end tell 

DeltaGraph Dictionary of AppleScript 
Commands 

The following tables provide a quick reference of the commands 
in the Delta- Graph AppleScript dictionary. 
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Required Suite 

Command Description 

	
  

open 
Open the specified object. 

open alias:  list of objects to open 

	
  

print 
Print the specified object(s). 

print alias:  list of objects to print 

	
  

quit 
Quit application. 

quit 

	
  

run 
Send to an application when double-clicked. 

run 

	
  

	
  

	
  

DeltaGraph Server Suite 

Command Description 

	
  

Close File 

Close the named document and optionally save. 

Close File alias:  name of the open document to save 

[save file integer]:  0 = No, 1 = Yes 

	
  

Close Library 
Close a DeltaGraph library by name. 

Close Library alias 

	
  

	
  

Specify the data source for the next chart to be plotted. 

Data string: Optionally supply data as a string 
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Data [as type Tab Delimited/Comma Delimited/Space Delimited/ 

Excel] 

[from file alias] 

	
  

Get Chart List 

Return a list of all charts by name from open libraries. 

Get Chart List 

Result:  list 

	
  

Load Color Scheme 
Load color scheme file. 

Load Color Scheme alias:  File name of color scheme file 
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Open Library 
Open a DeltaGraph library file by name 

Open Library alias 

	
  

Output 

Set output type and location for chart to be plotted next.  

Output JPEG/PICT/PICT with Embedded 
Postscript//EPSF/Microsoft Windows Bitmap/Adobe Photoshop 
4/TeachText:   

Supply type of output data [to file alias] 

	
  

Plot Chart 

Name the chart to be plotted and plot it. 

Plot Chart string 

Result:  with no export option, result is a picture 

	
  

	
  

Plot Options 

Set various options for the next plot. 

Plot Options 

[Text Font string]: Default font to use for labels 

[Text Size small integer]: Default font size to use for labels [Text 
Color RGB color]:  Default font color to use for labels (RGB) 

[Colorstyle default color/patterns/scheme color/colored 
patterns]:  Use of color in default chart 
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Set Axis Lengths 

Set lengths of chart axes in points 

Set Axis Lengths 

for X integer 

for Y integer for Z 
integer 

	
  

	
  

Set Info3D 

Set appearance of 3-D charts 

Set Info3D rotation 
integer elevation integer 
perspective integer 
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DeltaGraph Immediate Suite 

Command Description 

	
  

	
  

	
  

No default 

Clear the name for the current default data object. 

No default 

[document null]:  Active document 

[sheet null]: Active data sheet 

[Excel sheet null]:  Name of Excel sheet to open when importing 
data. 

	
  

	
  

	
  

Select Data 

Select a section of a data sheet for plotting a chart. 

Select Data 

[start row integer]:  The first row of data in the selection 

[start column integer]:  The first column of data in the selection 

[end row integer]:  The last row of data in the selection 

[end column integer]: The last column of data in the selection. 

	
  

	
  

	
  

Use 

Make the named element the default. 

Use 

[document alias]:  Active document 

[sheet string]:  Active data sheet 

[Excel sheet string]: Name of Excel sheet to open when importing 
data 
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Chart Types Quick 
Reference 
2-D Business Charts 

 

Column 

Use a Column chart to compare one item to another or to 
compare different items over a period of time. Column 
charts effectively show dramatic changes from one 
category to another. 

 

Stacked Column 

Use a Stacked Column chart to compare parts to the total 
or to show how components of an item change over time. 

 

Bar 

Use a Bar chart to compare sizes and amounts or to 
emphasize differences between items, usually at the 
same point in time. 

 

Bar With Line Overlay  

Use a Bar with Line Overlay chart to compare sizes and 
amounts or to emphasize differences between items, 
usually at the same point in time. The line overlay shows 
the trend of one or more items over a period of time or 
number of events. 
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Stacked Bar  

Use a Stacked Bar chart to show how all categories in a 
series compare over time or to compare parts to the total. 

 

Stacked Bar with Line Overlay 

Use a Stacked Bar with Line Overlay chart to compare 
parts to the total or to show how components of an item 
change over time. The line overlay shows the trend of 
one or more items over a period of time or number of 
events. 

 

Stacked Column with Line 
Overlay 

Use a Stacked Column with Line Overlay chart to 
compare parts to the total or to show how components of 
an item change over time. The line overlay shows the 
trend of one or more items over a period of time or 
number of events. 

 

Build-Up 

Use a Build-Up chart to show components that build up 
to a total over time or make up a whole. 

 

Stacked Build-Up  

Use a Stacked Build-Up chart to show groups of 
components that build up to a total over time or make up 
a whole. 
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Floating Bar 

Use a Floating Bar chart to compare ranges of data 
among series and categories. 

 

Floating Column 

Use a Floating Column chart to compare ranges of data 
among series and categories. 

 

Floating Stacked Bar 

Use a Floating Stacked Bar chart to specify ranges of 
data in bar format and to compare parts to the total or to 
show how components of an item change over time. 

 

Floating Stacked Column 

Use a Floating Stacked Column chart to specify ranges 
of data in column format and to compare parts to the 
total or to show how components of an item change over 
time. 

 

Floating Stacked Bar with Line 
Overlay 

Use a Floating Stacked Bar with Line Overlay chart to 
compare parts to the total or to show how components of 
an item change over time. Specify the lowest and highest 
value for each bar. This results in bars that “float” (not 
attached to the category axis). The line overlay shows 
the trend of one or more items over a period of time or a 
number of events. 
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Floating Stacked Column with 
Line Overlay 

Use a Floating Stacked Column with Line Overlay chart 
to compare parts to the total or to show how components 
of an item change over time. Specify the lowest and 
highest value for each column. This results in columns 
that “float” (not attached to the category axis). The line 
overlay shows the trend of one or more items over a 
period of time or a number of events. 

 

High-Low 

Use a High-Low chart to show the highs and lows for 
different items or different periods of time. 

 

Range 

A Range chart shows the highs and lows of an item, as 
well as the midpoints between the two. You can make 
these comparisons over time. 

 

Column Segmentation 
Use a Column Segmentation chart much like a Column 
chart but with a second value for each series that results 
in width, allowing you to compare two variables for each 
column. 

 

Stacked Column Segmentation 
Use a Stacked Column Segmentation chart to compare 
two values for groups of data that combine to form totals 
in categories. 
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Bar Segmentation  
Use a Bar Segmentation chart much like a Bar chart but 
with a second value for each series that results in width, 
allowing you to compare two variables for each bar. 

 

Stacked Bar Segmentation 
Use a Stacked Column Segmentation chart to compare 
two values for groups of data that combine to form totals 
in categories. 

 

Line 

Use a Line chart to show the trend of one or more items 
over a period of time or number of events. Line charts 
are best for plotting a long series of data points. 

 

Line Fill 

A variation of a Line chart, using a fill below the data 
series line. To create a fill, use the “Fill Below Line” 
option in the “Options” dialog box. 

 

Step 

Use a Step chart to compare items that do not show a 
trend. Step charts display discrete points along the value 
axis, with vertical lines showing the difference between 
each point. 

 

Open High Low Close Use an Open High 
Low Close chart to show values that fluctuate within a 
given time period, such as a day or hour. 
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Candlestick 

Use a Candlestick chart to show whether the open or 
close activity has increased or decreased within the 
bounds of the highs and lows for different items or 
different periods of time. This chart is similar to the 
Open High Low Close chart. 

 

Bubble 

Use a Bubble chart to show a visual comparison using 
three values. 

 

Area 

Use an Area chart to emphasize the volume or size of a 
data series, over time. 

 

Area Percent 

An Area Percent chart is a variation of an Area chart 
with the data series appearing as a percentage of the 
whole. To create an Area Percent chart, use the 
“Percentage” option in the “Options” dialog box. 

 

Spider 

Use a Spider chart to show multiple variables, such as 
performance levels, ratings in different areas, or 
progress. 

 

Radar 

A Radar chart is a variation of a Spider chart. To create a 
Radar chart, turn off the “Show Fill” and “Show 
Axes/Ticks” and turn on the “Radius Major” options in 
the “Options” dialog box. 
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Pie 

Use a Pie chart to show the relationship of parts to the 
whole. 

 

Donut 

A Donut chart is a variation of a Pie chart with a hole in 
the middle. To create a Donut chart, use the “Donut” 
option in the “Options” dialog box. 

 

Stacked Pie 

Use a Stacked Pie chart to show the relationship of the 
parts to the whole for two or more data series. 

 

Multiple Pie 

Use a Multiple Pie chart to show the relationship of the 
parts to the whole for two or more data series. 

 

Time Line 
Use a Time Line chart to display a project schedule, time 
line, or even a product comparison based on a 
predetermined scale. 

 

Table 

Use a Table chart to show chart data as it appears in the 
Data page. 
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Volume Open High Low Close 
Use a Volume Open High Low Close chart to show 
values that fluctuate in a given time period, such as a day 
or hour. You can plot the total volume, starting value 
(open), the high, the low, and the final (close) values. 

 

Volume High Low Close 
This chart is similar to the Volume Open High Low 
Close chart except that it does not use the second column 
of data, the open values are not represented, and the 
corresponding second column in every series should be 
left empty. 
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2-D Technical Charts 

 

Paired Scatter 

Use a Paired Scatter chart to show data points from 
oneor more data series, each point having unique X and 
Y coordinates. This chart is similar to the Paired XY 
Line chart in the way the data is organized, but the 
Paired Scatter chart does not sort the X values before 
plotting the data. 

 

Paired Intensity Scatter 
Use a Paired Intensity Scatter chart to show data points 
from one or more data series with each point having 
unique X and Y coordinates. “Paired” refers to how the 
chart interprets the data that makes up each series of X 
and Y coordinates. 

 

Paired XY Line 

Use a Paired XY Line chart to show sorted data points 
from one or more data series with unique X and Y 
coordinates. “Paired” refers to how the chart interprets 
the data that makes up each series of X and Y 
coordinates. 

 

Scatter 

Use a Scatter chart to show data points from one or more 
data series, each point having the same X coordinate and 
unique Y coordinates. This chart is similar to the XY 
Line chart in the way the data is organized, but the 
Scatter chart does not sort the X values plotting the data. 
The number of rows determines how many points are in 
a data series. 
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Intensity Scatter  
Use an Intensity Scatter chart to show data points 
from one or more data series with each point having 
the same X coordinate and unique Y coordinates plus 
a Z-axis intensity value. The number of rows 
determines how many points are in a data series. 

 

XY Line 

Use an XY Line chart to show a comparison of one or 
more data series, each having the same X coordinate 
and unique Y coordinates. This chart is similar to the 
Scatter chart in the way the data is organized, but the 
XY Line chart sorts the X values from left to right 
before plotting the data. 

 

XY Column 

Use an XY Column chart in much the same way as a 
Scatter chart. Create columns by filling the area below 
and to the left of each XY data point. 

 

Polar 

Use a Polar chart to show relationships between angles 
measured in degrees and some other quantity. 

 

Ternary 

Use a Ternary chart to show the percentage of a whole 
based on three parts of information. 
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Ternary Percent 

Use a Ternary Percent chart to show the percentage of 
a whole based on three parts of information, two of 
which are data in percentage form. 

 

Contour Line 

The Contour Line chart is a variation of the Contour Fill 
and 3-D Surface Line/Fill charts. A Contour Line chart 
does not have a value axis; the values are shown as a 
series of lines and numbers within the chart instead. 

 

Contour Fill 

Use a Contour Fill chart to show surface variation based 
on two sets of evenly spaced values (such as latitude and 
longitude at 10° intervals), which can be entered as row 
and category labels, and a unique number (such as 
elevation at a given point). 

 

XYZ Contour Line 

Use an XYZ Contour Line chart to show variations and 
relationships over three sets of values: latitude, 
longitude, and elevation. 

 

XYZ Contour Fill 

Use an XYZ Contour Fill chart to show variations and 
relationships over three sets of values: latitude, 
longitude, and elevation. 

 

Gridded Vector 

Use a Gridded Vector chart to display a direction (like 
air flow) using vectors (arrows) over a gridded area. 
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R/A Gridded Vector  
Use a Radius/Angle Gridded Vector (R/A Gridded 
Vector) chart to show direction (such as airflow) using 
vectors (arrows) over a gridded area. 

 

XY Vector 

Use an XY Vector chart to display a direction (such as 
airflow) using vectors and a magnitude (dependent 
upon the endpoint calculation method). 

 

2-D Statistical Charts 

 

Histogram 

Use a Histogram chart to show the frequency or 
occurrence of selected data in a specified range. 

 

Pareto 

Use a Pareto chart to show data that need to be counted 
and sorted. 

 

Ogive 

Use an Ogive chart to show the 
running sum of frequency counts. 
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Box Plot 

Use a Box Plot chart to show the 
“spread” of data between categories. 
Statistics are computed to reduce the 
amount of information displayed while 
still showing the distribution of data in 
each category. 

 

Survival Chart 

Use a Survival chart to show the decay of a variable 
based on an independent variable (typically time). 

 

Quality Control Charts 

 

X-R (X Bar-R) 

The X-R chart uses measured values in each sub- group 
to compute the average value and the range of the data. 

 

X-S (X Bar-S) 

The X-S chart is similar to the X-R chart except the 
standard deviation is plotted. This chart is more 
appropriate when the set of measured values is greater 
than 10. 

 

Fraction Defective The Fraction Defective 
(p) chart shows the fraction of defective items in each 
measured subgroup. Data are shown as subgroup sizes 
and defectives are represented as percentages. 
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Number of Defectives The Number of 
Defectives (pn) chart shows the number of defective 
items in each subgroup. All subgroups must have the 
same number of members. 

 

Defects Per Unit 

The Defects Per Unit (u) chart shows the number of 
independent defects per unit. Use this chart if there may 
be many defects. Subgroups can vary or be constant. 

 

Number of Defects The Number of 
Defects (c) chart shows the number of defects within a 
subgroup. The subgroup sizes are constant. 

 

3-D Business Charts 

 

3-D Column 

Use the 3-D Column chart to compare one item to 
another or to compare different items over a period of 
time. Column charts effectively show dramatic changes 
from one category to another. 
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3-D Area 

Use a 3-D Area chart to emphasize the volume or size 
of a data series, frequently over time. This chart is a 
variation of a 2-D Line or Area chart. 

 

3-D Ribbon 

Use a 3-D Ribbon chart to show trends. This chart is a 
variation of a 2-D Line chart. 

 

3-D Technical Charts 

 

3-D Scatter 

Use the 3-D Scatter chart to plot data points created by 
the intersection of three different coordinate values. The 
points are connected to one of the chart planes with a 
drop line. Each of the three values that make up a point 
corresponds to a particular axis in a 3-D grid. 

 

3-D Scatterline 

The 3-D Scatterline chart is a variation of the 3-D 
Scatter chart, except that it connects the data points by a 
line, as in “connect-the-dots.” This chart measures 
something that moves in space as a function of time: a 
satellite orbiting earth, for example. The chart shows a 
path of contact points along an implied time line 
represented by the position of the points along the line. 
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3-D Wireframe 

Use a 3-D Wireframe chart to show three-dimensional 
changes in an object or over time. It is a variation of a 
Contour chart. 

 

3-D Surface Fill 

Use a 3-D Surface Fill chart to show surface variation 
based on two evenly spaced values (such as latitude and 
longitude at 10° intervals), which can be entered as row 
and category labels, and a unique number (such as 
elevation at a given point). 

 

3-D Surface Line 

Use a 3-D Surface Line chart to show surface variation 
based on two evenly spaced values (such as latitude and 
longitude at 10° intervals), which can be entered as row 
and category labels, and a unique number (such as 
elevation at a given point). 

 

3-D XYZ Surface Fill  
Use a 3-D XYZ Surface Fill chart to show three 
dimensional data in which one quantity (plotted on the 
Z axis) varies depending on X and Y values. XYZ data 
are not evenly incremented like Surface Line or Fill 
data. 

 

3-D XYZ Surface Line 

Use a 3-D XYZ Surface Line chart to show three 
dimensional data in which one quantity (plotted on the 
Z axis) varies depending on X and Y values. XYZ data 
are not evenly incremented like Surface Line or Fill 
data. 

 


